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This manual is organized as follows:

Introduction

About Viz Mosart

Installation

Frame Accurate System Operations
Audio Players

Manus Administrator

Media Administrator
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Story Recorder Mode

AV Automation

AV Automation Device Properties
Device Connection Strings
Device Configuration Files

Viz Mosart Template Database
Maintenance

Trio Interface

ActiveX

General Configuration Files
Appendix
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1 Introduction

This guide takes you through the setup of Viz Mosart and is a reference guide for use during its
installation and configuration. The purpose of this document is to help new users become familiar

with the system; to illustrate the main workflow, and to show the available options. Familiarity with
XML is required.

1.1 Related Documents

Viz Mosart User Guide: Contains information on how to use Viz Mosart in live production.
For more information about all of the Vizrt products, visit:

- www.vizrt.com

- Vizrt Documentation Center
Vizrt Training Center

- Vizrt Forum

1.2 Feedback And Suggestions

We encourage suggestions and feedback about our products and documentation. To give feedback
and/or suggestions, please contact your local Vizrt customer support team at www.vizrt.com.
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2 About Viz Mosart
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Viz Mosart is a broadcast solution designed for newsroom environments. Mosart allows a control
room to be fully operational with minimal effort and consistency within the production.

Viz Mosart is a collection of server and client applications, along with services, that control
equipment within your broadcast environment.

This section contains the following topics:

Naming Convention for Components
The Viz Mosart System

Viz Mosart Server

Viz Mosart Client

Other Viz Mosart Applications

2.1 Naming Convention For Components

When contacting support, please use the following standard naming convention for Viz Mosart
applications and components:
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Short
Name

AVA

Gul

KVM
Manus

Admin

Media

Admin

MMR

NCS, NRCS

oGl

RCC

RCS

Trio
Interface

URL

Viz Mosart

Long Name

AV Automation
Viz Mosart GUI

Keyboard, Video,
Mouse

Manus
Administrator

Media
Administrator

Media Router

Newsroom
Computer System

Overlay Graphics
Interface

Robotic Camera
Controller

Remote Control
Service

Uniform Resource
Locator

Viz Mosart
Newsroom
Automation
System
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Description

Application controlling attached broadcast equipment.
Main user control application.

Application allowing multiple computers to share the same
monitor, keyboard and mouse.

Application controlling the Viz Mosart Rundown.

Media Administrator. Application for monitoring media objects
(clips).

Application that shares broadcast devices between control
rooms. See Media Router and Mosart Template Database.

Application that controls Overlay graphics systems.

Service used for all external PCs, like GUI and Timing Display,
to connect to Viz Mosart Server. Sometimes referred to as
RCPS.

Application that controls Vizrt overlay graphics. (Kept for
backward compatibility only - use Overlay Graphics instead).

In this context, address of web service.
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2.2 The Viz Mosart System

The Viz Mosart system is a collection of software applications that join to make your production
come together. The applications used may vary between installations and are dependent on your
broadcast environment.

The following is a general and simplified overview of the Viz Mosart system.

Viz Mosart comprises two main applications: the Viz Mosart Server and the Viz Mosart GUI. There
are also several supporting applications, such as the Timing Display and Audio Panel. You can
have more than one Viz Mosart GUI running at workstations connected to the Mosart server.
Normally there are two Mosart servers: one active (live) and one backup server.

Mewsroom
System

VIZ MOSART SERVER

Mosart
Manus Administrator % GUI

T,
Remote Audio
Control Panel
Service —
. . \\ i Y
Media Graphics AV Timing
Admin Interface Automation ™ Display
T N
Audio
Player

BROADCAST DEVICES

A Note: The shaded boxes in the diagram signify a physical device such as a workstation,
server or a piece of hardware. White rectangles represent Viz Mosart applications, white
circles represent Viz Mosart services, and rounded rectangles represent user displays.

The figure above shows a typical Viz Mosart installation with one Viz Mosart Server and four Viz
Mosart workstations to run the user control software. There is also provision for a physically
attached remote audio fader panel attached to a Viz Mosart workstation via the Audio Panel
application. Redundancy is not shown.

All Viz Mosart applications and services are connected via TCP/IP, allowing them to run on any
computer in a common logical network.
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2.2.1 Viz Mosart Applications

The Viz Mosart software package consists of the following applications:
Viz Mosart Server

- Viz Mosart Server
Manus Administrator
Media Administrator
- Overlay Graphics Interface
- AV Automation
Log Service and Log Viewer
Remote Control Service

Viz Mosart Client Applications

- Viz Mosart Client
- Viz Mosart GUI
- Audio Panel
- Timing Display
- Audio Player
- ActiveX
iNews Timer

Other Viz Mosart Applications

- Other Viz Mosart Applications
Media Router and Mosart Template Database
- Omnibus Controller
- SNMP Service
- Test Suite
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2.3 Viz

Mosart Server

VIZ MOSART SERVER

Manus Administrator

Remote
Control
Service
Media Graphics AV
Admin Interface Automation

2.3.1 Viz Mosart Server

The Viz Mosart Server comprises a suite of dedicated server applications, relevant to your
broadcast environment, running independently of one another on the same workstation.

The Viz Mosart Server supports multiple GUI workstations connected to it at any time. The control
room has two Viz Mosart GUIs, one for redundancy, while others can be used for information

purposes and
The Viz Mosa

locked to Browse Mode for monitoring the rundown outside the control room.

rt Server also supports multiple timing displays. Various timing information can be

seen at a glance wherever the application is installed. It may also be helpful to have a different
display for the control room and another for the studio floor. The Timing Display is connected to
the Viz Mosart rundown that is currently On Air.

2.3.2 Viz Mosart Server Components

Icon

Application

Mosart Manus Administrator Executable(s): either
MMConsoleAdmin_2007.exe (FTP, for iNEWS) or
MMConsoleAdmin_MOS.exe (for MOS workflow Newsroom Control
Systems)

Mosart Media Administrator Executable: MMMediaAdministrator.exe
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Icon Application

K

Mosart AV Automation Executable: MMAVAutomation.exe

Mosart Overlay Graphics Executable: MMOverLayGraphicsinterface.exe

T

The Viz Mosart Server is split into four main components plus two services, each handling an
important role for the system to function. Splitting the system into components allows greater
flexibility in handling a variety of broadcast devices and productions.

A typical Viz Mosart Server installation contains the following applications and services.

Manus Administrator (console application): Handles the connection to the Newsroom Control
System (NCS).

Media Administrator (console application): Application for monitoring media objects (clips)
referenced in the current rundown. Supports the media search option used in the Viz Mosart
GUL.

Overlay Graphics Interface (Windows application): Application for controlling and monitoring
overlay graphics.

AV Automation (Windows application): Application for controlling all other external
broadcast equipment.

Log Service and Log Viewer (Windows service): Service used for generating Viz Mosart
command logs. Automatically installed with Viz Mosart Server and the Viz Mosart GUI.
Remote Control Service (Windows service): Service used for all external PCs, like GUI and
Timing Display, to connect to the Viz Mosart Server. Automatically installed with the Viz
Mosart Server.

Normally, all of the services listed above should be running at all times on the Mosart server. To
ensure this, you could start them from a convenience batch-script such as the one below:

StartMosartServicesAndGUl.cmd

1 @echo off
2
3 @REM Assume we are 1installed at the default location, otherwise fix path
4 cd "C:\Program Files (x86)\Mosart Medialab\Mosart Server"
5
6 start "Manus Admin" /MIN MMConsoleAdmin_MOS.exe
7 timeout /T 1 > nul
8 start "Media Admin" /MIN MMMediaAdministrator.exe
9 timeout /T 1 > nul
10 start "AvAutomation" /MIN MMAVAutomation.exe
11 timeout /T 2 > nul
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12 start "OverlayGraphics" /MIN MMOverlLayGraphicsInterface.exe
13 timeout /T 1 > nul

14 cd "C:\Program Files (x86)\Mosart Medialab\Mosart GUI"

15 start "Mosart GUI" MosartMultiGui.exe

The status of the console applications (Manus Admin and Media Admin) can easily be seen on the
Viz Mosart server console. The same applies Windows applications AvAutomation and
OverlayGraphics.

The RCS (Remote Control Service) and Log Service run as Windows services and are therefore not
available for easy visual inspection. It's recommended to make these services start automatically
when Windows starts up. One easy way to do this is to use the Windows services application (Start
button > Services): locate the required services in the services window, right-click the service and
make sure its properties are set to Automatic as shown in the screenshot below:

File Action View Help

e |FEdE HeE » oo

- =

£ Services (Local) MName Description
‘&l MessagingService_19ebbed Service supporting text messaging and related functionality.
&l Microsoft (R) Diagnostics Hub Standard M R c | Service P ‘e (Local C « hing, this service

. . . . t t t rt t . .
& Microsoft Account Sign-in Assistant osart Remote Control Service Properties (Local Computer) Iy services, If this
& 0 Ry
i Microsoft App-V Client General LogOn  Recovery Dependencies
&k Microsoft iSCSI Initiator Service uter to remote i5
& Microsoft Office Click-to-Run Service Service name:  Mosart RemoteCortrolService B, and system int
Sk Mi .
i Microsoft Passport Display name: Mosart Remote Control Service ffo authenticate t
‘£l Microsoft Passport Container ser to identity p
&k Microsoft Software Shadow Copy Providg  Description: Efrtr;:;:tirs;ponmble for remate control of the Mosart by the Volume £
‘&l Microsoft Storage Spaces SMP ment provider. If
£l Microsoft Windows SM5 Router Service, Path to executable:
‘£ Mosart Logging Service "C:\Program Files (x86)\Mosart Medialab'Mosart Server'\RemotePanelDispz
&l Mosart Media Router Service -
. . Startup type: Automatic o

‘& Mosart Omnibus Controller Service press
&Mosar‘c Remote Control Service \ utormation
‘£ Mosart SNMP Service
~.,(' _’;Mom a Waintenance Senvice Service status:  Stopped n nyeste og sikn
Gl M5-MPI Launch Service S - o S
15l Natural Authentication - - ol e put and other tr.
&} Net.Tep Port Sharing Service You can specify the start parameters that apply when you start the service ocal.
&l Netlogon from here. the domain cor
&l Network Connected Devices Auto-Setup ors and installs g
&1 Network Connection Broker receive notificat
Ch Network Connections ons folder, in wh
S Network Connectivity Assistant nents
o | ok || Cancel Apply
Gl Network List Service nected, collects
% Matiuanrls | aratinn Auaransce Fallarte and ctnrar ranfimratinn infrrenatinn far the nebunrl and notif

If you prefer the command line, you can easily inspect and start/stop services from Powershell.
Start an elevated Powershell (Admin) session via Start > Powershell > right-click and select Run as
administrator.

In the example below, the Mosart Logging Service and RCS are running, while other Viz Mosart
services are stopped:

PS C:\Users\bva.VIZRTINT> Get-Service | grep Mosart

Running MosartLogService Mosart Logging Service

Stopped MosartMediaRout... Mosart Media Router Service
Stopped MosartOmnibusCo... Mosart Omnibus Controller Service
Running MosartRemoteCon... Mosart Remote Control Service
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Stopped MosartSNMPService Mosart SNMP Service

Manus Administrator

' Viz Mosart - ManusAdministrator 3.8.0.25778 IDLE - <no active rundown= — O *

strator_2887 ExSetAvConfig Loading AvConfig
aredChannelTemplat SHvideoChannel Did not find Server A/B Roll defintion for SERVERGS
not find Server A/B Roll defintion for SERVER

2 15 Did not find Server A/B Roll defintion for BACK UP SERVER
2 I 3 15 MMAVSharedChannelTemplates getHSHvideoChannel Did not find Server A/B Roll defintion for BACK UP SERVE

Newsroomsettings version OK.
88:27:54 I 3 18 NewsroomSettingsRepository Initialize MNewsroomsettings configurations succesfully loaded into th
e repository.@8:27:54 18 Newsroomsettings configurations succesfully loaded into the repository.

NEWSROOMSETTING hanneltemplates\newsroomsettings.xml

e v
e 7: 3 trator_2807 ManusDirectory Manus Directory i
e sAdministrator 2867 ExSetAvConfig Loading AvConfig@s:: 15 Loading AvConfig

15 Did not find Server A/B Roll defintion for SERVER
nel Did not find Server A/B Roll defintion for SERVER
5 UP SERVER
3 15 MMAVSharedChannelTemplates getHSHvideoChannel Did not find Server A/B Roll defintion for BACK UP SERVE

3 15 ManusAdministrator_2807 ExSetChannelTemplates ChannelTemplates loaded, current studiosetup is TVA 2817
15 ChannelTemplates loaded, current studiosetup is TVA 2

Manus is short for manuscript, the script originating from the Newsroom Control System

(NCS). Manus Administrator is the central Viz Mosart application that controls the current rundown
in the Viz Mosart GUI and receives rundowns from the attached NCS. It issues events according to
the different story items in the rundown and is dynamically updated when changes are made in the
NCS. Although Manus Administrator receives information from the NCS, it does not send updates
back - this prevents rundown control conflicts between the systems.

The Manus Administrator handles the connection to the NCS, and executes commands at the
appropriate time according to GUI input and template configuration.

The Manus Administrator runs as a live console application and responds to free text commands.
For improved execution speed, Manus Administrator should be run in the background or be
minimized.

Variants

Manus Administrator has variants with slightly different settings that suit different broadcast
environments. During installation, select the Manus Administrator appropriate to your
environment:

MMConsoleAdmin_2007 for iNews FTP Newsroom connections
MMConsoleAdmin_MOS for MOS Newsroom connections

A Note: Manus Administrator is sometimes also referred to as MMConsoleAdmin,
ManusAdmin, ManusAdministrator or just Manus.
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Media Administrator

¥ Select Viz Mosart - Media Administrator 3,8.0.25778 — O X

[y

LoggerFactory Created

-

g set to Verbos
3 on to manus administ
Initiate connection to servers
Started event thread
/1
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[]
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18 I ection to TCP://localhost ! artRemotePanelService succee
ded: MMMediaAdministrator@BGO-OVA-21.08-: . MediaAdministrator
Server Connected
27:18 I 3 7 MediaAdministrator ' ManusAdministrator connected
~ InitEventReceiver S tion to MJAdministrator: localho
~ InitEventReceived U a "3 25
n Clear In lizing clip stack to zero
OnRemoteDispatcherConnected Remote atcher connected: True
rtRemote OnvVideoSery 8 Invalid command MIRROR_SWITCH
rtRemote OnVideoServerSalvo Invalid command SALVOLIST
rtRemote OnVideoSery alvo Ignores ACTIVE_VIDEO SERVERS, no dynamic configuration enabled
~tRemote OnVideoSer alvo Ignor IVE_VIDEO_SERVERS, no dynami ration enabled
OnVideoSer alvo Ignore IVE_VIDEO_SERVERS, no dynami ration enabled
OnvideoSery alvo Ignores ACTIVE_VIDEO_SERVERS, no dynamic configuration enabled
rtRemote OnvideoServerSalvo Invalid command CHANGESALVO
rtRemote onvideoServersalvo Ignores ACTIVE_VIDEO_SERVERS, no dynamic configuration enabled
MosartRemote OnVideoServerSalvo Invalid command SALVOLIST

e
e
e
e
e
e
e
8
e
e
e
e
e
e
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WO W W W W W W W W

The Media Administrator (MMMediaAdministrator) handles the database connection to your video
servers. This application references the database to provide a current clip list within the Viz Mosart
timeline, without making changes.

Mainly used for monitoring and searching video clips on connected video servers, the Media
Administrator:

Is responsible for reporting status for all clips in the current rundown to the Manus
Administrator - typically whether a clip is present and properties like clip duration. The clip
status for video servers is displayed in the Viz Mosart GUI as horizontal bars. A light-blue bar
indicates a clip that is present on the video server, whilst a checkered bar indicates a non-
existing clip. Clip length is shown by the length of the horizontal bar in the Viz Mosart GUI.
For other media objects, Viz Mosart may present clip status in other ways.

Makes it possible to search for clips on the video server. This functionality is used by the Viz
Mosart media search window, making it possible to add clips to the rundown without the
use of an NCS. You can also search for other media objects like subtitles, graphic elements,
and audio files.

The Media Administrator runs as a live console application and responds to free-text
commands. It should be run in the background or minimized for improved execution speed.

Overlay Graphics Interface
This is used for controlling and monitoring overlay graphics for graphics engines.
The two overlay graphics interfaces are:

OverlayGraphics Interface (recommended).
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- Trio Interface (to be deprecated, kept for backward compatibility only).

& Note: An overlay graphics interface is only used for overlay graphics. Full-frame
graphics are controlled through AV Automation.

¥iz Mosart - OverlayGraphics

The Overlay Graphics is used for controlling and monitoring the overlay graphics for all Viz Mosart

approved graphics engines. Configure it using Overlay Graphics Configuration. For a list of
supported graphics devices, see Overlay Graphics Types.

Trio Interface

& Note: Trio Interface is no longer recommended for use and is kept for backward
compatibility only. Vizrt recommends using the Overlay Graphics instead.
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= Viz Mosart - AVAutomation: NameOfGallery (TEST)
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-25 -51 0 0 0 0 -5

LIVE1 LIVE3 | LIVE4 | CLIP1 | CLIF2 | CLIF3 | CLIP4 |
transeffect

LIVE1 LIVEZ LIVEZ LIVE4 CLIF2 CLIFZ CLIF4

Connection to ManusAdmin failed: Attempt reconnect in 2 seconds
Requesting reconnect to ManusAdmin: admin=Falze
Connection to ManusAdmin failed: Attempt reconnect in 2 seconds
Requesting reconnect to ManusAdmin: admin=False
Connection to ManusAdmin failed: Attempt reconnect in 2 seconds
Requesting reconnect to ManusAdmin: admin=False
Connection to ManusAdmin failed: Attempt reconnect in 2 seconds
Requesting reconnect to ManusAdmin: admin=False
Connection to ManusAdmin failed: Attempt reconnect in 2 seconds
Regquesting reconnect to ManusAdmin: admin=False
Connection to ManusAdmin succeeded: admin=True

Build 0.0.0.23539 271016 ManusAdm Mirror MR

W

TDB
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—Status

—Video Ports

17.11.2016 13:26:34

AV Automation (MMAVAutomation) controls all Viz Mosart broadcast devices with the exception
of Overlay Graphics engines. Full-screen graphics is also controlled here.

Commands are issued to each device either on the fly through the Viz Mosart GUI, or as pre-
determined by the rundown submitted from the NCS.

All device commands are stored as predefined Viz Mosart templates in the Template Editor and are

saved in C:\channeltemplates or in a template database.

Log Service and Log Viewer

Log Service

This is used for generating Viz Mosart command logs and is automatically installed together with

the Viz Mosart Server and the Viz Mosart GUI.
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Log Viewer

(o

Logviewer

Log Viewer is used to decipher Viz Mosart logs. It is stored as an XML file once published, and as
a .log file while actively running.

The log entries are color-coded to allow for quick command visualization in the file. Microsoft
Excel may also be used to display log files (XML), and lets you use several layers of filtering and
plot graphs.

o C:\Users\Matt\Desktop\TVQ Logs\MMLOGS\Log.20140217-142444.xmI - o
File ~ Show ~ Search ~ Show only Reset Filter filter Out Refresh Showlast 0 AutoRefresh
CueDelay set to 1000 ms (25 frames, min. cue delay)

=

inde | Log time Hosiname | Log module Method Logclemert | | Logten
. a
4561 | 2014-02-17T16:37.29.., | SASTVADT | MMConsoleAdmi.. | SwitchBackGrou.. | ManusAdministr | 3 | Slug=CAM BLACK, Story=1650 CLAPPER-VIZ. Temp!
.4552 2014-02-17T16:37:30... .SﬁST\-"QD'l ll'u'll'-la‘u’h.r:nmatm .Cue.bcneasmesl..l Ao Automation PREVIEW ACCESSORIESRouter set matrix 0 level
[4563 | 201402-17T16:37:30... | SASTV01 | MMAVAUtomation | PrepareGraphics | Graphics 3 Got Vizcommand from dataelement ' CLAPPER / BRIS
4564 | 201402-17T16:37:30.. SASTVOO! MMAVAtomation LoadGraphics | Graphics |3 | Graphics loaded * CLAPPER / BRISBANE (TVQ) UPDAT. |
4566 | 201402-17T16:37:30... | SASTVGOT MMAVAUtomation | SchedueElement | Graphics ‘3 | Schaduing: viz=viz_mosan_b, commandecim, shows... -
-455? 2014-0217T168:37:32... .S.P«STVQm MMAVAUtomation -DaEa'ryTakehC .Genelallrfu . 3 . EarlyCommand DIRECTTAKE - 800{STBY ALL MICs
.4553 20140217T16:37:32... lSﬁST\-"QD‘I MMAVALtomation .Takeﬂ«cusw'ies lthurnﬁion H PROGRAM ACCESSORIESRouter set matrix 0 level
|4569 | 2014.02.17716:37:32.. | SASTVQO1 | MMAVAutomation | TakeGraphics | Graphics 3 Graphics taken ' CLAPPER / BRISBANE (TVQ) UPDATE
4570 | 2014-02-17T16:37:32... | SASTVGO1 | MMAVAtomation | RipleGraphicsGr. | AvAutomation |3 | Graphics ripple 2 current=2, next=2

[4571 | 20140217T16:37:32. | SASTVRD!  MMAVAtomation  MMAudia fudoMuer |3 Post onair channels: SVR D ST, READER1 MAIN, SVR
I I T T [ T

Remote Control Service

The Remote Control Service (RCS, sometimes referred to as RCPS) allows all external PCs, such as
the Viz Mosart GUI and Timing Display, to connect to the Viz Mosart Server. RCS is automatically
installed together with the Viz Mosart Server.

See Also

Manus Administrator

AV Automation

AV Automation Device Properties
Media Administrator
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2.4 Viz Mosart Client

The main components that make up Viz Mosart Client are:

Viz Mosart GUI: Fullscreen Windows application used to control and monitor the Viz Mosart
rundown.

Audio Panel: Fullscreen Windows application used to control and monitor software audio
faders.

Timing Display: Fullscreen Windows application used to display various timing information
from the Viz Mosart rundown.

Audio Player: Used to play out audio files located on the file system.

Additional Viz Mosart Client applications:

ActiveX
iNews Timer

A Note:
= Multiple instances of the above applications may run on any workstation connected

to the same network as the Viz Mosart Server.
= All instances of Viz Mosart software must run the same Viz Mosart version with a
standard OS across all Viz Mosart client machines.

2.4.1 Viz Mosart GUI

-~
P L
Mosart GUI
The Viz Mosart GUI workstation is a standalone networked PC with a single instance of the Viz

Mosart GUI application (MosartMultiGui) run in full-screen mode. More than one PC can run the
same software component, for example, you can add a backup GUI PC.

The Viz Mosart GUI is the main control interface for the Viz Mosart Server. The director can run the
production from a single key press on the workstation keyboard.
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Alternate configurations may also host a fader panel and a Timing Display. Each Viz Mosart Client
application should run on a standalone networked PC.

The Viz Mosart GUI is described in detail in the Viz Mosart User Guide.
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2.4.2 Audio Panel

T Mesan e Panel = ]
mosart

ETAMDEY STAMDEY

STAHDEY

Audio Panel (Server)

The Audio Panel (AudioPanel) lets you use a Behringer BCF2000 or JL Cooper MXL with a Viz
Mosart Server. The panel controls data transmission between the physical hardware panel and AV
Automation on the Viz Mosart Server.

Audio Panel (Client)

liviberesanis Eyupefies
(Prericsl)
The Audio Panel (Client) is a software representation of the audio mixer connected to the Viz

Mosart Server, displaying current faders, on air faders, and faders in preview.

The Audio Panel is described in detail in the Viz Mosart User Guide.
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2.4.3 Timing Display

Tooks ‘Conrastiions mosa rt

MOSART 2100 BUSINESS NIGHT

+ 04:15

OO0: 09O PMTOPMARKETS # 2L-WPSTLVO OO = O A

09:27:30 PM

00:08

1613.2401.36 ASXBIZLVO =S

00:26

The T|m|ng D|splay (WPFTlmmgInfo) provides timing information to the studio control room and
the studio floor.

The Timing Display is synchronized to the current rundown in the Viz Mosart GUI. You can run as
many customized Timing Display applications as you need for the production.

The Timing Display is described in detail in the Viz Mosart User Guide.

2.4.4 Audio Player

The Audio Player is part of the Viz Mosart installation and may be used to play out audio files
located on the file system. This is useful for playing out files that are used on a regular basis, such
as openers and audio-beds.

& Note: A broadcast sound card is required for audio output. If you're running the Audio
Player on a Windows Server, you must install Windows Audio features on the machine in
order for the various audio formats to work.
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() Viz Mosart Audio Player  Settings

9 LiveSoundService AVAutomation pinged the service
io Di : CAlydvignetter\Nyhetskanale . . L " . T
] LS UM LA R EE 11 LiveSoundService AVAutomation stopped pinging
1: Qutput 1 Stopped (Pnmary Sound Driver)
2: Output 2 Stopped (Line QOut (4- Scarlett 2i4 USE]))
3: Qutput 3 Stopped (Speakers (Realtek High Definition Audio))

AVAutomation 10.211.114.132

& Note: The Audio Player replaces the discontinued Soundfile Player.

The Audio Player is described in detail in the Viz Mosart User Guide.

2.4.5 ActiveX

£
Viz Mosart
[Los -] +
iFunu::spen: j
CaERA 1 —Description T ezt
FACKAGE i name...
YOICEOWER S0T deszcription ;I
o3 S0T?
GRAFHICS FLLL
WIDEDQ EFFECT LOOF ﬂ
JINGLE — Transition
FHOMNO
FLOAT Mix =]
BREAK
WIDECWYALL
CG Mame | Yalue
SOUND clip_description
ACCESSORIES e
COMMAND clip_hirespath
Wersion 3.7.0,23436

The ActiveX is used to insert Viz Mosart template information into the Newsroom System script.
It's compatible with any newsroom system that allows ActiveX plugins.
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The ActiveX list displays the first template name result it finds under NCS tags in Newsroom
Settings. The user selects a Viz Mosart template type and variant, which can then be dragged into
an entry in the Viz Mosart rundown. When the script is saved, information is pushed to Manus
Administrator and the active rundown in the Viz Mosart GUI.

The ActiveX is installed as a standalone component and is independent of the version of Viz
Mosart Server used.

Viz Mosart has its own ActiveX NCS plugin. The plugin lets users insert Viz Mosart commands to
the scripts from a list of available Viz Mosart templates.

The templates and transition effects that are shown in the ActiveX may also depend on the value of
Studio Setup in AV Automation > Audio and Video Setup.

When a particular Studio Setup has been selected in the ActiveX (in the second dropdown box),
only effects with this studio setup (as defined in AV Automation > Audio and Video Setup) will be
available in the Transition dropdown. Effects with no studio setup defined are global effects and
always appear in the Transition dropdown.

2.4.6 iNews Timer

The iNews Timer provides accurate timing of the production in iNews, and is used to synchronize
the story currently on air in the Viz Mosart GUI to the corresponding entry in iNews.

2.5 Other Viz Mosart Applications

This section contains the following topics:

Media Router and Mosart Template Database
Omnibus Controller
SNMP Service

- Test Suite

2.5.1 Media Router and Mosart Template Database

Media Router and Template Database with a MySQL database enables two features within Viz
Mosart:

Resource sharing: video servers, graphics devices, robotics, and so on.
Viz Mosart can be configured to use shared broadcast devices between control rooms via the
dedicated Media Router (MMR). This device enables Viz Mosart to select other devices before
the next show.
The vision switcher and audio mixer are not included in Media Router control, but may in
some situations be shared, depending on the device’s capability and/or the planned use of
the device.

- Template sharing: Viz Mosart template information between multiple Viz Mosart
installations.

These features are a licensed addition to the Viz Mosart Server. Please consult your nearest sales
agent for more information.
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2.5.2 Omnibus Controller

The Omnibus Controller allows communication with Omnibus systems for Viz Mosart installations
running Omnibus equipment.

2.5.3 SNMP Service

This application allows for system monitoring of the Viz Mosart Server with SNMP agents such as
Nagios and Navigator. Any SNMP agent application with MIB support is able to use this service.

2.5.4 Test Suite

The Test Suite contains various diagnostic utilities that can be used when installing Viz Mosart for
the first time or when connected broadcast devices must be checked.

This is a list of some of the tools available in the Test Suite:

- AsRunLogTester: Test AsRun Log publishing
MediaRouterTester: Test Media Router
MVCPSimul: Test MVCP protocol
NexioTest: Test Nexio protocol
- QuantelTest: Test Corba protocol
RoboTest: Test camera robotics
- ShotokuTester: Test Shotoku camera robotics
- TestAudioMixer: Test Audio Mixer communications
- TestMIDIShowControl: Test MIDI Lighting control
- TestRouterControl: Test Router communications
- TestVDCP: Test VDCP protocol
- TestVisionMixer: Test Vision Mixer communications
- VintenTester: Test Vinten 200 protocol
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3 Installation

This section contains an overview of how to install the various Viz Mosart Applications, by running
standard Microsoft installers (.MSl files).

Prerequisites
Viz Mosart Installation Files
Viz Mosart Installation Administrator

3.1 Prerequisites

There are several system prerequisites that must be in place before the Viz Mosart Applications are
installed.

This section contains:

System Requirements
Microsoft .NET Framework
Microsoft Visual C++ Redistributable Package (x86)
Hardware Requirements
- Viz Mosart Automation Servers
- Viz Mosart GUI PCs
Viz Mosart Audio Player
- Viz Mosart Timing Display and Audio Panel PCs
- Viz Mosart Shared Template Database
Pre-Installation Tasks
Connections

3.1.1 System Requirements

The following apply all machines running Viz Mosart software:

Prerequisite Target Description
Microsoft Viz Operating system. Viz Mosart has been verified working with
Windows Server Mosart Windows Server versions up to and including Windows Server 2019.
2008 R2 or Server  Viz Mosart Server will also work with Windows 10.
later
Microsoft Viz Operating system. Microsoft Windows 7 Professional may also be
Windows 10 Mosart used, but this version is no longer supported by Microsoft.

Client
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C++
Redistributable
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All

Viz
Mosart
Server

All

All

Viz

Mosart
Server

Viz
Mosart
Server

All
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Description

See the Viz Mosart Release Notes for the applicable Microsoft .Net
version. Most of the Viz Mosart installers abort the installation
process if .NET 4.5 is not detected.

See the Viz Mosart Release Notes for the applicable Microsoft Visual
C++ Redistributable Package.

The following folder must be available, containing Viz Mosart
installers, before installation: C:\mosart\installers

For some versions of Windows, it may be necessary to open ports.
Either completely disable Windows firewall, or alternatively open for
Ping and ports 8080-8099. If Mosart Template Database is used,
port 3306 also must be opened.

If MIDI devices are connected via direct conversion serial adapters,
Windows Audio feature must be enabled on the server.

& Note: If using Windows Remote Desktop, audio must be set
to play on the server, not the remote PC, as the Audio
configuration will otherwise be disturbed.

It may be favorable to configure the Windows Server running the Viz
Mosart Server software to Application Server, as this automatically
pre-configures several features and also automatically sets a
detailed .NET configuration.

For more details, see below.

& Note: All prerequisites must be completed before installing any Viz Mosart components,
both server and client applications.

Microsoft .NET Framework

Microsoft .NET must be installed on the system before installing any Viz Mosart Applications. See
the Viz Mosart Release Notes for the applicable Microsoft .Net version.
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To determine which Microsoft .NET Frameworks are installed

If you do not know how to determine this, contact your IT System Administrator to learn how
to.

Installing the Microsoft .NET Framework

1. Obtain the applicable Microsoft .NET Framework Installer from the Microsoft Download
Center.

2. Run the installer and follow the prompts.

3. Restart the machine if prompted on completion.

Microsoft Visual C++ Redistributable Package (x86)

A Microsoft Visual C++ Redistributable Package (x86) must be installed on the system before
installing the Viz Mosart Server software. See the Viz Mosart Release Notes for details on the
Microsoft Visual C++ Redistributable Package.

& Note: Viz Mosart is a 32-bit program.
Obtain the applicable Visual C++ Redistributable Package (x86) installer from the Microsoft
Download Center.
Installing Microsoft Visual C++ Redistributable Package:

1. When downloading, please ensure that you select the 32-bit (x86) version.
2. Run the installer and follow the prompts.
3. Restart the machine if prompted on completion.

3.1.2 Hardware Requirements

Viz Mosart Automation Servers

Two servers: one main and one backup.

Minimum Recommended Hardware Configuration

Dual Power Supply for redundancy

Redundant disk configuration

Integrated Lights Out (iLO), IPMI or similar with Keyboard-Video-Mouse (KVM) support
- Windows operating system with applicable .NET Framework

2 x Gigabit Ethernet ports

1280 x 1024 display adapter

8 GB Memory

Recommended Performance-related Components

2 Processors with performance as 2.0 GHz dual-core and with 4 MB L2 cache
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Minimum 50 GB free storage space
- Windows Server 2008, 2012 or 2016 operating systems

Site-specific Requirements
Location-specified external device connections might include the following examples:

PCI multiport serial card RS-422/RS-232 (short distance connections).
www.moxa.com CP-118EL-A.htm
IP connected Terminal Servers with serial output ports RS-422/RS-232 (long distance
connections).
www.moxa.com - 2650
www.moxa.com - 5150
IP connected Terminal server with MIDI output port.
www.kissbox.nl - CM-MIDI
- Additional Ethernet ports
IP connected GPIO control box
https://www.wut.de/e-57730-ww-daus-000.php

A Note: W&T is the only GPIO control device vendor supported by Mosart. Up to four boxes

can be controlled, giving 48 outputs. Only the first box is used for input, giving you 4
predetermined Mosart rundown functions, and 8 general inputs. Display, keyboard and
mouse should be available in the relevant gallery.

Viz Mosart GUI PCs

Two PC's: one main and one backup.

Minimum Recommended Hardware Configuration

Local PCs physically located in the control room. Alternatively Integrated Lights Out (iLO),

IPMI or similar, optionally with Keyboard-Video-Mouse (KVM) support.
- Windows 10 64 bit operating system with applicable .NET Framework
- Gigabit Ethernet port
- Approved video adapter with resolution 1920 x 1080

8 GB Memory

5.0

Displays with minimum 1920 x 1080 resolution, keyboard and mouse should be installed in

the gallery.

Recommended Performance-related Components

Processor with performance equal or better than Intel 2.0 GHz Dual-core
Minimum 50 GB free storage space.

Viz Mosart Audio Player

If you will use the Viz Mosart Audio player, a single dedicated PC is normally placed in the server

room.
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The degree of hardware redundancy required for this function shall be considered.
The PC running the Viz Mosart Audio Player should be equipped with:

- A broadcast quality audio card registering with Windows driver. For example:
Lynx Studio Technology AES16e PCl Express AES/EBU Interfaces, www.lynxstudio.com
- Windows 10 operating system with applicable .NET Framework.
Ensure the audio card is supported by the selected Windows operating system.
Remaining hardware configuration and performance parameters are similar to GUI PCs.

& Note: The Viz Mosart Audio Player replaces the discontinued Mosart Sound File Player.

Viz Mosart Timing Display and Audio Panel PCs

The main purpose of these two PCs is to display the output from the respective Viz Mosart
applications.

For the Audio Panel it is also possible to interact with the application via mouse and
keyboard.

The configuration and performance parameters shall be similar to the GUI PCs.

Viz Mosart Shared Template Database

The Template Database is built on an Oracle MySQL Server. Actual database traffic will be light -
any modern PC will suffice, since Viz Mosart template features are more similar to a shared
storage function than a classic database transaction server.

Recommended MySQL Software

Refer to the Viz Mosart Release Notes

Minimum Recommended Hardware Configuration

Keyboard-Video-Mouse (KVM) support.
- Windows operating system with applicable .NET Framework.
- Gigabit Ethernet port

1280 x 1024 display adapter

The above hardware can be increased, for example with dual redundant PSUs, NICs, disks etc. for
redundancy.

& Note: Some of the hardware components (for example dual PSU) might necessitate an
upgrade to a server proper, running a recent version of Windows Server. It is also possible
to add another machine as a backup server.

5.0

Copyright © 2022 Vizrt Page 38


https://www.lynxstudio.com/products/aes16e/

Viz Mosart Administrator Guide - 5.0

Recommended Performance-related Components

Processor with performance equal or better than Intel 2.0 GHz Dual-core.
8 GB Memory
Minimum 50 GB free storage space.

Pre-Installation Tasks

A computer platform as described must be installed by the customer prior to the start of
installation.

This includes:

Dual independent power feeds to Viz Mosart Servers and the GUI PCs, where one of the
inputs is from an Uninterruptible Power Supply (UPS) source.
Set-up of keyboard, video and mouse for Viz Mosart GUIs and Viz Mosart Servers in the

relevant gallery.
Cabling and connectivity-testing from the Viz Mosart servers to the gallery equipment to be

automated.
Tested networks connection from the Viz Mosart servers to the Newsroom system and the

Viz Mosart GUIs.
For all IP connections (see Connections below), the customer must make sure relevant ports

and services are opened in any in-between firewalls.
Viz Mosart Support should be permitted remote access to all Viz Mosart computers for

online support.

Connections

All Viz Mosart applications and services are connected via TCP/IP. This allows them to run on any
computer in a common logical network.
Connections to external devices are a combination of TCP/IP and serial communication

protocols like RS-232, RS-422 and MIDI.
Extenders and translators, terminal servers and MIDI over IP, may also be used.

A Note: All device connections (such as link layer and application protocols) are dependent
on the device itself.

3.2 Viz Mosart Installation Files

Viz Mosart is delivered as a software package comprising various server and client applications,
used for connecting to studio devices and managing the NRCS rundown, imported into Viz Mosart.

Viz Mosart Installer Files
Manual Installation
Version Numbering
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Viz Mosart Installer Files

Description

Installer containing the ActiveX, used for displaying Viz Mosart
Templates in the NCS client.

Installer containing the Audio Panel, an application for controlling
audio faders, both on air and in preview.

Installer containing the Audio Player, typically installed on a
computer, or Viz Mosart Server, attached to the newsroom audio
mixer.

& Note: Audio Player is a replacement for the discontinued
Soundfile Player.

Installer containing the Viz Mosart GUI application, which is the Viz
Mosart user interface. This is available both as .msi and .exe.

Installer containing the iNews Timer, an application used to create
accurate timing of the production in iNews.

Installer containing the Viz Mosart Installation Administrator, (NIA)
an installation assistant for Viz Mosart software (beta version,
feedback is welcomed).

Installer containing the Log Viewer, an application used to
decipher Viz Mosart logs.

Installer containing the Media Router. For more details, see Media
Router and Mosart Template Database Administrator Guide.

Installer containing the Omnibus Controller, an application used
for Omnibus Server control.

Installer containing the various Viz Mosart Server components;
Manus Administrator, Media Administrator, AV Automation, and
Overlay Graphics Interface.
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Description

Installer containing the SNMP Service, used for monitoring the Viz
Mosart Server suite via SNMP.

Installer containing the Test Suite, test utilities used when
installing Viz Mosart.

Installer containing the Timing Display, used to provide timing
information to the studio control room and studio floor.

3.2.2 Manual Installation

When installing or upgrading Viz Mosart, run the Viz Mosart Installer Files manually from Windows

Explorer.

Backing-up Viz Mosart

The locations are:

All files in the following folders:

- C:\channeltemplates

- %localappdata%\Mosart_Medialab
- %programdata%\Mosart Medialab\ConfigurationFiles
- C:\Program Files (x86)\Mosart Medialab\<Mosart application>\ConfigurationFiles
- All files with extension .exe.config in folders
C:\Program Files (x86)\Mosart Medialab\<Mosart application>\
where <Mosart application> is the relevant Viz Mosart application, e.g. Mosart Server, Mosart

GUI, etc.

Windows registry settings for

HKEY_CURRENT_USER\Software\[Wow6432Node\]Mosart Medialab
HKEY_LOCAL_MACHINE\Software\[Wow6432Node\]Mosart Medialab

Installation

@ Tip: Vizrt provides a beta software utility Viz Mosart Installation Administrator that can
speed up installation and upgrading of your Viz Mosart system. Refer to section Viz Mosart
Installation Administrator.

To Perform a Manual Installation

1. Download all relevant Viz Mosart Installation Files to the preferred location. The default
location is C:\Mosart\Installers. You are advised to make a sub-directory for the installers
for a particular version/build containing all the MSI installer-files and any other supplemental
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files. This directory should be named using the Release.Version.Patch.Build naming
convention, for example: C:\Mosart\Installers\3.4.5.12345 for Viz Mosart 3.4.5 build
12345,
2. If you are upgrading from an earlier Viz Mosart version it is recommended to take a backup
of your current installation settings before you start the installation of the new version. See
Viz Mosart Backup below.
Double-click an MSI installation file, and follow the prompts to complete installation.
Repeat the above step for all relevant installation files.
. You need to start a set of Windows services to make Viz Mosart run properly. These are
automatically started when the computer is started.
a. The safest is to reboot the computer to verify that the automatic start of the services
is working.
b. Service names will be displayed as in the screenshot below:

vl bW

Service status p4¢

o Services started:

MosartMediaRouterService - Already Started
MosartOmnibusControllerService - Already Started
MosartLogService - Already Started
MosartRemoteControlService - Already Started
MosartSNMPService - Already Started

oK

3.2.3 Version Numbering

Installation folders are named with the Viz Mosart version number. All files inside that folder also
have the corresponding version number attached to the filename.

Version numbers have the following syntax:

Major.Minor.Revision.Build (for example 3.4.5.12345)

Where:

Major.Minor.Revision denotes the Viz Mosart Version Number
Build denotes a patch number

Example: Installers\3.4.5.12345\VizMosartServer-3.4.5.12345.ms"i

In this example, the computer has a folder for the Viz Mosart 3.4.5.12345 release, containing
associated installers.

Every significant code change of Viz Mosart results in a change to the Viz Mosart version number.
This increases either the major, minor, or revision number.

Patches are identified by having a higher build number than the remainder of the files.
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3.3 Viz Mosart Installation Administrator

Viz Mosart has its own installation utility, Viz Mosart Installation Administrator (MIA). It can save a
lot of time when installing and upgrading a Viz Mosart setup.

& Note: The Viz Mosart Installation Administrator is beta software. Please provide any
feedback to your Vizrt Support organization.

This section contains the following topics:

Installing the Viz Mosart Installation Administrator (MIA)
Viz Mosart Installation Administrator Interface
Semi-Automated Installation
Settings
- Take Snapshot
Start Mosart Application
Backup Files
Stop Services
Uninstall Mosart
Install Mosart
Start Services

3.3.1 Installing the Viz Mosart Installation Administrator (MIA)

0

Mosart
Installation
Administrator

You need to first download and install the Viz Mosart Installation Administrator (MIA) before
working with Viz Mosart system installations.

To Install the Viz Mosart Installation Administrator

1. Download the MosartInstallationAdministratorInstaller.<version>.msi to the
preferred location.
Default location is C:\Mosart\Installers.

2. Double-click the installation file, and follow the prompts to complete installation.
Repeat this installation process on all PCs where you plan to install any Viz Mosart
Applications.
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© Warning: The directory that holds the Viz Mosart installers must be named using the
Release.Version.Patch.Build naming convention.
For example:

C:\Mosart\Installers\3.4.5.12345 for Viz Mosart 3.4.5 build 12345, or
C:\Mosart\Installers\4.0.0 for VizMosart-4.0.0 etc.
If this rule is not followed, MIA will not display the installation directory.

3.3.2 Viz Mosart Installation Administrator Interface

m Mosart Installation Administrator (BETA) = &

Welcome to Mosart Installation Administrator |:|

What would you like to do?

4.0.30364.0

Common operations

]
Take Snapshot Start Mosart
Applications
Manual installation (follow workflow)
Backup Files Stop Services Uninstall Install Start Services
Mosart Mosart
4 ) [ 4
O @ @ )
EXIT

The MIA utility assists in installation and upgrade of Viz Mosart.
The various tools are described below.
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Manual installation (follow workflow)

Backup Files

=+

The Viz Mosart Installation Administrator can run a semi-automated installation process.

Viz Mosart Administrator Guide - 5.0

Stop Services

=

Uninstall
Maosart

=

Install
Mosart

Start Services

The buttons above are placed in the order you would normally progress through when upgrading
an existing Viz Mosart installation.

New Installs

If Viz Mosart has not been installed before and installer files are in the correct installation location,
begin from the Install Mosart button.

Upgrades

Follow a five-step process running from left to right when performing a semi-automated upgrade.

& Note: If Viz Mosart has previously been manually installed on the system you are using
without using the Viz Mosart Installation Administrator, the user must uninstall Viz Mosart
manually through Windows’ Uninstall or change a program before using the installation

assistant. This is due to a filename mismatch in the Windows Registry and installation
assistant that makes MIA unable to locate previous manually installed Viz Mosart

Applications.

3.3.4 Settings

Settings are accessed by clicking on the cog-wheel icon, at the top right of MIA.

The screenshot below shows default settings.
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ia Settings = =

Settings
Backup path ch\Mosart\Backuph
Installers path ch\Mosart\Installersh,
Send mail to msupport@vizrt.com

Install timeout (sec)

Correct Mo=sart version numbers

OO

Start Mosart applications after upgrade

K

A Note: Any paths not found in MIA settings can be manually changed by editing the file:
C:\Program Files (x86)\Mosart Medialab\Mosart Installation

Administrator\MosartInstallationAdministrator.exe.config

Backup path: Defines the path to where the installation assistant places backup files.
Installers path: Defines the path to where the installation assistant should look for
installation files.

Send mail to: Defines the e-mail address where error reports should be sent when
troubleshooting.

Install timeout (sec): Viz Mosart Services attempt to start/stop for the defined number of
seconds.

3.3.5 Take Snapshot

Take Snapshot

£

A snapshot of current Viz Mosart logs and user configuration files. These are helpful for Viz
Mosart Support to assist in diagnosing any issues you encounter.
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- You must specify a date and time in the past for the snapshot.
- The following files are collected:
C:\MMLogs
C:\MMLogs\MosLog
C:\MMLogs\AsRunLog
%appdata%\..\Local\Mosart_Medialab\.\user.config

Once complete, the MIA copies the files to the configured Backup path (see Settings) and
compresses the files in .ZIP format. An email interface appears with the .ZIP attached for the user
to send the file to Viz Mosart Support.

3.3.6 Start Mosart Application

Start Mosart
Application

MIA provides an quick launch of any installed Viz Mosart application. This feature only
allows for one application to be started at a time.

s Select User - B

Please choose application type to run:

Rovlication: [ ViartAucic Panel

OK | | Cancel

3.3.7 Backup Files

Backup Files

]

- This tool backs up all user.config files from folders with current version numbers and all
files located in C:\channeltemplates.

- The files are copied to the specified Backup path (see Settings) with the Viz Mosart version/
username as folder name.
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3.3.8 Stop Services

Stop Services

&

=

Pressing this button stops all Viz Mosart services installed, with a timeout of six seconds.

@ Tip: The timeout length can be adjusted in the installation assistant Settings.

A dialog box appears with the current service status:
Service status

"-.I Services stopped:

¥ MosartlogService - Stopped
MosartRemoteControlService - Stopped
MosartSMMPService - Stopped

oK

Repeat as necessary.
Alternatively, perform a manual stop within Windows Services.

3.3.9 Uninstall Mosart

Uninstall
Mosart

=

Pressing this button displays all installed Viz Mosart Applications.
You can then select one or all of the applications to uninstall.
The MIA does not delete desktop shortcuts.

Existing shortcuts can be reused on completion of an upgrade.
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Installers Selection = =

Select installed Mosart applications to uninstall.

[] Check All

[] Mosart Timing Display 2

[ ] Masart Test Suite

[] Masart Remote Panel Contraller
[ Masart GUI

[] Masart SNMP Service

[ ] Masart Audio Panel

[ ] Mosart Sound File Player

[ ] Masart Log Viewer

[ ] Masart Server

oK || Cancel

3.3.10 Install Mosart

Install
Mosart

I

1. Pressing this button displays all available Viz Mosart installers found in the configured
Installers path (see Settings).

The default is C:\Mosart\Installers.

s Download installers — O

Please enter version to install
(Installers are selected from c\Mosart\Installers’)

34314296 v

Version:

oK || Cancel
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2. Select the Viz Mosart version you want to install, and click OK.
The next screen shows applications found in the installation folder. You can select one or all
of the installers to run.
Note that if the installation folder is not named purely with the Viz Mosart version number,
like the example 3.4.3.14296 above, MIA will fail to show the below list of installers.

e Installers Selection = =

Please select applications to install:

[] Check All

[ ] MasartActiveXInstaller.2.4.2.14296.msi

[ ] MosartiudioPanelinstaller.3.4,3,14296.msi

[ ] MasariGUlInstaller.3.4.3.142%6.msi

[ ] MosartiMEWSTimerlnstaller.2.4.3.14206.msi

[ ] MosartLoglnstaller.3.4.3.14296.msi

[ ] MasartMediaRouterAdmininstaller.3.4.3.14296,msi
[ ] MasariMediaRouterinstaller.3.4.3.14296.msi

[] MasartOminibusContrallerinstaller.3.4.3.14296.msi
[ ] MasariRemotePanelControllerinstaller.3.4.3.14296.ms
[ ] MasartServerinstaller.3.4.3,14206,msi

[ ] MasariSNMPServicelnstaller.3.4.3.14296,msi

[ ] MosartSoundFilePlayerinstaller.3.4.3.14296.msi

[ ] MasariTestSuite.3.4.3.14296.msi

[ ] MosartTimingDisplay2installer.3.4.3.14296.msi

OK | | Cancel

@ Tip: For details on how to locate/change your installation folder path, see Settings.
3. MIA then performs a silent installation of the selected applications, no user interaction is

required.

The installation assistant does not create or delete desktop shortcuts. Any existing shortcuts from
a previous version can be reused on completion of the upgrade.

& Note: Viz Mosart Server components must be selected on the first installation. This is done
by creating shortcuts from C:\Program Files (x86)\Mosart Medialab\Mosart Server. Select
the components relevant to your broadcast environment.
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3.3.11 Start Services

Start Services

This button starts all installed Viz Mosart services, with a default timeout of six seconds.

@ Tip: The timeout length can be adjusted in the installation assistant Settings.

A dialog box then displays current service status:
service status

1 Services started:

¥ MosartLogService - Running
MosartRemoteControlService - Running
MosartSMMPService - Running

oK

Repeat as necessary, or perform a manual start within Windows Services.
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4 Frame Accurate System Operations

To ensure reliable operational synchronization between Viz Mosart and the studio equipment that
it controls, the system can be calibrated to perform on a frame accurate level of timing precision.
This section introduces:

- Why Frame Accuracy Matters
Requirements
Enabling Frame Accuracy Operation
Calibrating the System
Genlock Logging
Frame Accuracy in Story Recorder
Limitations

4.1 Why Frame Accuracy Matters

There are two areas where frame accuracy in a Viz Mosart controlled system are significant:

Predictable Behavior of Equipment
Latency Compensation.

4.1.1 Predictable Behavior of EQuipment

Unless it is known where in the frame the Viz Mosart command is issued, the response from the
equipment will always be arbitrary.

In the figure below, the red bars represent the start of a frame. The outgoing Viz Mosart
commands (cmd 1, cmd 2) are now aligned with the start of the frame grid (frame accurate).

@ Tip: The illustrations in this section are animated. If you are viewing a PDF, we recommend
the online version.

This provides deterministic behavior from the controlled equipment, as the equipment is always
given exactly the same amount of time to respond (in the above figure, after one frame).
Without frame accuracy, cmd 1 might be fired already somewhere in the first or second frame
above, and the gear will not operate at the anticipated frame, giving unpredictable results.
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4.1.2 Latency Compensation

In non-frame accurate systems, Viz Mosart only compensates for delays in the behavior of the
playout video server.

With frame accuracy, Viz Mosart can compensate for any latency of the controlled equipment.

video switcher

audio mixer

video server

As a pay-off of Predictable Behavior of Equipment, a calibration process can reveal the latency of
each piece of gallery equipment.

Viz Mosart can then compensate for these delays, by always executing commands earlier.

In the figure above, the three devices (video switcher, audio mixer and video server) have
millisecond latencies of 1, 2 and 3 frames respectively.

After compensating by executing each command specifically earlier, Viz Mosart can now
successfully perform the TAKE command, synchronized for all three devices, from the same frame.

4.2 Requirements

On the Mosart server machines (main and backup), a Plura genlock/timecode card must be
installed.

This implies that the machine must have a free slot for this type of card.

Vizrt has only verified Plura PCI 3G, with digital genlock (SDI) and supports, for time being,
only the traditional digital VITC or ATC-VITC as timecode formats.

Calibration has been performed.

A dedicated template set.

There will be timing differences for template execution under frame accurate

operation. Latencies are automatically compensated for primary events.

& Note: Whilst frame accurate operations are being continually developed and

improved, not every feature from standard mode may be available or possible in
frame accurate mode. This is also why a dedicated template set is essential.
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4.3 Enabling Frame Accuracy Operation

For frame accurate behavior, both Viz Mosart and the equipment it controls, require setup of both
a genlock and timecode feed.

- Genlock Settings
The switcher, video server (playout and recording) and Viz Mosart Server, all require

genlock.

- Timecode Feed
Both the recorder and Viz Mosart Server require a timecode feed.

& Note: Story Recorder can be used without having proper genlock setup and a timecode
reader card installed on the Mosart Server machine, but only for testing. In this case, the
time of the day will be used.

4.3.1 Configuring Viz Mosart for Frame Accurate Operation

Once the system, including all equipment has been calibrated, frame accurate operation can be
easily switched on or off.

To activate frame accurate operations
Frame accuracy related settings and options are made in Av Automation.

1. Navigate to Devices > Properties > Genlock tab.
2. Select
a. Execution Mode: Select Genlock mode.
b. Clock Source: When checked, select which genlock / timecode card is installed, if any.
By default, this is Plura timecode reader card (and for time being, the only option).
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¢. Calibration: These are the individual latencies of the gear being controlled, as derived
when calibrating the system.

Device Properties
Audio  Camera Robotics Light Control  Fouter  Subtites GPIAQ  Video Wall  Intearated Engine | Genlock | General il
Execution Mode: (O Standard (@) Genlock
Clock Source: Plura FCle w
Timecode Format: QOVITC @ ATC-VITC
[ Statistics On
Log path: C:\MMLogsGenLock Stats
Calibration
Video Server: 7 framels)
Switcher: 1 = framels)
PGM-Recorder: 1 | frame(s)
Audio Mixer: 40 = ms
Cancel Apply Save & Close

3. Click Apply, then Save & Close.

Combinations of the configuration above for Execution Mode and Clock Source settings:

Execution mode Clock Source Logic

Standard Not selected Classic mode. No timecode in the Viz Mosart
logs. No statistics can be performed.

Standard Selected Classic mode. Timecode from the selected
clock source (by default, this is Plura PCle and
the only supported option) is written in the Viz
Mosart logs generated from AV Automation.

Genlock Selected Frame accurate behavior when executing Viz
Mosart templates during a show. A clock
source is required.

Timecode from the selected clock source
(Plura) is written in the Viz Mosart logs,
generated from AV Automation.

Viz Mosart falls back to the internal clock
source if the selected clock source is detected
as inaccurate.

Copyright © 2022 Vizrt Page 55



Viz Mosart Administrator Guide - 5.0

Genlock Not selected Not allowed. Viz Mosart will fall back to

Standard execution mode, with no timecode.

To deactivate frame accurate operations

Open AV Automation.

A WN—

Navigate to Devices > Properties > Genlock tab.
Execution Mode: Select Standard mode.

Clock Source: Deselect.

Click Apply, then Save & Close.

4.3.2 Genlock and Timecode Reliability

Viz Mosart contains a high resolution internal genlock clock as a built-in safety mechanism which
takes care of intermittent or lost external genlock and/or timecode signal.

- Whenever the external genlock signal drops out or becomes unreliable, Mosart will fallback

to the internal genlock clock. Mosart will return to external once the signal is reliable again.
Mosart effectively runs on the internal timecode clock, constantly synchronized to the
external clock when available, keeping Viz Mosart in phase.

4.4

Calibrating The System

For Viz Mosart to function in frame accurate mode, a calibration process has been created to
better understand the timings associated with the gear being operated.
Contact Vizrt Support for further details.

- The guide defines six tests that must be executed to detect the latencies (delays) introduced

when operating gallery gear, so that Viz Mosart can compensate for these delays and verify
equipment reliability.

4.4.1 Timecode Readers

In Av Automation, you can change properties related to the Plura timecode reader card.
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1. Open the Av Automation Settings (user.config file).
Use keyboard shortcut Ctrl+Shift+S in AV Automation.

Settings (C:\Program Files (86)\Mosart Medialab\Mosart Server)

=
v Genlock A
ClockSourceStatisticsLogPath C-\MMLogs\GenlLockStats
EnableClockSourceStatistics False
EnableGenlock True
v <TimeCodeReader Type="AlpermannVelte"><Slot>1</Slot ><Mode>0</Mode ><VitcReaderMode>1</\
EnableMidFrameGenlock False
Mode o
Slot 1
TimecodeFormat VITC
Type AlpermannVelte
VitcFirstLine 6
VitcLastline 22
VitcPriority 1
VitcReaderMode 1
terTimecodeF ormat VITC
terType Plura PCle
terlseTimeCodeReader True
v GenlocklLalencies
AudioMixerCmdLatency 40
PgmRecorderLatency 1
VideoServerCmdLatency 7
VideoSwitcherCmdLatency 1
v Misc
AdminPingDelay 00:00:02

2. If any changes have been done on the Genlock tab in AV Automation properties (see To
activate frame accurate operations above), click the Apply button or close the Properties
window and do Ctrl+Shift+P for the changes to take effect.

4.4.2 Gathering Clock Source Statistics for Vizrt Support

Once Viz Mosart is set up for frame accuracy, it is recommended to perform clock source statistics
that will verify the reliability of the genlock and timecode signals.

Follow the setup procedure below, and forward the results to Vizrt customer support, who will

perform an analysis and report results.

To start clock source statistic gathering

1. You start/stop statistics in AV Automation.

a. Navigate to Devices > Properties > Genlock tab.

b. Execution Mode: Genlock

c. Clock source checked and a clock source selected.
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d. Statistics On: Selected

Graphics Audio Camera Robotics Light Control Router Subtiles Weather Video Wall integrated Engine  Genlock G/« | »

‘ Execution Mode: O standard @ Genlock ‘
[ Clock Source: Plura PCle v
[~ statistics On

Log path C:\MMLogs\GenLock Stats\

Calibration

<

Video Server: frame(s)

Suitcher 1 frame(s)

PGM-Recorder: 1 frame(s)

Do W

Audio Mixer 40 ms

Cancel Apply Save & Close

Specify the location where you wish to save the stats in field Log path.

Click Apply, then Save & Close.

the configured external clock source, if available. The file generated

Check the indicator in the AV Automation status bar at the bottom of the screen, that
statistics are on:

om2 VIiZ VSA VSB CAMS ME1 ME2 LIVE2 DDR1 DDR2 CAaM3 CAM4 LIVE1 CAM1

DSK1 DSK2 DSK 3 DSK4 Omneon

Status Video Ports
Video Switcher: VIZRT-IPS on 10.211.112.226:5951 Omneon:OMNEON:1
Audio Mixer: MIDIMIXER -A: Omneon:MIP7600
Graphics1: VIZ localhest -B: Omneon:MIP7600)

ament MirrorBGO-MOS-SERVERT:8099 MR | ACTIVE | TDB | GENLOCK |Plura PCle - STATISTICSON | Ir
Measurements will be performed for about 8-10 minutes

You can stop the statistic measurements earlier by unselecting Statistics On, as described in

step (1) above.

. Collect the saved statistics from the location defined in Log path (above) for:

a. The configured external clock source:
ExternalClockSourceStats_<uid>.csv.

b. The Mosart frame clock, driven by the selected clock source (internal or external).

Logs are stored in FrameClockStats_<uid>.csv.

Tip: You can start/stop the clock source statistics by toggling the keyboard shortcut
Ctrl+Shift+l directly in AV Automation, without the need to open the Genlock settings
in the Properties menu.
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To analyze clock source statistics
This is a complex operation performed by Vizrt Support.

- The frame clock (FrameClock) is used internally by Viz Mosart to execute templates frame
accurately.
If the external clock source is not reliable (shown in red on the AV Automation status bar),
the frame clock is driven by the internal clock source:
Y]

Tl niror | MR | AcTive| ToB | Gentock |[METREI| Info 10/4/2021

Clock source: Internal (UTC). External genlock timeout. Switched to internal.

If the external clock source is reliable, the internal FrameClock should behave more or less
as the external clock source.

This can be seen in MS Excel by comparing the chart generated (in Excel) from
GenlockPeriodMs or JitterMs columns in FrameClockStats_<uid>.csv file,

with the chart generated from the same columns in ExternalClockSourceStats_<uid>.csv.

4.5 Genlock Logging

A new type of logging has been introduced with frame accuracy in Viz Mosart to help identifying
problems related to genlock, if this is enabled.

- To enable the genlock logging, copy the configuration file GenLogRepositoryConfig.xml
from the Viz Mosart installation folder/Mosart Server/ConfigurationFiles to your working
folder (Channeltemplates or ProgramData).

Open GenLogRepositoryConfig.xml in an editor and configure it in a similar way as the other
type of logging (refer to System Logging). These configurations also include settings about
when the logging files shall be purged.

- The genlock logging is by default generated in C:\MMLogs\Genlock every time a new show is
run in Mosart (whether Story Recorder mode is enabled or not).

- A new genlock logging file is generated when a rundown is (re)loaded in Viz Mosart or when
the show is paused whilst Story Recorder is enabled.

@ Tip: Contact Vizrt Mosart Support for assistance with
Statistics analysis
Calibration
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4.6 Frame Accuracy In Story Recorder

For Story Recorder to provide high quality final shows, frame accuracy is a requirement. SR can
also be run with Viz Mosart running in Standard mode, but only for testing.

See also the section Story Recorder of the Viz Mosart User Guide.

4.7 Limitations

Frame accuracy is only available on events driven from primary templates (clips, switcher, audio
and full screen graphics), not secondary events (like overlay graphics or accessories).
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5 Audio Players

- Setting Up an Audio Player
- Working with Audio Players

A Viz Mosart user can play out audio files using an audio player. This is useful, for example for
playing regularly used audio, like openers and audio-beds.

A basic audio player is always included as standard in a Viz Mosart. You can also install third party
audio drivers (for example SpotOn) as standard player, as described below.

User actions are presented in the Viz Mosart User guide in section Playing Audio.
Requirements

Refer to general section Prerequisites.

5.1 Setting Up An Audio Player

- Setting up the default Viz Mosart audio player
- Setting up a third party audio player device

5.1.1 Default Viz Mosart Audio Player

Supported File Formats

The standard Viz Mosart audio player supports formats: mp3, wav, wma, aac, m4a, mp4, aiff, avi.

Setting up the default Viz Mosart audio player

1. On the machine that will be used for the audio player, open the Viz Mosart installation folder
and locate the Audio Player installer file, named something like
VizMosartAudioPlayer-5.0.2.32554.msi

Install Audio Player, then start it.

On the Viz Mosart server, open AV Automation.

Go to Devices > Preferences > Audio > Sound player.

Check Use sound player and choose from the players in the drop-down list.

uTh WN

Audio mixer | | Sound player | Loudness controller

Use sound player |Mosart Audio Flayer >
Masart Sound File Player
Host Mosart Audio Player

SpotOn Audio Player

Default directory
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6. Under Host write the IP address to the computer where audio player is running.
7. Under Default directory, write the folder path where the audio files are stored.

P
VIDEAIT L'eVICE Froperties

Wision I'H'Ii:erl Video Servers | Graphics Audio |Camera Robotics | Light Corrtmll Hm.rterl Su

Audio mixer | I Sound player | Loudness controller |

¥ Use sound player IMusart Audio Player ﬂ
Host IIucthust

Default directory ID:\audiu

8. Restart AV Automation and check that the connection is

- o SDUND
PRGA PRGB MIC3 MIC4  plavER 1

v A4 W v
| 90 [ %0 | 90 | 50l

DEK2 DSK 3 DEK 4

Log window disabled. Right click to enable

.211.112.226:5951
7001

5.1.2 Third Party Audio Player Devices

Setting up a third party audio player device
You can connect a compatible third party audio player.

This sample procedure prepares a SpotOn audio player.

1. Download, install and start the device software to a host machine available to the Viz Mosart

server.
2. In AV Automation, go to Devices > Preferences > Audio > Sound player.

3. Check Use sound player and choose SpotOn Audio Player from the players in the drop-down

list.
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Device Properties

Vision Mixer Video Servers Graphics Audio  Camera Fobotics  Light Control

Audio mixer | I Sound player | Loudness controller

Use sound player Mosart Sound File Player e
Mosart Sound File Player

Haost

Moy K e

4. Under Host write the IP address to the machine where the SpotOn player is running.
5. Restart AV Automation and check that the connection is green.

= .. _SOUND
MIC2  MIC4  piaveRd1

PRGA

PRGB

Graphics

Sound Player

b4 b w A4 b v w b4 b A4 b v w
90 | 90 | 90 | 90 | -9 [ 90 | 90 | 90 | 90 | | 90 [ 90 | -9 | o0l

DsEK2 DSK 3 DSK 4

Log window disabled. Right click to enable

5.2 Working With Audio Players

5.2.1 Working with the Viz Mosart Audio Player

When the default Viz Mosart Audio Player is configured, the user opens the Ul from a desktop

shortcut
or file location C:\Program Files (x86)\Mosart Medialab\Mosart Audio Player\Mosart Audio

Player.exe.

& Note: User actions are described in section Playing Audio of the Viz Mosart User Guide.
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Viz Mosart Audio Player Ul

& Viz Mosart - Audio Player Settings

Audio Directory: D\audio

1: Output 1 Stopped (Speakers (Realtek(R) Audio))
2:Output 2 Stopped (C32F391 (HD Audio Driver for Display Audio))

AVAutomation 192.168.1.176

Ul Element Description

Settings button Open the Settings window for configuring the Audio
Player. See Audio Player Settings below

Audio Directory Folder path to where your audio files are. All files in this
folder are ready to be played
(This location is set in AV Automation Devices > Properties
> Audio > Sound Player)

Numbered Output list A list of all available devices. The first number is the
(left hand panel) number you use in AV Automation or the NRCS to specify
the audio file playout.

Log panel (right hand panel) All log messages that the audio player creates.

AVAutomation status Green: AV Automation is connected
Red: No AV Automation connection.

IP Address IP address of the computer Audio Player is running on.

Version Version number of the Audio Player.

Copyright © 2022 Vizrt Page 64



Viz Mosart Administrator Guide - 5.0

Audio Player Settings

Click the menu bar Settings to open the settings dialog.

=3 Settings

m Testing panel

If a new file is set to play on an output already playing:
© Stop the file playing, and play new file
Ignore new file

Play new file on next available output

Outputs

Name Device
Qutput1 ———  —  Speakers (Realtek(R) Audio)
Qutput2 —— (C32F391 {(HD Audio Driver for Display Audio)

New

Testing Panel
Turn On to show the panel! for testing the Audio Player. Testing panel can be used to
test the functionality of the audio player.

Testing panel

Opens a panel for testing the functionality of the selected Audio Player.

File already playing behavior

Controls what the Audio Player does if a new file is played when a file is already playing.
Outputs

The list on the left shows all the outputs, and the list on the right shows available playback devices
on the computer. The line between them shows playback device mapping.

Click an output to map to playback device.
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Click New to add an output.
Outputs

Name Device

Outputl ————  Primary Sound Driver
Line Qut (4- Scarlett 2id USB)

Qutput 2 ‘-_-._.
Speakers (Realtek High Definition Audio)

Qutput 3

MNew

- You can rename or delete an output.

Audio Player Configuration File
The Audio Player Configuration file Mosart Audio Player.exe.config is at
%ProgramFiles(x86)%\Mosart Medialab\Mosart Audio Player).

Change the baseAddvress attribute to use another port:

<add baseAddress="http://localhost:8084/LiveSoundService.svc/"/>

5.2.2 Working with a Third Party Audio Player

This example explains the SpotOn audio player.

SpotOn Audio Player

Addressing an audio file that is stored in a SpotOn client is similar to the default player method
above, but the file identifier is different.

~ LeveL __ AUDIOFILE  guTPUT
] || 0452 3264 ||

| 0K Cancel

LEVEL: This value does not affect the audio fader that is taken to Program. Instead a special
command option is offered. Set LEVEL to -90 to send a STOP (playing audio) command. All

other values are ignored.
- OUTPUT: Enter the panel button number to identify the associated sound file (in this

example "2a").

@ Tip:
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Use the button number (mapped to OUTPUT) as reference (instead of the audio file
name). You can then replace the audio file assigned to a button (for example, when a
show is rebranded and new music selected) and still keep the same template
information.

This avoids having to change the file name.

AUDIO FILE: Enter the panel button name here (in this example 0452_32Bit).

0452_32Bit Eliza and the Bear Jain - Makeba -
- | Wanna Feel Bubble Edit

01:02 03:12

0452_32Bit_1 Jain - Makeba -

Bubble Edit

03:12

A Note:
- Newsroom tag available. If a newsroom tag is added, and a value is provided by the
NRCS, that value for the file name (with either AUDIO FIE or OUTPUT) is used.
When both panel button number and panel button name. are used as file identifier,
the value of panel button number takes precedence.
See also

Audio in AV Automation Devices
Playing Audio in the Viz Mosart User guide (user actions).
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6 Manus Administrator

Manus Administrator is the intelligent element of Viz Mosart, monitoring the rundown in the
connected NRCS, parsing the content into Viz Mosart functionality that is presented in the Viz
Mosart GUI.

MY Viz Mosart - ManusAdministrator 3,

225 IDLE - <no active rundown> - ) 0 “%

3 E ].1PI"‘ iceConnected MosartRemoteService
B(B? 32 231? 1d 29 S6><ServerStarteds><version»><24225><120117>
<Inews ftp server is iNEWS-Bergen>
(hecking for newsroumsettings version...
sion OK.
nn:ltemplatP5~nPw<ruomfPtt1ngf xml

g D!j not find S er Af 0 defintion for SERVER
Did not find S A/B Roll defintion for BACK UP SERVER
2 Lh.annel'lemylatrﬂs loaded, current studiosetup is Fumcspec

Manus Administrator is a console application that must be kept running at all times on your
Mosart server.

6.1 NRCS Software Compatibility

There are two versions of the Manus Administrator, corresponding to the newsroom system that it
connects to.

The version choice is offered at initial Viz Mosart (server) installation:

MMConsoleAdmin_2007.exe For iNEWS (with ftp) workflow.
MMConsoleAdmin_MOS.exe For newsroom systems with MOS workflow.
Use for all systems except iNEWS with ftp workflow, including iINEWS with MOS workflow.

Only one Manus Administrator can be active at any given time.

@ Tip: Type help in the Manus Administrator console window to see which commands you
can use. See Manus Administrator Commands.

See also Avid iNews Web Service for Status Feedback in the appendix.
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6.2 Configuration Utilities

From the Manus Administrator console you can open the following configuration editors in a new
window:

- To open the frmSettings XML Editor, type settings in the console followed by ENTER. For

details see:
- Settings Editor iNews or
- Settings Editor MOS as appropriate.

- To open the Newsroom Settings XML Editor, type ns in the console window followed by

a

ENTER. For details see:
Newsroom Settings Editor.

Note: The configuration editor opens in a new window. If you make changes to the
configuration, restart Manus Administrator for the changes to be applied.

The rest of this section covers these topics:

- Settings Editor iNews
- Settings Editor MOS

Newsroom Settings Editor
Field Mapping
Manus Administrator Commands

6.3 Settings Editor INews

To simplify setting up the connection to iNEWS, the Manus Admin console includes a configuration
tool called frmSettings XML Editor.

- To open the frmSettings XML Editor, open the Manus Administrator console, then type

settings followed by ENTER.
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Bl frmsettings — | *
g

i 1guranon ]
Configuration file paths
Crossover

Default

Default item durations

INews conhgurabion

INews Web Service configuration
Logging

Manus configuration

Read speed

Template database conhgurabon
Viz Media Sequencer conhiguralion

Configuration

The editor comprises several sections, each dedicated to a collection of settings:

Configuration
Configuration File Paths
Crossover Configuration
Default Item Durations
iNews Configuration
iNews Web Service Configuration
Logging
Manus Configuration
Read Speed
- Template Database Configuration
Viz Media Sequencer Configuration

6.3.1 Configuration

- Auto preview overlays: Lists graphics destinations that support preview of overlay graphics
(i.e. DSK enables preview of all overlay graphics with handler=DSK). Default: Empty = no
preview.

- Auto preview overlays early: Enable preview of overlay graphics as early as possible. When
set to False, the preview will be displayed only when the graphics is the next item to be
taken.

- Auto Take Offset: Sets offset for the autotake function. Default: 0.

Default Handler Name: Defines a default handler name for all graphics that have no handler
name. This can be configured using DefaultHandlerName setting in Manus Administrator.
Default: DSK.

Default Lower Third Out Behaviour: Default method for taking out a lower third.

Force clip editorial time: Shows Editorial time in GUIL. Default: False
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Frame rate: Determines the frame rate of the system. Valid rates 25, 29.97, 50 and 60 .

Ignore updates if nothing changes: Ignores story update from the NRCS if the updated story
is assumed to be equal to the current version of the story when set. Default: False (no NRCS
story updates are ignored).
Keep story status on updates from NCS: Keeps played out stories gray if the story is updated
in the NRCS when enabled. Default: False
MetaData creator priority: Overrides priority timing information from the video file's
source. Select between:

Newsroom editorial time

MAM duration

Full video clip length.

Separate IDs with commas. Use the name of the Media Administrator entry. Special names are
NCS (for information from the NRCS) and GLOBAL (global values from media object).

If Empty, Viz Mosart inserts NCS as the first and GLOBAL as last entries.

Default: Empty.

Minimum clip length: Sets the minimum visible length of an offline clip in a story in the GUI.
When Viz Mosart receives clip information the visible length is updated. Default: 5 (ss:ff).
MyPort: The port used for other Viz Mosart applications to connect to the Manus
Administrator. Default: 8085.

Network exclude: Manus Administrator automatically enters idle mode on network failure.
This property is a CSV list of network names to ignore when monitoring networks. Default:
Empty (monitor all networks).

Network include: Manus Administrator automatically enters idle mode on network failure.
This property is a CSV list of network names to monitor for network failure. Default: Empty
(monitor all networks).

Offset secondary events with mix delay: Secondary events follow primary events mix delay.
For example, a lower third element is delayed with the same mix delay as the package it is
to be keyed on. Default: False

Pause Automation timing on first Break: When enabled, any first story with a single break
template will not start the automation server rundown timing (Elapsed rundown duration).
The timing will start when the next story is taken. This does not affect the NRCS timing.
Preload Accessory Cue Delay: Defines the delay between end of cue the next item and when
a pending preload/pretake accessory shall be executed.

Time is in frames. Default = 6 frames, so the accessory preload/pretake functions takes
place after the cue operation is done in AV Automation with an additional and configurable
delay of Settings Editor iNews frames.

Reset AutoTake on 'Clear Loop': Disables the autotake mode automatically when using the
clear loop function from the GUI when enabled. Default: True

Server description: User-defined descriptive name of the server that is displayed in the
Timing Display.

Should upgrade: For internal use only. Do not change. Default: False

Startup in idle mode: Determines whether or not the Manus Administrator is idle at start-up.
For normal Viz Mosart operation, this setting shall always be True, so that the Viz Mosart
server starts up in Idle mode. Switching between Idle and Active mode shall in normal
operation, be done from the GUI. Default: True
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- Story Compare Ignore Attributes: Used for debugging purposes only. Default: Empty
- Templates allowing graphic pretake: Lists template types that allow pretake of overlay
graphics elements. Available template types:

- ADLIBPIX
BREAK
CAMERA
DVE
FULLSCREENGRAPHICS
LIVE
PACKAGE
TELEPHONEINTERVIEW
VOICEOVER

Default : PACKAGE, VOICEOVER.

Only the first graphic found on the next item is taken and this is taken immediately regardless
of its start time.

& Note: For graphic pretake to work, make sure the Pretake overlay on handler setting is also
configured in the Newsroom Settings Editor.

- Transitions on Accessories: Allows transition effects on accessory templates when enabled.
If disabled, any transition effects are removed from accessory templates when translating
newsroom XML into Mosart XML. This is how it has been, historically.

- Use Take Out Logic: Enables the CG takeout functionality. When two CG graphic objects with

the same graphic IDs are next to each other, the first one is not taken out, only take in on
the second object is executed.

When True, enables the takeout functionality for overlay graphics. Default: False.

- UseltemStatusToNCS: Sends online offline CUE/PLAY/STOP status to the NCS when enabled.
Default: False

6.3.2 Configuration File Paths

- AvConfig: The path to the XML-file containing the audio and video mappings defined in the
AV Automation application. Default: c:\channeltemplates\avconfig.xml.

- Channel templates: The path to the file containing the Viz Mosart templates built in the AV
Automation Template Editor. Default: c:\channeltemplates\channeltemplates.xml.
Manus Directory: The path to the folder containing copies of the internal Viz Mosart
rundown. Default: c:\manus .

Newsroomsettings: The path to the XML-file containing the mappings from newsroom
system commands to Viz Mosart templates. Default: c:

\channeltemplates\newsroomsettings.xml .
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6.3.3 Crossover Configuration

- ConnectionString: The connection string of the crossover, for example: controller=/P
address, client=crossover. Default: ¥’

- Crossover Auto Take On Switch Offset: Offset in milliseconds to pre-take an autotake when
the next story item is after a crossover switch.
A positive value triggers the autotake before the given duration of the story item.
A negative value triggers the autotake after the given duration of the story item.

- Crossover Set Next On Switch Delay: Delay of sending set next story from the server running
the show when taking control. Default: 500 (milliseconds).

6.3.4 Default Item Durations

Break: The minimum length given to the BREAK template type in the rundown. If no time is
given in the NCS, then this time is given to the element. Default: 7100 (frames).

- Camera: The minimum length given to the CAMERA template type in the rundown. If no time
is given in the NCS, then this time is given to the element. Default: 125 (frames).
DVE: The minimum length given to the DVE template type in the rundown. If no time is given
in the NCS, then this time is given to the element. Default: 725 (frames).
Full-screen-graphic: The minimum length given to the FULLSCREEN GRAPHIC template type in
the rundown. If no time is given in the NCS, then this time is given to the element. Default:
125 (frames).
Item: The minimum length given to any template type in the rundown. If no time is given in
the NCS, then this time is given to the element. Default: 700 (frames).
Live: The minimum length given to the LIVE template type in the rundown. If no time is given
in the NCS, then this time is given to the element. Default: 125 (frames).
Lower-third: The minimum length given to the Lower-third template type in the rundown. If
no time is given in the NCS, then this time is given to the element. Default: 700 (frames).

- Telephoneinterview: The minimum length given to the PHONO template type in the
rundown. If no time is given in the NCS, then this time is given to the element. Default:
125 (frames).

- Video Clip: The minimum length given to the CLIP template type in the rundown. If no time
is given in the NCS, then this time is given to the element. Default: 725 (frames).

6.3.5 iNews Configuration

- Server: Hostname or IP address where the iNews FTP server is running.
User Name: Username of a valid iNews FTP account. Normally the name of a valid iNews user
with access rights to the iNews FTP server.
Password: Password of a valid iNews FTP account. Normally password to a valid iNews user
with access rights to the iNews FTP server.
FTP Port: iNews FTP port.
Encoding: Character encoding of the iNews story items. Should match the encoding used in
iNews.
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Default: Encoding for the operating system's current ANSI code page.
Other values: UTF7, UTF8, UTF32, UNICODE, BIGENDIANUNICODE, ASCII.

Use FTP active mode:
True: Active mode where Manus Administrator establishes the command channel but the
iNews server is responsible for establishing the data channel.

A Note: In active mode, the client starts listening for incoming data connections from
the server on port M. It sends the FTP command PORT M to inform the server on
which port it is listening. The server then initiates a data channel to the client from
its port 20, the FTP server data port.

False: Passive mode where Manus Administrator establishes both channels.

& Note: Where the client is behind a firewall and unable to accept incoming TCP
connections, passive mode may be used. The client then uses the control connection
to send a PASV command to the server and then receives a server IP address and
server port number from the server, which the client then uses to open a data
connection from an arbitrary client port to the server IP address and server port
number received

FTP active port range: Ports used for Active mode. The format is '<low_port>..<high_port>',
random ports are used when left empty or the format is wrong. Useful when the current
machine has certain ports that are blocked or used for other purposes.

& Only used when active mode is selected. Similar to the iINEWS environment variable
RXDATAPORTRANGE. Because a new connection is opened for each data transfer
(listing directories, downloading stories) the port range must be sufficiently wide
(~100 wide range works in most cases).

When the port range is left empty or the format is invalid, random ports are
used.

When the port range is not wide enough, the rundown won't fully load.

These situations are indicated in the Manus Admin console and in the logs. For

example: o

_4§ 1 - do‘l.:nlc_:-a; ;‘FDSHW.BALAZS.CLIPS @Ccs50973C: 00810193 :61A8DCCT story #3
downloading No wvalid active data port available!

download of SHOW.BALAZS.CLIPS 145D9745:60810489:61A168812 random
downloading No wvalid active data port available!

download of SHOW.BALAZS.CLIPS ©35D9754:8088105C9:610D9661 clip
downloading No wvalid active data port available!

Prefer FTPS connection:

True: FTPS encryption is used if supported by the iNews server. Otherwise it falls back to
plaintext FTP communication.

False: Using plaintext FTP communication.

& Because FTP uses a dynamic secondary port (for data channels), many firewalls were
designed to snoop FTP protocol control messages in order to determine which
secondary data connections they need to allow. However, if the FTP control
connection is encrypted using TLS/SSL, the firewall cannot determine the TCP port
number of a data connection negotiated between the client and FTP server.
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Therefore, in many firewalled networks, an FTPS deployment will fail when an
unencrypted FTP deployment will work. This problem can be solved with the use of a
limited range of ports for data and configuring the firewall to open these ports.
FTP connection type and status are reported in Manus Admin:

- With FTP:

12:0/:47 1 b MAT=2nsml.

12:87:47 15 Inews ftpserver (bgo-mos-inews using FTP) connected:
12:87:47 15 NCSS5tatus set iNews bgo-mos-inews True

N - w W, b )

- With FTPS:
17:8b: 10 14 S ORMAT=2nsml.
12:86: 14 Inews ftpserver (inews7x-a using FTPS) connected:

6:18 14 NCSStatus set iNews inews7x-a True

- Working Directory: Initial directory in iNews. Viz Mosart provides access to all rundowns
stored hierarchically within this directory.
Default: SHOW
Default Rundown: Deprecated.
Ignore Send Cue Status To NCS For Offline Clips: Enable this flag to prevent the NCS from
receiving CUED or READY statuses of offline video clips.
Default: False
Refresh Media On NCS Update: Triggers clip refresh for all clips that belong to a story being
updated, normally via story updates from NCS when set to True. This ensures that all clip
information is synchronized.
Default: False

- Time to delay initial devices while waiting for NCS to add story: Delay of displaying the
loading rundown when rundowns are published to Viz Mosart.
Default: 500 (milliseconds)

6.3.6 iNews Web Service Configuration

- Web Service Connection: Connection string.
Example: WebServiceServer=/localhost; iNewsServer=10.211.112.104;
iNewsUsername=mosart;, iNewsPassword=mosart; SendUpdatesStatusForAllltems=true;
ClearStatusWhenRundownReloaded=true

6.3.7 Logging

Ignore verbose events filter: Semicolon based list of events to ignore in the log when using
verbose logging. Default: Empty (log all events)

In use: Enables or disables the logging of events from the Manus Administrator to

the logfile. Default: True

Log level: Sets the detail level of logging to the log file: O=normal, 1=warnings, 2=errors,
3=info, 4=detailed

MSMQ Log limit: Value to identify when the application should dump the log queue to file.
Default: 4023
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Pass verbose events filter: Semicolon based list of events to log when using verbose logging.
Default: Empty (log all events)
Path for MMLog: The path where the Viz Mosart Log is stored. Default: MosartLog

- Trace internally: Enables or disables internal tracing to console, for debugging only. Default:
False
Use verbose logging: Enables or disables verbose logging. If UseLogging is set, verbose
increases the details sent to the log. Default: False

6.3.8 Manus Configuration

Default Manus: Selects the default rundown to use. If the setting UseDefaultManus is set to
True, the system loads this rundown on startup.

Manus expiration time: Number of days to keep Manus Administrator files. Older files (than
that number of days) are deleted when Manus Administrator is started.

Default: 60 (files are deleted after 60 days).

Legal values: -1 (never deleted), 1 and above (number of days until deleted from manus
folder).

Manus keep file pattern: If ManusExpirationTime is given this property allows a list of file
search patterns for files to keep in the Manus Administrator directory.

For example, "TEST* DEMO??.xml" keeps all files starting with “TEST’ and all DEMO??.xml
files where ‘2’ denotes a wild character.

Default: Empty (no files to keep).

& Note: ‘;’ is used to separate the file search patterns.

- TestManus: Rundown to be used for maintenance purposes.
Use the default selected manus: Initializes the rundown given in the Default Manus setting
automatically when enabled. Default: True

6.3.9 Read Speed

Read Speed: Number of words read per minute by the anchor. Applied to the prompter text
to determine the duration of an announcement, which is then the length of the green
camera bar and the green part of the voice-over bar in the Viz Mosart GUI. Default: 745
(words per minute)

Words are usually taken to be the parts of text separated by space characters. See the
setting Use character for read speed word below.

A Note: This is a fallback read rate which is only used when the NCS System fails to
provide a ReadRate of its own. This function can be tested by changing any
readrate="xx" to readrate="" on an item in a local Manus file.

Use character for read speed word: If True, each character counts as a word for the purpose
of calculating the spoken duration of prompter text, see Read Speed above.
This option can be useful for languages like Chinese and Thai, where words are not
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separated by using the space character. If False (default), words are separated by space
characters.

6.3.10 Template Database Configuration

- ConnectionString: The connection string for the Template DB. For example, for MySQL:
server=<hostname>; User ld=<user>;Password=<password>; database=mosarttemplatedb.
Default inserter: The name to be used for the insertedby and updatedby columns in the
Mosart Template Database.

Name of provider: The provider name for the Template DB. For example,
MySql.Data.MySqlClient for MySQL.

Use template database: When true, enables the Template DB functionality, i.e. importing
template type aliases from DB to newsroomsettings.xml at startup, and exporting

newsroomsettings.xml to DB after saving newsroomsettings.xml . Default: False.

6.3.11 Viz Media Sequencer Configuration

Mse Playlist Panel Host: The host address of the Media Sequencer Engine (MSE)

Configure or change an existing MSE host to activate the MSE Playlist panel. The Playlist

panel users active (touch or click-sensitive) thumbnails of graphics held on an MSE.

The Viz Mosart Ul needs this MSE connection defined in order for the user to see the Playlist panel
(View > Floating windows > Playlist Panel). See Viz Mosart User Guide, section Viz Mosart user
Interface >MSE Playlist Panel.

6.4 Settings Editor MOS

To simplify setting up the connection to a MOS-based NRCS, the Manus Admin console includes a
configuration tool called frmSettings XML Editor.

- To open the frmSettings XML Editor, open the Manus Administrator console, then
type settings followed by ENTER.
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31

Advanced

Configurahon

Configurabon file paths
Crossover conhgurahon

Default item durabons

INews Web Service configuration
Logging

Manus configuration

NCS configuration

Template database conhiguration
Viz Media Sequencer configuration

* 1=
TRLI

Configuration

The editor comprises several sections, each dedicated to a collection of settings:

Advanced

Configuration

Configuration File Paths
Crossover Configuration

Default Item Durations

iNews Web Service Configuration
Logging

Manus Configuration

NCS Configuration

Template Database Configuration
Viz Media Sequencer Configuration
Notes

6.4.1 Advanced

ltemldGenerator: Default: Empty.

Mosart generates internal IDs using a combination of rundown, story and item IDs. Some
newsroom systems reuse item IDs between story updates. If a new object is inserted before
an old object, Viz Mosart will therefore generate the same ID for the new object that the old
object had, and the old object will be given a new ID.

A custom ID generator can be assigned by setting the ItemldGenerator property in the Viz
Mosart server settings.

Value Description
(Empty) This is the default value and uses the default ID
generator
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Value Description

ltemAndObjectID This ID generator appends the object ID to the default ID
generator. This setting should be used for Dalet
Newswire.

6.4.2 Configuration

- Auto preview overlays: Lists graphics destinations that support preview of overlay graphics
(i.e. DSK enables preview of all overlay graphics with handler=DSK).

Default: Empty = no preview.

- Auto preview overlays early: Enable preview of overlay graphics as early as possible. When
set to False, the preview will be displayed only when the graphics is the next item to be
taken.

- Auto take offset: Sets offset for the autotake function.

Default: 0 (milliseconds).

Default Handler Name: Defines a default handler name for all graphics that have no handler
name.

Default: DSK.

Default Lower Third Out Behaviour:

Default: TIMECODE.

Force clip editorial time: Shows Editorial time in GUL.

Default: False.

Frame rate: Determines the frame rate of the system. Valid rates 25, 29.97, 50 and 60.

Default: 25.
Ignore initial synchronization: Ignores all roReq on startup when synchronizing with the
NRCS.

Default: False.
Ignore sending item status filter: Lists regular expressions used to prevent sending MOS
status back to the NRCS.
The regular expressions are matched against Moslds of MOS objects. Set to ‘*’ to disable the
sending status for all MOS objects.
Default: Empty (send status for all MOS objects).
Ignore updates if nothing changes: If True , a story update from the NRCS is ignored if the
updated story is assumed to be equal to the current version of that story.
Default: False (no NRCS story updates are ignored).
Item status unavailable values: Lists status values used to identify NRCS content as invalid.
Content as graphics or clip objects.
Default: NOT_READY, ERROR.
Keep story status on updates from NCS: When enabled, keeps played out stories gray if the
story is updated in the NRCS.
Default: False.
MetaData creator priority: Select between

Newsroom editorial time

Copyright © 2022 Vizrt Page 79



Viz Mosart Administrator Guide - 5.0

MAM duration
Full video clip length.

Separate IDs with commas. Use the name of the Media Administrator entry. Special names
are NCS (for information from the NRCS) and GLOBAL (global values from media object).
If Empty, Viz Mosart inserts NCS as the first and GLOBAL as last entries.

Default: Empty.

Min. time between story update: If no update is received from the NRCS within the minimum
time stipulated, Viz Mosart forces a story update.

Default: 7000 (milliseconds).

Minimum clip length: This value sets the minimum visible length of an offline clip in a story
in the GUI. When Viz Mosart receives clip information, the visible length is updated.
Default: 5 (ss:ff).

Network exclude: Manus Administrator automatically enters idle mode on network failure.
This property is a CSV list of network names to ignore when monitoring networks.

Default: Empty (monitor all networks).

Network include: Manus Administrator automatically enters idle mode on network failure.
This property is a CSV list of network names to monitor for network failure.

Default: Empty (monitor all networks)

Offset secondary events with mix delay: Secondary events follow primary event mix delay.
For example, a lower-third element has the same mix delay as the package on which it is to
be keyed.

Default: False.

Pause Automation timing on first Break: When enabled, any first story with a single break
template will not start the Automation server rundown timing (Elapsed rundown duration).
The timing will start when the next story is taken. This does not affect the NRCS timing.
Default: False.

Preload Accessory Cue Delay: Defines the delay between end of cue the next item and
execution of a pending preload/pretake accessory. The duration is displayed in frames.
Default: 6 frames, i.e. the accessory preload/pretake functions shall take place after the cue
operation is done in AV Automation with an additional and configurable delay of
PreloadAccessoryCueDelay frames.

Read Speed: Number of words read per minute by the anchor. By default, words are defined
as the parts of text separated by space characters. See Use character for read speed word
below. This is applied to prompter text to determine the duration of an announcement and
thus the length of the green camera bar and the green part of the voice-over bar in the Viz
Mosart GUI.

Default: 745 (words per minute).

& Note: This is a fallback read rate, only used when the NRCS System fails to provide a
ReadRate of its own. This function can be tested by changing any readrate="xx" to
readrate="" on an item in a local Manus file.

Reset AutoTake on 'Clear Loop': Enable this to automatically disable the autotake mode
when using the clear loop function from the GUI.
Default: True.
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- Server description: Used for display only, in Timing Display.
Default: ControlRoom.

- Startup in idle mode: Determines whether or not Manus Administrator is idle at start-up. For
standard Viz Mosart operation, this setting shall always be True, so that the Viz Mosart
server starts up in Idle mode. Switching between Idle and Active mode shall in normal
operation be done from the GUI.

Default: True.
- Story Compare Ignore Attributes: Used for debugging purposes only.
Default: Empty.
. Story Scope: Displays either:
- Single = A single story uses one row in the Viz Mosart GUI.
Grouped = A single story may span over multiple rows in the Viz Mosart GUI.
Currently only supported for ENPS stories in Grouped mode that have the same story
name but different story segments; these are then treated as the same story in
Viz Mosart.
Default: Empty (Single).

- Templates allowing graphic pretake: Lists template types that allow pretake of overlay
graphics elements. Available template types: ADLIBPIX, BREAK, CAMERA, DVE,
FULLSCREENGRAPHICS, LIVE, PACKAGE, TELEPHONEINTERVIEW, VOICEOVER. Default:
PACKAGE, VOICEOVER.

Only the first graphic found on the next item is taken. This graphic is taken immediately
regardless of its start time.

A Note: To enable graphic pretake, the Pretake overlay on handler setting must be
configured in the Newsroom Settings Editor.

Use character for read speed word: If set to True, each character counts as a word when
calculating the spoken duration of prompter text, see Read Speed above. This can be useful
in languages like Chinese and Thai, where the space character is not used to separate words.
If False (default), words are separated by space characters.

Default: False.

Use Take Out Logic: Enables CG takeout logic. When two CG graphic objects with the

same graphic ID are next to each other, the first one is not taken out - take in on the second
object is executed only. True enables the takeout functionality for overlay graphics.

Default: False.

6.4.3 Configuration File Paths

- AvConfig: The path to the XML-file containing the audio and video mappings defined in the
AV Automation application.
Default: c:\channeltemplates\avconfig.xml.

- Channel templates: The path to the file containing the Viz Mosart templates built in the AV
Automation Template Editor.
Default: c:\channeltemplates\channeltemplates.xml.
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Manus directory: The path to the folder containing copies of the internal Viz Mosart
rundown.

Default: c:\manus

Newsroomsettings: The path to the XML file containing the mappings from newsroom
system commands to Viz Mosart templates.

Default: c:\channeltemplates\newsroomsettings.xml|.

6.4.4 Crossover Configuration

- ConnectionString: The connection string of the crossover. For example: controller=IP
address, client=crossover.
Default: Empty.

5.0

- Crossover Auto Take On Switch Offset: Offset in milliseconds to pre-take an autotake when
the next story item follows a crossover switch. A positive value triggers the autotake before

the given duration of the story item. A negative value triggers the autotake after the given

duration of the story item.
Default: 0.

- Crossover Set Next On Switch Delay: Delay of sending set next story from the server running

the show when taking control.
Default: 500 (milliseconds).

6.4.5 Default Iltem Durations

Break: The minimum length given to the BREAK template type in the rundown. If no time is

given in the NRCS, this time is given to the element.
Default: 700 (frames).

- Camera: The minimum length given to the CAMERA template type in the rundown. If no time

is given in the NRCS, this time is given to the element.
Default: 125 (frames).

DVE: The minimum length given to the DVE template type in the rundown. If no time is given

in the NRCS, this time is given to the element.
Default: 125 (frames).

Full-screen-graphic: The minimum length given to the FULLSCREEN GRAPHIC template type in

the rundown. If no time is given in the NRCS, this time is given to the element.
Default: 125 (frames).

Item: The minimum length given to any template type in the rundown. If no time is given in

the NRCS, this time is given to the element.
Default: 700 (frames).

Live: The minimum length given to the LIVE template type in the rundown. If no time is given

in the NRCS, this time is given to the element.
Default: 125 (frames).

Lower-third: The minimum length given to the Lowerthird template type in the rundown. If

no time is given in the NRCS, this time is given to the element.
Default: 125 (frames).
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- Telephoneinterview: The minimum length given to the PHONO template type in the
rundown. If no time is given in the NRCS, this time is given to the element.
Default: 125 (frames).

- Video clip: The minimum length given to the CLIP template type in the rundown. If no time is
given in the NRCS, this time is given to the element.
Default: 125 (frames).

6.4.6 iNews Web Service Configuration

- Web Service Connection: Example:
WebServiceServer=localhost;iNewsServer=10.211.112.104;iNewsUsername=mosart;iNewsPas
sword=mosart;SendUpdatesStatusForAllltems=true;ClearStatusWhenRundownReloaded=true.
Default: Empty.

6.4.7 Logging

Ignore verbose events filter: Semicolon-based list of events to ignore in the log when using
verbose logging.
Default: Empty (log all events).
In use: Enables or disables the logging of events from the Manus Administrator to the log
file.
Default: True.
Log level: Sets the detail level of logging to the log file. 0 =normal, 17 =warnings, 2 =errors, 3
=info, 4 =detailed.
Default: 0.
Mos communication is logged: Enable logging of the communication to and from NCS.
Default: False .
MSMQ Log limit: Value to identify when the application should dump the log queue to file.
Default: 4023.
Pass verbose events filter: Semicolon based list of events to log when using verbose logging.
Default: Empty (log all events).
Path for MMLog: The path where the Viz Mosart log is stored. Default: MosartLog .

- Trace internally: Enables or disables internal tracing to console for debugging only.
Default: False .
Use verbose logging: Enables or disables verbose logging. If UseLogging is set, verbose
increases the details sent to the log.
Default: False.

- WTC Level: Sets the detail level of logging to the console. 0 =normal, 1 =warnings, 2
=errors, 3 =info, 4 =detailed.
Default: 4.
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6.4.8 Manus Configuration

Default Manus: This value selects the default rundown to use. The READYTOAIR value selects
and uses all rundowns indicated by the newsroom system as ready to air.

Default: READYTOAIR

Manus expiration time: Number of days to keep Manus Administrator files. Older files (than
that number of days) are deleted when Manus Administrator is started.

Default: 60 (files are deleted after 60 days).

Legal values: -1 (never deleted), 1 and above (number of days until deleted from the manus
folder).

Manus keep file pattern: A semicolon-separated list of file name patterns. Files with names
satisfying any of these patterns will be kept even if they are 'too old' according to the
ManusExpirationTime setting.

Default: Empty (no files to keep). Example: "TEST*;DEMO??.xml" keeps all files starting with
“TEST” and all DEMO??.xml files where ‘?’ denotes a wild character.

Use the default selected manus: Initializes the rundown given in the Settings Editor

MOS setting automatically when enabled.

Default: True

6.4.9 NCS Configuration

These settings are used when sending Mosart templates as MOS objects to the NRCS. MOS objects
can then, for example be used to create items in a rundown (as an alternative to the legacy Mosart
ActiveX implementation).

You can also send a MOS object containing lower-third information.

Forced Mos protocol version: Protocol version to use for NRCS communication. Default
(blank) setting detects the version from the NRCS, otherwise, use a discrete value, for
example, 2.8.3.
Default: Empty.
Ignore Send Cue Status To NCS For Offline Clips: Enable this flag to prevent the NRCS from
receiving CUED or READY statuses of offline video clips.
Default: False.
Lower Port: The MOS protocol communicates on three ports: lower, upper and top.
MosUpperPort is MosLowerPort + 1 and MosTopPort is MosLowerPort + 2.
Default: 10540
Mos server timeout: Timeout information for MOS ports. Default: 0.0.0.0.
1. NCS to Mosart Lower port: NRCS heartbeat sent to Viz Mosart. If the time between
received heartbeats exceeds this value, the connection is displayed as lost.
Value=0 means no timeout.
Default: 0 (seconds).
2. NCS to Mosart Upper port: NRCS heartbeat sent to Viz Mosart. If the time between
received heartbeats exceeds this value, the connection is displayed as lost.
Value=0 means no timeout.
Default: 0 (seconds).
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3. NCS to Mosart High port: NRCS heartbeat sent to Viz Mosart. If the time between
received heartbeats exceeds this value, the connection is displayed as lost.
Value=0 means no timeout.
Default: 0 (seconds).
- 4, Mosart to NCS: Timeout value for an established connection between
Viz Mosart and the NRCS. If the time from heartbeat is sent to response is received
exceeds this value, the connection is displayed as lost. Value=0 means no timeout.
Default: 0 (seconds).
Mosld: MOS identification of this instance of the Manus Administrator. Generic value
is mosart.<gallerylD>.<station|D>.mos.
Default: mosart.mos.
NCS Time Zone: Used when the time zone is not indicated by the NCS Server. Valid values
are Z (meaning UTC) and +/-hh[:mm], where hhand mm are double digit hours and optional
minutes.
Default: Z (UTC) unless another value is specified.
NCS Type: Generic: No special handling of native NRCS commands. Can be: Generic,
DaletPlus, ENPS, NcPower, Octopus, Open Media and MOSInews.
Default: Generic.
NCSId: Same form as mosID, but this value is the ID for the newsroom system.
See Notes below.
Default: NCSSERVER.
NCSId Backup: Same form as mosID, but this value is the ID for the backup newsroom
system. See Notes below.
Default: Empty.
Newsroomtag keep keywords ( NewsRoomTagKeepKeywords): A comma (or semicolon)
separated list of CAPITALIZED words. If a newsroom tag value is equal to any of these words,
the newsroom tag will be assigned the value of the last Newsroom tag with the same name
in the same story.
Default: KEEP.
See Keep Newsroom tag (with the same name) within a story in Newsroom Tags . If
a comma) is used all newsroomtags will be kept.
ReadyToAir by default: If the value is true, all MOS active rundowns are assumed to be ready
to air.
Default: False.
Refresh Media On NCS Update: Trigger clip refresh for all clips that belong to a story that is
being updated, usually via story updates from the NRCS when set to True. This ensures that
all clip information is synchronized.
Default: False
Reply with connection Mosld: If set, any MOS message sent to the NRCS uses the connection
Mosld instead of the current mos object ID.
Default: False.
- Schema: A string used to identify Viz Mosart items in the rundown. Default: http://
www.mosartmedialab.no/schema/mositem.dtd.

," (only
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- Server: IP address or hostname of the main newsroom system’s MOS gateway.
See Notes below.
Default: NCSSERVER.
- Server BackUp: IP address or hostname of the backup newsroom system’s MOS gateway.
See Notes below.
Default: Empty.
- Template feedback to NCS:
- Enabled: Enables sending templates to the NRCS through MOS communication.
Default: Enabled.
- GenerateUniqueObijld: Create a unique identifying name when creating a new MOS
Object. The NRCS uses this information to search for and reference the MOS Object.
- GroupedByType: Enable to send all template types as one MOS object with the variants
embedded in the objects. Disable to send all template variants as separate MOS
objects.
MergedClips: Determines whether PACKAGE and VOICEOVER templates are merged as
CLIP templates.
- SendAllTemplateSets: Sends templates from all template sets to the NRCS when
enabled. Disable to send only the default template set.
- TemplateChangeWanted: Set to true, the NRCS will receive an update whenever
a template is changed or deleted.
Use NCS backup server: Enables an NRCS backup configuration. See Notes below.
Default: False.
UseltemStatusToNCS: Sends roltemStat/roElementStat messages to the NRCS when clip
updates are received from the Media Administrator. If the clip is available on
the playout server, READY is sent. Otherwise NOT READY is sent.
Default: False.

6.4.10 Template Database Configuration

- ConnectionString: The connection string for the Template DB. For example, for MySQL:
server=<hostname>;User Id=<user>; Password=<password>;database=mosarttemplatedb.
Default: server=Ilocalhost;User Id=root;database=mosarttemplatedb.

Default inserter: The name to be used for the ..._insertedby and ..._updatedby columns.
Default: inserter.

Provider name: The provider name for the Template DB. For example,
MySql.Data.MySqlClient for MySql.

Default: MySql.Data.MySqlClient.

Use template database: When True, this enables the Template DB functionality, so template

type aliases can be exported from DB to newsroomsettings.xml at startup, and the

import of newsroomsettings.xml to DB after the file has been saved.
Default: False.

& Note: Enter the TemplateDbConnectionString before enabling UseTemplateDb.
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6.4.11 Viz Media Sequencer Configuration

Mse Playlist Panel Host: The host address of the Media Sequencer Engine (MSE)

Configure or change an existing MSE host to activate the MSE Playlist panel. The Playlist

panel users active (touch or click-sensitive) thumbnails of graphics held on an MSE.

The Viz Mosart Ul needs this MSE connection defined in order for the user to see the Playlist panel
(View > Floating windows > Playlist Panel). See Viz Mosart User Guide, section Viz Mosart User
Interface > MSE Playlist Panel.

6.4.12 Notes

If there is more than one main newsroom system, the setting parameters MosServer,
MosServerBackup, ncsID, and ncsiDBackup should contain space-separated lists of values,
and the values must be in the same order.

If some of the newsroom systems do not have a backup system, put them last in the list and
leave the corresponding values blank for MosServerBackup and ncsIDBackup.

If two newsroom systems are backup for each other, both must be listed as both main and
backup. If one system is backup for more than one main system, it must be listed as
backup for each system.

If different newsroom systems need to give Viz Mosart different MOS IDs, the settings
parameter mosID should also be a space-separated list of values, in the same order as for
ncsiD.

Use only a single space between list values. All values are case sensitive.
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6.5 Newsroom Settings Editor

Edit

NCS tags

MNewsroom alias

CAMERA
PACKAGE

Mosart type
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This section contains the following topics:

- Working with the Newsroom settings
Configuring NRCS Tags
Newsroom Settings Editor - Edit Menu
Story External Metadata
Graphic Destination Letters

Properties

- Viz Mosart Object Structure

- Vizrt MOS Item With Payload Data Nodes
Vizrt MOS Item Without Payload Data Nodes

- Viz Mosart and Viz Content Pilot (VCP) MOS Item Integration

MOS ID Mapping

- Additional Newsroom Settings Examples

Defining Default Values for Lower Thirds

iINEWS: Overriding Default Field Names when Parsing Stories
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6.5.1 Working with the Newsroom settings

Configuring NRCS Tags

To open the Newsroom Settings XML editor

1. Open the Manus Administrator console
2. Type ns followed by ENTER.
3. From the menu bar Edit > NCS Tags.

To save changes
Any changes made to the Newsroom Settings configuration must be saved:

1. Either

a. Go to File > Save, or,

b. Close the Newsroom Settings Editor and select Save.
2. Restart Manus Administrator for changes to apply.

Newsroom Settings Editor - Edit Menu

The Edit menu lists the configuration categories that are available.

5.0

NCS tags: Menu for assigning the NRCS command aliases from the newsroom system to the

corresponding Viz Mosart type. Each type can have multiple aliases. For example, Camera

type can have aliases CAM, CAMERA, KAM, KAMERA, and so on.

NCS omit stories: List of stories that should be ignored, and not displayed in the Viz Mosart

GUL.
NCS omit tags: (iNews only) List of iNews grommet commands that are ignored in Viz
Mosart.

NCS breakline stories: List of story names that are automatically converted to a Viz Mosart

break line story when the story is tagged as break.

NCS accessory stories: Viz Mosart interprets a story with this title as a story with accessories

only.

NCS lowerthird mapping: List for converting lower third template names from what is written

in the NRCS (origin) to the required template (translated) in the graphics system.
Transtype can be begins, exact or contains.

- Timecode character: Settings for textual analysis of timecode character, start character and

split character.
Keywords: Translation of CUT , MIX , WIPE and EFFECT transition keywords.

Lower third keep while background: Lower third variants that are kept on air for the duration

of the parent Viz Mosart template.

Lower third keep while story: Lower third variants that are kept on air for the duration of the

parent story.
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Lower third none auto out: Lower third variants that are kept on air until replaced by another
lower third of the same variant. Can be taken out with a keyboard shortcut (for example
HOME).

Lower third keep until manual taken out: Deprecated.

Pretake overlay on handler: Name of the overlay handlers that automatically take the first
lower third element in the next story on item types configured in Manus Administrator
Settings, Template allowing graphic pretake (same configurations for MOS Settings Editor
MOS or iNews).

The graphic is taken immediately regardless of its start time.

In the following example, only the graphics with destination DSK, WALL or WALL_2 are
pretaken.

Example

<pretakeoverlayhandlername>
<handlername name="DSK" />
<handlername name="WALL" />
<handlername name="WALL_2" />

</pretakeoverlayhandlername>

NCS device shortening: (iNews only) A list of aliases for clipname or clip_hirespath values
that can be used as newsroom tags in iNews grommets.

Parenthesis: Start and end parenthesis. Content within these parentheses is translated to Viz
Mosart commands. A value of (*) translates all commands in the form (** COMMAND ***) as
the * (asterisk) value is interpreted as one or more asterisks.

Story External Metadata: The NRCS can send external story values in a container

called mosExternalMetadata (MEM). These can be translated to Viz Mosart content, as
described in section Story External Metadata below.

Graphic Destination Letters: Used to identify the output and behavior of graphic elements.
See Graphic Destination Letters below.

A Note: Only applies Vizrt VCP MOS items and the use of the Viz Mosart extended data
element description.

Lower thirds type translation: (ENPS only) CG commands. Use this to translate a CG item to a
Viz Mosart primary story element
templatetype: CG template ID to translate
type: Viz Mosart primary story element
variant: Viz Mosart variant of the primary story element
transtype: begins, contains or exact. Describes the usage of the templatetype value
when searching the CG item.
Newsroom tag to lowerthird channel map: Translate the handler name of a graphic item into
the value defined by this mapping in the newsroomsettings.
For example, with the following configurations in newsroomsettings.xml:
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<inewstags>
<tags>
<tag name="CAMERA" type="CAMERA" scope="A11" />
<tag name="PACKAGE" type="PACKAGE" scope="A11" />
<tag name="VOICEOVER" type="VOICEOVER" scope="All" />
<tag name="VOICE OVER CLIPS" type="VOICEOVER" scope="All" />
<tag name="CG" type="LOWERTHIRDS" scope="A1ll" />
<tag name="FLOAT" type="ADLIBPIX" scope="A1ll" />
</tags>

<newsroomtypehandlernamemap>
<tag name="CG" value="DSK" />
</newsroomtypehandlernamemap>

</inewstags>

when a graphic MOS object is parsed in Viz Mosart and found to be a CG command as
defined in the <tag> node, Viz Mosart converts it to a Viz Mosart graphic item.

It then sets the handler_name attribute to DSK, based on the mapping defined in
<newsroomtypehandlernamemap> node

In this case, the graphic is redirected on the DSK channel of the configured graphic engine.
Omit text: (iNews only) Omit text from iNEWS presenters area.

Properties: (iNews only) iNEWS custom settings, see Overriding Default Field Names When
Parsing iNEWS Stories below.

Ignore parenthesis: (MOS-systems only) List of start and end parenthesis that encloses text
ignored in Viz Mosart.

MOS Id mapping: Enables Viz Mosart to recognize MOS elements from the NRCS and trigger
specific Viz Mosart actions when encountered. Must not be changed by the user.

See MOS ID Mapping below for a description of mapping MOS ID fields in

the newsroomsettings.xml file.

MediaObject property mapping: keywords specified during Viz Mosart installation for
installation-specific behavior of Viz Mosart. Should not be changed by the user.

Story External Metadata

The NRCS can share story values in a container called MosExternalMetadata (MEM). These values
can then be translated to Viz Mosart content. The values are:

mostagnhame: An XML element, often originating from a column name in the NRCS.
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@ You can derive this NRCS-assigned name for example in iNews, by Right-clicking >
Field Properties:

XPoint1 l)(pomt.? |XPoint3 Duration ’Custom [En‘
|SR First Story ID 03:00
Form Properties E]
Apply to:
Curmrent field Attrbutes Type
Label Label size J
Type =di size Lyt
Write Group
Text alignment Label placement Label alignment
Entries 4 K+ @
No Color
Text style Label style N |
| 7 _
In this example, the user friendly SR Base Name is stored internally in iNews as
var-007.

mos_value: This is the text that appears in the XML element mostagname (set in the NRCS).
Mosart Action:
template_type: Use a value from the NRCS to create a new Mosart item in the rundown
story. The value from the NRCS can be a newsroom tag of TEXT item scope. Newsroom
tags are configured in newsroomsettings.xml, (for example, CAM, KAM, KAMERA,
PKG).
You can also use the Viz Mosart type number, where for example, 0 is for Camera, 1
for Package. If the value from NRCS is empty, no item is created.
Example:

<mostag mostagname="var-1" mosart_action="template_type" format_type="Stri
ng" />

A new Viz Mosart item of type given in the NRCS column var-1 is created.
item_variable: Uses the value from NRCS to set a field on the first primary item found
in the story. Non-empty values overwrite any existing fields.

Example:
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<mostag mostagname="var-2" mosart_action="1dtem_variable" action_value="cli
p_hirespath" format_type="String" />
<mostag mostagname="var-3" mosart_action="ditem_variable" action_value="out
put_preview" format_type="String" />

The fields clip_hirespath and output_preview are set on the first primary item found in
the story, with the values taken from the columns var-2 and var-3 configured in NRCS.
item_duration: Use the value from the NRCS column as the duration for an item or
several items in the story.

If action_value is empty,

- the duration is applied to the first primary item in the story.

If action_value contains the template type of a Viz Mosart item (given as

a newsroomtag defined in the NRCS tags from Newsroomsettings or as a

number (for example CAM or 0) or a list of template types separated by comma,

- the duration applies to all items of that type.

For example: action_value=CAM or action_value=PKG, JINGLE or

action_value=0 or action_value=17,JINGLE.

If action_value contains pairs <type><separator><variant> or a list of such

pairs separated by a comma,

- duration applies to those specific items in the story.

For example: action_value=CAM=1 or action_value=CAM/1,PKG).

n_n ||||| n.n non

The <separator> can be "=",

n.n

N, or .
Use Format type to select if the value is given as seconds (integer), frames
(integer) or as a time code.
template_variant: Use the value from the NRCS to add or change the variant of the first
primary item found in the story.
template_transition: Use the value from the NRCS to add effect transitions to the first
primary item found in the story.
This also provides a good overview in the newsroom about which effects are used
between the stories.
For example:

<mostag mostagname="TranFromNcs" mos_value="SLIDE" format_type="String"
mosart_action="template_transition" action_value="MIX,24" />

Use the value from the NRCS to add effect transitions to the first primary item found
in the story.

The effect transition is given in the format <effect_name><separator><input>
, Where <separator> can be white space, bar (]), commag,), semicolon(;) or colon (:).
The <effect_name> can be EFFECT, MIX, WIPE or their translations as configured in

the Keywords section in Newsroomsettings.
For example, if EFFECT is mapped as EFFEKT in the Keywords section, we can add the
following effect to the Viz Mosart item: Effekt 2.
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story_variable: Use the value from the NRCS to set a field on all items (excluding
prompters and some secondaries with type > 300) found in the story. Non-empty
values do not overwrite existing fields.

story_duration: Use the value from the NRCS as the planned duration for this story.
Use Format type to select if the value is given as seconds (integer) or as a time code.
directtake_pre_story: Executes the direct take template given in the action_value at the
start of the story (in the switch from the previous to current story).
directtake_post_story: Executes the direct take template given in the action_value at
the end of the story (in the switch from the current to the next story).

guimarker_X: Translates the set of mostagname and mos_value to a marker in the GUI,
valid action_values are blank , O (green), 1 (orange) and 2 (red).

device_property: Sends a key-value pair to the device driver. For example, for

camera robots this can be used to adjust speed and camera positions.
story_endphrase: Use the value from the NRCS to override the endphrase attribute for
the last primary item in a Viz Mosart story.

segment_duration: Use the value from the NRCS to set the duration of a group of
stories.

words_per_minute : Sets the read rate for a story.

back_time: Sets the backtime attribute for a story (the exact time when a story must
start in order for the show to remain on schedule.). This is used to set a next break
time of the show. The break attribute must be set to true.

cume_time: Sets the cumetime attribute for a story - the amount of airtime required
from the beginning of the show up to a certain point in the show in order for the show
to remain on-schedule. This is used to set a next break duration of the show.

The break attribute must be set to true.

category: Sets the category attribute for a story used to identify a story category such
as sports, news, business etc.

field_value_X : Overrides the field value of a Viz Mosart item with the value stipulated
in the NRCS. This applies only to the first primary item in a story and the field must
already exist for that item. For example, if the first primary item in a story is a
Package with the following fields:

<fields>

<field name="clip_description" value="" default="" fieldtype="TEXT"
keylist="" />

<field name="clip_hirespath" value="" default="" fieldtype="TEXT"
keylist="" />

<field name="metadata_lookuppath" value="" default="" fieldtype="TEXT"

keylist="" />

</fields>

and the following mappings are given in newsroom settings:

<mostag mostagname="ClipDescrCol" mosart_action="field_value_1"
action_value="clip_description" format_type="String" />
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clip_hirespath=MyClip" mos_value="test" format_type="String" />

then the field is set to the value given in the NRCS in the column with id
ClipDescrCol and the field clip_hirespath are set to the value MyClip if the value from
column ClipldCol in the NRCS is test.

action_value="

A Note: The attribute action_value for <mostag> node in newsroom setting can
contain the field name or pairs of field name=field value separated by comma,
colon, semi-colon, dash, equal or bar.

asruninfo: Sets the attribute asruninfo for all items in a Viz Mosart story. This is used
to store specific information that is stored in the AsRunlLog.

Graphic Destination Letters

EMosart Newsroom Settings - ¢ ,channeltemplates’ newsroomsettings.xmil ;[g|5|
File  Edit Graphic destination Letters

Drestination mapping | Graphic type Templatetype field Dezcription fields Usze TC Out MOS object delimiter Mozart object delimiter TC format
_ Lawerthird il o False rarr: =5 FF
1 Super Lowerthird 0 on Falze 4

cgw whall 21 Falze

I whall_1 gl Falze

B Wwall_2 2 Falze

Arnythingroutw/ant wallM a2 Falze mim;ss:ff

F Fullscreen o Falze

T TEST true hib: rrnn: s:5: £

T2

Test

ff

T

T

TRT

TKT

Graphic destination letters identify output and behavior for graphics elements. Use them to parse
a Vizrt MOS object and obtain a Viz Mosart object.

Properties

Each row contains the following columns:

Destination mapping: The mapping defined in the Viz Mosart command from Viz super.
Graphic type: Used to identify the output for the graphics elements, either on predefined
channels:
Fullscreen: Full screen graphics for FULL output (channel)
Lowerthird: Overlays for DSK output
Wall: Overlays for WALL output
WallIN: Overlays for outputs WALL_1, WALL_2, WALL_3 etc.
Ticker: Ticker for TICKER output
or on custom channels (so any string can be set as graphic type).
Templatetypefield: Index of the description field which is set as the TemplateType. (the
value of the description field found at the specified index). The index is 0-based. Default:
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empty.
For example: If the MosAbstract is: <mosAbstract>fieldl/field2/field3/field4/
Mosart=S|00:04|00:10</mosAbstract> , and you set Templatetypefield=1

, then the templatetype attribute from the Viz Mosart object is setto field2 .

Descriptionfields: A list of indexes of the fields which should be shown in the description of
a Mosart story item. These fields are shown in the Viz Mosart GUI separated by the character
given in the outputtxtdelimiter setting. The indexes are 0-based and are separated using a
pipe ‘|’ character.

For example: descriptionfields="0/1". Default: empty.

Use TC Out: Specifies if the duration should be used as tc_out.

Inputtxtdelimiter: Vizrt MOS object delimiter. Default: ‘/’ (slash)

Outputtxtdelimiter: Viz Mosart object delimiter. Default: ‘/’ (slash)

Mask: Specifies the timecode format of the graphics starting time, end time or

duration. Default: mm:ss. Example of formats: hh:mm, hh:mm:ss, mm:ss:ff, mm:ss, ss:ff, ff.

Mapping example:

<graphicdestinationletters>

<graphicdestinationletter destinationmapping="L" type="Lowerthird"
templatetypefield="1" descriptionfields="0|1" use_tc_out="False" +inputtxtdelimiter=""
outputtxtdelimiter="" mask="mm:ss:ff"/>

<graphicdestinationletter destinationmapping="Super" type="Lowerthird"
templatetypefield="0" descriptionfields="0|1" use_tc_out="False" +inputtxtdelimiter="|
" outputtxtdelimiter="%" mask=""/>

<graphicdestinationletter destinationmapping="cgw" type="Wall" templatetypefield=""
descriptionfields="2|1" use_tc_out="False" qinputtxtdelimiter="" outputtxtdelimiter="
ll/>

<graphicdestinationletter destinationmapping="A" type="Wall_1" templatetypefield="1

" use_tc_out="False" tinputtxtdelimiter="" outputtxtdelimiter=""/>
<graphicdestinationletter destinationmapping="B" type="Wall_2" templatetypefield="2
" use_tc_out="False" tinputtxtdelimiter="" outputtxtdelimiter=""/>

<graphicdestinationletter destinationmapping="AnythingYouWant" type="WallN"
templatetypefield="" descriptionfields="0|1|2" use_tc_out="False" inputtxtdelimiter="
" outputtxtdelimiter="" mask="mm:ss:ff"/>

<graphicdestinationletter destinationmapping="F" type="Fullscreen"
templatetypefield="" descriptionfields="0|1" use_tc_out="False" qinputtxtdelimiter=""
outputtxtdelimiter=""/>

<graphicdestinationletter destinationmapping="T1" type="TEST" use_tc_out="true"
mask="hh:mm:ss:ff"/>

<graphicdestinationletter destinationmapping="T2" type="Test" mask="ff"/>

<graphicdestinationletter destinationmapping="T" type="T"/>

<graphicdestinationletter destinationmapping="TXT" type="TXT"/>
</graphicdestinationletters>

Walls
There are two ways to support a configurable number of walls:
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1. By having a general rule in the graphics destination mappings where the graphics type must
be WalIN. The destionationmapping attribute can be set to any string of alphanumeric
characters.

<graphicdestinationletter destinationmapping="Walls" type="WallN"
templatetypefield="" descriptionfields="-1" use_tc_out="False"
inputtxtdelimiter="" outputtxtdelimiter="" mask="mm:ss"/>

In this case, the Vizrt graphic objects must contain a Viz Mosart string command ending in a
number (this provides the wall number).
For example:

Mosart=cgwl|00:00|00:05 or Mosart=something2|M|S or Mosart=wall3|00:00]|

B or Mosart=W4|00:04|00:10 and so on.

Given these examples, the destination for the first graphic is WALL_1, followed
by WALL_2, WALL_3 and WALL_4, respectively.

2. By not ending the Viz Mosart string destination mapping with a number.
For example:

Mosart=B|00:00|00:05, Mosart=Z|00:00|00:05, Mosart=Wall|00:00|00:05,
Mosart=Something|00:00]|00:05 and so on.

In this case, the configuration in newsroomsettings must specify the wall number in
the graphics type. For the Mosart string examples given above, the configuration can
therefore be:

<graphicdestinationletter destinationmapping="B" type="Wall_2"

templatetypefield="" descriptionfields="-1" use_tc_out="False"
inputtxtdelimiter="" outputtxtdelimiter="" mask="mm:ss"/>
<graphicdestinationletter destinationmapping="Z" type="Wall_3"
templatetypefield="" descriptionfields="-1" use_tc_out="False"
inputtxtdelimiter="" outputtxtdelimiter="" mask="mm:ss" />
<graphicdestinationletter destinationmapping="Wall" type="Wall_4"
templatetypefield="" descriptionfields="-1" use_tc_out="False"
inputtxtdelimiter="" outputtxtdelimiter="" mask="mm:ss"/>
<graphicdestinationletter destinationmapping="Something" type="Wall_5"templatet
ypefield="" descriptionfields="-1" use_tc_out="False" {inputtxtdelimiter=""
outputtxtdelimiter="" mask="mm:ss" />

Overlays with Mosart=B|00:00|00:05 are then redirected to WALL_2,
those with Mosart=Z|00:00|00:05 to WALL_3 and so on.
As well as redirecting graphics to predefined destinations like DSK, WALL, WALL_i, FULL, the

graphic destination letters rules can be used for any desired destination.
For example:

<graphicdestinationletter destinationmapping="T" type="TEST" templatetypefield=""
descriptionfields="-1" use_tc_out="False" inputtxtdelimiter="" outputtxtdelimiter=""
mask="mm:ss"/>
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and a Vizrt graphic with Mosart string T|00:00|00:06 sends the graphic for playout on the
channel TEST.

6.5.2 Viz Mosart Object Structure

When building a graphic Viz Mosart object from a Vizrt MOS object, an XML structure is created:

<item type="100" slug="L3-Anna Smith|Vizrt reporter|Mosart=L|00:00|00:06" source="1"
index="100___2_5" +ddref="5" templatetype="TIMECODE-DSK" status="0" error="0" in="0Q"
dur="150" pin="0" pdur="150" rdur="0" externaleffect="" intimeline="true" date_0=""
accessory="False" static="false" endfrase="" mosid="PILOT" objid="121" ismoselement="
true" use_graphics_id="true" graphics_id="121" handler_name="DSK" graphics_out_on="TI
MECODE" description="(DSK) - L3-Anna Smith|Vizrt reporter|Mosart=L|00:00|00:06"
auto_continue="false">
<fields>

<field name="graphics_description" fieldtype="TEXT" value="L3-Anna Smith|Vizrt
reporter |Mosart=L|00:00|00:06"/>

<field name="graphics_id" fieldtype="TEXT" value="121"/>

<field name="tc_dur" fieldtype="TIMECODE" -inputmask="mm:ss" default="00:00" value="
00:06"/>

<field name="continuecount" value="-1" fieldtype="TEXT"/>

<field name="payloaduri" value="http://bgoemo:8177/dataelements/121/payload"
fieldtype="TEXT"/>

<field name="thumbnailuri" value="http://bgoemo:8177/dataelements/121/thumb"
fieldtype="TEXT"/>

<field name="tc_in" fieldtype="TIMECODE" inputmask="mm:ss" default="00:00" value="
00:00"/>

</fields>

</item>

The graphic slug is used to visualize the graphics in the Viz Mosart GUI Assets window or in the
Overlay Graphics interface, for example. The slug is taken from MosAbstract found in the Vizrt
MOS object and the fields delimited by the inputtxtdelimiter are replaced with outputtxtdelimiter.

Viz Mosart can receive several types of Vizrt MOS graphic objects from the NRCS, including a

Vizrt MOS Item With Payload Data Nodes and a
Vizrt MOS Item Without Payload Data Nodes.

Vizrt MOS Item With Payload Data Nodes

If a Vizrt MOS item contains <mosPayload> with data entries, then the graphics_description is
built from these data nodes delimited by outputtxtdelimiter.

The property inputtxtdelimiter is used only to build the slug, not the description.

If descriptionfields is empty, then the graphics_description attribute from the Viz Mosart item
(created from the Vizrt MOS item) is set to the slug value (created from MosAbstract, see above).
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If the field is populated, the slug is set to the description created from data nodes entries where
only the data nodes from the positions specified in the descriptionfields are added and separated
by outputtxtdelimiter.

Example 1:
Using a Vizrt MOS item containing the following values:

<mosExternalMetadata>
<mosScope>0BJECT</mosScope>
<mosSchema>http://www.vizrt.com/mosObj/data</mosSchema>
<mosPayload>
<data>
<entry name="data">
<entry name="">
<entry name="" type="widestring">Navn/Titel/Sted</entry>
</entry>
<entry name="1" description="Name">
<entry name="1" description="Name" type="richtext" upper="true" singleline="
true" location="2/3/1/1">L3-Anna Smith</entry>
</entry>
<entry name="2" description="Title">
<entry name="2" description="Title" type="richtext" upper="true" singleline="
true" location="2/2/2/1">Vizrt reporter</entry>
</entry>
<entry name="Mosart">
<entry name="Mosart" type="widestring">Mosart=L|00:00|00:06 </entry>
</entry>
</entry>
</data>
</mosPayload>
</mosExternalMetadata>

apply the following mapping:

<graphicdestinationletters> <graphicdestinationletter destinationmapping="L" type="Lo
werthird" templatetypefield="" descriptionfields="" inputtxtdelimiter=""
outputtxtdelimiter="|" /> </graphicdestinationletters>

Note that inputtxtdelimiter is empty, so the default * / ’is used.

The result is the following Mosart item. Note the slug and description attributes and

graphics_description field:

<item type="100" slug="L3-Anna Smith|Vizrt reporter|Mosart=L|00:00|00:06" source="1"
index="100___2_5" ddref="5" templatetype="TIMECODE-DSK" status="0" error="0" in="0Q"
dur="150" pin="0" pdur="150" rdur="0" externaleffect="" intimeline="true" date_0=""
accessory="False" static="false" endfrase="" mosid="PILOT" objid="121" dismoselement="
true" use_graphics_id="true" graphics_id="121" handler_name="DSK" graphics_out_on="TI
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MECODE" description="(DSK) - L3-Anna Smith|Vizrt reporter|Mosart=L|00:00|00:06"
auto_continue="false">
<fields>
<field name="graphics_description" fieldtype="TEXT" value="L3-Anna Smith|Vizrt
reporter|Mosart=L|00:00|00:06"/>
<field name="graphics_id" fieldtype="TEXT" value="121"/>
<field name="tc_dur" fieldtype="TIMECODE" inputmask="mm:ss" default="00:00" value="
00:06"/>
<field name="continuecount" value="-1" fieldtype="TEXT"/>
<field name="payloaduri" value="http://bgoemo:8177/dataelements/121/payload"
fieldtype="TEXT"/>
<field name="thumbnailuri" value="http://bgoemo:8177/dataelements/121/thumb"
fieldtype="TEXT"/>
<field name="tc_in" fieldtype="TIMECODE" inputmask="mm:ss" default="00:00" value="
00:00"/>
</fields>
</item>

Example 2:

Using the same Vizrt MOS item as above, but with the following mapping:

<graphicdestinationletter destinationmapping="L" type="Lowerthird" templatetypefield="
1" descriptionfields="0|1" outputtxtdelimiter="%" />

In the result below you can see that the delimiters are now ‘%’ instead of ‘|’. Note
that templatetype is set to the value found at index 1.

<item type="100" slug="L3-Anna Smith%Vizrt reporter" source="1" index="100___2_5"
idref="5" templatetype="Vizrt reporter" status="0" error="0" in="0" dur="150" pin="0"
pdur="150" rdur="0" externaleffect="" dintimeline="true" date_0="" accessory="False"
static="false" endfrase="" mosid="PILOT" objid="121" dismoselement="true"
use_graphics_id="true" graphics_id="121" handler_name="DSK" graphics_out_on="TIMECODE
" description="(DSK) - banner%Anna Smith" auto_continue="false">
<fields>
<field name="graphics_description" fieldtype="TEXT" value="L3-Anna Smith%Vizrt
reporter" />

</fields>
</item>

Vizrt MOS Item Without Payload Data Nodes

MosAbstract

If the Vizrt MOS item does not contain data nodes, but has MosAbstract set, then the slug and the
description are built from MosAbstract.

In this case, inputtxtdelimiter is taken into consideration when building both the slug and
description.
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Similarly, if descriptionfields is empty, the graphics_description attribute from the Mosart item
(created from the Vizrt MOS item) is set to the slug value (created from MosAbstract, as explained
above).

Otherwise, the slug is set to the description built as explained above from MosAbstract where only
the fields from the positions specified in descriptionfields are added and separated
by outputtxtdelimiter.

Example 3:

Using the following Vizrt MOS Item:

<mosAbstract>00:00 | Super Tema + info | 26 | 1:Tema | 2:This is what the item 1is all
about |Mosart=S|M|00:04</mosAbstract>

apply the following mapping:

<graphicdestinationletters> <graphicdestinationletter destinationmapping="S" type='"Lo
werthird" templatetypefield="" descriptionfields="1|3" inputtxtdelimiter="|"
outputtxtdelimiter="%" /> </graphicdestinationletters>"

The result is:

<item type="100" slug="Super Tema + info%l:Tema" source="1" index="100___2_2" idref="
2" templatetype="TIMECODE-DSK" status="1" error="0" in="0" dur="100" pin="0" pdur="10
0" rdur="0" externaleffect="" +dintimeline="true" date_0="" accessory="False" static="f
alse" endfrase="" mosid="VIZ.NPRO.MOS" objid="1529718" -ismoselement="true"
use_graphics_id="true" graphics_1id="1529718" handler_name="DSK" graphics_out_on="TIME
CODE" description="(DSK) - Super Tema + 1info%l:Tema" auto_continue="false">
<fields>
<field name="graphics_description" fieldtype="TEXT" value="Super Tema +
info%l:Tema"/>
<field name="graphics_id" fieldtype="TEXT" value="1529718"/>
<field name="tc_dur" fieldtype="TIMECODE" inputmask="mm:ss" default="00:00" value="
00:04"/>
<field name="continuecount" value="-1" fieldtype="TEXT"/>
<field name="payloaduri" value="n/a" fieldtype="TEXT"/>
<field name="thumbnailuri" value="n/a" fieldtype="TEXT"/>
</fields>
</item>

6.5.3 Viz Mosart and Viz Content Pilot (VCP) MOS Item Integration

Vizrt MOS items do not contain any information about playout channel destination. By adding an
optional Mosart-part in the Vizrt data description, properties for channel destination, automatic or
manual play-out and timing information can be extracted from the MOS item.

This section presents the Vizrt MOS item metadata required to allow Viz Mosart to separate play-
out channel and extract timing information.
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Basic requirements

Viz Mosart requires details on whether the graphics element is a lower third, a graphics played out
on a video wall engine, or a full screen graphics. Any graphic requires the following properties:

Destination: lower third, video wall or full-screen graphics

For lower thirds/video walls:

- Play-out: manual or automatic

- For automatic play-out: in time

- Duration/out time or the special durations background end, story end or open end
Mosart item (optional): Stored at the end of the description of the data element or as a
specified field in the mosExternalMetadata section of the MOS item and is formatted as
follows:

Mosart={destination}|{in behaviour}{{out behaviour}|{X}/{F}

where

{destination} is an alphanumeric string specifying the destination of the graphic.
Suggested values are L=lower third, W=wall, F=full screen graphics

{in behaviour} is

- either M for manual play-out

- or a time code formatted as mm:ss (minutes, seconds) as in time

{out behaviour} is

- either a time code formatted as mm:ss (minutes, seconds) as duration

- or a single character field with values B, S or O where B=background end, S=story
end and O=open end

X is used only for lower thirds to ignore “Replace TakeOut Logic” meaning that when
taking and taking out the item, the replace logic is ignored if the value is set on the
item

F is used only for lower thirds to force “Replace TakeOut Logic” for graphics coming
from different templates with same layers (when used, it practically ignores the “O”
state for a layer). Not to be confused with destination letter “F” often used for full
screen graphics.

The rules which define the output and behavior for graphics elements can be configured
in Graphic Destination Letters.

Field Example:

The following table contains examples of the Mosart= part of the Vizrt data element description in
the value cg_gordon_brown/prime minister/Mosart=L|00:02|00:05. The data element is played out
as a lower third, automatically in at two seconds with five seconds duration.

L|00:02|00:05 Lower third, automatically in at 2 seconds with 5 seconds
duration
L]|00:02|S Lower third, automatically in at 2 seconds with duration equal

to the length of the story (taken out at the switch from one
story to the next)
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L|00:00|0 Lower third, automatically in at O seconds, never taken out
(except for when replaced by another item or manually from
the operator)

LIM|00:05 Lower third, manual play-out, duration 5 seconds

L|00:00|00:10|X Lower third, automatically in at 0 seconds with 10 seconds
duration and Replace TakeOut Logic is ignored

W|00:00|B Video wall, automatically in at 0 seconds, out when switching
from one story element to another

F Full screen graphics (note that this letter is usually used for
full screen graphics, but any combination of alphanumeric
characters can be used to identify a fullscreengraphic)

If no fields are given, the element defaults to a full screen graphics element.

VCP template requirements

The Mosart field is supported when embedded as a part of the VCP data element description or as
a dedicated field in the mosExternalMetadata section.

Storing the Mosart field in the VCP data element description

When saving the VCP data element, the Mosart field shall be appended to the stored database
description (the name of the data element).

Storing the Mosart field in the mosExternalMetadata section of the VCP data
element
This method is only supported if the mosExternalMetadata data section is enabled for the VCP

Template Filler ActiveX. See Appendix A for configuring the ActiveX to include this section in the
MOS object.

The scene needs a ControlObject. The Mosart field should be stored in a hidden text field in the
template, and the text field shall use Mosart in the ControlObjectName property. The Mosart field
can either be included in the scene or added manually after importing the scene to the Viz
Template Wizard.

VB script Example

The following VB script can be used in a Vizrt Template Wizard template and returns a properly
formatted Mosart field string:

"' Method that returns a properly formatted Mosart description
Function GetMosartDescriptionPart(AType, AVariant, AOperation, ATCIn, ATCOut)
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'Template variant
Dim FType, FVariant, FDefaultVariant, FDefaultOperation
Select Case AType
Case "LOWER"
FType = "L" 'LOWER (lower third, over shoulder gfx)

If AVariant = "" Then
AVariant = "AUTOOUT"
End If
Case "WALL"
FType = "W" 'LOWER (lower third, over shoulder gfx)
If AVariant = "" Then
AVariant = "OPENEND"
End If
Case Else
'"FType = "F" 'FULL (fullscreen)
GetMosartDescriptionPart = "Mosart=F"
Exit Function
End Select

'Take out logic (Only applies for lower thirds)
FVariant = TranslateVariant(AVariant)

'Operation selection
Select Case AOperation
Case "MANUAL"
FOperation = "M" 'FULL
FTCIn = FOperation
If (FVariant="A") Then
FTCOut = ATCOut
Else
FTCOut = FVariant
End If
case else 'case "AUTO+"
FOperation = "A" 'AUTO+
FTCIn = ATCIn
If (FVariant="A") Then
FTCOut = ATCOut
Else
FTCOut = FVariant
End If
end select

GetMosartDescriptionPart = ToMosartProperty(FType, FTCIn,
End Function

Function ToMosartProperty(AType, ATCIn, ATCOut)
splitChar = "|"
Dim vals
'vals = vbNewLine
If Not AType = "" Then
vals = vals & "Mosart="
vals = vals & AType
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If Not ATCIn = "" Then
vals = vals & splitChar & ATCIn
If Not ATCOut = "" Then
vals = vals & splitChar & ATCOut
End If
End If
End If
ToMosartProperty = vals
End Function

Function TranslateVariant(AVariant)
select case AVariant
case "OPENEND"
TranslateVariant = "0" 'OPENEND
case "STORYEND"
TranslateVariant = "S" 'STORYEND
case "BACKGROUNDEND"
TranslateVariant = "B" 'BACKGROUNDEND
case else 'case "AUTOOUT"
TranslateVariant = "A" 'AUTOOUT
end select
End Function

Viz Pilot plugin Prerequisites

To enable the mosExternalMetadata section in the Viz Pilot News (Active X) plugin, the system
administrator must also enable a field in the VCP parameters list in the Viz Pilot database.

If you Viz Pilot 5.7 or later, this setting is available in the Viz Pilot Data Server settings page found
in:

http://[hostname of PDS]:8177/settings#Params

VCP parameters Search Providers Tag settings

MHame= = WValus Dh==criplion

ax_add_dbdata_to_mossxbernal Adds mxbrs information about the dats in the =lement o Bhe mos it=m

In the Value column, the checkbox should be checked (set to true).

If you have a Viz Pilot version older than 5.7 this is easily achieved by opening the Preferences
editor in the Viz Content Pilot (Options - Preferences — Advanced), by adding or editing the field
called ax_add_dbdata_to_mosexternal setting the value to y.

2rver

Spellcheck
‘- Resource Plugins

6.5.4 MOS ID Mapping

A MOS Id mapping can be performed in the newsroomsettings.xml file, as follows:
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<mosids>
<tag name="" value="" fieldmapping="" appendContent="" embeddedMosartItem=""
keywords="" />
</mosids>

Where:
name: The MOS ID that identifies the MOS elements coming from the NRCS.
- value: The mapping ID used to identify a mapping for MOS element fields to be parsed. The
MOS element's fields to be parsed are defined using <mosmaps> (/mmConstants/

xmltemplates/mosmaps/mosmap/) .

- fieldmapping: Set to true if field mapping should apply.
appendContent: Set to true if the mapping should be appended to the Viz Mosart element
item.
embeddedMosartltem: Set to true if the MOS element has a Viz Mosart command embedded.
keywords: Currently only the MOS parsing of Vizrt objects uses this column. It contains a
comma-separated list of device-specific values.

novideo : Adding this excludes video clip information from Vizrt Video MOS objects,

and only uses the lower thirds of the MOS item. The video ID can then be given from
any other MOS object, or a story field. For example the video id column in iINEWS.
nodefaultitem: Adding this excludes Vizrt full-frame graphics if no default item is
found (when missing Viz Mosart template).

IgnoreTemplateSet (or IgnoreTemplateSet=true ): When added to a MOS ID
named "MOSART" , the templateset attribute from a MOS object coming from the

NRCS is ignored.
For example:
<tag name="MOSART" value="" appendContent="false"

fieldMapping="false" keywords="IgnoreTemplateSet=true"/>

6.5.5 Additional Newsroom Settings Examples

Defining Default Values for Lower Thirds

You can set default values for parsing of lower third objects. Usually these values are set from the
objects received from the NRCS. Altering these values is usually part of a customization task.

In newsroomsettings.xml add the default values to themmConstants/inewstags/
propertieselement:

<mmConstants><inewstags>

<properties>
<item name = "DefaultLowerThirdDuration" value = "125"/>
<item name = "DefaultLowerThirdHandlerName" value = "DSK"/>
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<item name = "DefaultLowerThirdOutBehaviour" value = "TIMECODE"/>
<item name = "DefaultLowerThirdOwnerMedia" value = "MEDIA"/>
</properties>
</inewstags></mmConstants>

Lower Third Properties

Property Description Default value

DefaultLowerThirdDuration The default duration of a TIMECODE 125
lower third, in frames

DefaultLowerThirdHandlerNam  The default graphics destination / DSK

e handler

DefaultLowerThirdOutBehaviou The default out behaviour TIMECODE
r

DefaultLowerThirdOwnerMedia The default owner attribute for MEDIA

secondary NRCS objects

INEWS: Overriding Default Field Names when Parsing Stories

When parsing the iNEWS NSML, the system extracts various field values using default field names.
These defaults can be overridden by setting new values in Newsroom Settings > Edit > Properties.

rE * Mosart Newsroo... I. = | =l |ﬂh]1

File  Edit

name value

[ J FieldNameShowld my-d
FieldMameClipHiresPath | my-video-id
FieldMName Tatal Time my-totaldime
FieldNameVideoTime my-video4time
FieldMame Tesxd Time my-{exttime

Field name INEWS default field Description
hame
FieldNameShowld id The house ID of the show. Used for as-

run logging.
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FieldNameClipHiresPath

FieldNameTotalTime
FieldNameVideoTime

FieldNameTextTime

iNEWS default field
hame

video-id

total-time

tape-time

text-time
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Description

The video ID column. The field is
appended to the first primary element in
the story.

The total planned duration for the story.
The video time of the story.

The iNEWS-calculated text time of the
story. If the total time is not available,
the value is calculated using this value is
added to video time.

6.6 Field Mapping

The custom MOS object mapping is a setup which extracts field values from foreign MOS objects
and translates these into Viz Mosart fields. This is done in the newsroomsettings.xml
configuration file. This simplifies integration, as no new code needs to be deployed.

- The Tool Set
- What to Configure
- Target Fields

Mapping Source Fields to Target Fields

Examples

- Video Server ltem

Graphics Item

Harris Video Objects in Octopus

6.6.1 The Tool Set

Default configurations are available as part of newsroomsettings.xml file.
- Select content from XML using simple XPath 1.0 expressions.
- Concatenate the XPath result using a separator.
Replace parts of the result using static or dynamic variables.
- Apply conversion rules for the specific field type.

6.6.2 What to Configure

Reuse or modify existing MOS field mapping in newsroomsettings.xml.
- Add MOS Id map entry using newsroom settings editor.
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Newsroom alias: MOS ID of foreign item.

- value: Field mapping entry name.

- appendContent: appends the complete MOS object to the internal Viz Mosart <item />
as a _<content /> _sub child.

- embeddedMosartltem: signal if the item has a Viz Mosart item embedded.

6.6.3 Target Fields

Target fields is a list of the fields used when controlling a video server or graphics elements.
Video Server

- clip_hirespath: The name or ID of the video file.
- clip_description: A human-readable description of the video file (optional).
- clip_dur: The duration of the video file.

clip_mark_in: The start frame of the video file (optional).

Graphics Systems

- graphics_id: The ID of the graphics item.

- graphics_description: A human-readable description of the graphics item.

- tc_in: Planned in time for the item relative to the parent item.

- tc_dur: Planned duration for the item.

- graphics_profile: The graphics concept context this item should be forced to play in. This
value is forwarded to graphics systems supporting concepts for graphics when cueing and
playing an item.

- graphics_category: Used in CG Take Out Logic to identify graphics that should be kept at
story item transitions. If not set, graphics_id is used for identification.

- channel: The channel to play the item, i.e. DSK, WALL etc.

- take: MANUAL or AUTO. If MANUAL then tc_in is 0 and only tc_dur is used.

- outBehaviour:

- TIMECODE = the element is taken out relative to the current primary element using
tc_dur.
BACKGROUNDEND = the element is taken out when switching primary story element.

- STORYEND = the element is taken out when switching from one story to the next.

- OPENEND = the element is taken out when reloading the rundown or by manually
taking the element out.

- auto_continue: true/false (only for Orad, to send PlayWithoutPause command).

6.6.4 Mapping Source Fields to Target Fields

The following mapping <mosmap id=”VENDOR” elementtype=”CLIP”> </mosmap> contains the
attribute descriptions:

Id: Value used in the MOS map section of the newsroomsettings.xml.
Elementtype: CLIP for video servers, GRAPHICS for graphics systems.

And <fieldmapping /> contains the attribute descriptions:
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fieldname: Viz Mosart target field name.
mospath: A simple XPath 1.0 expression to the location of the source value.
separator: Value used for joining multiple returned values for the mospath.
fieldtype:
- FIELDS - the source value is in video fields.
FRAMES - the source value is in video fields.
TIMECODE - the source value is in time code format. Use mask attribute to identify
format.
STATIC - the value for the fieldname has no mospaths and should be as defined in the
value attribute.
REPLACE
- ADJUST
value: The value to use if fieldtype is STATIC.
valuetype: TEXT, TIMECODE.
mask: Value on time code format for, i.e. hhimm:ss or hh:mm:ss:ff.
mustexist: Set to true if the Viz Mosart field should only be added if a non-empty value
exists.
regex: Regular expression used on the value. Use this to extract parts of the value from the
MOS object.
matchindex: Group index of the result from the regex.
overwrite: Overwrites if a field already exists if set to true. Default is false.

6.6.5 Examples

Video Server Item

The example below is of a Quantel video item:

Source MOS XML (Quantel MOS item)

<mos>
<itemID>3</itemID>
<itemSlug>New Row 3 CVD 1-3</itemSlug>
<objID>15160::559</0objID>
<mosID>QUANTEL</mosID>
<mosAbstract>Flug Uber die Alpen fertig2 1:00</mosAbstract>
<abstract>Flug Uber die Alpen fertig2 1:00</abstract>
<objDur>1500</objbDur>
<objTB>25</0objTB>
<objSlug>Flug Uber die Alpen fertig2</objSlug>

</mos>

& Note: The objID is constructed from two numbers where the first is the Quantel clip id. The
second number is the Quantel zone.
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Viz Mosart MOS mapping

<mosmap id = "QUANTEL" elementtype = "CLIP" idasindex = "false">
<fieldmapping fieldname = "clip_hirespath" mospath = "//objID" regex = "A\d+"/>
<fieldmapping fieldname = "clip_description" mospath = "//objSlug"/>
<fieldmapping fieldname = "clip_mark_in" fieldtype = "static" value =
"00:00:00:00" valuetype = "TIMECODE"/>
<fieldmapping fieldname = "clip_dur" fieldtype = "FIELDS" mospath = "//objDur"
valuetype = "TEXT"/>

</mosmap>
Target Viz Mosart XML
<fields>
<field name = "clip_hirespath" value = "15160"/>
<field name = "clip_description" value = "Flug Uber die Alpen fertig2 1:00"/>

<field name = "clip_mark_in" value = "00:00:00:00"/>
<field name = "clip_dur" value = "750"/>
</fields>

Graphics ltem

The example below is of an XPression graphics item:

Source MOS XML (XPression MOS item (modified and stripped to fit screen))

<mos>
<itemID>11</itemID>
<objID>{01E4E214-2414-4C71-956F-6587E3FD1E4B}</0objID>
<mosID>XPRESSION</mosID>
<mosAbstract>MAIN KEY Name (B2B): This is a test | Test</mosAbstract>
<jtemChannel>1</1itemChannel>
<jtemEdStart>0</itemEdStart>
<jtemEdDur>0</itemEdDur>
<itemTrigger>CHAINED</itemTrigger>
<macroOut>NONE</macroOut>
<mosExternalMetadata>
<mosPayload>
<gfxtype>CG</gfxtype>
<itcTimeIn>500</itcTimeIn>
<jitcTimeDur>250</itcTimeDur>
</mosPayload>
</mosExternalMetadata>
</mos>
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Viz Mosart MOS mapping

<mosmap id = "XPRESSION" elementtype = "GRAPHICS">

<fieldmapping fieldname = "graphics_id" mospath = "(//itemID | //objID)"
separator = "-" fieldtype = "REPLACE" value = "{STORYID}-{MOSPATH}"/>

<fieldmapping fieldname = "graphics_description" mospath = "//mosAbstract"/>

<fieldmapping fieldname = "tc_in" fieldtype = "FRAMES" mospath = "//itcTimeIn"
valuetype = "TEXT"/>

<fieldmapping fieldname = "tc_dur" fieldtype = "FRAMES" mospath = "//
itcTimeDur[text()!='0"']" valuetype = "TEXT"/>

<fieldmapping fieldname = "outBehaviour" mospath = "//macroOut"/>

<fieldmapping fieldname = "channel" fieldtype = "STATIC" mospath = "//
gfxtype[text()="'CG']" value = "DSK" valuetype = "TEXT" mustexist = "true"/>

<fieldmapping fieldname = "channel" fieldtype = "STATIC" mospath = "//
gfxtype[text()='0TS']" value = "WALL" valuetype = "TEXT" mustexist = "true"/>

<fieldmapping fieldname = "channel" fieldtype = "STATIC" mospath = "//
gfxtype[text()='FS']" value = "FULL" valuetype = "TEXT" mustexist = "true"/>

<fieldmapping fieldname = "channel" fieldtype = "STATIC" mospath = "//
gfxtype[text()="'OTHER']" value = "FULL" valuetype = "TEXT" mustexist = "true"/>
</mosmap>

Target Viz Mosart XML

<item>
<fields>
<field name = "graphics_id" value =
"VER7TENPS1;P_VANLAB\W\R_F3144D55-78F2-494B-863EDO60OAT4D92F7 ;D02D7434-58BB-43D6-
BO3601E7B7BBC1E7-4-{1ECA795F-101D-4301-A559-2A1392F3AA2D}" fieldtype = "TEXT"/>

<field name = "graphics_description" value = "BANNER:Chanl: | Manual |
Timed(---) :TIMED" fieldtype = "TEXT"/>
<field name = "tc_in" value = "" fieldtype = "TEXT" dinputmask = "ff" default
= "00:00"/>
<field name = "tc_dur" value = "125" fieldtype = "TEXT" {dinputmask = "ff"

default = "00:00"/>
<field name = "outBehaviour" value = "TIMED" fieldtype = "TEXT"/>
<field name "channel" value = "DSK" fieldtype = "TEXT"/>
</fields>
</item>

Harris Video Objects in Octopus

How to configure MOS mapping of a Harris video object in Octopus:
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Viz Mosart MOS mapping

<storyItem>
<itemID>2-1</itemID>
<itemSlug>0406 ZN MUNDE 5 WIN 3 PM NEW</itemSlug>
<octext_elemLabel>V0</octext_elemLabel>
<objID>0406 ZN MUNDE 5 WIN 3 PM NEW</objID>
<mosID>ZEE.HARRIS.MOS</mosID>
<itemTrigger>MANUAL</itemTrigger>
<octext_elemType>vo</octext_elemType>
</storyItem>

Update the newsroomsettings.xml file by opening it in a text editor and adding the
following XML entry in the <mosmaps /> section (as a child to the <mosmaps /> element
node)

Target Viz Mosart XML

<mosmap id="HARRIS" elementtype="CLIP" -didasindex="false">
<fieldmapping fieldname="clip_hirespath" mospath="//objID" />
<fieldmapping fieldname="clip_description" mospath="//itemSlug" />
<fieldmapping fieldname="clip_mark_in" fieldtype="static" value="00:00:00:00"
valuetype="TIMECODE" />
<l-=
<fieldmapping fieldname="clip_dur" fieldtype="FIELDS" mospath="//itemEdDur"
valuetype="TEXT" />
-—>
</mosmap>

Open the newsroomsettings.xml file in Mosart Server application using the ns command.
Open Edit -> MOS Id mapping from the menu and add an entry where the value in Newsroom
alias is the MOS ID of the Harris item, (in the above example ZEE.HARRIS.MQOS), and the Value
column is set to HARRIS (the id of the mosmap above). If the columns appendContent and
embeddedMosartltem are shown, they should both have the value false .

6.7 Manus Administrator Commands

These console commands are only intended for advanced users, and principally for
troubleshooting. They shall never be used on a live system.

© Warning: Use of these commands may adversely affect system performance. Unauthorized
use of these commands may invalidate a contracted Vizrt Support agreement.
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tmpPrint: Print the manus

pcol: Print col1

setrundown, SR, CD [name]: Set a new rundown

TESTUPDATE: Start test timer

PRINTRUNDOWNS: Print newsroom rundowns
setManusDirectory: Set the directory in which manus are stored
VERSION Prints the current version

START: Start or stop the timeline
-FILEWATCHER -FW Starts the application in file watcher Modus

R: Release background
INIFILEPATH: Set ini file

INEWSFTPSERVER [servername] [username] [pathword]: Set the ftp connection to iNEWS FTP server,
you must restart

GTS, G: Go to next story

NONEAUTOS: List none auto lower thirds

S: Skip next story

WQ: Write queue list

INEWSWORKINGDIRECTORY: Set the working directory
INEWSDEFAULTRUNDOWN: Set the default Showpath
LOG: Collect logs for all connections

SETTINGS: Show the Settings dialog
NEWSROOMSETTINGS, NS: Show Settings dialog for newsroomsettings
LOG: Write current log to file

SHOWLOG: Show logging elements

HIDELOG: Hide logging elements
PARSENATIVESTORY, PNS - Parse a native NRCS file to Mosart XML
PS [0] [0]: Print story or story item

PST: Print states

READSPEED [0]: Set read speed in words per minute
RELOADMANUS, RL, RELOAD: Reload current manus
RELOADTEMPLATES, RT: Reload channeltemplates
RESYNC: Resync rundown with NRCS

LM, LOADMANUS [filename]: Load manus from file
LISTCLIPS: List all items in media cache

TRACE: Activate/deactivate the Trace listener

SAVE [path]: Save the rundown as a file.
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STEST Y or N millisec

SS, STUDIOSETUP: Set the current studio setup

SAVEASSEQUENCE [sequencename as string]: Save the rundown as a sequence

DUMPNCSSTORY, DNS [storyname] /p[destination filepath]: Dump a story in native NSML Format

DUMPNCSRUNDOWN DNR /pl[destination filepath]: Dump the current rundown in the native NSML
Format
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7 Media Administrator

L Viz Mosart - Media Administrator 3,7.0.24523

help
MediaAdministra
[2 Outputs t

lipName | ) - Adds given clip

1

[filename ] st al i y in the cache as xml

the
pending

ingDelay, MextAdminPingDelay, NextAdminAttem

Open
Turns

The Media Administrator handles the database connection to your video servers. It is responsible
for reporting the clip status for all the video server elements in the current rundown, and for
searching the video server for clips within the Viz Mosart GUI. The Media Administrator runs as a
console application and should be kept running at all times as long as its services are required.

The Media Administrator receives the video server configuration (i.e. which servers are active) in
the following circumstances:

when the Media Administrator is started.
when the Manus Administrator is activated (i.e. from idle to active transition).
- when the Av Automation changes the current setup.

To open the Settings XML Editor, type settings in Media Administrator followed by ENTER.

A Note: The application must be restarted for any change to the settings to be applied.
This section contains the following topics:

Media Administrator Commands
Media Administrator Properties Editor

7.1 Media Administrator Commands

Media Administrator is a console application, where you can run the following commands:
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add <clipname> <index>: Adds a clip manually to the list of clips currently monitored.
Typically used to test the installation.

delete <index>: Deletes a monitored clip with the given index.

dumpclips <filename>: Outputs a list of all monitored clips in an XML format. Outputs to
console if no filename is given.

dumpprofiiler: Shows timing information. Typically used to test the installation.

exit: Exits the Media Administrator.

flushactionqueue: Flushes the internal action queue of all pending actions.

help: Outputs all available commands.

listactionqueue: Outputs the pending list of actions to be executed.

listclips: Outputs a list of all monitored clips.

listservers: Outputs a list of all configured media servers.

mmbhost <hostname>: Sets the hostname of the Manus Administrator. Default: localhost.
postroll <roll>: Sets/displays the current value of the post roll.

reconnect: Reconnects to all configured media servers. Typically only one video server is
connected.

reconnectadmin: Reconnects to the Manus Administrator.

refresh <n>: Refreshes the status for all monitored clips <n> times (by making a request io
the server for all clips). Typically used to test the installation. Default <n>= 1.

search <regex>: Issues a clip search to the video server. The regex is a regular expression
for clip names. Typically used to test the installation.
set <property>=<value>: Sets a property value. If no property is given, a list of all supported
properties is displayed. The following properties are available:
NextClipAttemptDelay: Delay in seconds when to automatically verify presence of non-
existing clips. Note that most video servers support asynchronous notifications
making this functionality not necessary.
NextServerAttemptDelay: Delay in seconds when to try to reconnect to a video server.
When the connection to a video server is not successful, this delay determines the
time to wait before a new connection attempt.
NextPingDelay: Delay in seconds when to ping the connected video servers, to detect
whether the servers are valid.
MonitorCliplnterval: Interval for monitoring clips. A clip is polled for changes as long
as any of its attributes changes.
settings: Opens the Media Administrator Properties Editor.
verbose: Toggles verbose output. In verbose mode, more information is logged to the
console.
version: Outputs Media Administrator version and some system information.

7.2 Media Administrator Properties Editor

Media Administrator is configured through the Properties XML Editor, which is opened by typing
settings in the console window.
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& Note: Once you have made any changes, you must restart the Media Administrator for
changes to apply.

C] ' -
au 4l
v Configuration
Enable dynamic configuration False
Post roll frames 5
ShouldUpgrade False
+ Connecton
Existing clip check interval 00:00:30
Maot elip duration for key frames -1
Monitoring clip interval 00:00:05
Mext zdmin attemgpt delay 00:00:05
Mext admin ping delay 00-D0-05
Fing delay 00:01:00
Server reconnect delay 00:00:30
« Connection Media search Servers
Video elip Server 1 Hame=0M: Type=0OmneonSearch; Server=10.211_114.103; Load Database=trse: Ext List = mod_MXF mov. MOV Config=Clip ServerOmneon soml
Video clip Server 1 Backup
Video clip Server 2 Mame=K2, Type=GrassValley K2, Server=10.208_13_2 1:Domain=Mosan K2; User=Admini strator; Pass =adminGV!; Suite=Mozanx Volume =V Bin=MNyhe
Video clip Server 2 Backup
Video clip Server 3 Name=ASMS: Type=AirSpeedMultiStream Search Config={lip ServerMulti Siream oml . Serverslocalhost JoadDat sbase=inue

Wideo clip Server 3 Backup
Video clip Server 4
Vigeo clip Server 4 Backup
Video chp Server 5
Video clip Server 5 Backup
Video clip Server &
Video clip Server 6 Backup

~ Logging
Ignore verbose events filter
Log exist True
Pass verbose events filter
Uza logging Tirue
Use verbose logging True
Manus admin connection
Host localhost
Part 8035
Media router
Configuration filename MediaRout erConfigVideo xml
Server index name
Use False
Manusz admin conneciion

7.2.1 Configuration

Enable dynamic configuration: If False ( default), Media Administrator connects to all servers
configured. (See Connection Media Search Servers, Video clip Server <n> below.) However, if
this setting is True, it connects only to
those servers that are part of the salvo selected in AV Automation (See Video Servers,
Virtual Server Ports, Switch between salvos), and
those servers which have Static=True in the connection string. (See Connection Media
Search Servers, Video clip Server <n> below.)
Post roll frames: Subtracts value from the actual clip length when sending clip info back to
the Manus Administrator. Default: 75 (frames).

ShouldUpgrade: For internal use only, should be set to False. Default: False.
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7.2.2 Connection

Existing clip check interval: Delay in seconds when to automatically verify the presence of
non-existing clips. Note that most video servers support asynchronous notifications, making
this functionality unnecessary. Default: 00:00:30 .

Max clip duration for key frames: Disables showing keyframe markers for video files greater
than this value in frames. Default: -1 .

Monitoring clip interval: Default interval for monitoring clips. A clip is polled for changes as
long as any of its attributes changes. Default: 00:00:05 .

Next admin attempt delay: Interval for retrying reconnecting to the Manus

Administrator. Default: 00:00:05 (hh:mm:ss).

Next admin ping delay: Interval for sending heartbeat to the Manus Administrator. Default:
00:00:05 (hh:mm:ss).

Ping delay: Interval between command requests (heartbeats) that Media Administrator sends
to the video server. Pinging is used to detect whether the connected video servers are valid.
Default: 00:01:00.

For some video servers, ping can be disabled using the DisableHeartbeat property inside the
connection string. See, for example, Configuration File Properties - VDCP >
DisableHeartbeat.

Server reconnect delay: Delay in seconds when to try to reconnect to a video server. For
example, if connecting to a video server is unsuccessful, this delay determines the time to
wait before a new connection attempt is made. Default: 00:00:30.

7.2.3 Connection Media Search Servers

Video clip Server <n>: Connection string to media server (video server or MAM system) <n>.
A maximum of six media servers may be connected. In most cases only one server
connection is necessary.
These connection strings all share a common format of a semicolon-separated list of pairs
Property=Value. Although the selection of properties and values may vary according to the
type of media server, some properties are common to all. For example:

Name.

Any connection string may have the property (and value) Static=True.

For details, see Video Server, MAM and Database Connection Strings.

Viz Mosart in general requires two connections to each video server, one from Media
Administrator (as defined here) and one from AV Automation (see Video Servers, section Working
with Video Server Configuration). AV Automation also has a Name property, and the two
connections to the same server should have the same, unique Name, This name cannot be used
for any other connection.

By default, Media Administrator connects to all servers defined here.

However, if the setting Enable dynamic configuration is True, it connects only to

those servers (identified by the Name property) that are part of the salvo selected in AV
Automation (see Video Servers, Virtual Server Ports, Switch between salvos), and
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those servers which have Static=True in the connection string.

A Note: When MediaAdmin searches through all servers for information on a media clip, the
search sequence starts with the last (highest numbered) server configured. This may
impact the result of the media search if the media clip is present on more than one of the
servers, and some property of the clip is not identical on these servers. In this case, the
property is set from the last server checked (the lowest numbered server configured) from
where the clip was available.

- Video clip Server <n> Backup: Deprecated.

7.2.4 Logging

Ignore verbose events filter: Semicolon based list of events to ignore when using verbose
logging. Default: <none> .

Log exist: Verifies the presence of the Viz Mosart Log Service at startup. Default: True .

Pass verbose events filter: Semicolon based list of events to log when using verbose logging.

Default: <none> .
Use logging: Passes all logging to the Log Service if true. Default: True.
Use verbose logging: Enables verbose logging if true. Default: False.

7.2.5 Manus Admin Connection

Host: Sets the hostname or IP address of the computer running the Manus Administrator
application. In a typical configuration, the Manus Administrator runs on the same computer
(i.e. the default value is normally sufficient). This value is also possible to set using the
mmbhost command. Default: localhost.

Port: Determines TCP/IP (.NET Remoting) port to establish the connection to the Manus

Administrator application. Default: 8085 .

7.2.6 Media Router

Configuration filename: Determines the configuration file to use for Media Router. Default:

MediaRouterConfigVideo.xml.
Server index name: Deprecated.
Use: Uses the Media Router if true. Default: False.
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8 Overlay Graphics

The Overlay Graphics interface provides control and monitoring of overlay graphics for all Viz
Mosart-approved graphic engines.

For a list of supported graphics devices, see Overlay Graphics Types.
Configuration is done in the Overlay Graphics Configuration menu.

Start Overlay Graphics by double-clicking the application icon:

N

or by navigating to the installation directory (by default C:\Program Files
(x86)\Mosart Medialab\Mosart Server ) executable MMOverlLayGraphicsInterface.exe.

& The Overlay Graphics Interface (and application icon) is only available if Overlay Graphics
was selected when installing the Viz Mosart Server.
The Overlay Graphics interface is only used for overlay graphics. Full-frame graphics are
controlled through the AV Automation application.

A menu bar at the top offers Settings, Graphics profile, Tools and Standby.

sark - |._|'r'|..‘='|-:'1‘;'|_'|F-:]'|_Ih'll'.h.

033629/ 2 |1 | B |

09.36:44.32 | OUT | A |DSK _|L3Defaut/Auto+/AutoDut/Mosait=LID0:02(0...
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The Overlay Graphics interface consists of four main areas ([1] to [4] in the illustration).

A status bar at the foot of the Ul provides information on product version number and the total
number of graphics in Viz Mosart (rundown overlays + named overlays + button overlays. 7 in the
example above).

The main column labels are:

- Time: The time when the graphic was added in Overlay Graphics (usually at rundown
import).

- #U: The number of times this graphic has been updated.

- #T: The number of times this graphic has been taken.

- Type: The graphic type. Can be:
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Description

Auto Out (a Manual CG can also be Auto Out)
Background End

Story End

Manual (Open End)

Last Out

Stay Always

if template is STORYSTART

None of the above

If the graphic is a locator, then the type is suffixed with an "L".

A Note: Locator is a special graphics item that is linked to a video server crosspoint. When
taking the crosspoint from a Viz Mosart template, either as a switcher crosspoint or keyed
crosspoint (in a DVE box), the graphics are also (re-)taken.

[1b] Details of a Selected Graphic from the List of Overlay Graphics

Selecting an overlay graphic from the list displays further details:

L3 Default/Auto+/AutoDut/Mosart=LI00:02100:10 I DSK

Test CGs

I TIMECODE

100_SHO'W.MOSART TEST_18DABF7D_2 2

Take Take out Clear

i

Build 3.7.0.23732 151116 | 7 |
Explanation of Details

Element

[L3Defauit/Autor/AutoDut/Mosart=LI00.02100:10

DSH
TIHEEDDEi

Description

Graphic title

Handler name (the destination or the channel for this graphic)

Graphic description
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Element Description

[100_SHOWMOSART TEST_18DABF7D_2_2 Graphic ID

& This is the Viz Mosart Graphic ID, not the graphic ID from
graphic database (Graphic Hub/Oracle)

Toke | Tokeo | Oea o | Action Buttons

Take: Takes graphic on air
Take out: Takes graphic off air
Clear: Takes out all taken graphics

Info: Opens an editor window where the graphic MOS item can be
changed and updated

8.2 [2] Server Status

Viz Mosart server and configured graphic engines statuses are displayed (Green: OK, Red: Failure)

in the panel at the top riﬁht:

Time Action  Type Handler | fem

13275756  IN 5 DSK In:00:00/HEADLINE OPENER/Mail bombs ... / 19.08.2019 16:10:23

19.9T7.CTTIC AT o now T LA A T AT IR S IITRIT Y Ao d AN A0 AN ArAnnn

8.3 [3] General Log

The center right contains a log of all actions performed on the overlay graphics either triggered by
Viz Mosart or by clicking Overlay Graphics buttons.

To clear this area, double-click inside it.

8.4 [4] Event Log

The bottom right contains an event log with messages, warnings and errors from the Overlay
Graphics application.

To clear this area, double-click inside it.
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8.5 System Information

The information line at the bottom displays application version, number of graphics in the table
and whether the Mosart Media Router (MMR) is in use:

8.6 Menu Bar

B Vir Masant - OverlayGraphics = — O *

Settings
Properties: Opens Overlay Graphics Configuration.

Graphics Profile: Select the required graphics profile.
See Graphics Profiles Tab.

Tools
When things don't go as expected, there is a debugging option.

Editor: Opens a Test graphics window.

Test graphics ﬂ
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Instrumentation Panel: Displays all device commands in real time, as sent to the various connected

devices.
See Mosart Instrumentation Panel.

Standby: Toggles the graphics engines in or out of standby.

Take any controller into standby. All the engines linked to the controller are set /unset to
standby. The same action can also be performed from the Viz Mosart Ul.

Take any engine individually into standby (only in OGIl) while the other engines in the same
controller are active.

8.7 Overlay Graphics Configuration

8.7.1 Overlay Graphics Configuration Window

The Overlay Graphics Configuration (OGC) window provides options for the Overlay Graphics
interface.

Overlay Graphics Configuration Window
Controllers, Engines and Destinations
Configuration Panels
Panel 1 - Graphics Configuration
Panel 2 - Mosart Graphics Destinations
Panel 3 - Property Tabs

In the Overlay Graphics application, select Settings > Properties to open.

Copyright © 2022 Vizrt Page 126



Viz Mosart Administrator Guide - 5.0

Select (double-click) an object (here: the controller named HEGO).
The form displays more information.

‘& Viz Mosart - Overlay Graphics Configuration - ] X ‘

Graphics configuration Mosart graphics destinations

Gi iic handler
T e
Delay (frames) o FULL (n/a) Name DSK
Distribute status O B Link
] Description WALL_2 (n/a) Handler 1:CGA
[ Replace takeout logic
Delay (frames) 0 WALL_5 (n/a)
Enable O
WALL1 (n/a)
BRANDING (n/a)
[ TICKER (n/a)
Brand and type of graphics

Grephica Profies  Actins MMR General Obsolete Corfig
Display Hame ShowPath Defaut scene on wal

" Defaut
o
0

Controllers, Engines and Destinations

Controller

A controller defines the type of the graphics system that is to be used. For each controller,
both common and specific properties can be configured as described below.

As a rule, connection settings for the graphics system are not defined at Controller level.
However, for some graphic handlers, connection definitions to auxiliary components must
be provided (for example, when connecting to the Media Sequencer for Vizrt graphics
systems).

Engine

Engine 2 [2(2)]

For each controller, one or more engines can be added. An engine defines the connection to
the graphics system.

Destination

The destination defines the output channels where you play out the graphics.
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8.7.2 Configuration Panels

For explanation, each panel is presented in this style:

& VizMosar - Oversy Graphics Configurstion

1A

Graphics configuration

1B

- o X

Mosart graphics destinations

2A | 2B

3

Panel 1 - Graphics Configuration

Panel TA

Mew controller

Mew enging

New controller: Select to add.
New engine: Select to add.

When a controller has been clicked:

HEGO
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Hego properties
El Active signal
Delay (frames) 0
Distribute status
El Description
Hego Id 1
Mame HEGO
E Replace takeout logic
Delay (frames) 0

Enable

Hego example

- Active signal
Delay (frames): Displays an integer value indicating number of frames to be
delayed. Default: © .
Distribute status: Displays a checkbox indicating whether the selected controller is set
to distribute status. Default: Unchecked.

Description
Graphic Type: Displays the selected controller type from a dropdown list of possible
controllers.

Hego Id: Displays an integer value indicating the selected controller's ID number.
Name: Displays the written name of the selected controller.

Replace takeout logic

Delay (frames): Displays an integer indicating a number of frames to be delayed. Default: 0

Enable: Displays a checkbox indicating whether the Replace takeout logic has been enabled.
Default: Unchecked.

When an engine has been clicked:

1[CGA(T)]
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Hego engine
EI Behaviour
Always Take In
Continue Scene
E Configuration
Channel 0
Encoding
Host localhost
Port 10003
=l Description
MName 1
El Handler
Handler Id 1
Name CGA

Hego engine example

Behavior
Always Take In: Whether the selected engine is set to always taking in .
Default: Unchecked.
Continue Scene: Whether the selected engine is set to continue the scene.
Default: Unchecked.
Configuration
Channel: Shows the integer number for the channel. Default: o .
Encoding:
Host: Displays the host identification name. Default: localhost.
Port: Displays an integer value for the selected engine's port number. Default: 10003

Description

Name: Displays an integer value for the selected engine's ID number. Default: 1 .
Handler

Handler Id: Displays an integer value for the selected engine's ID number. Default: 1

Name: Displays the name of the engine handler.
Bottom of Panel (information)
Further details about the active property

Graphic Type
Brand and type of graphics
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Panel 1B

- This section contains a list of controllers:

HEGO

VIZRT M5E

- A sub-list of any engines for each controller:

HEGO

T[CGA(T)]
P VIZRT MSE

Engine 2 [2(2)]

Panel 2 - Mosart Graphics Destinations

Panel 2A

- A list of destinations:

WALL (n/a)

WALL_2 (n/a)

- The activated destination is orange.

Multiple engines can be assigned to:
- The same destination (Mirrored Graphics Playout), where you use identical graphics
concepts.
Different destinations with different names, where you use separate concepts for each
output.
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Different destinations with the same name, for example, playing out the same
graphics on multiple parallel outputs, either in a virtual set configuration or in a multi-
branding setup.

Panel 2B

MNew destination

New destination: Select to add.

Graphic handler
B Description ...
Mame DSK
B Link
Handler

Graphic handler

Description: Displays the selected, named destination.

Link: Displays a concatenation of the Handler Id and the Handler Name separated by a semi-
colon. This information indicates the graphics handler linked to this specific destination.
Bottom of Panel (information)

Handler
The graphic handler that is linked with this
destination

Further details about the active property

Panel 3 - Property Tabs

Graphics Profiles

Only available when the selected item is a controller.

Graphics Prfiles  Actions MMR  General Obsolete Corfig

Display Name ShowPath WCP concept Default scene on wall Default
» Mosart/Cverays/Green Green
Yellow Mosart/Ovedays,/ Yellow1 Yellow O
O

& tis mandatory to have an exclusive (non-null) value for ShowPath configured!
Display Name

ShowPath:
Default scene on wall:

Copyright © 2022 Vizrt Page 132



Viz Mosart Administrator Guide - 5.0

Default: Indicates whether the entry may be set as default.
Default: Unchecked

Actions
Only available when the selected item is an engine.
Event:
Action:
Value:
MMR
(Graphics Profiles  Actions MMR  General Cbeclete Config
[ Use Media Router Engine Destination Map
Engre 1 [#] |DSK Engine 5 []
Engne 2 [] [waLL Engine & [
Engne 3 [] - Engine 7 [
Engne 4 [] Engine 8 [

Use Media Router: Default: Unchecked.
See the Viz Mosart Media Router Guide.

Engine Destination Map
Engine 1 [to 8]: Displays a drop-down list of optional destinations to be linked to this

engine. Check the box to set the destination. Default: Unchecked.

General

Graphics Profiles  Actions MMR  General  Obwolete Config

Logging Mosart server

[ Vesbose Hostname  |localhost

[ Trace

G Control Graphics Mimonng Connectrvity

[ show local ids [] Enaiie Conmected when in standby

[] Connected when idle

Logging
Verbose: If checked, verbose actions are logged. Default: Unchecked.

Trace: If checked, trace actions are logged. Default: Checked.

GUI Control
Show local id's: If checked, local IDs are displayed. Default: Unchecked.

Mosart server
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Hostname: Shows the Mosart Server host name. Default: localhost.

Graphics Mirroring

Enable: If checked, graphics mirroring is enabled. Default: Unchecked.

Connectivity

Connected when in standby: If checked, Mosart Server remains connected in standby
mode.

Default: Unchecked.

Connected when idle: If checked, Graphics devices will remain connected in idle (when
switching from main to backup, for example).

Default: Unchecked.

Obsolete Config

© Overwrite Alert: Clicking the red CONVERT button in the Obsolete Config tab overwrites
your existing configuration. Make sure you understand the consequences before clicking
CONVERT.

Type:

Engne 1 []
Engne 2 []
Engne 3 []

Engne 4 []

Handler name Host Port Default Scene Destination Preview engine

OGA

Graphics Profiles  Actions  MMR  General Obsolete Corfig

HEGOD

A Ol static configuration
- Press the CONVERT button
ocahost 10003 DSK 1 v to convert the cument
configuration to the new

This action wil oversrite any

configuration in the new
soetup

-

Type: Displays available controller types.
Engine

Engine activation: Activates the engine by checking the checkbox.
Handler name: Sets the name of the engine handler.

Host: Sets the name of the host.

Port: Sets the port number.

Default Scene: Sets the default scene.

Destination: Sets the destination by selecting one from the dropdown list.
Preview engine: Sets the order of the preview engines.

Old static configuration: This part of the form is considered obsolete.

(@ Obsolete Configuration Notification: The red CONVERT button in the Obsolete Config tab is
only intended for use by those who have been working with the old configuration and want
to convert the old configuration and replace it with the current configuration.
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8.7.3 Managing Overlay Graphics Controllers and Engines

Overlay Graphics Controllers and Engines

- Working with Controllers

- Working with Engines
Common Graphic Controller Properties
Common Graphic Engine Properties

Working with Controllers

To Add A New Controller

1. Open the Overlay Graphics Configuration window by going to Settings > Properties.
2. Click New controller.

0] Viz Mosart - Overlay (

Graphics configuration

New mnhollerD\L MNew engine m

Graphic Controller Properties

B Active signal
Delay [frames) 0
Distribute status ]
E Description
Graphic Type *
Id 0
Mame new

E Replace takeout logic
Delay (frames) 0
Enable L]
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3. In the Graphic Type drop-down, select the type of graphics system you are using (see

Overlay Graphics Types).

MNew controller Mew engine

Graphic Controller Properties

B Active signal
Delay (frames)
Distribute status

El Description
Graphic Type
Id
Mame

E Replace takeout logic
Delay (frames)

Enable

0
L]
BIGVIZ [:
CASPAR
CHYRON
DEKO
HEGO
CRAD
PIXEL POWER CC
VIZRT
KPRESSIOMN

HEGO

4. Set additional controller properties according to the selected Graphic Type.
5. Optionally, add graphics profiles via the Graphics Profiles Tab. Only applicable for some

graphics systems.

6. To add engines to the controller, see To Add a New Engine below.

To Remove A Controller

1. Open the Overlay Graphics Configuration window by navigating to Settings > Properties.

2. From the list of controllers, select the black box of the controller you want to remove.
iraphics contiguration

Mew engine
.......... Remove
Add Engine
=

El

3. Right-click and select Remove.
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Working with Engines

To Add A New Engine

1. Open the Overlay Graphics Configuration window by navigating to Settings > Properties.
2. From the list of controllers, select the black box of the Controller you want to use.
3. Click New engine, or right-click the controller and select Add engine.

Graphics configuration

MNew controller Mew engine VIZRT MSE

Graphic Controller Properties Remove

B Active signal | Add Engine N |
Delay (framesz) 0 ;
Distribute status ]

1 Mazrrintinn
4. Set the engine properties according to the selected graphic type (See Overlay Graphics
Types).
5. Optionally, set actions for selected system events using the Actions Tab (Event and Action
Rules).

To Remove An Engine

1. Open the Overlay Graphics Configuration window by navigating to Settings > Properties.
2. From the list of engines, select the black box of the engine you want to remove.
3. Right-click and select Remove.

Common Graphic Controller Properties

The Graphic Controller properties that are available depend on the graphic type of the controller.
The controller properties common to most graphics types are described below.

& Note: Additional properties specific to each graphic type are described in section Overlay
Graphics Types.

- Active signal: The active status signal is sent to AV Automation containing on air status of a
graphics engine.

- Distribute status: When set to true, reports the on air/usage status of an engine to AV
Automation. This status message is sent to the AV Automation log area, the Manus
Administrator console and the Overlay Graphics log area.

Delay (frames): Sets the delay of the graphics active status changed event signal.
Using a negative value for the delay disables the functionality (Distribute status is
false).
Upon receiving the signal, AV Automation performs the following actions:
Sets the DSK if this is enabled (Control DSK from Overlaylnterface is checked on
the Switcher preferences page and the switcher can set DSK).
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Executes direct take templates configured on the Switcher preferences page in
Overlay DirectTake control (see section Vision Mixer).
Cuing the graphics in certain conditions (the rundown story item is in preview,
the channel template used has a graphics device setup, the engine is not in use,
the channel is not on air).
Description
Graphic Type: Selects the brand and type of graphics.
Id: Identifies the graphics controller (unique number ID ). Shall be unique among all
defined controllers.
Name: Defines the name of the server (optional).
Replace takeout logic: Reads out the transition logic context of elements to either suppress
take out or re-take items. Take outs are suppressed if another item with the same context
was taken before the scheduled for take out action. Take outs are replaced with re-takes if
the item scheduled for take out replaced an item with the same context. Only for Vizrt
graphics with transition logic.
Delay (frames): Delay when checking for duplicate ‘take in’ commands in the next
element.
Enable: Use transition logic aware take in/out commands.

& Note: See also Graphics Profiles Tab for other controller settings.

Common Graphic Engine Properties

MNew controller New engine ) m

GraphicEngineProperties ]
Engine 1 [1(1)]

E Behaviour

Always Take In ]

Continue Scene ]
B Configuration

Channel 0

Enceding

Haost

Port ]
Bl Description

Mame Engine 1
Bl Handler

Handler Id 1

Mame 1

The Graphic Engine Properties that are available depend on the graphic type of the controller. The
engine properties common to most graphics types are described below.

The additional properties for each Graphic Type are described in Overlay Graphics Types.
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Behavior
- Always Take In: Turns off the logic that does not take in a graphic element that is
already taken and no other graphic element has been taken since.
- Continue Scene: Use continue for take out of scene based graphics.
- Configuration
- Channel: Defines the output channel from the graphics system. Set to © when not
used for takes.
Encoding: Encoding to use on text. UTF-8 or UTF-16. Default: UTF-8.
Host: Defines the hostname or IP address of the graphics engine. See also descriptions
for the various graphics types.
Port: Defines the TCP port to use when connecting to the graphics system.
Description
Name: The name of the engine.
Handler: ID and name of the handler. Note that if handler ID is changed and the engine is
assigned to a destination, then the link must be removed and engine re-assigned.
Handler Id: Auto-generated ID.
Name: The name of the handle (auto-generated).

& Note: See also Actions Tab (Event and Action Rules) for other engine settings.

8.7.4 Overlay Graphics Types

Each graphic provider is stored as a Graphics Type. Several Graphics Types are currently
supported. These include:

- VIZRT
CHYRON
DEKO
ORAD
PIXEL POWER CC
- XPRESSION
BIGVIZ

All operations are managed from the Overlay Graphics Configuration menu.

- Open the Overlay Graphics Configuration menu by opening the console application Viz
Mosart Overlay Graphics Interface > Settings > Properties.

VIZRT
Graphic Type = Vizrt (Vizrt via Media Sequencer [shortname: MSE])
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Vizrt properties Vizrt engine
E Active signal E Configuration
Delay (frames) 0 Channel 0
Distribute status ] Enceding
E Description Host
Graphic Type VIZRT ~ Port 0
Id 0 Preview Engine
Mame VIZRT M5E | |E Description
E Media Sequencer Name Engine 2
Apply channel name to ne.. B Handler
Host Handler Id 2
Part 5504 Mame 2
E Media Sequencer Backup
Host
Mame Backup
Part 8504
E Playlist
MOS playlist
Use concept override ]
E Replace takeout logic
Delay (frames) ]
Enable ]

Vizrt properties: Properties in addition to Common Graphic Controller Properties:
Media Sequencer
Apply channel name to new elements: Assigns a channel name automatically to
new graphics elements.
Host: Hostname or IP address to the Media Sequencer.
Port: IP-port to the Media Sequencer. Normally 8594 (Media Sequencer TreeTalk
protocol) or 8580 (REST protocol).

Media Sequencer Backup: For an optional backup MSE. Same properties as for Media
Sequencer. Note that the Apply channel name to new elements property is common to
both main and backup Media Sequencers.
Playlist
MOS playlist: Name of playlist in MSE where graphics elements are stored.
Use concept override:If concept override is enabled, the currently selected
graphics concept will override any concept defined within the graphics element.
Use the Graphics Profile tab to define the various graphics concepts.
Vizrt engine
Configuration
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Host: Hostname or IP address of the Vizrt Engine. The input can be specified as
just a Hosthame, just an IP Address, or a combination of Hostname:Port or
IPAddress:Port. If no port value has been specified as part of the Host field, the
port from the Port field will be used. However, if no port value has been
specified in either of the Host or Port fields, the default port value will be:

6100 .

& NOTE: If a port value is specified in the Host field, this value will
override whatever port value has been specified within the Port field.

Port: TCP/IP port of the Viz Engine.

CHYRON
Graphic Type = Chyron (Chyron Lyric)
Chyron properties Chyron engine
E Active signal E Behaviour
Delay (frames) 0 Always Take In ]
Distribute status ] Continue Scene ]
E Description E Configuration
Graphic Type CHYROM - Channel 0
Id 0 Enceding
Marme CHYROM LYRIC Host
= Replace takeout logic Port 0
Delay (frames) 0 E Description
Enable ] Mame Engine 25
E Handler
Handler Id 23
Marme 25

Chyron properties: The properties are the same as described in Common Graphic Controller
Properties.

Chyron engine: The properties are the same as described in Common Graphic Engine
Properties.

DEKO
Graphic Type = Deko
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Deko properties Deko engine
E Active signal E Behaviour
Delay (frames) 0 Always Take In ]
Distribute status ] Continue Scene ]
E Description E Configuration
Graphic Type DEKOD  ~ Channel 0
Id ] Encoding
Mame DEKO E Connection
E Replace takeout logic COM port
Delay (frames) 0 Machine ID 0
Enable ] E Description
Mame Engine 19
E Handler
Handler Id 19
Mame 19

Deko properties: The properties are the same as described in Common Graphic Controller
Properties.
Deko engine: Contains the following properties in addition to Common Graphic Engine
Properties:
Connection:
COM port: Defines the serial port connected to the Deko engine.
Machine ID: Digit 0-9. May be used for multi-drop. Multi-drop lets you specify
different fields or layers (TypeDeko) when more than one TypeDeko is

connected to the Deko host. Set equal to 1 if there is only one.

& Note: For using a default take out scene in Deko, the setting <item name="ClearScene"
value=""/>needs to be added to the IntelligentinterfaceConfiguration.xml file instead of
the clear command. The value should be set to any scene that should be used for take
out.

ORAD
Graphic Type = Orad (Orad Maestro)
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Orad properties
E Active signal
Delay (frames)
Distribute status
E Description
Graphic Type
Id

Mame

E Replace takeout logic

Delay (frames)

Enable

Orad engine

B Behaviour

0 Always Take In
] Continue Scene
E Configuration
CRAD - Channel
0 Enceding
ORAD MAESTRO Host
Port
0 &l Description
] Mame
E Handler
Handler Id
Mame
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[]
L]

Engine 24

24
24

Orad properties: The properties are the same as described in Common Graphic Controller

Properties.

Orad engine: The properties are the same as described in Common Graphic Engine

Properties.

PIXEL POWER CC

Graphic Type = Pixel Power CC (Pixel Power Control Center)

Pixel Power Control Center properties

E Active signal
Delay (frames)
Distribute status

E Description
Graphic Type
Id

Mame

E Replace takeout logic

Delay (frames)

Enable

PixelPower CC engine

B Behaviour

0 Always Take In
] Continue Scene
E Configuration
PIXEL POWER CC ~ Channels
0 Encoding
PIXEL POWER CC Host
Port
0 El Description
] Mame
= Handler
Handler Id
MName

[]
L]

Engine 23

23
23

Pixel Power Control Center properties: The properties are mostly the same as described in
Common Graphic Controller Properties.
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Pixel Power CC engine: The properties are the same as described in Common Graphic Engine
Properties.
Configuration
Channels: Specifies the Pixel Power channels associated with the Pixel Power
engine. Specify as a comma-separated list of integers.

XPRESSION
Graphic Type = Xpression (Ross Xpression)
XPression properties XPression engine
B Active signal & Behaviour
Delay (frames) 0 Always Take In ]
Distribute status ] Continue Scene ]
& Description E Configuration
Graphic Type APRESSION ~ Channel 0
Id 1 Enceding
Mame ROSS XPRESSIOR Host
= Replace takeout logic Port 0
Delay (frames) 0 E Description
Enable [l Mame Engine 22
& Handler
Handler Id 22
Mame 22

XPression properties: The properties are the same as described in Common Graphic
Controller Properties.

XPression engine: The properties are the same as described in Common Graphic Engine
Properties.

BIGVIZ

Graphic Type BigViz is a BBC developed system that integrates with ENPS, Vizrt graphics, IBIS
Playout, and Autoscript.
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BigViz properties BigViz engine
E Active signal E Behaviour
Delay (frames) 0 Always Take In ]
Distribute status ] Continue Scene ]
E Connection E Configuration
Encoding UTF-8 Channel 0
Host Client 1D
Port 0 Encoding
E Connection Backup Host
Host Part 0
Mame E Description
Part 0 Mame Engine 18
E Description E Handler
Graphic Type BIGVIZ ~ Handler Id 18
Id ] Mame 18
Marne BIGVIZ
E Replace takeout logic
Delay [frames) 0
Enable ]

BigViz properties: Controller connection properties are not used. All connectivity to BigViz is
configured as part of the Engine configuration.
BigViz engine: The following properties are used only (all other properties related to Viz
Graphics configuration are not used by BigViz):
Host: Hostname or IP address of BigViz service.
Port: TCP/IP port of remote BigViz service. Default port is 8165 .
Client ID: Identifies the Mosart server. Must match the corresponding BigViz
configuration. Default: mosart.

8.7.5 Overlay Graphics Configuration Property Tabs

Graphics Profiles |Fu::tiu::ns | MME I General I Obsolete Corfig |

Please select a controller to edit Graphics profile data

The tabs functions are:
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Working with Overlay Graphics Configurations

- To Change a Graphics Profile

- To set up event-action rules

- To configure the Mosart Media Router

- To configure general settings

- To convert an incompatible overlay graphics configuration

Graphics Profiles Tab

The selection of graphics profile affects the look of all graphics used for the specific show. Viz
Mosart handles which concept the graphics devices use (on Vizrt graphics systems this technique
is called concept override, on other graphics systems Viz Mosart uses its own concept override
technique).

To Change A Graphics Profile

1.
2.

3.

Navigate to Settings > Properties > Graphics Profiles tab.

Select the controller (black) that you want to configure.

The Graphics Profiles list changes dynamically, depending on which controller is selected.
When the graphics profile is changed in the Overlay Graphics Interface (or the Viz Mosart
GUI), all the controllers are scanned.

If a controller has the selected graphics profile, the show path, VCP concept (Viz only) and
default scene for wall values, are all changed.

Remember to restart the Overlay Graphics Interface application for any changes to take
effect.

Graphics configuration Mosart graphic

New controller | | New engine ]

DSK (1:Engine1,2:Eng

Vizrt properties
____________________________________ | } [Engine1(
B Active signal i [Enginel(1)) {S:Engine J)
Delay (frames) 0 2 [Engine2(2)] FULL (n/a)
Distribute status J £ * 4 m

mluun | Obsotete Config|

Displary Name ', ShowPath VCP concept  Default scene on wal Defaul
BBC24 EBC24 London L
BBC WORLD EECWORLD | World ]

BBC FOOD BECFOOD Kitchen

Display Name: Name of the Graphics Profile that is displayed to the user. The Graphics
Profiles are displayed as menu options both in the Mosart GUI and in Overlay Graphics.

- ShowPath: Path to the files the graphics engine uses. Absolute path where graphics are

located within the graphics engines. Dependent upon graphics type.
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VCP concept: Name of the Viz Pilot concept that should be used when working with the
selected profile (Vizrt only).

Default scene on wall Scene name to use as default for wall graphics. Dependent upon
Graphics Type.

Default: Selects the graphics profile to use as default. The default graphics profile is used
initially before any profile is set from the user.

Click on the Graphics Profile tab to switch between profiles. The default profile is displayed in
bold, and the active profile is marked with a check mark, and is displayed in parenthesis on the
menu itself.

iaraphics profile (BEC24)

BBC24

BBC WORLD
BEC FOOD

Actions Tab

Configurations on this tab control Event and Action rules.

To Set Up Event-Action Rules

1. Navigate to Settings > Properties > Actions tab.
In the Actions tab, any number of event-action rules can be set up.

Graphics Profiles | Actions | MMR | General | Obsolete Corfig

Event Action Value

3 Becomeldle v | Macro W

BecomeActive

Macro L

" Clear k LY
Mirmorfctive
Mirorinactive
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2. Select the engine that you want to configure these actions on.
The rules list changes dynamically depending on which engine is selected.

Graphics configuration \f

New controller | | New engine | 'l VIZRT D DSK (1:Engine

r

Vizrt engine
. _ 1 [Engine1(1)] WALL (3:Engine
Use Transition Legic... [ )

B Configuration 2 [Engine2(2)] FULL (n/a)
Commrlim— | N . | it

o —
Graphics Profildg | Actions | MR | Gpeferal | Obsolete Config |

Event x Action Walue
[Eecumeﬂ.cti\re - [Mac:m - | E1
[Eiecnmeldle - [Mac:m - | E2

7 |Cear = | TakeNamed... |~ |LOGO OFF
* [ - [ -

3. Set required event-action rule by selecting parameters.
You must define three parameters to set up an event-action rule:

Event: Specifies the event that will trigger an action. The following events are available:
BecomeActive: Triggers an Action whenever the Overlay Graphics Interface state
changes from Idle to Active.

Becomeldle: Triggers an Action whenever the Overlay Graphics Interface state changes
from Active to Idle.
Clear: Triggers and Action whenever a Clear event is received to clear all overlay
graphics. A clear event is typically received when a rundown is reloaded or deleted.
MirrorActive: Triggers an Action when the mirroring graphics engine becomes active
(for mirroring). Can only be used only when using Mirrored Graphics Playout.
MirrorinActive: Triggers an Action when the mirroring graphics engine becomes
inactive (for mirroring). Can only be used only when using Mirrored Graphics Playout.
- Action: Specifies which action to trigger for the given event. Two actions are available:
Macro: Invokes a macro on the given engine. The macro to take is specified in the
Value parameter.
- TakeNamedOverlay: Invokes a named (or constant) CG on the given engine. The
named CG to take is specified in the Value parameter.
- Value: Optional value depending on selected Action. As shown above, there may be multiple
event-action rules for a controller, for example:
- Add a new event-action rule by setting values in the row at the bottom, marked with a
star ‘*’.
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Selecting the corresponding row is done by clicking in the column left of the

Event column.

Delete existing event-action rules by selecting the corresponding row, and then press
DELETE on the keyboard.

MMR Tab

Configurations on this tab affect behavior of the Mosart Media Router.

To Configure The Mosart Media Router

Navigate to Settings > Properties > MMR tab.
Graphics Profiles | Actions | MMR | General | Obsolete Config

Use Media Router Engine Destination Map

Engine 1 DsSK W Engine & ] W
Engine 2 WALL Engine & [ | W
Engine 3 [] W Engine 7 [] W
Engine 4 || W Engine & [] W

Explanation of configurable fields

Use Media Router: To use the Media Router (MMR), this must be enabled (checked). The use
of Media Router by Overlay Graphics Interface must also be enabled in General > Media
Router.

Engine Destination Map: Maps between Engine number and graphics destination. The Engine
number is part of the Media Router configuration and is given as a DeviceName property.
For more information see the Viz Mosart Media Router Guide. Use the check boxes to select
a maximum of eight engines. In the example above the MMR configuration specifies two
overlay graphics engines with numbers 7 and 2 respectively.

General Tab

On this tab are several configurations that affect Viz Mosart Overlay Graphics operation and
behavior.
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To Configure General Settings

Navigate to Settings > Properties > General tab.
Graphics Profiles  Actions MMR General  Obsolete Corfig

Logging Mosart server

Verbose Hostname  |localhost

[ Trace

GUI Cartrol Graphics Mimraring Connectivity

[ Show local id's [] Enable Connected when in standby

Connected when idle

Explanation of configurable fields

Logging
Verbose: Increases the detail level of information sent to the Viz Mosart log if enabled.
Trace: Activates internal tracing (more details are sent to the debug view) if enabled.
Used for debugging purposes only.
GUI Control
Show local id’s: Enables display of graphics ID in the OverlayGraphics GUI. Shown in
dedicated columns in both repository and log tables.
Mosart server
Hostname: Defines the hostname or IP number of the Manus Administrator. Default:
localhost.
Graphics mirroring
Enable: Allows simultaneous control of two different graphics engines driven in
mirroring by Viz Mosart. When enabled, both engines will receive “take” commands at
the same time. For more details, see Mirrored Graphics Playout
Connectivity
Connected when in standby: Maintains connection to graphics devices when in
standby or idle modes if enabled.
Connected when idle: Maintains connection to graphics devices when put on
idle, for example when switching from main to backup if enabled (Default =
disabled).

A Note: A similar parameter is available for full screen graphics, see
_GraphicsConnectedWhenldle _ in AV Automation Settings (see
Graphics).

Obsolete Config Tab

This tab is used to convert overlay graphics configuration from Viz Mosart 3.4 or earlier versions.
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To Convert An Incompatible Overlay Graphics Configuration

1. Navigate to Settings > Properties > Obsolete Config tab.

Graphics Profles  Actions MMR  General Obsolete Corfig

Type:  |HEGO "
Oid static configuration
Handler name Host Port Defauk Scene Destination Preview engine " ' '
Press the CONVERT button
Engine 1 1] |CGA localhost 10003 DSK L to convert the cument
: . . o . ) corfiguration to the new
Engine 2 [] This action will overwte any
configuration in the new
Engine 3 [] CGC scalhost 3 setup
Engine 4 [] v CONVERT

© IMPORTANT! If you have configuration based on Viz Mosart 3.5 or later, then DO
NOT use the Obsolete Config tab.
Only if you have a configuration based on Viz Mosart 3.4 or earlier, is it strongly
recommended to convert your configuration to the new standard.

This tab displays the configuration parameters as they were in Viz Mosart 3.4 and earlier,
and is used to update old configurations to the new standard.
2. Click the CONVERT button.

This overwrites any existing standard configuration.
The fields in this tab are:

- Type: The type of graphics used
Engine 1-8 (check box): Check the graphics engines to be active. When converting to new
configuration, only active engines are converted.
Handler Name: Default CGA, CGB etc.
Host: Hostname or IP-address of graphics engine.
Port: TCP/IP port number of graphics engine.
Default scene: Specifies the graphics destination to be associated with the graphics engine.
The graphics destination is assigned to graphics received from NCS.
Preview engine: The number of the engine to use as a preview engine.

8.7.6 Mosart Graphics Destinations

This section presents configuration of overlay graphics for various system setups.

- Working with Graphics Destinations
Overlay Graphics Interface
Graphic Handler Properties
Mirrored Graphics
Mirrored Graphics Playout
Mosart Media Router (MMR) and Mirrored Graphics
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Working with Graphics Destinations

Overlay Graphics Interface

The Overlay Graphics Interface provides definitions to a set of standard Mosart graphics
destinations. These include WALL handlers (WALL, WALL_2 to WALL_5), FULL, and TABLE. It is
recommended that you keep each definition as-is.

Mosart graphics destinations

DSK {-I 1] L Mew destination
Graphic handler
WALL (n/a) _
B Behaviour
FULL (n/a) Always Take In L]
Continue S5cene ]
WALL 2 (n/a) E Description
Mame WALL
WALL_3 (n/a) 2 Link
WN_L_4 {ﬂfﬂ} Handler n/a
E Replace takeout logic
WALL 5 (n/a) Enable [
WALLT1 (n/a)
WALLZ2 (n/a)

To Add A New Mosart Graphics Destination

- Click New destination, then fill in the Graphic handler properties.

Graphic Handler Properties

The properties displayed depend on the graphic handler used. For some handlers (e.g. Viz Engine)
the full set of or possible properties will be shown. For others, a simplified set of properties will
show: Description and Link.

Behavior:
- Always Take In: Turns off the logic that does not take in a graphic element that is
already taken and no other graphic element has been taken since.
- Continue Scene: Use continue for take out of scene based graphics.
- Configuration:
Preview Engine: Handler name used for preview.
Description:
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Name: Name of the graphics destination.

Link:
Handler: Shows the engine that is linked to this destination. The engine is shown as
Handler ID: Handler Name.

Replace takeout logic:
Enable: Reads out the Transition Logic context of elements and use this to either
suppress take out or re-take items. Take outs will be suppressed if another item with
the same context was taken before the scheduled for take out action. Take outs will
be replaced with re-takes if the item scheduled for take out replaced an item with the
same context.

To Link An Engine To A Destination

- To create a link from an engine to a destination, drag an engine node to the preferred
destination.
The destination label and Handler property will be updated to show the Handler ID and
Name of the engine.

" BIGVIZ L S
I ‘ WWALL

FULL

To Remove Engine Links From A Destination

1. Mark an engine.
2. Right-click to display the context menu context menu and select Remove.

Mirrored Graphics

Mirrored Graphics Playout

The feature of playing out the same graphics through multiple graphics engines is called Mirrored
Graphics Playout. This functionality is supported both for overlay graphics and full-screen graphics
(AV Automation). Here we describe the approach used in Overlay Graphics Interface.

& For using Mosart Media Router (MMR) in conjunction with Mirrored Graphics, see Mosart
Media Router (MMR) and Mirrored Graphics below.
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1. Enable Graphics Mirroring in the General tab.
Graphics Profiles | Actions | MMR | General | Obsolete Config

Logging Mosar server

[] Verbose Hostname  |localhost

[] Trace

GUI Control Graphics Mirmoring Connectivity

[] Show local id's Enable [] Connected when in standby
k [ ] Connected when idle

2. Set up multiple graphics engines with the same destination.
Example: To configure mirrored graphics for a destination, create two destinations with the
same name and assign a different engine to each destination. In the example below,
mirrored graphics is enabled for DSK and WALL destinations.

" VIZRT MSE DSK (2:2)
Engine 1[2(2)] * DSK (2:3)

Engine 2 [3(3)] WALL {2-2)

WALL (3:3)

3. (Optional): Configure actions to be triggered when changing the active mirrored graphics
engine.
Do this from the Actions tab.

Mosart Media Router (MMR) and Mirrored Graphics

If your setup employs MMR for mirrored graphics, the integration requires additional configuration
to ensure that all new graphics elements are tagged with their corresponding destinations in the
Mosart playlists.

Ensure the ApplyChannelNameToNewElements property located
in DefaultGraphicsConfiguration.xml, is set.
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This is described in detail in the Viz Mosart Media Router Guide, in the section MMR Configuration

of Vizrt Graphics.

8.7.7 Sending Lower Third Graphics MOS Object to an NRCS
You can send details to a MOS-based NRCS as MOS objects.
For all template details as MOS objects in the NRCS, see section Mosart Templates Feedback to the

NRCS.

Managing Destinations

Active Destinations

The list of channels contains the active destinations is configured in the Overlay Graphics
Interface. Active destinations are destinations linked to a graphic engine.
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Mosart graphics destinations

Engine 1 [Eng1(1]]
Engina 2 [Eng2(2])

Engine 3 Engd(3)
 Engine 4 [Eng4(4)

4
BRANDING (nia)

TICKER (n/a)
[z eceol ’

WALL3 (nfa)
S

Gasphics Profies | Actions | MMA | Genesal | Obsolete Coriig |
Showfah VTP

In the configurations above, the following engine-destination mapping is performed:

Destination Engine number
DSK 1

WALL 2

WALL_2 3

WALL_2 4

TABLE 3
MOS Format

The list of channels in the LOWERTHIRDS MOS object will be:

<keys name="channels">
<K>WALL_2</k>
<Kk>WALL</k>
<k>TABLE</k>
<k>DSK</k>

</keys>
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The active channels from Overlay Graphics are sent to the NRCS only if the Overlay Graphics
Interface is started.

This is the recommended workflow to correctly send the channels configured in Overlay Graphics
Interface to NRCS.

The steps in square brackets are optional:

Start Mosart Administrator Mos application

Start Overlay Graphics

[Do any configuration changes if necessary in OverlayGraphics Settings]

[Restart OverlayGraphics or do Ctrl+Shift+G in case any configurations have been changed]
[Verify that %localappdata%\Temp\Mosart Medialab\MOS State\ MosTemplateCache.xml
contains expected data]

Execute mosReqObijList or mosReqAll from NCS

uThWN —

o

Detailed Description of MOS Objects

See the Appendix for code-level descriptions of MOS Object with Lowerthird Information.

8.8 Take Out Logic

Introduction
Enabling Take Out Logic
Prerequisites for Take Out Logic

8.8.1 Introduction

For overlay graphics, Viz Mosart supports four different methods to take out any graphics that are
currently on air:

1. Automatic: Timed, where graphics are taken out automatically after a fixed duration,
provided in a timecode.

2. Background End: The graphic is taken out automatically, when the next story item is taken.

3. Story End: The graphic is taken out automatically when the first story item of the next story
is taken

4. Manual: Open ended, the graphic is taken out manually. Also called a non-auto out.

For the Background end and Story end cases, there is a potential issue if the graphic to be taken
out reappears in the next story item. When taking the next story item, the standard behavior of
such graphics is:

1. Take out the graphics due to the end of scope (either Background end or Story end)
2. (Re)take in the graphics since the graphics is also present in the story item to be taken.

This leads to a visual artifact on air, since the graphics will be take out and retaken within a short
time interval.

This is illustrated in the following figure:
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Story1: | Item1: ltem2:
BackgroundEnd: graphics_id="52" <any type>: graphics_id="52"
Story2: | Item1: ltem2: ltem3:;
StoryEnd: graphics_id="67"
Story3: | Item1:
<any type>: graphics_id="67"

Example 1: Background End
Story]1 consists of two story items, ltem] and Item2.

In Item] there is an overlay graphics of type BackgroundEnd
In Item?2 the same graphics is reused. The type is not relevant here.

- When the user takes ltem?2 on air, the normal behavior is to take out the graphics (out of
Item1) and then (re)take it (also part of Item2)
If Take Out Logic is enabled, the graphics will remain on air during the transition from ltem1
to Item2

Example 2: Story End

Story?2 consists of three story items, Item], Item?2 and Item3 and the next story, Story3 consists of
one story item, Iltem]

In Story2.ltem?2 there is an overlay graphic of type StoryEnd. l.e. this graphic is scheduled to
be taken out at the end of the story.
In Story3.Item1 the same graphics is reused. The type is not relevant here.

- When the user takes Story3 on air, normal behavior is to take out the graphics (out of
Story2.Item3) and then (re)take it (also part of Story3.ltem])
If take out logic is enabled the graphics will stay on air during the transition from StoryZ2 to
Story3.
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8.8.2 Enabling Take Out Logic

- Take out logic is enabled via setting Use Take Out Logic in Manus Administrator as shown in
the figure below:

B} frmSettings — O x
o 2
Should updgrade False ﬂ
Startup in idle mode True
Story Compare Ignore Aftributes
Templates allowing graphic pretake PACKAGE VOICEOVER
Transitions on Accessories False
True E I—‘
UzeltemStatusToNCS False
~ Configuration file paths
AvConfig c:\channeltemplates\avconfig.xml
Channel templates c:\channeltemplates‘«channeltemplates .xml
Manus directory c\manus
Mewsroomsettings c:\channeltemplates‘newsmoomsettings .xml
~ Crossover
Croseover fadn Take Oin Swateh Oiffz et n j
Use Take Dut Logic

Enables the CG takeout logic. When two CG graphic objects with the same graphic |Ds are next to each
other, the first one is not taken out, only “take in” on the second object will be executed. Default:False.

& Note: Enabling take out logic applies to non-Vizrt graphics only.

8.8.3 Prerequisites for Take Out Logic
For take out logic to work, there must be a unique way of identifying the graphics.

There are two ways to do this:

1. Use the graphics_id graphics property. The graphics_id property is used by most graphics
drivers to do actions on the graphics. Therefore it can normally be used as a unique
identifier for the graphics. For most graphics systems used by Viz Mosart, there is a defined
way of setting this property when receiving graphics from NRCS.

2. Use the graphics_category graphics field property. This is a special property for the take out
logic. Use this if graphics with different graphics_id shall be treated as the same graphics
and handled as part of the take out logic. This normally requires custom field mapping in
configuration file newsroomsettings.xml.
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9 Story Recorder Mode

Enabling Story Recorder mode
Prerequisites
Overview

- Activating Story Recorder Mode
Verification

- Troubleshooting
Housekeeping

9.1 Enabling Story Recorder Mode

To enable Story Recorder (SR) mode in your setup, follow the configuration procedures below.

& Note: Once SR mode is activated, you will need to establish system-wide, frame accurate
clock synchronization. This is described in section Frame Accurate System Operations.

End user (Viz Mosart operator) documentation for Story Recorder is provided in the section Story
Recorder of the Viz Mosart User Guide.

9.2 Prerequisites

- The Viz Mosart system is already fully operative in live (non-SR) mode.

- The system, including studio equipment, can be calibrated for frame-accurate operations, as
described in section Frame Accurate System Operations.

- A dedicated set of frame-accurate templates has been created for Story Recorder.
Frame-accurate operations are automatically latency-compensated for primary events,
introducing timing differences in the execution of the templates, compared to Standard
mode.

Additionally, not every feature in Standard mode is available or possible in Frame Accurate
mode.

- An operating license is obtained from Vizrt Support.

& Note: Please refer to the Viz Mosart Release Notes for details of which devices are
supported for Story Recorder mode.

9.3 Overview

Story Recorder (SR) both introduces new system components and repurposes existing
functionality. Important to note are:
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The Mosart Logging Service plays a significant role together with a new Story Recorder Log
Adapter, for capturing events for recording.

This new log adapter must be configured after installing the Mosart server.

A snippet transcoder, Vizrt's Coder, is added to the installation.

The relationships between the system elements introduced with SR are presented below. This
example has a Harmonic Spectrum video server and Vantage for EDL transcoding:

* Media Player configured in Windows for snippet
review.

e Shortcut: Pause the timeline.

e Shortcut: Set Retake Point.

® Shortcut: Broadcast the timeline for consolidation.

Configure to read the
EDL/final clip base name
from NRCS

* Copy AsRunLogRepositoryConfig.xml and
LogAdapterStoryRecorderConfig.xml into
channeltemplates.

* Enable Story Recorder Log Adapter in
AsRunlLogRepositoryConfig.xml as described in
documentation.

e Configure the settings from
LogAdapterStoryRecorderConfig.xml.

¢ 2 channel ports for A/B playout of both
the show clips and the recordings for
prerolling.

e 2 ports for clean- and dirty recording.

® Plura timecode reader card settings.

* Genlock settings.

L Access snippet cut clips.

Viz Coder
Worker

Generate snippets
around retake point

Viz Mosart
Server
Snippet

Av Automation cut clips

Generate EDLs

Harmanic
Spectrum
Video Server
_Q Vantage
) L i Transcoder |
Recorded clips Harmonic EDL
Spectrum watch
£s folder
C
Final show

clips

A Note: The folder where the final show clips reside is not controlled by Viz Mosart. This is
set on the EDL transcoder side. In the above setup, the EDL transcoder is Vantage.

9.4 Activating Story Recorder Mode

Execute each of these procedures:

Upgrading to a Version of Viz Mosart that includes Story Recorder

Enabling the Story Recorder Log Adapter

Configuring Video Server Settings for Playout and Recording
Enabling Snippet Generation at the Cut Point

Managing Naming of the Final Clip Show

Pre-Roll Duration
Automatic Pause at Show End
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For setups where several Mosart applications are installed on the same machine and are
using their own logging service (for example, Viz Mosart Ul, Viz Mosart Audio Player and
Viz Mosart Server), please ensure that the Viz Mosart Server was the last component to be
installed and that the Mosart Logging Service points to the Viz Mosart Server installation
folder. This is relevant for Story Recorder because any supported log adapters (in this
procedure, the newly introduced Story Recorder Log Adapter) reside on the Mosart Server
side. For additional information, refer to the topic System Logging.

9.4.1 Upgrading to a Version of Viz Mosart that includes Story

Recorder

Story Recorder was introduced with Viz Mosart 5.0, so the first step will be to install the new

software bundle.

1. Stop the service Mosart Logging Service.

2. Install the new software bundle taking into account the previous note regarding the

installation order.

9.4.2 Enabling the Story Recorder Log Adapter

1. In the Manus Administrator console, type settings and verify that Logging > In use is set to

True:

@ Settings

oz 24

Full-screen-graphic

Item

Live

Lower-third

Telephoneinterview

Video clip

INews configuration

Default Rundown

Encoding

FTP Port

Ignore Send Cue Status To NCS For Offline Clips
Password

Refresh Media On NCS Update

Server

Time to delay initialie devices while waiting for NCS to add story
Username

<

Working Directory
v INews Web Service configuration
Web Service Connection
Logging
Ignore verbose events filter

<

Log level

MSMQ Log limit

Pass verbose events filter
Path for MMLog

Trace internally

Use verbose logging
Manus configuration
Default Manus

Manus expiration time

<

Inuse
Set to true to enable logging

125
100
125
125
125
125

STUDIO4 RUNDOWN
Default

21

False

False

True
0
4025

MosartLog
True
True

STUDIO4. RUNDOWN
1]

2. Check if you have the following two files in your working folder, Channeltemplates or
ProgramData\Mosart Medialab\ConfigurationFiles\.

If yes, go to the next step.
If not, copy

1. AsRunlLogRepositoryConfig.xml
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2. LogAdapterStoryRecorderConfig.xml
from C:\Program Files (x86)\Mosart Medialab\Mosart

Server\ConfigurationFiles into your working folder.

Open AsRunLogRepositoryConfig.xml in an editor and add or uncomment the following line:

<Adapter type="LogAdapterStoryRecorder" name="LogAdapterStoryRecorder" configuration="
LogAdapterStoryRecorderConfig.xml" assembly="LogAdapterStoryRecorder.dll" />

Open LogAdapterStoryRecorderConfig.xml in an editor and configure the following settings:

Setting

RemoteDispatcherHost

RemoteDispatcherPort

BackupHost

BackupPort

EdIWatchFolder

Description

The host for service Mosart Remote
Dispatcher (MosartRemoteControlService) is always local, running
on the Mosart server machine.

Default: localhost . No other value should be given.

The port where the Mosart Remote Dispatcher service
(MosartRemoteControlService) resides. This should be the same
as configured in RemoteDispatcherServiceConfig.xml.

Default: 8090 (locally on the Mosart server machine).
The hostname of the Mosart backup server.

The port for connecting to the Backup Story Recorder Adapter.
This should be the same on both the main and backup Mosart
machine.

Default: 5001.

Location of a shared folder to which Viz Mosart has access and
monitored (watched) by your EDL transcoder.

In the figure above, this folder is named EDL watch folder .

This setting can not be empty and can be any shared network
path where both Viz Mosart and the EDL transcoder have access
(for example, \\somehostname\\EDL).

The folder must have read and write permissions for the Mosart
Server Logging Service.

Viz Mosart does not clean up any files created in this folder. See
more details in section Housekeeping.
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SnippetGenerationRequestD
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SnippetLengthForEachRecor
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Description

Location of a local folder where Viz Mosart drops the Story
recorder EDL files. This folder is a secure 'backup' for the
EdIWatchFolder. The EDL transcoding node does not have access
to this folder, but if ever the EDL files fail to be generated in the
EdIWatchFolder because of say, connection issues, the user can
later manually copy the files to the EDL transcode node.

The setting can not be empty and it must be a different location
than the EdIWatchFolder

(for example, C:\MMLogs\EDL or \
\mosart_server_hostname\MMLogs\EDL).

This folder must have read and write permissions for the Mosart
Server Logging Service.

Viz Mosart does not clean up any files created in this folder. See
more details in section Housekeeping.

When a retake of a story item is performed, a rendered snippet
around the cut point will be placed in this folder shortly after the
item was retaken.

If this property is not configured or left empty, no snippet of the
cut can be created.

The location should be a network shared folder where the user
running Mosart Server Logging Service has read and write access
and the user running Mosart GUI has at least read access.

(for example, \\somehostname\StoryRecorderSnippetClips)

In the figure above, this is Snippet cut clips.

To set up a shippet recorder see Enabling Snippet Generation at
the Cut Point.

Default: empty. This implies that a snippet recorder is optional.

How long in seconds after the retake process started, that
generation of the snippet clip (from around the cut) shall begin.
(The retake process is the last part from the following chain of
actions : Show is paused - Pre-roll is taken on-air - Pre-roll auto-
takes the item to be retaken). See section Story Recorder of the
Viz Mosart User Guide).

Default and minimum recommended: 15 seconds.
The amount of time (in timecode format) from each recording to

be included in the snippet clip.
Default: 00:00:05:00 (5 seconds from each recorded clip).
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Description

Prefix added to the recording clips generated during a Story
Recorder session using the configured video recorder. This is
used by Viz Mosart to easily identify the recorded clips for
housekeeping. (Only clip file names prefixed with this value will
be subject to Viz Mosart housekeeping.)

Default: SRVizrt.

Location of the video server's file system folder where it stores
recordings created by Story Recorder. In the figure above, this
folder is named Harmonic Spectrum FS.

(for example, \\somehost\fsO\clip.dir).

This location is defined on the video server side.

This folder must have read and write permissions for the user
running Mosart Server Logging Service which performs
housekeeping tasks.

Number of days to keep the recording clips (minimum 1 day) on
the video server. An empty, zero or a negative value means the
housekeeping of the intermediate recording files is disabled,
there is no deletion of the intermediate files.

If enabled, the housekeeping task is run every time Mosart Server
Log Service is (re)started and keeps running at regular intervals
defined by RecordingRetentionDays setting.

Note that the recorded clips can be very large files easily filling
the disk space. See also section Housekeeping.

Default: 0 (disabled).

The name of the variant of the pre-roll template. This will be used
to automatically create the pre-roll template in the current studio
setup.

Default: PREROLL.

& Note: If another package template with this same name
exists on your system which was manually created, delete
or rename it.

The pre-roll template for Story Recorder must retain its
default minimal characteristics and can not contain
additional control parameters.

This unique minimal template can be reused after an
upgrade.
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MinPrerollDuration

MaxPrerollDuration

- Any changes in the configurations above require a restart of the service Mosart Server Logging

Service.

Viz Mosart Administrator Guide -

Description

The minimum and default preroll duration in seconds that the
Preroll template will insert.

& This time needs to be sufficient for the video server to
reset and be ready to record, after being paused.
Typically 10-15 seconds.

The preroll duration can be increased by the user in the Story
Recorder Ul, see Minimum Pre-Roll Duration.

Default: 70.

The maximum preroll duration in seconds that the Preroll
template will insert. (See MinPrerollDuration above.)
Default: 30.

A For further details about logging in Viz Mosart, refer to section System Logging.

9.4.3 Configuring Video Server Settings for Playout and Recording

The video server is used for both playout of clips during the show and the recording of the story.
Ports are configured for both dirty and clean recording.
These port settings on the video server depend on defined signal inputs and are not defined from
Viz Mosart. To enable Story Recorder, some small changes must be made on the Viz Mosart side.

To configure video server recorder ports for Story Recorder

1. In AV Automation, navigate to Devices > Properties > Video Servers.
2. The settings for the Video server configuration and Mosart port configuration are already OK

for a working system.

Otherwise, refer to section Video Servers.
3. Configure the recording port(s) dedicated for Story Recorder.
4. For the recording port(s) mentioned in the step above, select IsEnabled in the Story Recorder

section.

5.0
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Vision Mixer Video Servers Graphics Audio Camera Robotics Light Control Router Subtites GPI/O  Tally  Vitual Set  Weather Video Wall Int « | *

Video server configuration Mosart port configuration
Add new server | | Add new port ‘ Omneon v DE Name: |Omneon
Omneon Properties - m ® DirectTakes
‘El Connection - Omneon:MIF76004 A: (Omneon:MIP76004) Mosart Port
| — -"*50;';1’-:" | Omneon: MIP76008 8: (Omneon-MIP75008) B AvConfig ..
ExtList mxf,MX A h 1 N
e — OmneonMIFTIOOREC 3 udio Channel 1| (empty)
nitial Standby . . Audio Channel 2 | (empty) ~
Server 10211.112.134 Orneon Growing_ingest | | Fecl: OmnecntlFTINRES) |- L (empty) ~
Server Type Omneon *  « i Rec2: <no ports> 5l Description
= — -
Description STP-HDPlay1 Name Recl
Alias El Server ports
Name Omneon STP-HDPlay2 Main Cmneon:MIP
STP:REC1 Mirror n/a
STP-REC2 Bl Story Recorder
IsEnabled v
STP:HDPlay3
STP:HDPlay4
Server connechion sining: Restore

Name=0mneon; Type=Omneon; Server=10.211.112.134.Directory=/fs0/chp.dir. Config=ClipServerOmneon.xml. ExtList=_mxf MXF
Cancel Apply Save & Close

This setting reserves the selected port for Story Recorder.
5. Click Apply then Save & Close.
6. Force a reconnect to the video server with Ctrl+Shift+V.
(or restart of Av Automation).

Clip naming pattern of temporary recordings

The temporary recording files generated by Viz Mosart are automatically named.
- When only one recorder is configured, the clip name pattern

is<RecordingClipNamePrefix>_<counter_<timestamp>.<extension>, where
- The RecordingClipNamePrefix is the setting configured in step (4), when enabling the log
adapter earlier.
- The counter is reset to 1 for each Story Recorder session.
- The extension is configured in AV Automation > Devices > Properties > Video Servers >
ExtList (the first in the list will be chosen). See the previous screenshot.

For example:

SRVizrt_1_211001153956.mxf
SRVizrt_2_211001153956 .mxf
SRVizrt_3_211001153956.mxf
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When more than one recorder are configured, the clip name pattern is
<RecordingClipNamePrefix>_<recorder name>_<counter_<timestamp>.<extension>, where
- The <recorder name> is the Name setting configured in Devices/Properties/ Video Servers
on the virtual recorder port properties (see setting Name set to Rec1 in the previous
screenshot).

- The counter is reset to 1 for each Story Recorder session.

- The extension is configured in AV Automation > Devices > Properties > Video Servers >
ExtList (the first in the list will be chosen). See the previous screenshot.

For example:

SRVizrt_Rec1_1_211014172330.mxf
SRVizrt_Rec1_2_211014172330.mxf
SRVizrt_Rec1_3_211014172330.mxf
SRVizrt_Rec2_1_211014172521.mxf
SRVizrt_Rec2_2_211014172521.mxf
SRVizrt_Rec2_3_211014172521.mxf

9.4.4 Enabling Snippet Generation at the Cut Point

This setup is optional and generates a few seconds (configurable) of verification video, intended to
reveal the integrity of a fresh cut, after a story item has been paused and then retaken. This
snippet creation employs Vizrt's versatile transcoder, Coder.

1. Download the most recent .exe version of Coder from the customer FTP, by navigating to
/products/VizOne/Latest Versions/Individual Installers and Docs/Coder/Latest Version.
2. You need only install the Coder Worker .
Install Coder on the same machine as the Viz Mosart Server. Coder's default installation
location is in C:\Program Files\Vizrt\Coder.

A Note: If you install Coder anywhere but the default location, you must then update
the following configuration, to specify the new path to the Coder executable,
amlbatch.exe:

<?xml version="1.8" encoding="utf-8"?>
Sl<configuration:

<configSections>
<sectionGroup name="userSettings" type="System.Configuration.UserSettingsGroup, System, Version=4.98.8.8, Culture=
<section name="CoderTools.Properties.Settings" type="System.Configuration.ClientSettingsSection, System, Vers
</sectionGroup>
</ronfigSections>
<userSettings>
<CoderTools.Properties.Settings>
<setting name="ExecutableFilelocation” serialirefs="String">
| <value>C:\Program Files‘\wizrt\Coderibin\amlbatch.exe</value>
</setting>
| </CoderTools.Properties.Settings>
</fusersettings>
<startup><supportedRuntime version="v4.8" sku="_.NETFramework,Version=v4.8"/></startup></configuration:

This config file is C:\Program Files (x86)\Mosart Medialab\Mosart
Server\CoderTools.dll.Config.

3. On the machine that runs the Viz Mosart GUI, define a default media player for *.mxf files
(for example, VLC).
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4. On the machine that hosts the Mosart server, in your working folder (ChannelTemplates or
ProgramData), locate the file LogAdapterStoryRecorderConfig.xml.
If not already set in step (4) earlier, provide values for:
a. StoryRecorderSnippetClipsFolder
b. SnippetGenerationRequestDelay
c. SnippetLengthForEachRecording.
5. Restart both the
a. Mosart Log Service (Windows Services menu)
and
b. Viz Mosart Ul.

9.4.5 Managing Naming of the Final Clip Show

This step is optional. By default, naming of the show (and EDL files) is derived from the rundown
name.

As a convenient option, you can instead provide a flexible and predictable naming scheme through
a mapping field defined in the NRCS story.

Viz Mosart will then pick up this value and use it as the base for file naming, including the final
show clip name. This is explained in Configure the NRCS and Viz Mosart for automatic naming of
the Final Clip Show below.

@ To prevent configuring the EDL/final clip base name every time the first story is changed,
the rundown can be designed to, for example, start with a Break which will not be part of
the show.

In addition, the user can also manually enter a name for the show's final clip, in the Story Recorder
Ul. This will overwrite the value given in NRCS.

Evening Show w34

Configure the NRCS and Viz Mosart for automatic naming of the Final Clip Show

From the NRCS, you can add a name that becomes the base of the final clip name in Story
Recorder.

1. In the NRCS, open the corresponding rundown for the show.

2. Add an NRCS column (here for example, SR Base Name).
The procedure is NRCS-specific and may require administrator privileges.
The following example is from iNews.

|sLUG SR Base Name |
SHOW NAME 9AM news show-en |
Cam

Clip - Yellow

Clip - Pink

3. Under this new column, provide a name for the show, in the first story in the rundown (here,
9AM news show - en).

Copyright © 2022 Vizrt Page 169



Viz Mosart Administrator Guide - 5.0

& Note: Viz Mosart will only read the naming at story level, from the first story in the
NRCS rundown. If the name is placed in any other story, it will be ignored.
Tip: If your NRCS operates on rundown level, not story level (for example
OpenMedia), you can create a script that will propagate your desired final story name
(as a text field on rundown level) to all stories in your rundown. As this also
populates the first story, Viz Mosart will then successfully read the name.

This name will be mapped in Mosart to appear in the Story Recorder Ul, when SR is enabled,
as illustrated at the end of this procedure.
The NRCS-side configuration is complete, next is to arrange value-mapping on the Viz
Mosart side.
4. In the Viz Mosart console application Manus Administrator, type ns. This opens
the Newsroom Settings menu.
5. From the menu bar select Edit > Story External Metadata and add the following row if not
already present:

|E| Mewsroom Settings (chchanneltemplates\newsroomsettings.xml)

File  Edit Story External Metadata
mostagname Masart Action Fomat Type mos_value action_value
coll4 tem_variable LI String ;I lang
var-007 tem_variable n String n ar_final_clip_name
col(1 directtake_pre_story ;I String ;I pre 101
coll directtake_post_story ;I String ;I post 102
var-1 template_type LI String ;I
var-2 template_varant ;I String ;I
var-3 template_transition ;I String ;I test Effektl12

where
mostagname: the column name as specified in the NRCS (in this iNews example, var-007).

& Note: For details on how to derive this naming (here var-007) from the NRCS, refer to
section Story External Metadata in Newsroom Settings Editor .

Mosart Action : must be set to jtem_variable .
Format Type : must be set to String .
mos_value : empty.
action_value : must be sr_final_clip_name .
6. Restart the Viz Mosart Server.
7. Verify the setup:
a. Provide the Final Clip Show name as described.
b. Load the rundown in Mosart Ul.
c. Enable Story Recorder mode (see Viz Mosart User Guide, in the Story Recorder
section).
d. Check that the name entered in Managing Naming of the Final Clip Show, appears in
the Story Recorder Ul when the associated rundown is loaded and Story Recorder
mode activated.
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Story recorder @ Ready!

REC 9AM news show - en

& Any changes made in NRCS for the Final Clip Show name are not taken into consideration
during a Story Recorder session, but only when Story Recorder mode is again activated (so
in the next Story Recorder session).

Clip naming pattern for EDL files and the final show clips
The EDL and final clip recording files are automatically named by Viz Mosart.

The name pattern used to generate the EDL files at show level and the final show clips generated
by the EDL transcoder is:

<Final Clip Show name>_<timestamp>.<extension>, when the show is broadcasted first time.
<Final Clip Show name>_v<counter>_<timestamp>.<extension>, when the show is
broadcasted more than once.

where

- Final Clip Show name> is the rundown name or as given from NRCS or as given in Story
Recorder panel (see Managing Naming of the Final Clip Show ).

- extension for the EDL files is the extension for the supported EDL transcoder (for
example, tsedl for a Vantage transcoder).

For the final clip shows, this is the extension configured on the EDL transcoder itself.

For the example used in this procedure. the Show Final Clip name is 9AM news show - en:
- 9AM news show - en_211011175050.tsedl

- 9AM news show - en_211011175050.mxf

- 9AM news show - en_v2_211011175050.tsedI

- 9AM news show - en_v2_211011175050.mxf

9.4.6 Pre-Roll Duration

The pre-roll period must be long enough for the video server hardware to reset itself and be ready
to continue recording, after a pause.

To set a pre-roll duration

1. Determine the time required by your video server hardware to commence recording. This is
typically 10-15 seconds.
2. Configure this value as described in MinPrerollDuration.
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3. You may increase the value in the SR panel:

Start time Duration

This setting is retained between SR sessions.

9.4.7 Automatic Pause at Show End

As an option, you can automatically pause the show and recording.

To set automatic pause
1. Create a dedicated template, typically a Break.
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%

2. Define a PAUSE_TIMELINE control command configured on the_ltemplate.

File = Template = Template Set ~ DB !

NEWS INT |
Take
BREAK + StopShow

Template properties

General Control Commands  Newsroom tags order  Destination panel

Command On Take Control commands Take

Command Value Parameter
» PAUSE_TIMELINE |~ N/A |~

L3 L

des:

[ Continue Paints

Autotake  Command  Value  Parameter

w

3. Insert this template at the end of the rundown.

In the Story Recorder session, when the story before this template is taken on air, a message
warns the operator that the next story is going to pause the show and thus the recording too:

SRS —w
19:30:18 00:00 00:30 [COUNTDOWN Countdown
Q NIB USVisas 10 G
STOP SHOW i

Story recorder @ Recording...

R Morning Show 06:00
00:00:17:00/00:29:43

ltem name

Story name Start time Duration
I\/ Countdown

Countdown 19:30:11 00:

I v CAMERA U1 ANMOD LIBYA 19:30:13 00:
I Countdown Recording...

Q NIB USVisas 10 G 19:30:18 00:00:11:00
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This step is optional and it assumes that Viz Mosart is already set up with redundancy as described

in section Redundancy.

This means that:

Both the Viz Mosart main and backup server have same configurations for at least Mosart

Administrator, AV Automation, Media Administrator and Overlay Graphics Interface.

AV Automation is configured for mirroring on both main and backup servers (with main
pointing to backup and main pointing to main):

Audio

Camera Robotics  Light Control

Standby &t startup

[ visien Mixer

[ Video Server

[] Graphics

[ Audie Mixer
Camera Robotics
Light control

[] Router

[ Subtitles

] GRID

[] \weather system
[ video wall

[] Sound player

[ Virtual set

[ Loudness contrel

IHRELS

Router Subtitles GPI/O Tally

Show in Console

[ Autotzke timing

Diagnostics

Trace
[] Verbose

Direct Takes

Directtake On Reload
Directtake On Become Active

Directtake On Become Idle

Crossover

Directtake On Activate

Directtake On Inactivate

Vitual Set  Weather Video Wall

1l

Integrated Engine  Genlock General PR

Redundancy

[#] UseMirroring  Hostname |BGO-MOS-SER

Media Router
Use for:
[] Video Servers

[] Graphics

[] Owerlay Graphics
[] Camera Robotics
[] Light Control

[] Video Wall

[ Subtitling

Configuration

Name [Mosart 1 | Port [8099]

|dle Salve ReleaseAll

Cancel Apply

The Viz Mosart Ul is configured to connect to the backup server:
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(_) General settings

* Server
Remove

Connection name: Gallery 1
Main localhost
Backup bgo-mos-server]

For Story Recorder, there are additional steps:

Story Recorder is configured on both main and back in the same way. For simplicity, once
main has been configured for Story Recorder mode as describe in section Enabling the Story
Recorder Log Adapter, copy AsRunLogRepositoryConfig.xml and
LogAdapterStoryRecorderConfig.xml in your working folder from the backup server
(Channeltemplates or ProgramData).

Open LogAdapterStoryRecorderConfig.xml from Mosart main server in an editor and provide
the hostname and port to the backup server (BackupHost and BackupPort) as described in
Enabling the Story Recorder Log Adapter, step 4.

Open LogAdapterStoryRecorderConfig.xml from Mosart backup server in an editor and
provide the hostname and port to the main server (same BackupHost and BackupPort
settings) as described in Enabling the Story Recorder Log Adapter, step 4.

Both main and backup machines have Plura card installed and Viz Mosart configured to
connect to Plura as described in Frame Accurate System Operations.

(Optional) If Snippet generation around the cut point has been set up for main, this should
be set up in the same way for backup. Install Viz Coder on both main and backup server.
The snippet folder configured in LogAdapterStoryRecorderConfig.xml where the Viz Mosart
Ul has access, needs to be configured to be the same on main and backup.

Same calibration settings from AV Automation: Devices > Properties > Genlock tab should be
configured for main and backup.

9.5 Verification

- The video server is prepared for recording.

- Viz Mosart is prepared to run in Story Recorder mode.
Snippet generation around the cut point is configured (optional).

- The integration is now established between Viz Mosart and the NRCS (optional).
Failover is setup as described (optional).
Ensure you have calibrated the system to frame accuracy, as described in section Frame
Accurate System Operations.

The Viz Mosart operator instructions, for switching on and running Story Recorder are described in
the Viz Mosart User Guide, in the Story Recorder section.
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A We strongly suggest to build a new template set for Story Recorder, mainly because of the
timing differences in the execution of the templates in Frame Accurate mode (now
automatically latency-compensated for primary events), and partly because not every
feature in Standard mode is available or possible in Frame Accurate mode.

9.6 Troubleshooting

Story Recorder must always first be switched On in Viz Mosart Ul.

Failure to Enable Story Recorder Session

Recording Ports not Found

Failure to Start Recording or Story ltems not Recorded in Story Recorder Panel
Naming of Final Clip Show from NRCS not appearing in Story Recorder Ul
Unreliable genlock. See more details in AvAutomation status bar

Genlock is not enabled

Retake position no longer valid. Please set retake point

Timeline can not be paused while pre-rolling

9.6.1 Failure to Enable Story Recorder Session

When the user switches on SR in the Ul, you see:

Story recorder & On

Failed to enable Story Recorder: Mosart Server Log Service can not be reached.

Check these scenarios, in this order:

Viz Mosart Server and Mosart Ul or Mosart Audio Player are on the same machine and the
server was not installed last.
If you installed the server before the Ul or Mosart Audio Player, Mosart Log Service will

incorrectly point to a copy of MMAsRunLogService.exe thatis located in the Mosart Ul
or Mosart Audio Player folder installation. Instead, this should point to the
MMAsRunLogService.exe located in Mosart Server installation folder:
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Marne Description Status Startup Type L
[k Microsoft Windows SMS Rauter Serf o ' ' - e '
L MOM bosart Logging Service Properties (Local Computer) >

%Musart Logging Serdice 5 | -
. . eneral  LogOn  Recoveny Dependencies
5k Mosart Rermote Control Service
5k Mozilla Maintenance Service

L Matural Authentication

i Met.Msmay Listener Adapter

L Met.Pipe Listerer Adapter Description: Provides logaing services for the Mozart zuite
i Met.Tep Listener Adapter

L Met.Tep Part Sharing Service

Service name; MozartLogService

Dizplay name: Mozart Logging Service

Fath to executable:

Yooy .y F T

: MetBalancerService frarn Files [#86]4\Mozart Medialab\Mozart ServeritiAzRunlogService. exe'
L Metlogon

EMetwork Connected Devices Auto-Se Startup type: i Lltsinells -
EMetwork Connection Broker

i Metwork Connections

i Metwork Connectivity &ssistant Service status:  Funning

L Metwork List Service

i Metwark Location fwareness Start Stop Pause Resume

S Metwoark Setup Service You can specify the start parameters that apply when you start the service
Ok Metweork Stare Interface Service fram here.

LSLWVIDIA Display Container LS
ChWVIDIA Display Driver Service
LCL NWIDIA Stereascapic 30 Driver Servid

£k Office Source Engine
Bl g

ok C I &ppl
5k Office Software Protection Platform _ nee e

To fix this, you should either stop the Mosart Log Service from Services and start it as console
from Mosart Medialab\Mosart Server\ MMAsRunLogService.exe (although you will still have
same problem after a machine restart) or re-install the applications in this order: first the Ul/
Mosart Audio Player and then Server.

e

After Mosart Log Service is started, enable SR again.

Verify that the (new) Story Recorder Log Adapter, and the
config LogAdapterStoryRecorderConfig.xml are setup according to section above, Enabling
the Story Recorder Log Adapter, around step (3).

A common oversight is that someone forgot to un-comment the lines for Enabling the Story
Recorder Log Adapter for Story Replay functionality in AsRunLogRepository.xml.

type="LogAdapterStoryRecorder" name="LogAdapterStoryRecorder" configuration="LogAdapterStoryRecorderConfig.xml" assembly;
"LogAdapterStoryRecorder.dll" /> |

For additional help, refer to the general topic Troubleshooting Log Adapters.
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If the Viz Mosart Ul is connected to a Mosart server on another machine, make sure there is
no VirtualBox or similar configured on the Mosart server machine.

I

F 3

1 & > [Control Panel > Network and Internet > Network Connections > |

File Edit View Tools Advanced Help

Organize ~ Disable this network device Diagnose this cogigection Rename this conn

L" . Ethernet 2 ." . VirtualBox Host-Only Network .

= _ Network cable unpl = Enabled -
b 4 % |ntel(R) Ethernet Connection (2) | &~ VirtualBox Hest-Only Ethernet Ad...

9.6.2 Recording Ports not Found

If when you switch on SR, you get errors about No recorders configured for Story Recorder, this
indicates that the connection to the video server that performs the recorder is faulty.

Mo recorders configured for Story Recorder

story name Start time Duration

Ensure you set up Viz Mosart, with correct configuration settings selected, as explained
above in To configure video server recorder ports for Story Recorder.

Even if the configured recording ports are enabled for Story Recorder as described above, you may
also get this error message after switching to a different video server salvo.
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MAF 1 MAP2  EXT1 KT 2 XT3 XT 5 KT6 1 ANGZ  AMGE  ANG4  ANGS

v v W v v W v v W v v v v v v W v v

90 | o0 [ %0 [ 0 | 0 | 90 | 90 | 9 [ 90 [ o0 [ o | s [ s | 90 | 90 [ 9 | 90 [ o0 | 90 | 0|

< >

oMme I oMa | KAMZ | KaMz I KA | KAMT | EXT1 I EXT2 | EXT2 | EXT4 I EXTS | EXTE | RIA I Ri18 | RIC | RID | RIP | ml | OGSE
0

OMA KAMZ KAM3 KAM4 KAMT EXT1 EXT2 EXT3 EXT4 EXTS EXT6 RIA R1B RIC RID RIP oGsa | oese | oese

10:34:0234  Performed command DIRECTTAKE - 702:
10:34:0234  Executing cmd TAKE CONTINUE POINT 600
10:34:03.56  Command DIRECTTAKE-702 performed
10:34:03.56 _|D | ACCESSORIES+702 OGSE SYN

10:34:0356  MIXon ME2OGSEin 15frames

10:34:03 56 Directtake Nr 702 702 OGSE SYN

10:34:0357  CueDelav sstto 1000 ms (25 frames, min. cue de...
10:34:04.59 |C | PACKAGE=SYN auto raus NEWS INT
10:34:0459  PREVIEW ACCESSORIESRouter NOT CONNE...
10:34:0459  CUING(StopAndCue) at frame 462 Pink-Vox-T...
10:34:05.07 CUED(StopAndCug):  Pink-Vax-TC-25fps-120s-...
10:34:0512  ServerCue  Pink-Vox-TC-25ps-120s-AVC Intra...
12:10:30.28  Executing cmd RECORD STOP AND DETACH...
12:10:58.63 - - - nitialize devicss - - - -

12.10:58.65 | | | BREAK=NEWS START NEWS INT

12:10:58.67  CueDelav setto 1000 ms (25 frames. min. cue de...
12:10:59.80 |C | CAMERA=U2 NEWS INT

12:10:59.80 | | PREVIEW ACCESSORIESRouter NOT CONNE...

After switching to a different salvo, perform the following steps:

1. Check that there are recorder port(s) configured and enabled for Story Recorder as explained
above in To configure video server recorder ports for Story Recorder.

2.

Restart AV Automation or force a reconnect to the new video server (use Ctrl+ Shift + V).

This step should be done regardless whether the previous step was necessary or not.

9.6.3 Failure to Start Recording or Story Items not Recorded in Story
Recorder Panel

Recording does not start and no story items appear in the Story Recorder panel.
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Verify in Viz Mosart Manus Administrator that logging is enabled:
Open Media Administrator and type settings.

[5] settings = O X

FH=: A
@z X

~ |News Web Service configuration
web Service Connection
v Logging
lgnore verbose events filter
[N True [~
Log level 0
MSMG Log limit 4025
Pass verbose events filter
Path for MMLog Mosart Log
Trace internally True
Ilse verbose logging True
~ Manus configuration
Default Manus STUDIO4 RUNDOWMN
Manus expiration time 1] ﬂ
Inuse
Set to true to enable logging.

On the machine hosting the Viz Mosart server, check that service Viz Mosart Logging
Service is up and running (as service or console).

If running as a service, verify that it points to MMAsRunLogService.exe from the Viz Mosart
server installation folder.

If the Viz Mosart Logging Service is restarted while other applications are running OK, then
an action in the Viz Mosart Ul (for example, reloading the rundown) must be performed to
reestablish the connection to the Viz Mosart Logging Service.

Until a Viz Mosart Ul action is made, no events are logged in the AsRunLog for the first story
item taken on-air.

This leads to Story Recorder not functioning correctly. For example, recording may appear to
start OK, but no story items show up in Story Recorder panel.

If the Viz Mosart Logging Service is restarted when the Overlay Graphic Interface is being
used for controlling the graphics systems, it must be restarted in order to re-establish the
connection.

Until the Overlay Graphic Interface is restarted, no graphic-related log events are logged in
AsRunLog for the first graphic encountered in the rundown, meaning Story Recorder will be
unable to backtrack the graphic.

& Note: After any Mosart Logging Service (re)start, as a rule of thumb, always restart
AV Automation and the Overlay Graphics interface.

Make sure Mosart Logging Service does not run both as service and console at the same
time.
To fix, stop both and then start either as a console or as a service.
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9.6.4 Naming of Final Clip Show from NRCS not appearing in Story
Recorder Ul

You have set up your NRCS to provide Viz Mosart with a base naming for your final clip produced
with Story Recorder, but the naming is not displayed in the Story Recorder panel.

Viz Mosart parses the MOS object corresponding to a story, and on the first primary story item
found in the rundown it will add the show final clip show given in NRCS.

Examine the underlying XML:
Do Ctrl + Shift + Alt + double click in the Viz Mosart Ul on the first story item in the rundown
to open this window and verify if the value given from NRCS is present:

12:57:19 02:00

SHOW NAME
(9

12:59:21 00:00 4 <item type="0" slug="SHOW NAME" source="1" index="9_SHOW.LAURA.SRDEMO_OCFEFA19_SHOWNAME_1" idref="1" templatetype ="BREAK" status="0" error="0" in="0" dur="100"
Cam 4 <fields>

inal_clip_name" va! "GAM news show - en"/>
I <item type="320" slug="PRUMIER" source="1" index="320_SHOW.LAURA.SRDEMO_OCFEFA19_PROMTER_-1" idref="m-1" templatetype="0" status="-1" error="0" in="0" dur="0" g
I <transitions value="MIX" rate="0" enable="True" mix_delay="0" default="true">

12:59:21 01:00

13:00:21 00:00
Clip - Pink
00:00

00:00
13:00:21 00:00 Copy to ClipBoard
If this is not present, here are possible causes:

The name is read from the first story in the NRCS rundown. Check the status of the first
story.

If for example it has been set to float, and is not displayed in Viz Mosart, you will need to
add the name to whatever story in the NRCS is now the first story.

If another story is Set As Next from Mosart Ul, then you will need to add the name to this
story in the NRCS which is now the first story.

If the Show Final Clip name was changed in NRCS during a Story Recorder session, this will
be taken into consideration only at the next Story Recorder session (disable Story Recorder
mode and enable again for a new show).

9.6.5 Unreliable genlock. See more details in AvAutomation status
bar

If this warning is shown in the Story Recorder panel while running a show or in pause mode, this
means that Viz Mosart detected problems in the configured clock source (refer to Frame Accurate
System Operations) and automatically fell-back to the internal clock source.
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Story recorder @8 On A\ Unreliable genlock. See more details in AvAutomation status bar.

™
(M) 9AM news show - en : Broadcast
‘-._.4/

LN

rusen  00:04:08:24 / -00:00:09

Item name Story name Start time Duration

<

_Yellow-Vox-TC-25fps-120s-AVC Intra 100 Clip split 10 parts 14

<

_Pink-Vox-TC-25fps-120s-AVC Intra 100 Clip split 10 parts 14:43:16

_Yellow-Vox-TC-25fps-120s-AVC Intra 100 Clip split 10 parts

<

_Pink-Vox-TC-25fps-120s-AVC Intra 100 Clip split 10 parts

<

_Yellow-Vox-TC-25fps-120s-AVC Intra 100 Clip split 10 parts

<

_Pink-Vox-TC-25fps-120s-AVC Intra 100 Clip split 10 parts

s 85 _f 8 B 0 B
<

_Pink-Lalala-TC-25fps-60s-iframe
Clip - Pink

Preroll (seconds):

The AV Automation status bar will also indicate that there is an issue with the selected clock
source:

il

ManusAdm Mirror MR | ACTIVE | TDB GENLOCEK (Raieyzes Info 10/4,/2021

Clock seurce: Internal (UTC). External genlock timeout. Switched to internal,
If the warning is shown infrequently, then the message can be safely ignored and the show can
continue as planned.

Viz Mosart has a built-in safety mechanism which takes care of intermittent or lost external
genlock and/or timecode signal (refer to section Genlock and Timecode Reliability in the
topic Frame Accurate System Operations).

If the warning appears frequently or it is persistent, the genlock signal and/or timecode signal
have become unreliable and must be fixed.

9.6.6 Genlock is not enabled

In the Story Recorder panel, this warning means the genlock has not be activated for Viz Mosart.
Refer to topic Frame Accurate System Operations for details on how to activate Genlock mode.

Story recorder @@ On A\ Genlock mode is not enabled.

9AM news show - en E Broadcast
00:04:08:24 / -00:00:09

ltem name Story name Start time Duration

I v _Yellow-Vox-TC-25fps-120s-AVC Intra 100 Clip split 10 parts
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Story Recorder can be used without having proper genlock setup and a timecode reader card
installed on the Mosart Server machine, but only for testing. In this case, the time of the day will be
used.

However, in order for Story Recorder to generate high quality final clip shows, frame accuracy is a
requirement.

9.6.7 Retake position no longer valid. Please set retake point

- This is a user error, described in the Viz Mosart User Guide , under topic Story Recorder
Mode.

9.6.8 Timeline can not be paused while pre-rolling

- This is a user error, described in the Viz Mosart User Guide , under topic Story Recorder
Mode.

9.7 Housekeeping

Viz Mosart automatically performs regular maintenance tasks to archive or delete working folders.
For Story Recorder operations, the following are important:

No management of local EDL folder (EdlLocalFolder, typically set to C:\MMLogs\EDL) and EDL
transcoder folder ( EdIWatchFolder).
See Enabling the Story Recorder Log Adapter.
Whilst these files are not large, they will require an occasional purging.
- Viz Mosart can perform some management of the clips generated during a Story Recorder
session.
Intermediate recording files, prefixed with the string specified in the config
RecordingClipNamePrefix (default SRVizrt) can be routinely purged from the video
server, after a time lapse defined in RecordingRetentionDays .
- When enabled, this task is run every time the service Mosart Server Log Service is
(re)started .
Default value for the number of days to keep files on the video server,
RecordingRetentionDays is 'keep forever'.

& Note: Recorded clips can be very large files, easily filling the disk space.
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10 AV Automation

AV Automation (MMAVAutomation) forms the bridge between Viz Mosart and the devices (for
example a vision mixer or video server) in the studio. It also controls full-screen
graphics (but not Overlay Graphics engines), which from a Mosart perspective, are treated as clips.

Overview
Menu Description
Logging and Status

10.1 Overview

R Viz Mosart - AV Automation | VIZRTV (SETUP 1) = m] X

HA K FM L2 L2
SOUND

Mmic1 mc2 MiCc3 MIC4 SKYPE1 SKYPE2 SKYPE3 SKYPE4  Zoom TEAMS GFX DDR1 DDR2 DDR3 DDR4 PLAY

= - - - i - - - - - - - - - - -

cam | came | cams | o= o= =] e | ern | ez | i | mestan | teams | zoom - aex2 | oom1 | ooz [ ooz [ oors [ wer | we | wes |

camt | camz "o | Te | T | Tw | Pt P122 | sryinin | Marshal | Teams | zoom | @Fx1 | oFx2 | DoR1 | DDR2 | DDR3 | DDR4 | MEt ME2 ME3

DSK'1 DSK2 DSK 3 DSK 4 I

1251:4539  Graphics engine 0 changed to NOT in USE . Video Ports
12514539  Got Vizcommand from dataelement FS dve - 2 Box - Clea... Video Switcher: vizrt-ips on bgo-viz DDR:vizrt-ips:5951
1251:4533  Graphics loaded 'FS dve -2 Box -Clean - ‘in enaine 1 Audio Mixer: vizrt-ips on bgo-vizrtv- -A: DDR:ddr1 @DDR 1
12:51:45.41 CUE@Q FULL1: 545 Graphics 1: VIZ bgo-vizrtv-ghen:6800 -B: DDR:ddr2 @DDR 2
125114541 Scheduling element /storae /playiists/{8788aa604af 4-466... Graphics2: VIZ bgo-vizrtv-ghen:6400 -C: DDR:ddr3 @DDR 3
1251:5769  Graphics engine Ochangedtoin USE Sound Player: bpo-vizrtv-sky -D: DDR:ddr4 @DDR 4
1251:5850  Graphics engine 0 changed to NOT in USE
12515850 Got Vizcommand from dataclement TS dve - 2 Box -Clea... WALL1:VIZENGINE bgo-vizrtv-wall:6100:6100
12515850  Graphics loaded FS dve -2 Box-Clean - 'in enaine 1
12:51:58.52 CUE@0Q FULL1: 545
1251:5852  Scheduling element /storae/plaviists/{8788aa60af4-4(6...
12534874  Graphics enaine 0 changed to in USE
12534955  Graphics enaine 0 changed to NOT in USE
12:53:4955  Got Vizcommand from dataelement 'FS dve - 2 Box -Clea... |
12:534955  Graphics loaded FS dve -2 Box-Clean - 'inenaine 1
12534956  CUE@0FULLI: 545
12:53:49.56 Scheduling element /storace/plaviists/{8788aa604af4-4f6... |+
va0.1.30847 [DCENENE| MirorBGO-VIZRTV-MOS2:8099 | MR | ACTIVE| TDB | TCR | Info 9/14/2020 3:0637PM -

The principal tasks for AV Automation are:

To Cue a clip (prepare) when in preview
To Play a clip when taken on air
To manage control commands to studio devices.

All device drivers are stored in AV Automation, offering the administrator a single point of
configuration.
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On the fly commands can then be issued directly to each device through the Viz Mosart GUI, or as
pre-programmed operations driven by the rundown submitted through the Newsroom System.

All device commands are stored as predefined Viz Mosart templates. They exist in the Template
Editor, and are saved in C:\channeltemplates or in a template database.

AV Automation is the device handler of Viz Mosart. This application communicates with all
connected devices such as cameras, video servers and vision mixers.

As well as presenting tools for configuring these devices, it includes Template Editor, for defining
and customizing templates.

H K FM L2 L2

Fader indication for audio
mixer. Allows user to set
fader levels

| eans | cauz | cams | cams | mvaa | mvse | maa | vaar | viaee | vase | vaer | me | Crosspoint indication for
[ ME1. Allows user to sat
crosspaint

Crosspoint indication for
PGM bus, Allows user to
| set crosspoint

Lia updsbed DSK onfoff buttons

Fsquesting reconnedt bo ManusAdmin: sdmin=False
Conneclion lo ManusAdmin sucoseded. admn=Tue Graphical: VIZ 192 168 100.100
- - - -hiliglize devices ----
Raquesting resn from ManusAdmin
Connection status
Connection indication for Mirrored window for Viz Connection status
Automation server, Media Router and Mosart controlled window for all video
Template Database devices, except video ports
l SEMVErS
Build 34314625 110314 VPO vieer | e | DB | Info
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10.2 Menu Description

% Viz Mosart - AVAutomation: NameOfGallery (Funcspec)

HA K FM 12 L2

Devices:
Preferences: Opens AV Automation Device Properties.
- Template editor: Opens Template Editor.
- A/V Setup: Opens Audio and Video Setup.
Record: See Recording.
Change password: Creates or changes the Other Template Functionality.
Show:
Show MVCP Control: Deprecated.
Instrumentation Panel: Opens the Mosart Instrumentation Panel.
Studio setups: Selects the template set to use for the current show. These template sets
are not available for selection:
- those marked as Hide from user
- the special template set DirectTakes.

& For more information on the concepts of template set, Directtakes, and direct take
templates, please refer to the Template Sets section in the Templates chapter in the User
guide.

Standby: Lists all configured devices and their connection status (Green: connected, Red: not

connected, Orange: standby).

Standby
A K FM L2 L2

From this menu, a device can be placed in Standby (or taken out of Standby).

(Standby means the device is not under control of Viz Mosart; no commands will be sent to

it from Mosart.)

The Viz Mosart operator can also perform this action from the main Ul. See the Viz Mosart
User Interface section of the Viz Mosart User Guide, under Main Menu, Standby for further

details.
Idle: This is an indicator that AV Automation is in idle mode, not a menu option. In this
state, the menu bar turns orange.
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ﬁ% Viz Mosart - AV Automation | NameOfGallery (Funcspec)

Devices  Show  Studio setups (Funcspec)  Standby Idle
HA K FM L2 L2

As long as AV Automation is not in idle mode, there is no 'ldle' in the menu bar.

10.3 Logging And Status

Below the fader and switch representations are three monitoring panels.

10.3.1 Logging Panel

To the left is a Logging panel with time stamped event details. Logging is disabled by default.

To Enable Logging
There are two options:

Right-click in the panel and select Enable
In Properties > Shortcut> Target, add the command parameter enable_logwindow.

!-] Mosart AV Automation Properties x
Security Details Previous Versions
General Shortout Compatibility

ﬁ Mosart AV Automation

Target type: Application

Target location: Mosart Server

Target: senvertMMAY Automation exe” enable_lngwindm‘.” ’
d

Logging will then be enabled at AVAutomation start-up.

To Clear Logging
Clear the Logging panel by double-clicking in the panel.

The following AV Automation topics are presented:

Recording

Audio and Video Setup
Template Editor

Mosart Instrumentation Panel
Newsroom Tags
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See Also

AV Automation Device Properties

10.4 Recording

Viz Mosart can instruct a connected video server to initiate recording.

& Note: The Story Recorder feature of Viz Mosart offers more versatile record-pause-retake
features, beyond the recording functionality described in this topic.
Please refer to section Story Recorder Mode.

Managing Recordings
Supported Video Servers

The video server must first be configured, as explained in the procedure To add a recording port
of Video Servers.

The configured video servers are displayed in AV Automation under Devices > Record.

& Note: Recording is also presented in the Viz Mosart Ul under Tools > Record
Graphics profiles (}  Standby | Tools

General settings

Keyboard shortcuts editor
Impeort shortouts from server
Edit rundowns

Arrange rundowns

Record
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10.4.1 Managing Recordings

To Start a Recording

1.

2.

3.

In AV Automation, select Devices > Record > Recorders > [ Name of recording port]
$ Viz Maosart - AVAutomation: MameOfGallery (Funcspec)

Devices
Preferences
Template editor
AV Setup

Record L m Recorders  » m STP:RECISTP:RECT
Change password

A Note: If several recording ports have been configured, the Recorders menu will have
several menu items.

In the dialog box, enter a file name that will make it simpler to identify your recording, as
shown in the example below:

Record STP:REC1STP:RECT n
File name
2021-02-14_Valentines Show Teaser Create Stop |
Click Create.

The appearance of the dialog box changes.
- The Create button changes to Record.

Record STP:REC1STP:REC n
File name
A021-02-14_ValentinesShow Teaser Record I Stop |
DK

- The commands that are sent in the background to the video server, are presented in AV
Automation's Information panel.

17:59:14 96 RECORDICreateClip) failed: 2021-02-14 ValentinesShow Teaser@5TP:RECT (8...
17:59:15.00 Executing cmd RECORD Prepare Rec1 2021-02-14 ValentinesShow Teaser
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4. Click Record.
The appearance of the dialog box changes once again.
- The Record button is greyed-out, leaving only the Stop button active.

Record STP:REC1STP:RECT n
File name
2021-02-14_ValentinesShow Teaser Stop

- The commands that are sent in the background to the video server, are presented in AV
Automation's Information panel.

18:00:38.18 RECORD{RecordChannel) failed: @STP:RECT (2 msk: 403 Unit/port STP:RECT...
18:00:38.18 Executing cmd RECORD Startt Rec1 2021-02-14 ValentinesShow Teaser

Recordings are stored on the video server's system. Exactly where, is dependent on the video
server type.

To Stop a Recording

To stop an ongoing recording,

Click Stop.

The commands that are sent in the background to the video server, are presented in AV
Automation's Information panel.
18:04:07.02 Executing cmd RECORD Stop Rec1 2021-02-14Valentines Show Teaser

10.4.2 Supported Video Servers

Viz Mosart is continually improved to extend the range of video server drivers that are supported
for recording.

Driver Supported since
Omneon 2010-01
Harris Nexio 2011-09
VDCP 2014-07
Quantel 2016-08
MVCP 2016-08
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Driver Supported since
Grass Vally K2 2016-09
AirSpeed MultiStream 2018-05

5.0

10.5 Audio And Video Setup

In the Audio and Video Setup menu, you can add the relevant audio and video channels and
configure their attributes. Viz Mosart relies on predefined video crosspoints entered into AV
Automation at initial installation and setup of Viz Mosart. A simple XML editor utility is used to
configure the settings in AV Automation.

- To open the configurations editor, from AVAutomation, select Devices > A/V Setup.

This presents all configuration values. You can filter a specific set of configurations, for example

video configurations, as explained below.

- Video Configurations

- Audio Configurations

- Template-driven Effects
Router Source Configurations
Router Destination Configurations

10.5.1 Video Configurations

- To work with just video crosspoint configurations, open the Audio and Video Setup XML
Editor and select Edit > Video config.

(A XML Editor file;///c;/channeltemplates/avconfigxml = =
File  Edit Video config
¥poirt name| Physical input| Audiclink Audiolink Ch 2 Input type Hide From User
3 EXT1 ﬂ ﬂ camera ﬂ [
LIVE2 ExTz2 ~| ~| camera | r
LIVE3 j j camera j N
LIVE4 ﬂ j camera j u
CLIP1 ﬂ ﬂ videoserver ﬂ [

- As a minimum, you should enter the crosspoint details: X-point name, Physical input and
Input type (where applicable).
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Settings

- X-point name: Name to use for the video crosspoint in the Viz Mosart system. This name will
be displayed in the Crosspoints drop-down menu in all Templates and in the ActiveX
application.

Physical input: Input on the video switcher. These are the physical inputs of the video
switcher.

- Audiolink: Audio fader to link to the video source when the video source is changed in the
Newsroom Control System or Viz Mosart GUI, enabling the audio faders to follow the video
crosspoints.

The drop-down menu presents Audiolink-values corresponding to the audio sources that
may be selected for a fader, alongside the selected input source, for example a camera.

- Audiolink Ch 2: Second audio fader link for the video source. The fader name that will be
used when enabling videoserver Ch2 in the Template Editor. When the video source is
changed in the Newsroom Control System or Viz Mosart GUI, the audio faders will follow
video crosspoints.

Should be used for audio mixers with mono-faders which cannot be coupled in the mixer.
Input type:
- camera: Select to assign this crosspoint as a camera type. This is used by the Audio
Panel application.
external_source: Select to assign this crosspoint as an external source. This is used by
the Audio Panel application.
- videoserver: Select to assign this crosspoint as a server channel.
GRAPHIC_1-5: Select to assign this crosspoint as a graphics engine.
ROUTER_RIPPLE_A: Select to use as router source A.
ROUTER_RIPPLE_B: Select to use as router source B.
Hide from user: Do not show crosspoint in AV Automation. This prevents the crosspoint
from displaying in the Crosspoint drop-down menu in Templates and the ActiveX
application. Default: Unchecked.
Comments: Only for useful setup notes, in this menu. Not visible or used anywhere else in
the application.
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10.5.2 Audio Configurations

- To work with just audio mixer configuration, open the Audio and Video Setup XML editor
and select Edit > Audio config.

(A XML Editor file:///c/channeltemplates/avconfigxml = =
File  Edit Audio config

E;ﬁ_lnenel Physical input | Micer name | Input type Initial level |Initial standby |Delay address C"E:ﬁg:fs
» [ - mic |80 r

MIC2 |2 mic ~| r

EXT1 |21 E)iEI'I‘lEﬂ_SDLI...j B

ExTZ |23 e:-iemal_su:uu...j [

TLF |7 tf ~| r

- As a minimum, you should enter Channel Name and Physical input.

Settings

- Channel Name: Name to use for the audio fader in the Viz Mosart system (LAWO EMBER+:
This must be the switcher fader name. If you are able to inspect the mixer's Ember+ tree by
using the Ember+ Viewer, it is the userShort label).

Physical input: For audio mixers that use fader numbers or MIDI assigned faders, this
number must correspond with the fader number on the audio desk (LAWO EMBER+: This
must be an integer).

Mixer name: A unique fader identifier, for audio desks that use fader names instead of
numbers.

Input type: For the internal Viz Mosart audio logic, the input type of the fader must be set.
This can also be done in the Template Editor.

Initial level: Desired level for the audio fader to obtain after a reload of the Viz Mosart
rundown.

Initial standby: Selects the faders that should not be reset at the start-up of the AV
Automation application. Default: Unchecked.

Delay address: (Lawo non-Ember+ audio mixer boards only) Gives the signal address for the
delay function.

Loudness channel: Defines the channel number for loudness level control.

10.5.3 Template-driven Effects

You can define effects in Viz Mosart that can then be recalled by a template. This avoids having to
recreate the effect in each template that refers to it.

Use the Effects table, which is then referenced during the execution of a template that has
specified an Effect name or Effect Nr.
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- To edit vision mixer effects configurations, open the Audio and Video Setup XML editor and
select Edit > Effects.

A XML Editor file;///c;/channeltemplates/avconfigxml = =
File  Edit Effects
Emem Emem Emem Mesd :
Efect Effect i Fader | Audio| GPO 3
name Mr Nr i Nr Nr Duration | RCC | cus delay | file Preview | P
Preview | Program | Cleanup delay
I 7 et - | 1 10 1 |20
Bmixdela.. |2 2 10 -1 20
!
< | 5

- An effect may perform various actions on the vision mixer, the RCC, the Audio player, the
GPO, and possibly other devices.

Note: When using an entry in the predefined Viz Mosart Effect table, the EMEM must
include the transition between bus A and B, since transition is not performed by Viz
Mosart.

Settings

Effect name: Name or description of the effect. Mandatory.

Effect Nr: Value of the effect assigned from the newsroom system. Used in conjunction with
Studio Setup to uniquely identify effects. Mandatory.

EMEM Nr Preview: Video switcher preset to recall when the template is taken in the preview.
Mandatory.

EMEM Nr Program: Video mixer preset to recall when the template is taken on the program.
Mandatory.

EMEM Nr Cleanup: This register will be recalled when cueing the next template. Use only if
the register used for the effect demands another "cleanup" register recall to prepare the
mixer for the next events.

Duration: Duration of the effect in frames. Will hold the triggering of the template following
the effect, for this amount of time.

RCC: Recall a Robotic Camera Control shot.

Next cue delay: Used to hold the cueing in the preview of the second template/element after
the effect. The number of frames entered will be in addition to what is already set as Min.
cue delay in the Video Switcher setup.

& Note: Next cue delay is ignored if EMEM Nr Program has a negative value!

Fader delay: Delay opening the audio effect fader (the Audio Player fader). Value is given in
frames. Ignored if this value is greater than Next cue delay.
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- Audio file: Viz Mosart can play an audio file on Audio Player synchronous with the mixer
effect. Specify the filename for the audio file here.

- GPO Preview: Send GPO # when entering Preview mode.

- GPO Program: Send GPO # when entering Program mode.
Macro Preview: Refer to the Text field in Recall preview in the Template Device Functions -
Macro Recall section.
Directtake: Number of Direct Take template triggered when performing an effect transition.
Often used to allow control of additional devices.
For example, this could be a direct take triggering a named overlay graphic or a direct take
with additional commands required by the vision mixer for this effect.

- Studio Setup: Specifies a specific studio setup for which the effect will be run. This attribute
is optional and is used in conjunction with Effect Nr to uniquely identify effects.
Macro Preview Action: Refer to the Drop-down description in Recall preview in the Template
Device Functions - Macro Recall section.
Macro Program Action: Refer to the Drop-down description in Recall program in the
Template Device Functions - Macro Recall section.

& Macro Preview Action, Macro Program Action: Load Project could affect the
performance of the switcher and should thus be used with caution during a running
show.

Macro Program: Refer to the Text field details in Recall program in the Template Device
Functions - Macro Recall section.

Effect Number and Studio Setup

Normally the effects are shared between all the studios/control rooms. But in some cases, a given
effect is required to function differently in one studio setup than another. This is achieved by
adding an extra entry for that effect, but with the Studio Setup that this effect is reserved for. The
rules for how this works are as follows:

- The combination of Effect Nr and Studio Setup must be unique within the Effects table.
Multiple effects can have the same Effect Nr, but these must have different values in Studio
Setup.

- An effect which has Studio Setup specified will only be executed for the corresponding
studio setup.

- An effect without Studio Setup specified will be executed for all studio setups that do not
have any dedicated effect specified.

Viz Mosart processes an effect in the following order:

- Search for an effect with given Effect Nr and with Studio Setup that matches the active Studio
Setup.
If no match is found, search for an effect with given Effect Nr and emptyStudio Setup.

If there are duplicate values of Effect Nr and Studio Setup the cell will be highlighted and an error
message will indicate the reason for the warning.

Copyright © 2022 Vizrt Page 195



Viz Mosart Administrator Guide - 5.0

File  Edit Effects
Effect name Eed Studio Setup
Non Additive Fade || 33 T3
Edge LtoR{H) 1 T2
Cur 1 The pair of values "Effect Nr" and "Studio Setup" is already in use. See section "Audio and Video Setup” of the documentation.
Flash 3
Fleside A

10.5.4 Router Source Configurations

Router source crosspoints can act as an emergency switcher if the vision mixer fails to switch.
Alternatively, a router switch can change a background wall source in the studio, or anything in

your production that requires switching.
To edit Router source configurations, open the Audio and Video Setup XML editor and select Edit >
Router sources.

XML Editor file:///c/channeltemplates/avconfigxml = =

File  Edit Router sources

Source name | Physical input

LIVE 2
LIVE 2
LIVE 4
LIVES
ADHOC 1

L L I

Router switches are predefined as part of a Viz Mosart template. Keyboard shortcuts can also be
programmed for a router switch to take place.

Settings

Source name: Name to use for the router source in the Viz Mosart system.
Physical input: Physical or virtual input to the router.

10.5.5 Router Destination Configurations

Router destination crosspoints can act as an emergency studio output if the vision mixer fails to
switch. Alternatively, a router destination could be a monitor in the studio, a transmission output,
or anything that needs switching as part of your production.

To edit Router destination configurations, open the Audio and Video Setup XML editor and
select Edit > Router destinations.
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B XML Editor file:///c;/channeltemplates/avconfigxml = =
File  Edit Router destinations

Destination Physical
name output

DMs.oo [

 |pwe.2 1
B_WEB_03 2
B_WE_04 3
B_WB_05 4

Settings

Destination name: Name to use for the router destination in the Viz Mosart system. This
name will be displayed in the router crosspoints drop-down menu in all templates and in the
ActiveX application.

Physical output: Physical or virtual output on the router.

Audiolink: Linked device

10.6 Template Editor

You create templates as part of your show design. Use the Template Editor to configure the Viz
Mosart templates.

From AV Automation, select Devices > Template editor.

$ Viz Maosart - AY Automation | MameOfGallery (Funcspec)

Devices

Properties Ctrl+P
| Template editor Ctrl+T

ANV setum Crl+|

Record cngoing show ]

Change password
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A new application window is displayed:

n Template Editor | Funcspec: JINGLE + 3 - O
File » Ternplate + Terrplate St « [

[ | Funcspec

| | JINGLE + 3

x

Sescnption Funcspe: | 0B

See also: Template Device Functions.

Several detailed template topics are presented in this section:

Working with Templates
Template Examples
Template Device Functions
Working with Template Sets
Other Template Functionality

10.6.1 Working with Templates

This section contains the following topics:

Template Operations

Template Properties

Control Commands in Templates
Destination Panel

Mosart Templates Feedback to the NRCS

See also: Linking Device Properties and Newsroom Tags.

Template Operations

To Add a Template

Viz Mosart Administrator Guide - 5.0

You can add a new template to the currently selected template set.

1. Select File > New template.
2. Enter the new Template Properties.

To Edit a Template

Select Edit > Template properties.

A Note: Template properties can also be accessed by right-clicking in the device's Function

area. See the table Template Properties.
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To Remove a Template

1. Select File > Remove template.
2. Confirm delete in the dialog box.

To Flatten a Template

You can push a new template, created in another template set (that was created using the
hierarchical approach), back to the originating template set.

1. Select Template > Flatten.
A dialog box displays which template set the selected template will be flattened to.

Ternplate Editor

Flatten template JINGLE+3 to template set Funcspec?

Yes Ma

2. Click Yes.

& Note: For a description of Hierarchical templates, please refer to Working with Template
Sets.

To Copy a Template

You can copy a template from one template set to another template set.

1. Open the template you want to copy.

2. Select Edit > Copy template.

3. Switch to the other template set, and then apply Edit > Paste template.
4. Select Edit > Paste to all to copy the template to all template sets.

Template Properties

This section explains the configurable fields on the General tab of the Template Properties menu,
clarifying the function of a Sequence.

Configuration Descriptions
Sequences
Recalling a Sequence from Template
Recall a sequence from a direct take template
Controlling a Sequence
Template Database Sequences
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Template properties

General lContrDI Commands ] Newsroom tags on:ler] Destination panel ]

Name

Variant Description IRD?r:::l{ t;L €l

I Default NCS variant

W Sendto NCS
-

N T

™ Take at planned story in-time

I Fixed Duration
™ Story Duration
-

[ Default TC in
I~ Default TC out

™ Sub Sequence

x| [START [

I” Use state variants

ENDE
START
START VERTICAL

[ o] [ed

’:_ Reset State 'T

00:00:00 Reset State After | 2 Stories

r [ =
=] ~

Viz Mosart Administrator Guide - 5.0

I Hide from user

Configuration Descriptions

Item

Name

Type

Variant

Description

Description

The name of the template. This value will only show in log files. English
language is preferred, for making it easier to understand log-files.

The different primary and secondary templates types are described in the Viz
Mosart User Guide, section Viz Mosart User Interface under Rundown Window

The variant is a unique name for the selected type, and should match the

value entered in the newsroom system.

Description of the template (optional). English language is recommended, for

future maintenance purposes.
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Item

Recall Nr (Direct
take)

Disable in
Rehearsal mode

Default TC in
Default TC out

Default NCS
variant

Send to NCS

Preload

Take at planned
story in-time

Fixed Duration

Viz Mosart Administrator Guide - 5.0

Description

(Applies only for templates in the Directtakes template set). One or more
decimal digits. If this direct take template is to be recalled from the GUI
using the numeric keypad, a maximum of three digits is allowed. (If more
than three digits are used, the template may still be executed using e.g. a
control command.) The number must be unique among all direct take
templates.

& Note: Avoid starting numbers with zero (). For example, use 56
instead of 056 .

(Applies only for templates in the Directtakes template set). The direct take
will not be executed when in Rehearsal Mode

This sets the template as the default variant for the selected type.

When selected, allow this template to show in the NRCS ActiveX.

When selected, enable the preview functionality for the Accessory template.
The Accessory template must have time code 00:00 for this to function.
Only valid for Accessory templates.

If you want a story to start at a specific time of day, you can add a template
with this option checked, to a story that has a set "hit time" in the NRCS. The
"hit time" must be included in the story data sent to Viz Mosart, and the
field-name must be mapped to back_time in Newsroomsettings. See Story
External Metadata.

Make the template always have the same length (overriding the time from the
NCS) in the Viz Mosart rundown. Select this option and enter the time in

mm:ss:ff (minutes:seconds:frames). This can also be combined with

Autotake to make a frame accurate continue to the next story. Remember to
write the whole number each time, you cannot edit a single character at a
time.
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Item Description

Story duration When selected, the duration of the template will be set equal to "story
editorial duration”, coming from the NRCS. The "story editorial duration”
must be included in the story data sent to Viz Mosart, and the field-name
must be mapped to story_duration in Newsroomsettings. See Story External
Metadata.

If more templates are added to the story, their duration will be in addition to
the "Story duration” template, so calculated total duration of templates will
be greater than "story editorial duration".

Autotake next (Available for primary templates only, cf. Type above.) When selected,
automatically perform a Take Next (F12) at the end of the template's
duration, with an offset as described in Offset below

Offset Set the offset when Autotake is enabled to adjust the Viz Mosart continue
action at the end of the event. The value is in frames. A positive value will
make the continue action happen later. A negative value will make it happen

earlier.
Sub Sequence See separate explanation below this table.
Sequence See separate explanation below this table.
Loop See separate explanation below this table.

Hide from user When selected, this template is removed from the template list in the Quick

Editor.
Use state Please refer to Other Template Functionality for explanation of state variants.
variants
Control If the template should have control commands attached, configure here.

Commands (tab) Please refer to Control Commands in Templates for further instructions.

Sequences

A sequence is a saved story (including primary and secondary items with relative timing
information).

Sequences are created in Viz Mosart GUI.
This is described in the Viz Mosart User Guide, under Operation, in section Creating Sequences.

Recalling A Sequence From Template

To recall a sequence from a template

1. Select Sub Sequence
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2. Select the Sequence to recall. (The available options are the sequence names saved to the
template set).

A For a direct take template, all sequence names, regardless of template set, are
eligible, see Recall a sequence from a direct take template.

3. If required, select Loop.

When a sequence is recalled from a template, actually only the secondary items of the first primary
item are recalled (but still with the same timing information that it had in the saved story
sequence).

Recall A Sequence From A Direct Take Template

To recall a sequence from a direct take template

Sequences may be recalled from direct take templates just as from other templates. However,
when taking a direct take template, a sequence will be recalled only if the current template set (at
that time) has a sequence with the same name chosen. (And then that sequence will be recalled.)

A Any take out logic might not work as expected if the direct take is not fired at the
beginning of the current main template.
When using direct takes with sequences it is recommended to recall them from a primary
template and not use them with keyboard shortcuts.

Controlling A Sequence

When a sequence has been started it can be controlled using keyboard shortcuts with Control
Command - SEQUENCE.

See table Command Values and Parameters, COMMAND SEQUENCE, Value LOOP, STOP_LOOP,
STOP, START.

Template Database Sequences

A A template database workflow does not support sequences.

Control Commands in Templates

A Mosart control command can be triggered from a template, executed when the template is taken
(Command On Take), at continue points (Continue Points) or when the template is taken out
(Command On Take Out).

Working with Control Commands
- Adding a Control Command
Command On Take
Continue Points
Command on Take Out
Command Values and Parameters
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Parameters with Placeholders

A Note:
A Mosart template can trigger multiple control commands.
A (not-templated) control command can trigger a Mosart template, often used for
a DirectTake template.

Working with Control Commands

This is done through AV Automation > Devices > Template Editor > Template > Properties >
Control Commands tab.

Template properties SEIEESI “* =

General Control Commands | MNewsroom tags orderl Destination panel |

¥ Command On Take r—Control is Take
Command Value P
’ D ~| PLAY_PAUSE ~| D
- j j
[~ Continue Points —Continue Points
Autotake | Command | Value | P D
. El

[~ Command On Take Out [~ Control command Take Out

=1l =]

[ Hide from user ﬂl il

The figure above shows a single (video) control command to be executed when the template is
taken. Multiple control commands can be assigned here.

It is also possible to assign control commands to be executed at continue points and when the
template is taken out.

The latter has limitation since the Parameter setting is not available. In this context it may be
useful to trigger a direct take at this place.

Adding A Control Command

To Add a Control Command
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Click the Control Commands tab in the Template properties window.

The three categories of control command are Command On Take, Continue
Points and Command on Take Out.

Refer to the table Command Values and Parameters for command details.

Template properties =

General Control Commands | Newsroom tags onder I

[T Command On Take —Control commands Take
Command | Value | Parameter

. -

[ Continue Points —Continue Points
Putotake | Command | Value | Parameter | Description

. -

¥ Command On Take Out [ Control command Take Cut

UNKNOW/N =] A =]
-[ONKNOWN n

AUTOTRANS
TAKE_SERVER_TO_PROGRAM

. SET_CURRENT_ME el | oK
[ Hide from user SET_CROSSPOINT

SET_AUX_CROSSPOINT
DVE

FULLSCREEN_GRAPHICS

Command On Take

When selected, the commands inserted in Control commands Take are executed when the
template is taken to Program or On Air.

By setting a Newsroom tag as a parameter in the OnTake-commands, the user can set the
parameter from the NCS. When the user is using the ActiveX to add a template to the rundown, a
text box is visible, requesting this value.
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When selected, the commands inserted in Continue Points will be taken when pressing TAKE NEXT
(default: F12). Viz Mosart executes this continue point from within the primary template in which it
is inserted. Each line represents a new Continue Point.

Cue Next Item Index: Enter the line number (for example, 0, 1, 2, 3) of the continue point
that executes a cue for the next/following Primary object. If empty, Viz Mosart cues when

entering the last continue point in the list.

- Autotake: Insert the autotake time, in frames. The control command continue-point is then
automatically taken after that time.

Command On Take Out

The commands inserted here are executed when the template is taken from the program, taken
Off Air, or at the end of the template. Only a single command can be used in Command On Take
Out, and it does accept any parameters.

Command Values and Parameters

A Note: Parameters marked with (*) do not work for templates.

& Note: It is not possible to enter a Parameter in the Control command Take Out section.

COMMA Value
ND

ACCESSO  TAKE_NEXT
RIES

AUDIO FADE_MANUAL

FADE_OUT_KEEPS

FADE_DOWN
SECONDARY_AUDI
0]

FADE_UP
SECONDARY_AUDI
0]

Parameter

*)

Fader rate

Fader rate

Fader rate

Description

Toggle fade manual.

Faders that are set as "keep level" in the
template On Air are faded out. Will also work
when new templates have been taken in
between the 'keep' action and

the FADE_OUT_KEEPS.

Viz Mosart fades down relevant audio sources
not connected to the video currently On Air.

Viz Mosart fades up relevant audio sources
not connected to the video currently On Air,
when cutting between sources.
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COMMA Value Parameter Description

ND
SET_LEVEL_2_ONAI - The second level for faders in the template
R which are On Air are set.
SET_LEVEL_2_PREVI - The second level for faders in the template
EW are set on the template which is in preview,

and be performed on next transition.

FREEZE_AUDIO - All sound faders are frozen, and do not
respond to commands from templates. This
command is a toggle function, and is thus
NOT suited for use from a template.

AUTOTAK N/A *)

E

AUTOTRA PP, MET, MEZ2, MixEffect (MIX For example: MIX 33, WIPE 10.
NS ME3, ME4 OR WIPE) +

Transitionrate & Note: The Effect cannot be used.

AUX, Default ™)
CROSSOV  N/A *)
ERCOMM
AND
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COMMA Value Parameter Description
ND

DEVICE_P CAMERA CONTROL  See next o _
ROPERTY column. & Note: This is for camera robotics.

The 'DEVICE_PROPERTY' control command
with value 'CAMERA CONTROL' is only used as
a way to set speed (Camerobot) and presenter
(Camerobot/FxMotion) from a template.

Details for Camerobot Presenter:

ANCHOR=pos1:presenter1[,pos2:presenter2]

The position and presenter is given as a pair
divided by ‘.

Multiple position-presenter pairs are possible,
separated by ‘,’.

Template properties
General  Control Commands | Newsroom tags order | Destination panel

[ Command On Take Control commands Take

Comman: d Value Farameter
~ | DEVICE_PROPERTY _v||CAMERACONTROL || ANCHOR=PostionX1:SizeX1]

& Note: The position is a string and
does not have to be a number.

Details for Camerobot Time:

If Time =1 (>0), Viz Mosart sends
MATRIX_MOVE_MPOS command to
Camerobot,

while if Time = 0 Viz Mosart sends
MATRIX_CUT_MPOS command Camerobot.
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COMMA
ND

DEVICE_S
TANDBY

DEVICE_S
TANDBY

Value

AUDIO

AUDIO_MIXER, GPI,
LIGHTS,
LOUDNESS,
ROUTER,
SOUND_PLAYER,
SUBTITLING,
VIDEO_SERVER,
VIDEO_SWITCHER,
VIDEO_WALL,
VIRTUAL_SET,
WEATHER

GRAPHICS (full-
screen)

Parameter

demands
<fields>
structure as
parameter wit
h
parameter1=A
uDIO,
parmeter2=ke
Y,
parameter3=v
alue

OR
connectionstri
ng style

ON
OFF
TOGGLE

As above (ON/
OFF/TOGGLE)

OR

engineno:[ON]|
OFF|TOGGLE]
(Example:
2:TOGGLE)

Copyright © 2022 Vizrt
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Description

& Note: This is for an audio mixer.

ON: The device chosen (in Value) is put in
Standby.

OFF: The device chosen (in Value) is taken out
of Standby.

TOGGLE: The Standby status (ON/OFF) of the
device chosen (in Value) is toggled.

(If there are several devices of the chosen
kind (e.g. video servers), all of them are
affected.)

ON/OFF/TOGGLE: As above, applied to all
graphics engines.

If an engine number is given, only the
designated engine is affected.
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COMMA Value
ND

DEVICE_S ROBOTIC_CAMERA
TANDBY

DEVICE_S OVERLAY_GRAPHIC
TANDBY S

DIRECTT  The Recall Nr (see

AKE Template
Properties) of the
direct take
template to
execute

DVE FORWARD
REVERSE

Parameter

As above (ON/
OFF/TOGGLE)

OR

controller:
[ON|OFF|
TOGGLE]
(Example:
1:0N)

OR

controller:cam
era:[ON|OFF|
TOGGLE]
(Example:
1:2:0N)

As above (ON/
OFF/TOGGLE)

OR

Engine No:
[ON|OFF|
TOGGLE]

For example:
2:TOGGLE:
Toggles
Engine 2
Standby
status)

Recall
forward/
reverse EMEM

Viz Mosart Administrator Guide - 5.0

Description

ON/OFF/TOGGLE: As above, applied to all
cameras on all controllers.

If a controller (but no camera) is given, only
the cameras on the designated controller are
affected.

If both a controller and a camera is given,
only the designated camera is affected.

ON/OFF/TOGGLE: Applied to all overlay
graphics (all controllers and corresponding
engines).

If an engine number is given, only the
designated engine is affected.

& Note: Only engine number is
supported.
Engine numbers are shown in the list
of active engines in Overlay Graphics
Interface and followed by '/' and
destination name of the engine.

(Engine Handler, Destinations,
Controller have no effect).

Executes the direct take template given by
Value.

n/a
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COMMA Value Parameter Description
ND

ENABLE. n/a (*)
GRAPHIC

S_

MIRRORI

NG

FULLSCRE CONTINUE_FULLSC AUTO Continue Command Only: The AUTO
EN_GRAP REEN parameter will replace the continue command
HICS with the number of continue points in the
graphics item.
The number of continue points is taken from
the graphics_continuecount field.

Examples:

AUTO+1: The number of continue counts from
the graphics + 1

AUTO-2: The number of continue counts from
the graphics - 2

FULLSCRE CONTINUE_FULLSC Engine no The target output fullscreen engine number to
EN_GRAP REEN execute the action on. (e.g. 1,2,3)
HICS
MACRO Engine no : The target output fullscreen engine number to
macro execute the action on. (e.g. 1,2,3 ) and Macro
name.

The engine number must be same as the
number defined in AV Automation

GRAPHIC  N/A
SPROFILE

HOLD_AU N/A
DIO_

TRANSITI

ON

HOLD_VI  N/A

DEO_

TRANSITI

ON

LIGHT N/A (*)
MARKER  N/A (*)
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COMMA Value Parameter Description
ND
NCS START_STATUS, RUNDOWN Specific for Open Media
STOP_STATUS STORY
ITEM
NEXT_CU EXTEND A number of If there is a pending cue (when this control
E_DELAY frames command is executed), this cue is postponed

by the number of frames given.

Otherwise (no pending cue), the next cue
operation will be additionally delayed by the
number of frames given. (l.e., the value will be
added to the sum of the settings

Min. Cue delay in AV Automation Devices
Vision Mixer

Next cue delay in Audio and Video Setup,
Vision Mixer Effects Configurations,
Settings (if an effect is involved)).

OVERLAY CLEAR Destination or Destination or Render (Engine no.) to clear the
_GRAPHI Render graphics from.
CS (Engine no.)

Numerical value: Render (Engine no.)

Non-numerical value: Destination.
CONTINUE Engine no

TAKE_MANUAL_OU Destination or Destination to take out the graphics from.

T Empty Non-numerical value: Destination
Empty or Numerical value: Takes out all the
graphics
MACRO Engine no : For example: 4:macrohere
macro

PRETAKE_NEXT_OV Render
ERLAY (engine no)

TAKE_NEXT_OVERL (¥)
AY,

TAKE_NAMED_OVE
RLAY
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COMMA Value
ND

OVERLAY Parameter 1:
_TO_MAN ONAIR (default),
UAL PREVIEW.

PLAY_.ST N/A
ORY

RECORD  PREPARE,
START,
STOP

RELEASE_  N/A
BACKGRO
UND

RUNDOW  N/A
N_NCS_
RESYNC

Parameter

Parameter 2:
Comma-
separated list
of handler
names

Parameter 3:
AUTOMATIC
(default) /
MANUAL

Parameter

2 and Paramet
er 3 must be
separated by
a semicolon.
(E.g.
WALL,DSK;MA
NUAL.)

(*)

Split
parameters
using,

- first:
clipname,

- second:
recorder
(optional),

- third: port
name (default
Reo),

- fourth:
group name
(default Rec)

(*)

Viz Mosart Administrator Guide - 5.0

Description

For more details, see Viz Mosart User
Interface > Keyboard Shortcuts > Control
Command Keys > OVERLAY_TO_MANUAL in
the Viz Mosart User Guide).

& Note : If there is no semicolon after
Parameter 2; nothing to the right of
the semicolon; or Parameter 3 has any
value other than 'MANUAL', then
Parameter 3 gets the default value
‘AUTOMATIC’.

For example: clip33,recorder1,Rec,Rec
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COMMA
ND

SEQUENC
E

SET_AUX_
CROSSPO
INT

SET_CRO
SSPOINT

SET_CUR
RENT_ME

SET_VIDE
OSERVER

SALVO

STUDIOSE
TTUP

Value Parameter

LOOP

STOP_LOOP

STOP

START

N/A (*)

PP, MET, ME2, bus (A,B,C,D) :

ME3, ME4 xpoint
AUX
Default

PP, MET, ME2, (*)
ME3, ME4

AUX
Default

N/A (*)

#

Viz Mosart Administrator Guide - 5.0

Description

Sets a running sequence to start looping

Stops running a looped sequence in loop
Stops a running sequence

Restarts a previously stopped sequence

If layers are supported by the driver (e.g.
vizrt-ips) it is possible to also specify the layer
(A,B,C,D) in addition to the crosspoint.

Two arguments are supported separated by
semicolon. First parameter is crosspoint, the
second is layer.

If no semicolon is used the value is
interpreted as crosspoint only and bus A is
used.

Example: B:CAM2

Not implemented for templates
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COMMA
ND

SWITCH_
GRAPHIC
S_
MIRRORI
NG

SWITCH_
VIDEOSER
VER_
MIRRORI
NG

TAKE_CO
NTINUE_P
OINT

TAKE_SER
VER_TO_
PROGRA
M

TRANSITI
ON_TYPE

UNKNOW
N

VIDEO_P
ORT

VIDEO_SE
RVER_GO
TO

Value

TOGGLE,
ACTIVATE,
DE-ACTIVATE

N/A

N/A

N/A

CUT,
MIX

EFFECT

TOGGLE

N/A

N/A

N/A

Parameter

transRate
(integer) -
parameter.

(*)

Rate

Effect no

(*)

Must be a
comma
separated list
in the format:

command,por
t,parameter

(*)
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Description

Not implemented for templates

Takes a video server port to program on a
selected ME. For example: a video clip is
running on a video wall.

The shortcut can then be used to take the last
used/active video server to program.

Default fallback. Does nothing.

For example: PLAY_PAUSE,A,PLAY.

For more details, see Viz Mosart User
Interface > Keyboard Shortcuts > Video Port
Control Commands > OVERLAY_TO_MANUAL
in the Viz Mosart User Guide).
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COMMA Value Parameter Description
ND

VIDEOWA N/A (*)

LLMODE

WEATHER N/A (™)

Parameters With Placeholders

Control command parameters can include placeholders which are then populated with values
found among the fields of a currently On Air, Viz Mosart item. A placeholder is defined as a string

of characters, within curly brackets {placeholder}.
For example, a placeholder can be useful for transmitting values from the NCS, for use as control
commands that will be executed when the template is taken On Air.

Example: Providing the clip name to be recorded from NCS.

In NCS, a column can be created for giving the name of the clip to be recorded with Viz Mosart.
Then, in Viz Mosart Newsroom settings, map the column in Story External Metadata as follows:

Story External Metadata

<mostag mostagname="NCScolumn" mosart_action="1item_variable" action_value="NCS_filena
me" format_type="String" />

In Manus file, the Mosart item will have the following fields (the value Clip1 is given from NCS):

Mosart Item

<fields>
<field name="NCS_filename" value="Clipl" />
</fields>

Then, in Template Editor, the control command for the respective template is configured as
follows:

Control Command

RECORD PREPARE {NCS_filename}_Test,Recorder,RecPort

When the template is executed, a clip with name Clip1_Test is prepared for recording.
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Destination Panel

In the Destination panel tab, you can create rectangles that are then available in the Viz Mosart Ul
for assigning sources to newsroom tag destinations, while the template is in preview or program.

Press Add to add the selected target area.
The target areas are displayed in the Viz Mosart Ul as drop down boxes. They become
clickable if a source or shortcut is selected by the user.

Template properties

General ] Cortrol Commands | Newsroom tags order  Destination panel l

Destination: right - Add Remove Image | Browse..

@ [Dirag the edges of the area to resize or dick and hold to move it.

I Hide from user Cancel 0K

See also section Program Window in the Viz Mosart User Guide.

Mosart Templates Feedback to the NRCS

You can send Mosart templates as MOS objects to an NRCS. The MOS object can then be used by
an NRCS operator to insert the detailed Viz Mosart item (rundown event) as a program cue into
their rundown (some users call this a “brick system”).

This is an alternative to the Mosart ActiveX, and is the basis for the Viz Mosart web-based
application, NRCS Plugin.

In addition to MOS objects that contain Viz Mosart primary template details, a special MOS object
can be sent, containing lower third information.

Template Properties Menu

Working with Templates as MOS Objects

Sending Viz Mosart Template Content to the NRCS
MOS Object Containing Lower third Information
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- Usage Notes
Hierarchical Template Support
Detailed Description of MOS Objects

Template Properties Menu
You can view and modify the properties of a selected template.

In AV Automation, select Devices > Template Editor > Template > Properties.

INE
' lﬂl.l'l'E 1
1RUTE 2
_ |1 RuTE 3

Working with Templates as MOS Objects
Enabling The Template-To-MOS Object Feature

You enable the features described in this section from the Viz Mosart Administrator (MOS version)
Settings menu.
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Settings Parameters
Value Description
TemplateToMosObject Used to send templates to NCS through MOS

GenerateUniqueObjectid

Copyright © 2022 Vizrt

communication.

Enabled: Enables sending templates to NRCS through
MOS communication

Default: Enbaled

Some NRCSs (for example, OpenMedia) use objld to
identify a template.

True: The MOS object objld is sent to the NRCS as the
channel template ID , defined as GUID.

False: When GenerateUniqueObjectld is false and
- GroupedByType (see below) is false, objld is set to the
value of the TemplateSet-Type-Variant.

- GroupedByType is true, objld is set to the value of the
template type.

& Note: objld is unique among the templates from
the same gallery. If the same

channeltemplates file is used from two

different galleries, MOS objlds are no longer
unique.
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Value Description

GroupedByType Use to send all template types as one MOS object, with
the variants embedded in the objects from the default
template set.

- The SendAllTemplateSets property must be set to
false.

- The default template set must first be defined in

- AV Automation: Devices > Template Editor > Template
Set > Set As Default.
If the SendAllTemplateSets property is set to true, a
MOS object for each template type (with the variants
embedded in the object) is sent for each template set.
If no default template set is set, then no template will
be sent to the NRCS.

True: objld is set to the type of the template.
False: Send all template variants as separate MOS objects.
Default: True

MergedClips Use this option to merge only the clips from the default
template set, regardless of the value of
SendAllTemplateSets.

True: Send all PACKAGE and VOICEOVER templates as a
collection of type “CLIP” to the NCS using the NEWT or
UPDT commands in the Manus Admin console.

This property has to be used together with
GroupedByType (see above).

- The default template set must first be defined in AV
Automation: Devices > Template Editor > Template
Set > Set As Default.

If no default template set is set, then no template will
be sent to the NRCS.

Default: true

See Appendix section Structure of MOS objects sent to
NRCS for details about the MOS object structure when
merging clips.

SendAllTemplateSets Use to send templates from all template sets to the NRCS.

- The default template set must first be defined in AV
Automation: Devices > Template Editor > Template
Set > Set As Default.

False: Send only the default template set.
Default: False
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Value Description
TemplateChangeWanted Use to decide whether templates changed are updated in
the NRCS.

- When a template is changed or deleted on the Viz
Mosart side, the NRCS will only receive an update if
- mosReqObijList/mosRegAll (from the NRCS) or
- NEWT or UPDT (from the Viz Mosart Manus console)
has been executed at least once since Viz Mosart
Manus console was started.

- Only a template checked in the field Send to NCS (in
the Template properties menu), is sent to the NRCS.

True: Always receive updates.

Sending Viz Mosart Template Content to the NRCS
There are two ways to send Mosart templates to the NRCS:

1. Requesting from the NRCS using commands like
a. mosReqObijList
b. mosReqAll
c. mosReqObj <objld>
2. From the Viz Mosart Manus console, using commands like:
a. NEWT: Send the Viz Mosart templates to the NRCS as MOS objects with status NEW.
b. UPDT: Send the Viz Mosart templates to the NRCS as MOS objects with status

UPDATED.
c. DELT: Send the Viz Mosart templates to the NRCS as MOS objects with status DELETED

(meaning that the templates will be deleted).

(v) - To see samples of the corresponding MOS XML code, see section Detailed
Description of MOS Objects below.

& Note: You can also use the new Viz Mosart NRCS Plugin to quickly drag and drop the
underlying MOS object details of a selected Viz Mosart template, directly into an NRCS
rundown.

Caching MOS Objects For Sending To The NRCS
All the MOS objects corresponding to the templates sent to NRCS are saved in a cache file
MosTemplateCache.xml under %localappdata%\temp\Mosart Medialab\MOS State.

This file is created or updated when Viz Mosart Administrator (MOS version) is started.

Troubleshooting
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This file is useful when troubleshooting, enabling you to verify exactly what MOS objects have
been sent to the NRCS.

You can delete it, then perform a fresh request of the templates, using a NEWT command.

Ignoring The Templateset Attribute For A Viz Mosart Item

When sending all Mosart templates to the NRCS (SendAllTemplateSets is true), an attribute
templateset is set inside the MOS object.

This attribute is used internally to identify which Viz Mosart template set the type and template
type (variant) shall be used.

When a rundown is later loaded in Viz Mosart, the NRCS returns the MOS object with
this templateset attribute set.

Example

1. You change the studio setup in the Viz Mosart Ul by selecting another Template Set (the
active template set) which contains some of the variants used in the previous template set,
but with different properties (e.g same CAMERA 1, but with different crosspoints)

2. The item from the template set referred to by the attribute templateset will be executed,
instead of the item from the new, active template set.

3. To get round this, you can instruct Viz Mosart to ignore the templateset attribute (by setting
it to an empty value) from a MOS object coming from NRCS.

Now the Viz Mosart item from the active template set will be executed.
a. Do this by adding a mosid tag with value MOSART in newsroomsettings.xml with a
keyword set to IgnoreTemplateSet:

<tag name="some.mosid" value="MOSART" appendContent="false"

fieldMapping="false" keywords="IgnoreTemplateSet=true"/>
or
<tag name="some.mosid" value="MOSART" appendContent="false"

fieldMapping="false" keywords="IgnoreTemplateSet"/>

MOS Object Containing Lower third Information

For graphics, please refer to section Sending Lower Third Graphics MOS Object to an NRCS.
- The corresponding MOS XML code is presented in Detailed Description of MOS Objects.

Usage Notes

Automatic Sending Of Viz Mosart Templates To The NRCS

Templates are automatically sent to the NRCS whenever Manus Admin on the Viz Mosart server is
started/restarted if Template feedback to NCS is enabled in the Manus Admin settings and
TemplateChangeWanted is set to true.

In this case, Viz Mosart will send:

- All templates from all sets if SendAllTemplates is true.

- The templates from default template set, if SendAllTemplates is false and a template set has
been defined as default.
No templates, if SendAllTemplates is false and no template has been defined as default.
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See the Settings Parameters table above.

Creating And Modifying Templates

- When a new template is created or an existing template is changed
- The template set attribute is defined in the MOS object
<objGroup> is set to the template set that the template belongs to.
On the NRCS side, the template is stored in a folder named after the template set.
- When a template is changed or deleted, the NRCS will only receive this update when either
the commands
- mosReqObjList/mosRegAll (from the NRCS) or
- NEWT or UPDT (from Viz Mosart Manus console)
are executed at least once since Viz Mosart Manus Admin was started.
- To always receive these updates, set TemplateChangeWanted to true.

& Note: When GroupedByType is set to true, deletion of templates is not handled.
Execute UPDT in the Viz Mosart Administrator console or request the
templates from the NRCS for update

Hierarchical Template Support

The template feedback to NRCS functionality partially integrates with Hierarchical Templates,
supporting the two operations

1. Requesting a single template set
2. Requesting all template sets

from a gallery with hierarchical templates.

A Note: The management of a template set (NEW, UPDATE, DELETE a template) is not
supported.

Example

Assume the following template sets:
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&

FY

Tl has templates P1, P2, P3

T2 is based on T1 and

» pverndes P1 (keeps same type and vanant, but different content)
s (2 is based on P2, but since the variant (or the type) is changed to C2, then this

becomes a new lemplate in T2 with nd relation o P2 n T1

s inhernts P2 and P3

T3 is based on T2 and

& DVE ies P11 (Keeps same type and vanant, but different content)
s inhents P2 and P32 from T1 and inhents C2 from T2

If template set T1 is requested, then P1, P2 and P3 are sent.

If template set T2 is requested, then P1 and C2 from T2 and P2 and P3 from T1 are sent.
If template set T3 is requested, then P1 from T3, C2 from T2 and P2 and P3 from T1 are

sent.

Detailed Description of MOS Objects
See the Appendix for code-level descriptions of

MOS Objects with Mosart Templates Grouped by Type
MOS Object with Mosart Templates not Grouped by Type
MOS Object with Clip Templates Merged in a Mosart Template
MOS Object with Lowerthird Information
- Octopus

10.6.2 Template Examples

This section contains the following examples:
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Studio

Video Clip with Full Sound
Voice-over

Live External Source

DVE

Full Screen Graphics
Accessory Templates

Studio

The template for a typical studio camera is based on the CAMERA type. The example below defines
a standard camera 1 variant. An entry named CAM 1 in the video setup is selected at the PP bus
cross point. Transition duration is 0 frames (hard cut) and E-mem recall is disabled. There is only
one studio microphone, which fader is called "A Mic 1" in this template. Audio level is set to 0 dB,

and the input device is a microphone. The input device type is important for the handling of audio
in an ad lib sequence of full camera, DVE and full external source.

E% Type: CAMERA Variant:1 |:||E g|
File = Edit = Show = Test Template
Bl
1]
wpoint | smemnr_pr
FemoweFader
Fader byvpe 3
Link 3
Keep level
Fade up in preview
Inpuk device J | video server
Crossfadetime * Video server Ch2
External Source
Mic ||
- I Telephone
1] Soundplayer

Template set (Evening news)

For our standard camera 2 variant, the only difference in the above setup is the PP bus cross point
which is called CAM 2.

Video Clip with Full Sound

As crosspoint on the vision mixer, we use a source called S_RIP, which means Viz Mosart uses the
A/B roll and roll between the sources defined in the AV setup as videoserverA and videoserverB.
We chose RIP_C1 as the audio source, but as long as A/B roll is enabled, any source defined as
Video server follows the video source. The default transition is a three frame mix. The video
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channel control is also enabled and controls the clip. The server channel is automatically assigned
within the automation.

F® Type: PACKAGE Variant:SOT M=E
File = Edit = Show =  Test Template

channel

®point | =memne_pr RemoveFader
Fader bype »
Link 3
Keep level

Fade up in preview

Input device » |[ « | Viden server ||

CrossFadetime » Yiden server Chz

Exkernal Source
Mic

- I Telephone

Soundplayer
Template set (Evening news) 5 |

Voice-over

In this example, the variant VO is defined. Notice the difference from the two last examples and
the two fader setups. A Mic 1 is microphone input type and RIP_C1 is video server type.
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F® Type: VOICEOVER Variant:VO M=E

File = Edit = Show =  Test Template

channel

wpoint EMEMmnr_{r —_—

Template set (Evening news)

A second sound level can be set for each fader by using the SHIFT key over the fader to set the
second level. This second sound level for all faders is used as the start level for the voice over

sound bite type. The same special variant logic for video clip with full sound applies for the voice-
over type.

Live External Source

Live external source variants are typically defined by their corresponding vision and audio mixer
inputs. In the example below, we define variant 1 as source MW 1 on both PP bus cross point and
audio fader.
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E® Type: LIVE Variant:1 |Z||E||E|
File = Edit = Show =  Test Template

ol
1

Xpoint s ememnr_pr

RernoveFader

Fader bvpe 3
Link 3
keep level

Fade up in preview

Input dewice » | Yideo server

CrossFadetime ] Yideo server Ch2

| ¥ | External Source |I

Mic

- I Telephone

] Soundplayer

Template set (Evening news) _:EI

Additional variants 2 to 9 would typically use MW 2 to MW 9 as sources for both video and audio.

DVE

The example below describes four setup steps necessary to create a template that recalls a
predefined E-mem (emem number 10) defining a split screen DVE on M/E 1 on the vision mixer.

1. E-mem Recall Definition

The vision mixer effect uses key 1 and key 2 on M/E 1 as left and right split windows.
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ol
1

xpoint  ememnr_pr

E Recall
n E Recall

: in_pp
IF_PFEYIERW

Template set (Evening news)

The PP bus cross point is set to ME1 (program output of mixer effect). The E-mem recall control is

defined to recall emem 10 when the template is taken to preview.

2. Key bus Delegation Setup

Default crosspoints are chosen (CAM 2 and MW 1) and since a newsroom tag has been added for

both keys, the crosspoints can be set from the newsroom system.

Right click over the XPOINT window to add a newsroom tag. In addition, the template defines a

recall of a graphics background
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£® Type: DVE Variant:SPLIT

File = Edit = Show = Test Template

Graphics

! Key 2 KPOINT  AUDIOLINK  MIXEFFECT  KEY SETDELAY [~~~ [
CAM 2 M T | Il none - MET A | | i

Al
1

wpoint EMmEmnt_pr

&dd Mewsroom bag ||

Remove Mewsroom tag

Template sefk (Evening news)

The second key bus delegation is shown. As a default we assign CAM 2 to key bus 1 and MW 1 to
key bus 2 on the MET mixer effect bus.
(This assignment can be overridden from the NRCS story element by using the newsroom tag).

3. Audio Linking
The audio link is set to 1 for both the key 2 delegation and the second fader (MW 1).
[ Type: DVE Variant:SPLIT

File = Edit = Show = Test Template

: RemoveFader
*p oint EMEMnr_fr
Fader bype 3
Lirk, 3 | none

Keep level 1

Fade up in preview z

Input dewice 3 3

CrossFadetime 3 4
- |~ |

Template set (Evening news)

When using the newsroom tag to set key 2 to a different source (for example MW 3), both video
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and audio delegation will follow:
This leads to the key 2 source being set to MW 3 and the second audio fader being set to MW 3.

4. Graphics Engine Data Element Setup

£® Type: DVE Variant:SPLIT

File = Edit = Show = Test Template

EMGINE DATACOMMECTION COMTEMT SOURCE SCEMEMNAME
1 *  aygtemndefault *  dataconnection -
1 [ I

TEXT CONTWITHDVE USEVCP [ _—
| | r r

wpoint EMmEmnt_pr

Template sk (Evening news)

Setup of the graphics controller is described in the next section.

Full Screen Graphics

The graphics controller in the Template Editor is vendor-specific, due to the lack of a generic
control API. As a general feature, it can control multiple graphic engines. A typical controlled
cluster could for example be, one for full screen graphics, one for studio wall graphics and
additionally, an overlay CG engine. For DVE effects, this can be a fixed element, while for
telephone graphics or maps the element name and data are provided in the NCS story.

The controller's task is to cue graphics when taken to preview and run them when taken to
program.
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o Type: GRAPHIC Variant:head1fs

File = Edit = Show =  Test Template

EMGIME DATACOMMECTION COMTEMT SOURCE SCENEMAME
1 +  spsterndefault T FEWSTOom - | 00 | |_
Bl |— I

4 TEXT COMTWITHDWVE — LISE WCP
xpoint ememnr_pr | I — o o ok Fance!

Graphics

Add Mewsroom kag |

Remove Mewsroom tag

Template set (Evening news)

Accessory Templates

In this example you create an accessory template for driving content to a video wall driven by the
Template Router feature in Viz Mosart. this feature merges new template-based instructions onto
an existing one, enabling, as in this example, an asset to be diverted to the video wall. You need a
separate accessory template for each wall that will be controlled. The accessory template can
contain settings for cross points, video server port, graphics engine and aux.

Creating the Wall Accessory Template
The wall accessory template is created as a standard template.

You can create a new accessory template with a variant name of for instance "wall2".

Switcher Cross Point

To change switcher crosspoints enable Switcher crosspoint in the Template Editor.

The Switcher XPoints appear.

Here you can set the ME-step you want for the wall taken template.

When the template is set to the wall item it will use this ME step instead of the one specified
in the template.
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“Crosspoint 1

Mix Effect 1 Crosspoir
MET '+ | [none

FF Crosspoir
ME1

ME2 |

ME3

M_RIP
M OTH fold

hlise Maal=sas Il'!
The ME-step will show as a mix effect in the Template Editor.

SW Input
name SWInput
xpoint Cameral

ME4

i)

mix_delay
mix_delay_out

audiolink

delay _transitiononly
index

dsk_off

dsk_2 on
dsk_2_off_delay

Video Server Port

If a video clip is wall taken; another video server should be used.

This can be changed in the accessory.

channg
A

MIX NONE

0 A
xpoint  |ememnr_pr |3 - ‘W

Make sure the video clips are available through this port.
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AUX

- The AUX is controlled by the template but should be added to the accessory template.
The setting will be replaced by the wall taken template.

Graphics

- To avoid conflict with other graphic elements, you may want the wall to run on its own
engine. This can be changed in the accessory.
A wall taken graphic element will then use this engine.

channd

ML

| vI Engine
:

0
Xpoint=memnr_pr g Content Source
4
1/2
4

10.6.3 Template Device Functions

This section lists a selection of device properties:

- Working with Device Functions

- Video Switcher Crosspoint

- Video Switcher Transition

- Video Switcher Register/Timeline Recall
Macro Recall

- Video Switcher Auxiliary Bus Delegation
Keyfill: Video Switcher Key Bus Delegation

- Video Server

- Graphics

- Video Wall Register Recall

- Audio Player

- Virtual Set

- Robotic Camera Control

- GPO
Light Control
Router Control

- Audio Settings (General)

- Testing a Template
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Right-click inside the device function area to open a menu containing the following options:

To Enable Device Functions
1.

Enable: These commands are described in more detail below.
Template properties: Opens the current template's properties page, see Template Properties
in section Working with Templates.
Clear devices: Removes all devices from the device function menu, after confirming in a pop-

up message window.

Apply device settings to all sets: Applies all the device settings to all templates of same type
and variant throughout all template sets.

Right-click in the device's Function area (black row).
2. Select the device to configure from the Enable menu.
This opens the edit box for the selected device.

% Template Editor | *Funcspec: JINGLE + 3

File = Template ~ Ternplate 5et = DE ~

Funcspec
JINGLE+3

Take

I

4

Clear devices

Device properties

Apply device settings to all sets

description

Switcher crosspoint

Ernem Recall
Auxiliaries
Keyfill
Videoserver
Graphics
Video wall
Audio player
Virtual Set
Camera Control
GP1/O Control
Light Control
Router Control
Weather
Audio Mixer

| Funcspec | DB|

& Note: Depending on the protocol chosen, the caption EMEM Recall may alternatively

be:

Emem Recall
Dmem Recall
Snapshot Recall
Memory Recall
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To Modify Device Functions

1. Right-click in the device's Function area (black row).
2. Select Device properties. See the topics below for listings of properties for each device.

oy
%

File = Template = Template Set - DB

Funcspec
Take
JINGLE+3
BUS XPOINT AUDIOLINK  MIXEFFECT KEY SET DELAY KEY EMAEBLE
CAMI » || CAMT | none - || ME1 - - El

CAM3 CAM4

Ememnr_p

/A

& Note: Depending on the Protocol chosen, the caption Macro Recall may alternatively be:
Custom Control

To Remove Device Functions

1. Right click in the Device function area
2. De-select it from the Enable menu.

Linking Device Properties and Newsroom Tags

To Make A Device Property Editable From The NRCS

Right-click over Property and select Add newsroom tag.
The property is then reassigned to the value supplied from the newsroom system.

If several device properties are given to a newsroom tag with the same name in a template, all
devices use the value given in the NRCS.

See also: Newsroom Tags.
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The video switcher crosspoint enables switching on the video switcher. The A or B bus assignment
of the mixer effect (PP/MEx) is automatically handled by the automation.

Switcher XPoints

[ Cross Point Hold

Mix Delay

Mix Delay Out |0

Crosspaoint 1
Mix Effect 1 Crosspoint
PP * |none none T
Crosspoint PP
-

0 [ Transition Only

Diown stream keyer

Audio hink

DsK Off
DSK2 On

DSK 3 On

-
-

-

[ DSK40On
[ DSK50On
[ DSKEOn
[ DSK7On
-

DSK & On

EEEEEEE

Cancel |

X

Oiff delay

Undo |
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Guidelines for Video Switcher Crosspoint Configuration

Item Description

Mix Effect Selects which Mix Effect (ME) bank on your vision mixer that you are currently
handling.
Note : Newsroom tag available.

Mix Effect 1

PP -

[ . |
MET

ME1Sub2

ME2
ME25ub2
ME3
ME3Sub2
ME2
ME4Sub2
MES
MESSub2
M_RIP

MOTH v

Crosspoint  Crosspoint on the video switcher. Default value: none
1. Click to display a drop-down list of available x-points (Video Configurations).
2. Select from the list.

& Note: Newsroom tag available.

Audio link Default value: none

Audio link

nane | -

hwm—nﬁ

Crosspoint  If another Mix Effect (ME) than PP is selected, then you can select a crosspoint for
PP program by writing the crosspoint name in the field.

Set ME in If another Mix Effect (ME) than PP is selected, check this box to make that ME the
PP crosspoint for PP. (Checking this box disables XPOINT PP).

Cross Point  Keeps the crosspoint on the selected Mix Effect.
Hold
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Only

DSK Off

DSK 2
On, ...,
DSK 8 On

Off delay
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Description
Offset, in frames, of when to perform the transition.

Delay, in frames, of when to perform the next transition.
Only delay the switcher transition (sub items will perform).

Turns off the Downstream Keyer (DSK) on the video switcher when the template is
active in program.

The keyer selected as DSK in the switcher device property (Devices > Properties >
Vision Mixer > selected DSKNr), will be used.

[Foscor]

Downstream Keyer (DSK) 2-8 on. Turns on the DSK 2-8 (PP key 2-8) on the video
switcher when the template is active in program.

[ DSK20On
DSK 3 On
DSK 4 On
DSK 5 On
DSK & On
DSK T On

[ [ I I I

DSK E On

EEEEEER

Delay in frames to set the DSK 2-8 off.

Video Switcher Transition

The transition device is only available when video Switcher crosspoint is enabled.
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o *DEMC: CAMERA + 1 — O =

© File =~ Edit = Show = Test Template DE -

Xpoint  =memnr_pr
A

Enable k |[ v | Switcher crosspoint "

Template properties EMEM Recall

Clear devices Macro Recall
Apply device settings to all sets Auxiliaries 3
Keyfill b

Videoserver

Graphics
Video wall

- | - | Audic player

0o [ o Virtual Set
CAM 1 Camera Control
GPI/O Contral
Light Central

Router Control
Weather
Audio Micer

To Define Video Switcher Transitions

This procedure is based on the example in the screenshot.
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1. Click on MIX/WIPE/EFFECT to cycle through these three transition types.

value value
rate =
enable e cnable
mix_delay | o *DEMO: CA RGBT
File = Edit -
WIPE
0

value

rate

enable
a5 *DEMO: CARERTNELEET

2. Click directly on the selected value (in the screenshot above, this is either 0 or 7).

3. Enter
a. The default duration (in frames) for the Mix/Wipe transition, or

b. The effect number for the effect transition.
! *DEMO: CAMER

File - Edit -

File = Edit = Show

The transition is performed with the auto-transition functionality in the video switcher.

Usage and Tips

- To do a cut, use a MIX transition with © frames duration.
- To add a mix delay, right-click on the device (MIX/WIPE/EFFECT), select the number (below

Disable), and enter another number (in frames).
Adding a mix delay delays the start of the transition, compared to other device commands,

when the template goes On Air.
To disable the transition, right-click over the device and select Disable.

Video Switcher Register/Timeline Recall

Video Switcher Register/Timeline Recall (EMEM Recall/Emem Recall/Dmem Recall/Snapshot Recall/
Memory Recall) will recall a register and/or timeline in the video switcher.

To Open the Video Switcher Register/Timeline Recall
This procedure is based on the example in the screenshot.

1. Open Template Editor.
2. Right-click over ememnr_pr
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3. Select Enable > EMEM Recall

o5l *DEMO: CAMERA + 1 — O X
* File = Edit ~ Show - Test Template DE -

—

xpoint |=memnr_prff

Enable r Switcher crosspoint

Device properties | EMEM Recall

Clear devices Macro Recall

Apply device settings to all sets Auxiliaries 3
Keyfill ]

Videoserver

Graphics
Video wall
Audio player
I Virtual Set

0 [ 0 Camera Control
GPI/O Control
Light Control

Router Contral
Weather
Audio Mixer

4. Enter or select required values

| Ereeal ] e - | [ [

& Note: If a Register recall is paired with the video switcher key bus delegation and/or
auxiliary bus delegation, the key/aux bus delegation should be disabled in the Video
Switcher Register to prevent a conflict between the stored delegation and the Viz Mosart-
assigned delegation.

Guidelines for Video Switcher Register/Timeline Recall Configuration

Item Description
NAME Name of Register/Timeline.
DESCRIPTION Description of Register/Timeline.
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Item Description

MIXEFFECT Select the MIXEFFECT (ME) from where the Register/Timeline
should be recalled.

Drop-down menu values are PP (Program), MET, ME2, ME3,
ME4, and Master. Default value: Master.

(Depending on the Protocol chosen, there may be additional
values).

MIXEFFECT
PP -

ME1

MEZ

ME3

ME4

MER

Master

M_RIP

M QOTH b

To dynamically choose MET or ME2, values M_RIP and M_OTH
are available.

& Note: Newsroom tag available

EMEMNR PREVIEW Register/Timeline on the video switcher that will be recalled
when the template is cued in Preview.

EMEMNR PROGRAM Register/Timeline on the video switcher that will be recalled
when the template is taken to Program.

LOAD TIME Delay time (in frames) between when the mixer register is
recalled (in Program or Preview) and when all other template
instructions are executed.

OPEN VS FADER When selected, Viz Mosart opens the fader specified in Audio
effect server, defined in the Audio tab of Device Properties in
AV Automation.

Macro Recall

Macro Recall is available when the following vision mixer protocols (as selected in the
configuration menu Vision Mixer):

Ross Acuity
- Ross Carbonite
- GV CPL
- GV KAHUNA (Kahuna/Kula)
- SONY SERIAL TALLY
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VIZRT-IPS (NewTek/Vizrt Group IP series mixers (for example, Viz Vectar Plus, TriCaster,

VMCT).

To Open a Macro Recall

1.
2.

3.

Open Template Editor.
Navigate to Enable > Macro Recall

a5 *DEMO: CAMERA + 1

" File » Edit » Show » Test Template DE -

M
]
Xpoint  EMemnr_pr

MIA M

Enable

Template properties
Clear devices

Apply device settings to all sets

Switcher crosspoint

EMEPA Recall

Macra Recall

Auzxiliaries
Keyfill
Videoserver
Graphics
Video wall
Audic player
Virtual Set
Camera Control
GPI/0 Control
Light Control
Reuter Control
Weather
Audio Mixer

Enter or select required values.

a5l Macro Recall — O x
Recall preview I I LI
Recall program I I ;I

oK | cancel |

Undo |

A
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Guidelines for Macro Recall Configuration

Item General description Drop- Text field
down
Recall preview Action to be taken when entering preview mode. See below See below

Recall program Action to be taken when entering program mode.  See below See below

Drop-down Menu Alternatives

Drop-down option
None

Recall

Take

Recall and Take

Load project

Description

No action.

Macro is prepared (or cued).
Macro is taken.

Macro is prepared and taken.

Project is loaded (Kahuna/Kula only).

© Warning: Load Project could affect the
performance of the switcher. Use with caution
during a running show.

The format of the text fields depends on the mixer chosen:

Mixer Text field Remark
Acuity One bank character and two macro characters. Recall (and Recall and take)
Example: 102 (recall custom control 02 on bank 1) Take does nothing.
Note that Device is named C
instead of Macro Recall.
Carbonite One bank character and two macro characters. Recall (and Recall and take)
Example: 215 (recall custom control 15 on bank 2) Take does nothing.
Note that Device is named C
instead of Macro Recall.
GV CPL Macro number (integer) in the range 1-999 . Recall (and Recall and take)

Take just takes macro alrea
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Mixer Text field Remark

Kahuna/Kula The meaning and format of the text fields depend on the selected drop-down option:
Drop-down option Description
Recall Two-digit project number and three-digit macr

the format pp.mmm.

Take As for Recall above, or three-digit macro numk
Recall and Take As for Take above (if mmm only, the Recall is
Load project Project number in the range 0-100 (100 me.
project).
SONY SERIAL TALLY  Macro number (integer) in the range 1-250 . Recall (and Recall and take)

Take just takes macro alrea

VIZRT-IPS Plays a macro having the name provided Take only

& Note: Some Tricaster drivers use a non-standard macro in which the argument is the macro
text itself. However, this does not apply the driver currently used by Viz Mosart.

Video Switcher Auxiliary Bus Delegation

Auxiliary bus delegation enables routing of internal video switcher signals to the auxiliary outputs
of your video switcher.

& Note: VIZRT-IPS: Video switchers supporting VIZRT-IPS use NDI outputs, not auxiliaries. So
on the template, the Auxiliaries device is instead named NDI Router Output.
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o5 *DEMO: CAMERA + 1 - O
" File v Edit » Show + Test Template DE -
Key 1 Keyfill
none MIA " "
ML
0
xpoint EMEmMNr_pr 1 1
NIA A
Enable » Switcher crosspoint
Template properties EMEM Recall
Clear devices Macro Recall
Apply device settings to all sets | Auxiliaries J m AL A
Keyfill ] AUXEB
Videoserver AUXC
+ | - | Graphics ALK D
0 | 0 Video wall AUXE
Audio player ALXF
Virtual Set AUXG
Camera Control ALK H

GPI/O Control
Light Control
Router Control
Weather
Audic Mixer

Type or select relevant values.

Copyright © 2022 Vizrt

Page 247



Viz Mosart Administrator Guide - 5.0

Guidelines for Auxiliary Bus Delegation Configuration

Item

BUS

XPOINT

AUDIOLINK

SET DELAY

TRANS DUR

Description

Selects the auxiliary to assign a new source.

BUS

-

>

G0l G LT e G P —

A Note: Newsroom tag available.

Crosspoint on the video switcher.

& Note: Newsroom tag available.

Assigns a link group to this delegation. Please refer to Audio and
Video Setup for the use of this feature.

AUDIOLIME
none @

60 = 0 LR e G b — =l

Set the delay in frames of the key delegation when taking the
template to Program. If the field is left blank, the key is set in
Preview

If the vision mixer has the ability to mix on the AUX channels,
this is where the mix rate is set, 0 is a cut
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Configuring An NDI Router (Viz Vectar Plus Or Tricaster VMC)

A Note: For NDI output crosspoints, you must refer to actual crosspoint names recognized by
VMCI1 (and not any user-friendly names that would be mapped to the physical inputs).
These default naming on the NDI router side is typically:

- INPUTn

- DDRn

- BFRn

- MIX n.

The same naming must be used on the Viz Mosart side.

In AV Automation > Devices > A/V Setup > Video Config > Mixer name column, you must
provide the hardcoded name associated with the user-friendly name of the crosspoint.
This name is found on the switcher side.

In the example below, the value of the literal crosspoint name is the router output found in
the switcher's Macro Configuration > Macro Editor menu and added to AV Automation:

LVET s MA

HD1 104 ~ ~ | INPUTY
HDZ 105 ~ | INPUT2
LIVES 200 ~ ~ | INPUT13

There is a new setting UseOutputCrosspointNames in the IP-protocol
config VizrtlpSystemsVideoSwitcherConfig.xml set by default to expect the crosspoint
name, instead of the Viz Mosart standard of using physical input naming.

Keyfill: Video Switcher Key Bus Delegation

Video switcher key bus delegation enables routing of internal video switcher signals to the keyers
on the different mixer effects of the switcher.

A Note: VIZRT-IPS: For video switchers supporting M/E effects with 4 layers, the device is
named Key/Layer.

To Enable Keyfill by Bus Delegation
1. Open Template Editor.
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o *DEMO: CAMERA + 1

* File = Edit = Show + Test Template DE -

ML
0

Xpoint  Ememnr_pr

NI NI

I—Enable L Switcher crosspoint
Template properties EMEM Recall
Clear devices Macro Recall
Apply device settings to all sets Auxiliaries r
[ Keyfil VI keyfr |
Videoserver Keyfill 2
Graphics Keyfill 3
Video wall Keyfill 4
hd I hd I Audio player Keyfill 3
o [ o Virtual Set Keyfill 6
Camera Control Keyfill 7
GPI/O Control Keyfill &
Light Control
Router Contral
Weather
Audio Mixer

3. Enter or select required values.

To Enable Keyfill by Bus Delegation for M/E effects with 4 layers

Devices like Viz Vectar Plus or VMCI let you configure M/Es with effects supporting up to 4
primary sources/input layers (along with Key layers), called A, B, C and D buses.

Viz Mosart can control these buses from a template or keyboard shortcut when VIZRT-IPS is used
for a vision mixer.

1. Open Template Editor.

2. Navigate to Enable > KeyLayer > [KeyLayer index]
The Key/Layer device on a template can be used for VMCI1 vision mixer to either set the
crosspoint for a Key bus or to set the crosspoint for A, B, C and D buses of a M/E effect with
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4 layers.

File = Temmplate = TerplateSet = DS -

N s |

Audio player
Virtual Set

Key/Layer 5
Key/Layer§
Camess Cortrol KeyiLayer 7
GPYO Control
Light Control
Router Cantrol
Weather
Audio Mixer

EIEICOED NG E0 .
[5] sencmcompar T e T
Template properties. EMEM Recall
Clear devices Macro Recall OR | 0DR | e | CaM | we | jcam| | |
Apply device settings to all sets Auiliaries »
Key/Layer P[] eitayert 5
Videeserver [~ 2 =
— (9] ronoes  |DSKS]_osce | FE—-| s |
Video wall [#] eyitayerd Vidsa Parls
L. - e
[l

Ky /Layer 8

3. Right-click > Device properties.
Select from the BUS drop-down menu:
a. If the device is used for setting the crosspoint for a key bus, set the BUS drop-down
menu to a number between 1 and 8 on the Key/Layer device properties.
b. If the device is used for setting the crosspoint for a layer of a M/E effect with 4 layers,
then choose one of the letters A, B, C and D from the BUS drop-down menu.
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Guidelines for Keyfill Configuration

Item Description
BUS Selects the key bus on the selected ME.

BLIS

]

2

3

4

5

6

7

2

If the video switcher supports M/Es with 4 layers (e.g. VIZRT-
IPS), 4 more buses are available corresponding to each layer,
A, B, C and D:

BLIS

-

=3 m =

& Note: Newsroom tag available.

XPOINT Crosspoint on the video switcher. Default value: none

& Note: Newsroom tag available.
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Item Description

AUDIOLINK Assigns a link group to this delegation. Please refer to Audio
and Video Setup (previously Linking video and audio sources)
for the use of this feature.

AUDIOLINK

nong -

MIXEFFECT

& Note: Newsroom tag available.

KEY SET DELAY Set the delay in frames of the key delegation when taking the
template to a program. If the field is left blank the key is set in
preview.

KEY ENABLE Key enable drop-down menu.

KEY ENABLE

Ignore
On
Off

& Note: Newsroom tag available.

Video Server

SEFWERCHANNEL CUPHIRESPATH ~ CLIF DESCRIFTI  TRIGGER START ~ RECUECLIP  LOOP  CUEONLY El
a/b AB -l [l b r r r

Ememnr_p

NiA
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Guidelines for Video Server Configuration

Setting

SERVERCHANNEL

CLIP HIRESPATH

CLIP DESCRIPT

TRIGGER START

RECUE CLIP

LOOP

Description

The Mosart video port / port group where the clip is to be
played out /recorded.

For recording the corresponding video port has to be part of
the “Rec” port group.

Port groups are created as part of the video server
configuration in menu AvAutomation > Devices > Preferences.
Configurations are described in Video Servers, section Working
with Mosart Port Configurations.

Notably, the defined virtual ports are among the available
options.

In addition, the non-empty groups (groups with at least one
port) are available.

If a group has the same name as one of its ports (as may be the
case for the Rec and P groups, if defined), the group as such is
not available, but the port is.

The (default) clip ID or name.

A Note: Newsroom tag available, meaning that a value
from the NRCS will override the value specified here.

You can enter a Clip description, however a clip description
from the NRCS or video server overrides this value.

& Note: Newsroom tag available.

Enables the Trigger start function from control commands, a
shortcut or continue point could be set to PLAY the Clip.

In an A/B roll situation, when several Adlibs are played back-to-
back, this setting determines how a clip will be restarted after
it has been paused.

For example, if Clip A is paused when Clip B is taken On Air,
then next time Clip A is taken on the same channel, it can
either be played from where it was paused, or be re-cued
(played from the beginning).

This is only used for AdlibPix templates.

Sets the server port to loop the clip. Beware! Not all video
servers can loop.
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CUE ONLY

Graphics

Description

Viz Mosart Administrator Guide - 5.0

Cues only the clip when the template is in Preview. The
template will not start playing the clip when the template is

taken.

The Graphics device enables recall of graphic elements.

o *DEMO: CAMERA + 1

ALK A AL

Ml

" File = Edit = Show - Test Template DB -

0

xpoint  EMEemnr_pr 1

MIA A

’—Enahle

Clear devices

Temnplate properties

Apply device settings to all sets

Switcher crosspoint
EMEM Recall
Macro Recall

Auzxiliaries

Videoserver

| Graphics

| Video wall

Audio player
Virtual Set
Camera Control
GPIQ Contral
Light Control
Reouter Control
Weather

Audio Mixer

Graphic elements are cued (loaded) in Preview and played (started) when taken to Program.
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Graphics Device >

n _~| Engine [~ Send Continue on DVE FORWARD

|datacnnnec1icunj Content Source | Use VizContentPilot

Default Graphics
Scens Mame Scene Text

| |s database Index

[ Use take Out Command Take out Delay |0

QK | Cancel

Guidelines for Graphics Configuration

Engine
- Selects the engine to operate on when using this
. template based on your configuration.
2 See section Graphics.
3
4
B
172
34

Content Source

s O T - dataconnection: Uses content from the attached
e graphics database (only available when Vizrt

graphics are used)
newsroom: Uses content from the attached NRCS.
none: Uses content written into the template.

Send Continue on DVE FORWARD If checked, a continue command is sent together with
a DVE Forward command.

Use VizContentPilot Enable to run this element through a Viz Pilot client.
This allows for OnLiveUpdate events in Viz Pilot data
elements.

Copyright © 2022 Vizrt Page 256



Viz Mosart Administrator Guide - 5.0

Scene Name The default scene name is used if not overridden by
the NRCS.

& Note: Newsroom tag available.

Scene Text The default scene text will be used if not overridden by
the NRCS.

& Note: Newsroom tag available.

Is database Index

Use take Out Command If checked, a take-out command is sent when the
template status changes from On Air to Off Air.

Take Out Delay Delay of sending takeout command after template
status changes from On Air to Off Air.

Video Wall Register Recall

This device is only available for Videowall template types.

mﬂ_:u | Eﬂ.i.:::lE | | F'.ECALI;IPF'.E"-J']E | | EMI?:-I'INF{ - o
Setting Description
NAME Internal name of the shot.
RECALL PREVIE For WATCHOUT, see notes below. For the other brands, this is

the number of the recall to be taken when the template is
cued in Preview.

EMEMNR For WATCHOUT, see notes below. For the other brands, this is
the number of the preset to take when the template is taken in
Program.

& Notes for WATCHOUT

- The fields RECALL PREVIE and EMEMNR should contain the command or sequence of
commands to be sent when the template comes in Preview or Program, respectively.
- The general format is: [load "show"] [resetrun "timeline"]
Both load and run are optional, however at least one of them must be present.
The show and timeline parameters may not contain double quotes.
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The reset value is optional. For more information see the connection string
property ResetAnyway, described in the section Video Wall Connection Strings.
In most cases, RECALL PREVIE contains load "show" , and EMEMNR contains run

"timeline" .

Audio Player

LEVEL AUDIWFILE  QUTPUT r——
[ 0 J | | el

LEVEL: This value does not affect the level. Instead, a value > -90 (the value must be an
integer) starts playout, whereas a value <= -90 stops the playout.

AUDIO FILE: Optionally, enter an audio file name here. If a newsroom tag is added, and a
value is provided by the NRCS, that value is used.

OUTPUT: (Viz Mosart Audio Player only) Choose the output on the Audio Player to be used, if
nothing is inserted, the first port is used. This value is overwritten by values coming from
the NRCS.

Outputs are displayed on the Audio Player Ul (see the Audio Player section at AV Automation
Devices > Audio).

=% Settings

m Testing panel

If a new file i / on an output already playing:
(o] Stop the file pi and play new file
Ignore n

Play new ext available output

Outputs

ser for Display Audic

A Note: Newsroom tags available for both AUDIO FILE and OUTPUT.

For further details, including third party audio players, see section Audio Players.

Virtual Set

You can specify the camera to take in a virtual set.
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y
[ viral Set device (e ) [

Camera I'I_

Insert the camera number in the virtual set that is to be taken when the template is taken to
Program.

Robotic Camera Control

The camera control device allows for recalling camera shots (and pre-programmed moves) when
the template is cued in preview or aired in program. The device editor supports salvo recalls of
shots by adding multiple lines for each shot recall.

S “DEMO: CAMERA + 1 — O X

© File = Edit = Show = Test Template DB -
‘Camera Control

Protect
onair
source

Camera Page Preset Time Delay Page Preset Fade time Delay
A " number Preview Preview preview preview program program Program program

> name - 0 0 0 0 0 0 0 0
r.,:]\_.a: B 5 - 3 r 5 3 3 S 3 3
Ememnr_pr|

N/A

The Standard Robotic Camera Control Properties are described below, as well as exceptions for
specific camera types:

Guidelines for Standard Robotic Camera Control Configuration
Cambotics Properties
Camerobot Properties

Cinneo System Properties
Fx-Motion Properties

Panasonic Properties
Technodolly Properties

Shotoku TR_T Properties
Telemetrics Properties

Vinten 200 Properties

Electric Friends Robotic Camera

Guidelines for Standard Robotic Camera Control Configuration

Shot Name Not used.
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Camera number

Preview

Page Preview

Preset Preview

Time preview

Delay preview

Program

Page program

Preset program

Fade time Program

Delay program

Copyright © 2022 Vizrt
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-1 : Shot is sent to all cameras that are not in standby.
>=0 : Shot is sent to the camera with the same
number. The number refers to those given in the
Cameras fields in Camera Robotics.

The exact meaning and format of the Preview fields
depend on the type of camera robotics. (See the sections
below.) These following three fields govern what happens
when the template is taken in preview.

This field (together with Preset Preview) determines the
shot/move.

This field (together with Page Preview) determines the
shot/move.

This field (together with Preset Preview and Page Preview)
determines the duration of a move.

Not used.

The exact meaning and format of the Program fields
depend on the type of camera robotics. (See the sections
below.) These following three fields govern what happens
when the template is taken to air.

This field (together with Preset program) together
determine the shot/move.

This field (together with Page program) together
determine the shot/move.

This field determines the duration of a move.
Delay of move in Program (frames).

& Note: Only available for Vinten robotics systems
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Protect onair source Protected video switcher cross-point. If the video switcher
cross-point is On Air, the shot/move recall will be
ignored.

For Technodolly, this protection can be confined to
Preview and/or Program, and to Cuts and/or Moves.

Cambotics Properties

Camera Number: Set camera numberto 1.
Page Preview/ Page program: Robotic camera number.
Preset Preview/ Preset program: Shot number.
- Time preview/ Fade time Program: [Optional] Duration for move in deciseconds (10
deciseconds = 1 second).

& Note: All parameters not defined specifically, must be setto -1 .

Camerobot Properties

Page Preview/ Page program: Name of shot’s matrix in preview/program.
Preset Preview/ Preset program: Shot’s cell number in the selected matrix - the shot is
adjustable from NRCS and GUL.

- Time preview/ Fade time Program: 0 ~ cut (fastest move) to position, ?0 ~ programmed
move speed (adjustable from NRCS and GUI).

Cinneo System Properties

Page Preview/ Page program: Name of the camera to recall.
Preset Preview/ Preset program: Name of shot to recall - adjustable from NRCS/GUI.
- Time preview/ Fade time Program: Desired moving time (seconds).

Fx-Motion Properties

Page Preview/ Page program: Identifies the camera to recall (identical to Camera Number >
0), optionally followed by :category for temporary overriding any NRCS or GUI settings.
Preset Preview/ Preset program: Name of shot or move to recall.

- Time preview/ Fade time Program: =0 cut, <0 ~ default time to shot, >0 ~ wanted time
(frames).

Panasonic Properties

Camera Number: Identifies the Controller that the command is linked to.

Page Preview/ Page program: Identifies the Camera Number to be controlled in Preview/
Program.

Preset Preview/ Preset program: Identifies the Preset Stored Move in Preview/Program.
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- Time preview/ Fade time Program: Sets the Timed Delay in Preview/Program. Has no effect
for Panasonic TCP.

Technodolly Properties

Page Preview/ Page program: Identifies the camera, identical to Camera Number when >0.
Preset Preview/ Preset program: Name of the move to recall.
- Time preview/ Fade time Program: =0 ~ go to start of move, ?0 ~ move.

Shotoku TR_T Properties

Page Preview/ Page program: Page of shot to recall.

Telemetrics Properties

Page Preview/ Page program: Preset page number to recall.
Preset Preview/ Preset program: Preset number to recall.

- Time preview/ Fade time Program: =0 cut, <0 ~ default time to shot, >0 ~ wanted time
(seconds).

Vinten 200 Properties

Page Preview/ Page program: Name of the show to recall.
Preset Preview/ Preset program: Name of shot or move to recall.

- Time preview: <0 ~ go to end position of a move, = 0 ~ cut to shot, >0 ~ go to start position
of a move, or move to a shot (frames).
Fade time Program: For moves, move forward or backward according to Time preview. For
shots, = 0 ~ cut to shot, 70 ~ move to shot (frames).

Electric Friends Robotic Camera

For Preview use:

Page Preview: Show and Robotic camera name separated with a colon (e.g.: ShowName:Cam
1.
Preset Preview [Optional]: Shot name. Shot attributes: prepare, prepareplay and loop.
Separated with a colon (for example, prepare:ShotName and prepareplay:ShotName).

- Time Preview [Optional]: Duration for move in frames. The time is rounded up to the nearest
second.

For Program use:

Page Program: Show and Robotic camera name separated with a colon (e.g.: ShowName:Cam

1.
Preset Program [Optional]l: Shot name. Shot attributes: prepare, prepareplay and loop.
Separated with colon (for example, prepare:ShotName and prepareplay:ShotName).
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Fade time Program [Optional]: Duration for move in frames. The time is rounded up to the
nearest second.

Fomera Cortrdl — Prosst Time B Protect
i oy Fadetime Delay

szl ruber | Page Pueview Preview | prevew | prevew | Fage progm Presst program Frogram program -
r 2 Baoi soeniaken C.am 2 4 4 4 Brottscentsler Cam 2 PREPARE 506 EF_stat_ 05 1 -1
. 1 1 L 1 K

(PYW)

| |
|
Camera number | [Showname : Camera| | Shot name | Not used | (Showname : Camera Shot attribute - ‘ St xpoint
(Assetin AVA) | [icamera name a3 | Camera name as set | | shot name (PP) | (unchanged)
set In EF webserver) Time [Speed) In EF webserver Time (speed)

of movement of movement
(PWV] in frames (PP in frames

GPO
The GPO editor is used for sending GPOs to external equipment.
GPO Program gpo_preview | gpao_program
[ - -

The editor supports multiple GPO sends.
Add a new line in the editor for multiple GPO sends.

@ Tip: For GPO values, refer to section GPIO.

gpo_preview: GPO to send when a template is cued in Preview.
gpo_program: GPO to send when a template is taken in Program.

Light Control

’mr.ﬂw_q:mmﬂ |"HDG'W“M
| - -

Al
Fire

Go
GoCff
Load
MoteCff
MoteCn
Resat
Restore
Resume
Set
Stop
Custom

& Note: The commands to use are driver-dependent and may vary.
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Guidelines for Light Control Configuration

Option

PREVIEW COMMAND

PREVIEW VALUE

PROGRAM COMMAND

PROGRAM VALUE

Description

Command to use for the light mixer cue to be recalled
when template is cued in Preview.

& Note: Newsroom tag available.

Light mixer cue to use when template is cued in Preview.

& Note: Newsroom tag available.

Command to use for the light mixer cue to be recalled
when a template is taken in Program.

& Note: Newsroom tag available.

Light mixer cue to use when a template is taken in
Program.

& Note: Newsroom tag available.

Preview Command and Program Command options are available from the drop-down list:

Command

AllOff

Fire

Go

GoOff

Load

NoteOff

NoteOn

Reset

Parameter count

<none>

cue number

cue number

cue number

numeric note # (Std. MIDI command)

numeric note # (Std. MIDI command)

<none>
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Command Parameter count

Restore <none>

Resume variable

Set 40r9

Stop cue number

Custom SysEx bytesSend multiple custom SysEx bytes in the format \xnn

where nn is a humeric value ( 0-255).

The global prefix and postfix set in the device config is used in
the message

(for example, abc\x20def will send seven bytes as a SysEx
message).

TimedGo - (unsupported)

Router Control

The router control device allows setting crosspoints for source/destination pairs when the
template is both cued in Preview and aired in Program.

LA DS;:::: Dest preview DSI_E;::; Dest program Aindiunrﬁ:k Dest Audiolink matrix level program_delay | salvo_preview | salvo_program
=l =l =l <] =] 0 0 0 - :
CIRR ~ [N T~ I -~ [~ (I~ [T ~ | -1 -1 -1 4 -1

Add new lines in the router device editor to support setting multiple crosspoints.

Guidelines for Router Control Configuration

Item Description
Source preview Source to route when a template is cued in Preview.

& Note: Newsroom tag available.

Dest preview Destination of routing when a template is cued in Preview.
Source program Source to route when a template is aired in Program.
Dest program Destination to route when a template is aired in Program.
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Item Description

matrix If the router system supports multiple matrices, select the
matrix to use here.

level - 0: route on all levels.
1: video routing only.
2: audio routing only.
3: GPI/O routing only

program_delay Delay, in frames after the template has been taken to the
air, for ‘program’ routing to happen.

salvo_preview Salvo name to recall when a template is cued in Preview.

salvo_program Salvo name to recall when a template is aired in Program.

Audio Settings (General)

- The main level for the fader is set by dragging the notch or clicking the arrows.
The default fader level when adding a new fader is © dB.
- To set level 2 of the fader press SHIFT while dragging.
A tool-tip opens to signal the editing of the level 2 fader level.
- To set level 3 of the fader press SHIFT+CTRL while dragging.
A tool-tip opens to signal the editing of level 3 fader level.
Level 3 is the mute level of the audio fader.

To Add Audio Faders

1. Add audio faders to the template by right-clicking in an empty part (large grey area to the
left) of the audio fader area and selecting Add fader.

2. Set the audio mixer crosspoint from the drop-down menu by clicking the label at the top of
the fader.
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File ~ Edit ~ Show ~ Test Template DB -

Keyfill Key 2
NJA

Keyfill
hJA

vilA
0
®point  =memnr_pr
/A

Add Fader

Apply audio settings to all
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A Note: Clicking Apply audio settings to all applies all the changes to all templates of the

same type and variant throughout all template sets.

To Remove a Fader

Right-click over the fader and select Remove fader.

To Configure a Fader

Right-click over the fader to open the context menu and follow the Guidelines below.

Guidelines for Audio Properties Configuration

Remove Fader

Removes the fader from the template.

RemoveFader ‘

Order 3
Fader type 3
Link 3

Keep level

Fade up in preview
Input device 3
Cross fade time 3
Manual close

Mode 3
Delay 3

Loudness 3
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Order Re-arranging the order:

Move Left
Move Right

RemoveFader

Move Left
MoveRight

Fader type Action: When a fader control is set as an action fader, the
controls define whether the fader is enabled or disabled.

Level: For normal operation.

Action
Level

Link

oW g
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Keep level Keeps the fader level until manually changed.
Enabled to let the automation open the audio fader, leaving
it open until the operator closes it with the Fade audio
function in the Viz Mosart client,
or closes it from another template.

RemoveFader

Order 3
Fader type 3
Link 3
Keep level

Fade up in preview
Input device 3
Cross fade time 2
Manual close

Mode 3
Delay 3
Loudness 3
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Fade up in preview Fades up the audio in preview, when camera is in program.
To let the audio fader open when the template is cued in
program, set to enabled.

RemoveFader

Order 3
Fader type 3
Link 3

Keep level

Fade up in preview

Input device 3
Cross fade time 3
Manual close

Mode 3
Delay 3

Loudness 2

Enabling this functionality only works with specific template
combinations, as shown below:

Program Preview (with Fade up  Result
in preview enabled)

CAMERA LIVE
DVE
TELEPHONEINTERVIEW
PACKAGE
Other Templates

Other Templates  PACKAGE

DI < T > B < B < < B <

Other Templates
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Sets the type of the audio fader.

The setting is used in combination with primary template
type and On Air status to identify which fader should be
treated as secondary audio.

This special handling is applied to the types below:

none: No special treatment.

Video server: The fader controls a video server channel
audio output.

Video server Ch2: The fader controls a second video
server channel audio output.

Graphics: The fader controls audio output from the
Graphics Engine.

External source: The fader controls an external audio
source.

Mic: The fader controls a studio microphone.
Telephone: The fader controls a telephone hybrid.
Soundplayer: The fader controls the Mosart Audio Player
output.

—

RemoveFader
Order v
Fader type »
Link »
Keep level

Fade up in preview

Input device » =

Cross fade time 3 Video server

Manuzl close Video server Ch2

o e Graphics

Delay 4 External Source

Loudness 3 !Z‘ Mic

Telephone

Soundplayer

Sets the in and out crossfade time for the fader.

In
Out

RemoveFader

Order 3
Fader type >
Link 3
Keep level

Fade up in preview
Input device >

Cross fade time r In 5

Manual close Out ,T

Mode 3

Delay 3

Loudness 3
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Manual close Select to ignore sending Close-level commands to audio
mixer.
When selected, sending the Take out for the fader at the
end of the element is ignored; The fader has to be manually

taken down.
RemoveFader
Order 3
Fader type 3
Link 3
Keep level
Fade up in preview
Input device 3
Cross fade time 3
Manual close
Made 3
Delay 3
Loudness 3

Mode Only for Studer Vista and Lawo!

Sends the chosen value to the mixer board for the audio
fader.

Stereo (not for LAWO EMBER+)

Mono (not for LAWO EMBER+)

Left (LAWO EMBER+: Stereo faders only)
Right (LAWO EMBER+: Stereo faders only)

RemoveFader
Order 3

Fader type 3
Link 3
Keep level

Fade up in preview
Input device 3
Cross fade time 3

Manual close

Mode 3 Stereo

Delay 3 Mono
Loudness 3 Left

Right

Delay Only for Studer Vista and non-Ember+ Lawo!

Gives a delay value for that audio fader that will be sent to
the audio board.

Mixer delay. Default: 0

RemoveFader

Order
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Loudness Sends chosen recall value to send to the Junger audio
processor.

vi AN W N~

RemoveFader

Order >

Fader type 3
Link 3
Keep level

Fade up in preview
Input device >
Cross fade time >
Manual close

Mode >
Delay >

Loudness 3

woB W ks

Testing a Template

You can test the behavior of your template by simulating a Preview then Take.

To Test a Template

Select Test template from the main menu.

This cues the template in Preview then five seconds later take it to Program with the selected
transition.

10.6.4 Working with Template Sets
This section contains the following topics:
Template Set Types
Standalone
Hierarchical

Template Set Operations
Template Set Properties

Template Set Types

A Viz Mosart template and its variants are arranged in a set. There are two approaches to working
with template sets.
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Standalone
Hierarchical

Standalone
Traditionally, Viz Mosart template sets are treated individually, with no connection to each other.

For example, a template set is created for each show or program. This is usually combined with
automatically selecting the template set through the associated NCS rundown. In addition, startup
commands for preparing the studio (lights, sound etc) for running the show are included in the
template set.

The copy contains the same templates as the original, and each template set created in this
manner can then be changed without affecting the other. When working with the template set for
a new program, (based on a copy of an existing program's template set), you make small
adjustments according to the functionality needed by the program.

When this new template set is created (by copying an existing set), a copy of all templates and any
nested sets is made, and no references are made between the original and copied templates. Each
template set is classified as ‘standalone’.

Disadvantages With This Approach

Many duplicates are created. Normally only a few of the templates in the set need to be
adjusted for meeting the needs of a new program.

With an ever-growing bank of templates being created for each new show, the amount of
stored templates in Viz Mosart can exceed system norms. This results in long response
times when saving templates and increases the memory footprint of both the Mosart Server
and Viz Mosart client workstations.

Maintenance of templates becomes cumbersome and error prone. When a change is made in
a template that is common for all template sets, the same change has to be applied
individually to every template set. This is a time consuming task across numerous template
sets.

Hierarchical

An alternative approach to standalone is hierarchical template sets. This method also enables

a new template set to be created, based on the logic of an existing template set. However, to begin
with, no templates are copied from the existing template set.

Only when a change is made to an existing template, or when a new template created, is a new
template created and stored in the new template set.

The hierarchical approach can be adopted with all existing (standalone) template sets, to optimize
machine capacity and introduce a more efficient workflow.
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Guidelines For This Approach

You can see the relationship between a templates inherited from one set to another (created using
the hierarchic approach), by selecting properties of the template from the newer set.

5 Template Editor | Funcspec: ACCESSORIES + ME1 — | X
File - ’W\ Template Set = DB
A | Select 3 | Camera 3 S
Mew...  Ctrl+N Package ¥
Copy Ctrl+C | Voice Over 4 1 (override)
Paste  Ctrl+V B e v FULL (inherited)
Paste All Graphics 4 HEAD (override)
Delete Del mm DVE L4 LVO (inherited)
o I:‘ Jingle 3 VO )
Reset Telephone 4 WALL (inherited) C
Ad-lib Pictures  »
Undo Ctrl+Z Break v
Properties... F4 Bl video wall » E
H Sound 3
n Accessories 3 ~

Black letters without any parenthesis: Operation is defined in the current template set only
Black letters with (override): Operation is defined in the template set but also exist in the
base template set. The current template set definition is used and overrides the
implementation in the base

Blue letters with (inherited) : Operation is defined in a base template set and has no
implementation in the current template set

Red letters: An empty template, this operation is not defined.

You can break the relation (inheritance) between two template sets

You can base a new template set on a template set that was itself created using the
hierarchic approach

You can 'flatten’ an inherited template set back to its base (original) template set. This will
push any new templates back into the originating template set. After this operation, the new
(inheriting) template set is deleted

When renaming the originating template set, the relationship to any inheriting (based on)
template sets still works.

Template Set Operations

To work with a template set, from the AV Automation utility, select Devices > Template editor, to
open the editor.
From here you have several operations:

To Add a Template Set

1. Select Template Set > New.
2. In the Name field, enter the name of the new set.
3. Click OK.

File-based Template Sets
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This method can be used without the Template Database, for example at installation / show

design when trying out several solutions/designs.

You can select a ready-made template set, stored as an XML-file. This presents a convenient way of

switching between sets.

1. Select File > Open
ffi Template Editer | Funcspe

File ~| Template - Template &

Mew...

| Open... M
Save CtlFlz- 5
Save To Database

Save As,.,

Revert...

Exit Alt+F4

2. Select the preferred XML-file from the list, and click Open.

55l Open ChannelTemplates x
A » ThisPC > Windows (C) » channeltemplates v & | Search channeltemplates o
Organise v New folder =- ™ @
Name ” Date modified Type Size

# Quick access

[ AsRunLogRepositoryCenfigml XML Document 4KB

I This PC [1 aveonfigaml XML Document KB
B 30 Objects [ channeltemplatesxml XML Document 2668 KB
I Deskiop [ ChannelTemplatesLastSavexml XML Document 2331KB

[] ChannelTemplatesLastTemplateSet xml XML Document 2331kB

[ Documents

[7] keyboard_shortcutssml XML Decument 2KE

& Downioads [} LogRepositoryConfigaxml XML Document TkB
P busic [7] MosartGlobalSettings.sml XML Document ke
=] Pictures [ MosLogRepositoryConfigxml XML Decument ke
[ videos [ newsroomsettings.mi XML Document 13KB

2, Windows (C)
= FinanceBGO (\\bgo
= Installers (\\bgo-me
= common (\BGOFS

= CenterNorway (B¢

& Network

e “ -

To Open a Template Set

1. Select an existing template set with Template set > Select.
2. The name of the currently opened set is shown in the title of the Template Editor.

Fils = Templils = Termpdats S

Funcspec
JINGLE + 3
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To Rename a Template Set

1. Select Template set > Rename .
2. In the Name field, enter a new name for the set.

3. Click OK.

To Delete a Template Set

1. Select Template set > Delete .
2. In the dialog box, click Yes to confirm delete.

A Note: You cannot delete a template set that is the origin of any other (hierarchic)
template sets. In other words, if a copy of your template set has been made using
the hierarchic approach (see To Copy a Template Set below), you cannot delete the
originating (base) template set

To Copy a Template Set

Referring to the background discussion in Working with Template Sets above, when you copy a
template set, it is more efficient to use a hierarchical approach.

1. Select Template set > Copy.
2. Enter the name of the new set in the text box.
3. Hierarchic approach: Select check-box Base on original.

.“i,? Copy Template Set

| BasedOnNewsnight

>
MName OK
_ Cencel |

Cancel
[v Base upon original

& Note: If the Base on original check-box is not selected a physical copy of the entire
template set including all nested templates, is created.

4, Click OK.

To Flatten a Template Set

You can push all templates in a new template set (created using the hierarchical approach), back to
the originating template set.

1. Select Template set > Flatten .
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2. A dialog box displays which template set the selected template set will be flattened to.
Template Editor

Flatten template set BasedOnFuncspec to Funcspec?

| Yes Mo
3. Click OK.

All templates in the selected set are now inherited from the base set.

To Hide a Template Set

When a template set is hidden it is unavailable to users of the Viz Mosart GUI and any NCS
components (ActiveX) that normally provide user access to select template sets.

1. Select Template set > Properties .
2. Select check-box Hide from user.

ﬁi Template Set Properties — O ot
BasedOnFuncspec > Funcspec oK
Description;
|LU'IEJ1I'11E“-I_'"|‘~‘E- Cancel
Based On
|Takshaw =1 I Hide from user
Recall Setings
[ On select: |
| On unselect [
| On inihﬂllzanl
[ Graphics pn:]
3. Click OK.

Template Set Properties

You can manage some properties of a template set with Template Set > Properties.
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[} viz Mosart Template Editor NameOfGallery - O X

Funcspec
B JINGLE + 3
Copy

Delets

Taks

Rerame..

Hatten

Set As Default
Properties...  Shift+F4

X

descriphion Funcspec | DB

Which displays the configurable parameters:

Y% Template Set Properties — L >

11 oK

Description;
I Cancel

Based On:
“none: ;I [~ Hide from user

—HRecall Settings

[T Onselect: I
[T Onunselect: I
[T On initializaﬁc:n:l

[~ Graphics profi |E:Z|

Item Description

Descri  The name of the template set.
ption

Based Original template set, upon which this template set is a unique variant.
On

Copyright © 2022 Vizrt Page 279



Viz Mosart Administrator Guide - 5.0

Item Description

Hide Prevent template set from appearing in user selection menus.
from
user

On Behavior of recall under this condition.
select

On Behavior of recall under this condition.
unsele
ct

On Behavior of recall under this condition.
initiali
zation

Graphi  (When used) Profile that will be applied to the new template set.
cs
profile

10.6.5 Other Template Functionality

State Variance
Example of Using State Variants
- To Configure Template State Variance
Example - Reset State After
Dynamic ME Allocation
- Template Editor Password
- To Enable or Change a Template Editor Password
- To Reset a Template Editor Password

State Variance

A story sequence comprises items based on templates. With the help of state-based variants, a
single template can be used for all stories. For example, the figure below shows, after the first
story, a sequence of three stories where each story contains a single story item, and each story is
using the same Viz Mosart template (VOICEOVER+HEAD). State variance enables a different
template variant to be used depending upon the story's position in the story sequence.
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00:00:00 00:00 |

00:00:00 00:00 |HEADR

HEAD-01

00:00:00

00:00:00

HEAD-03

For example, the first story in a sequence can behave differently to the remaining stories. Another
example is when combining a sequence with music, so that each story in the sequence has a
specific length, synchronized with the music.

In both examples, is it necessary to invoke different templates depending upon the position of the
story in the sequence. You can make it simple for the user to add their stories by just referring to
the master template (HEAD in this example).

& Note: Template variance only works on Story level, meaning that only one story item /
template should be assigned per story.

Example of Using State Variants

[+ Use state variants

Wariants
HEADZ <= | |HEAD NO BONG &
HEAD3 — |HEAD WIPE
- HEADZ
M 0500 MEW FRC
M CATWALK OPE ¥
up | Down

Reset State | 6
Reset State After | 6 Stories

¥ Last state HEAD WIPE -

[ Single State | J

Continuing with the headlines example presented above, the templates can be placed into a
sequence.
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1. The template called HEAD is the master template, and the first story with a HEAD variant
uses this template.

2. The second story with a HEAD variant uses the template called HEAD2,

3. HEAD3 is used for the third story.
In this way, the only command (template variant) used in the newsroom system is HEAD,
regardless of whether it is the first, second or third.

4. You can now change the order of the headlines without any modification to the script,
making it very quick to do last minute changes.
In the same way, you can also define which template to use if there is only one HEAD, or if
the last HEAD template should act in a specific way.

To Configure Template State Variance

Configuring template state variance is done in the template editor using the Template
Properties dialog.

1. Select any template as the master template which will be used as the first template in the
sequence.

2. Add additional variants in the sequence using the << and >> arrow buttons.
For a particular template type, it is only possible to select variants of the same template
type. The same template variant may be used multiple times.

3. Use the Up and Down buttons to shuffle the variant order.

The following properties provide additional control over which template variant will be used:

Reset State: Index number of the template variant that will continue, if the number of stories
in a sequence is larger than the specified number of variants. The index O refers to

the first variant (i.e the master template itself).

Reset State After: The number of stories not belong to the sequence, that can be run before
the new sequence is started. This allows the variance sequence to be kept, even when there
are stories within the sequence that are not part of the sequence itself. See the example
below.

Last state: Special variant to be used for the /ast story in the story sequence.

Single State: To be used as the last state when there is only one story in the sequence.

A Note: When using Single State, the property Last state must be defined.

Example - Reset State After

This example continues with the story sequence presented above with the three stories all using
the HEAD template.

The HEAD template variant has a variance sequence of three item: HEAD, HEAD-2 and HEAD-3.
Executing the story sequence then invokes the template variants "HEAD", "HEAD-2" and "HEAD-3"
for the three stories respectively.

If you now add another story sequence, for example HEAD, HEAD, OTHER-STORY, HEAD, with Reset
State After defined, then executing this story sequence invokes template variants depending upon
the value of Reset State After:

Reset State After <= 1: HEAD, HEAD-2, OTHER-STORY, HEAD
The sequence is restarted since Reset State After is less than or equal to 1 (story).
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Reset State After > 1: HEAD, HEAD-2, OTHER-STORY, HEAD-3
The sequence is continued since the Reset State After is larger than 1 (story).

Dynamic ME Allocation

- To be able to use dynamic allocation, the vision mixer must have at least two mix effect
banks in addition to your program/preset bank.
- Viz Mosart uses ME1 and ME2 for the dynamic allocation.

& Note: Programming of the emem registers on the vision mixer vary between the various
models on the market. Contact Viz Mosart support for instructions on how to prepare your
switcher to work with Viz Mosart’s dynamic ME allocation

- When ME’s are included in a template with crosspoints or an emem recall, it’s possible to do
a dynamic selection of the ME, by choosing M_RIP or M_OTH.
Dynamic allocation can be useful in situations where you want an effect to load on an ME not
in use, or to set a crosspoint on the ME currently in use.

- To allocate a "new" ME in your template, then choose M_RIP (ME ripple). This loads the effect
or set crosspoint on the ME that has the status of "not in use".
When this template goes On Air, the status of the ME will change to "in use". The next
template that uses M_RIP will then load on the other ME.
Conversely, use M_OTH (ME other). Using this in a template loads the effect or set crosspoint
on the ME with the status "in use", and does not cause a change of status between the two
ME’s.
This means that if the next template also uses M_OTH, it addresses the same ME as the
previous.

Template Editor Password

Password protection can be enabled for the Template Editor. When enabled, the user is prompted
for the password when opening the Template Editor.

By default, no protection is enabled, and the user is not asked for a password before opening the
Template Editor.

To Enable or Change a Template Editor Password

1. Set focus on AV Automation.
2. Select Devices > Change Password.
3. In the Change password dialog box, enter a new password or change an old one.
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-
Change password u

Qld password: I

Mew password: ||

Retype new password: I

0K I Cancel

To Reset a Template Editor Password
If the password is lost, it can be reset.

1. Set focus on AV Automation.
2. Opening AV Automation Settings with CTRL+SHIFT+S.

3. Find the PasswordHashed entry, and remove the value.

2] CAProgram Files (x86)\Mosart Medial... E@g
B=4l |3
MewGalleryLoad Falze -
PasswordHashed DT —
port_audiomixer 3000 -
PazzwordHashed
e =

10.7 Mosart Instrumentation Panel

%= Mosart Instrumentation Panel = =

Time Dur Cat Event Device Description ReturnCode

The Mosart Instrumentation Panel displays all device commands in real time, that are being sent to
the various connected devices. Each command is time stamped, revealing when a device command
was issued, in relation to the taking of a Mosart template.
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10.8 Newsroom Tags

Newsroom tags is the mechanism for configurably transferring data values from the NRCS to Viz
Mosart. For example, a template for playing a clip can have a Newsroom tag for the clip name. The
journalist specifies the clip name in their NRCS story item. This clip name is then automatically
transferred to Viz Mosart, where the correct clip is played-out when the story item is taken.

A Newsroom tag has

- A name
- Optionally a value
- Optionally a list of permissible values. (If a list is given, the tag value, if any, will be in the

list.) This list will be one of those defined in AV Automation, section Audio and Video Setup:
- Video Config
- Audio Config
Effects
Router sources
Router destinations.

Note: invalid characters in XML 1.0 are also invalid characters when used with ActiveX and
newsroom tags. For more information, see the XML 1.0 documentation:
https://web.archive.org/web/20140228010526/http://validchar.com/d/xml10/
xml10_namestart
https://en.wikipedia.org/wiki/List_of_XML_and_HTML_character_entity_references
https://en.wikipedia.org/wiki/Valid_characters_in_XML

The basic workflow for one tag is:

1.

In the Template editor, a Newsroom tag is added to a template field. (See Adding a
Newsroom tag to your Viz Mosart Template below). The tag name is specified.

If the template field has an associated list of values (as listed above), that list will be the tag
list, too. If a value is given for the template field, that value will become the tag value, too.
In the ActiveX in the NRCS, when inserting the template into a story item in a rundown, the
tag value may be changed or set (depending on whether a value was given in the previous
step).

. When the rundown is loaded into Viz Mosart, the Newsroom tag value, if any,

is automatically assigned to the template field, overriding any value set in the Template
editor.

Note: Step [1] may be repeated, adding several tags to a single template. Then step [ 2 ]
may be repeated in the ActiveX, and step [ 3 ] will automatically be repeated, too.

If in step [ 1], the same tag name is specified for several template fields (in the same
template), only one newsroom tag will be added, so only one value need be supplied (for
this tag; there may be others) in step [ 2 ].

In step [ 3 1, this single value will be assigned to all template fields (in that same template)
having the newsroom tag with this name.
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(Optional) If the newsroom tag shows up in the GUI Program window or Preview window (see
the explanations for Program window and Preview window (Key Select sub-sections) in the
Viz Mosart User Guide, section Main User Interface ), the value may be modified there.

The remainder of this section deals with:

- Adding a Newsroom tag to your Viz Mosart Template
- To Add a Newsroom tag
Newsroom Tags Order
- To Set newsroom tag order
- Advanced Features for Specific NRCSs
- To Use a Column in ENPS as a Newsroom Tag
Inheriting Newsroom Tags (applies to MOS-based NRCS s only)
- Keep Newsroom tag (with the same name) within a story
Inherit from a Newsroom tag with another name
Inherit with default value
- Adding inheriting values to the lists defined in AV Automation's Audio and
Video Setup
Examples
DVE Template with inheritance
- Timeline Example

10.8.1 Adding a Newsroom tag to your Viz Mosart Template

To Add a Newsroom tag

Refer to section Working with Device Functions, which lists the properties of the device
where you want to add the Newsroom tag (e.g. the 'Switcher XPoints' as shown below).
Right-click the field (e.g. Crosspoint). A pop-up menu appears:

[F55)

Switcher XPoints -

Crosspoint 1 Diown stream keyer
Mix Effect 1 Crosspoint Audio link Off delay
- |KAM DSk Off
Cross | Add Newsroom tag
,_ Remove Newsroom tag DA !
T I

-
[ Cross Point Hold I
Mix Delay 0 I~ Transition Only
Mix Delay Out [0 1

oK | cancel | |

L I

(If the field already has a Newsroom tag, there will instead be a menu option Change
Newsroom tag, and the Remove option will be enabled. Please note that not all template
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fields support Newsroom tags. When right-clicking a non-supporting field, a pop-up menu
may or may not appear. If it does, it will not contain an Add Newsroom tag option).

Select Add Newsroom tag.
A dialog menu appears:

Add newsroom field name e
Newsroom field 0K
Cancel
kpoint |

Please note that a default name may be given.

Enter or change the Newsroom tag name, and click OK.

& Note: Avoid using any special characters in Newsroom Tag naming

Close the device properties window (e.g. the 'Switcher XPoints' as shown above).
- To verify, hover-over the device details. The Newsroom tag(s) are presented at the bottom of
the panel.
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$ *Viz Mosart Template Editor NameOfGallery

File = Template ~ Template Set ~ DB -

install
CAMERA + 1

SW Input

name SW Input
xpoint CKEY1
G EE

xpoint_pp

mix_delay_out
audiolink none
delay_transitiononly

dsk_8_off delay

-- Newsroom tags -
0) mixeffect mixeffect
order
1) xpoint xpoint
order

| install | DB/

10.8.2 Newsroom Tags Order
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If a template has more than one newsroom tag, the order in which the tags are shown in Viz

Mosart’s ActiveX, may be changed in the Template editor.

To Set newsroom tag order
1.

In the Template Editor, open the target template
2. Open Template Properties and select the Newsroom tags order tab
3. Order the Newsroom tags if there are several. (Select a tag, and then click Up or Down).

Template properties

right
middle

General | Control Commands  Newsroom tags order |

Order the newsroom tags by rearranging the
elements in the list below:

Up |
_ Don_|
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4. To verify, open the Activex in the NRCS, and observe that the tag order is as set in the
previous step:

BEE™™)
' )(=2)| €] C:\Program Files (86)\M 2 ~ & || & Mosart ActiveX i T 5o
Viz Mosart £
| E .
|TestTempIateSet _*J
CAM new Description
PACKAGE Double box
VO 3IBOX
LIVE SQUEEZE [ et
GRAPHICS —
Transition
TELEFHOME Default -
B-ROLL
BEREAK
CG MName Yalue
s left jcamt
COMMAND s
right EXT1
middle EXTZ2
v
£ >

10.8.3 Advanced Features for Specific NRCSs

To Use a Column in ENPS as a Newsroom Tag
You can use a column value in ENPS as a Newsroom tag in a Viz Mosart Template.
1. Add the column in ENPS, by using the TV station-specific routine to add a column in ENPS.
All the current fields are visible in System fields->ENPS fields.
A Usage Notes

The id of the field and the Newsroom tag in Viz Mosart must be named identically.
The naming is case-sensitive.

Make sure that Mos Send is checked.

Type must be Script+RO Column

2. Restart ENPS client to be able to add your new column in the layout.
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3. Add the column as a story variable in Viz Mosart config:

File  Edit Story External Metadata
mostagname Muosart Action Format Type mos_value action_value
inp1 tem_wariable j String j inp1
inp2 itern_wvariable j String ﬂ inp 2
inp3 tem_wvarable j String j inpd
inpd tem_wvarable ﬂ integer j inpd

4. In Viz Mosart External Metadata
a. Add the new ENPS field as, for example, an item_variable.
b. There is also a story_valuable available, but using this action value will affect all items
in the story (the Newsroom tag binds to all primaries in that story).
c. The target here should be the first primary item in a story.
5. Restart all Viz Mosart server applications to apply settings.
6. Add the Newsroom tag to required template, a standard operation as described in Adding a
Newsroom tag to your Viz Mosart Template.

Inheriting Newsroom Tags (applies to MOS-based NRCS s only)

For MOS-based NRCS, Viz Mosart offers a method where a Newsroom tag need only to be set once
within a story.

A Note: If, for ENPS, the Story scope is set to Grouped, a story in this context means the
contiguous collection of GUI rows with the same story name. See Settings Editor MOS,
section Story scope.

Story items that follow can be programmed to follow/inherit the given Newsroom tag (i.e.,
inheriting its value), with an optional default value.

Keep Newsroom tag (with the same name) within a story

If a Newsroom tag has the special value 'KEEP', this value will act as a placeholder in the sense that
the tag will get the value of the last Newsroom tag in the story with the same name.

A Note: The special value KEEP is configurable . See definition for Newsroomtag keep
keywords in Settings Editor MOS, section NCS Configuration.

Inherit from a Newsroom tag with another name

A Newsroom tag may inherit from another tag in the same story. Then the inheriting tag will
'inherit’ the value of the tag referred to, i.e., get the same value.

This is done in the following way: The value of one tag (the inheriting tag) may be given as
{name}', where name is the name of another tag (the tag inherited from).

Example: If there is a tag with name 'left’, another tag (with some other name) may inherit the tag
left by having this value: '{left}'.
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Inherit with default value

Optionally, a default value may be given, to be used when the tag inherited from has no value (in
the story), or does not exist at all. The general syntax (for the value of the inheriting tag) is '{name}
#default', where name is the tag inherited from (as above), and default is the default value.

Example: Continuing the example above, the inheriting tag may be given the value '{left}#0S 2'.
Then, if the tag left has no value (or does not exist at all), the value of the inheriting tag will be 'OS
2'.

Adding inheriting values to the lists defined in AV Automation's Audio and Video
Setup

As mentioned in the introduction above, a Newsroom tag may have a list being one of those
defined in AV Automation's Audio and Video Setup. Special values as defined above ('KEEP",
{name}', and '{namel#default’) may actually be added to these lists, making the available for
selection both in the template editor and in the ActiveX.

The following figures five such values added to the Video Config list, and how these values appear
in the ActiveX:

rE] XML Editor file///c:/channeltemp cnﬁg.meD (B[ B Viz Mosart
File Edit
¥-point name Physical input Audiolink Audiolink Ch 2 > = *
DVE1 64 j j uncspec ~
TEC 100 | ~| CAMERA LIVE Description
PACKAGE 2BOX name
ME30P2 125 | ~| VOREOVER —_——
ESOFs 126 | =l |los
{eft}tiCamera 5 - - GRAPHICS
left} J J VIDEO EFFECT
o j j JINGLE Transition
fight?} | ~| | PHONO Defaul
{ight}ALX12 ~| ~| EIE%OE;TK efault  ~
KEEP El =l { vibEOWALL
i | ~|—] cG Name Value
T4 | SOUND
S *| || ACCESSORIES left LIVET v
COMMAND right LIVE1
LIVE2
right LIVE3
LIVE4
CLIP1
CLIP2
CLIP3
CLIP4
STREAM1
STREAM2
INP1
INP2
INP3
INP4
KEEF
{left}#Camera 5
{left}
{right}
{right}{#AUX12
KEEF

Explanation:

{left}#Camera 5 - Use the value of the last Newsroom tag {left} or “Camera 5” if no such
Newsroom tag exists.

{left} - Use the value of the last Newsroom tag {left}. Nothing happens if no such Newsroom
tag exists
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KEEP - Special configurable word that means keep existing value of the corresponding

Newsroom tag. (In the ActiveX example "left")

Examples

DVE Template With Inheritance

A DVE 2BOX template where the left and right input may be inherited from sources within the

same story

Key

name Key

bus 1
xpoint {left’¥Camera 5 D
audiolink 1
index U
set_me_in_pp False

peint_hold False

fect M_RIP

-- Mewsroom tags --

xpoint boxleft

Key 2

{lefti#Cam {rig

ALK
1]
Xpoint ememnr_pr

|
DVE DTL 2 BOX

0

| 2406.201314:4302 |

In this template the values for Key 1 and Key 2 are:
Key 1 = {left}#Camera 5
Key 2 = {right}#AUX 12

This means that Key 1 will be either the current value of a Newsroom tag named left within the

same story or “Camera 5” if no such Newsroom tag exists.
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Timeline Example

Camera+4: LIVE+2: DVE+DTL2BOX:
left = Camera 4 right=0S 2 left = {left}
right={right}

In the figure above three templates are placed in a timeline:

1. Camera+4: Where xpoint is set to “Camera 4” with Newsroom tag = “left”

(4 “NEWSDAY: CAMERA + 4 (0] o] [ 5 e

File ~ Edit = Show = Test Template DB -

ML
0
Xpoint S ememnr_pr

SW Input
name S5W Input
xpoint Camera 4

| 2406.201315:21:04

delay
x_delay_out

k

-- Mewsroom tags --
xpoint
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2. Live+2: Where xpoint is assigned to OS 2 with Newsroom tag = “right”

SW Input

name
¥point
mixdelay

int_pp
mixeffect
set_me_in_pp
crosspoint_hold
dsk_off

mix_delay_out
audiolink

=

-- Mewsroom tags --

right

Qutside Source - Enter item timing in DURATION box belnw—righ* 24.06.2013 15:22:55 |

& Note: The Newsroom tag here is entered to make it possible for later templates in
the story to inherit the value. Adding a Newsroom tag here will also expose this
value to the ActiveX

3. DVE+DTL2BOX where left and right inputs are set to inherit Newsroom tag {left} and {right}
respectively.
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F |'1

ol *NEWSDAY: DVE + DTL 2BOX » Bl B %

© File = Edit ~ Show = Test Template DB -

Graphics

' Key 1 N

0
Xpoint  ememnr_pr

o | 0 | 0o [ o o0 o o1

DVE DTL 2 BOX | 2406.201315:42:02
L9 A
In this example, the left and right inputs are inherited from previous templates in the same
story exposing Newsroom tags with the same names.

A Note: Here, no default values are given., so nothing will happen if no values have
been assigned to the left and right Newsroom tags
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11 AV Automation Device Properties

AV Automation can send commands to all connected broadcast devices. For the commands to be
received, and interpreted according to the device's specifications, the device must be configured
within Viz Mosart.

Vision Mixer \fideo Servers Graphics fudio  Camera Fobotics  Light Control  Router  Subtiles GPL/AD  Taly  Virual Set Weather  Video Wall  Int| + |

Protocol SONY MVS v
Comport videoswitcher CoM3 v Ini - SNAPSHOT
Reset snapshot vw 1
DVE Forward SNAPSHOT
Auillary videowall 1 £ ] DVE Reverse SNAPSHOT
Diefault Camera mix on v I:I Effect Memory B »
Mix Effect Videowall 1 Me 1 - DSKMNr 1~
Min. Cue delay frames [ AUX Clicked preview |1
Min. Clip Mix delay frames [] Use DSK 1 on/off [] Control DSK from Overlay Interface
Usze DSK 2 on/off Owveray Direct Take control
FrameRate frames per second [ Use DSK 3 onloff Active |:|
Virtual ME Physical ME [] Use DSK 4 on/off Inactive |:|
FFP PP v
[] AsRun log cross peints in stand by
ME1 ME1 -
MEZ ME2 -
ME3 ME3 -
ME4 ME4 e

Cancel Apply Save & Close
To configure device properties in AV Automation, select Devices > Preferences.

& Note: AV Automation must be restarted before any changes will take effect.

The Device Properties menu has three common buttons:

Cancel: Exit this menu without saving any changes.

Apply: Save all changes and reconnect the device on the active tab (only applies to
tabs Vision Mixer, Video Servers, Graphics, Audio, Camera Robotics, Light Control
and Subtitles).

Save & Close: Save all changes and close the menu.

This section presents the following device properties:
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- Vision Mixer

- Video Servers
Graphics

- Audio
Camera Robotics
Light Control
Router
Subtitles
GPIO

- Tally

- Virtual Set

- Weather

- Video Wall
Integrated Engine
General

11.1 Vision Mixer

This dialog menu is accessed from the AV Automation menu bar with Devices > Properties > Tab:
Vision Mixer.
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Vision Muer | Video Servers | Graphics | Audio | Camera Robotics | Light Control | Router | Subitles | GPI/D | Tally | Virtual Set | Weather | Video Wal | Int¢ | »

v Protocal |Carb-::ni‘te ﬂ
Hest videoswitcher: |'| 52.168.0.123
Port videoswitcher: 7788 Ini - EMEM 99
Auxillary videowall 1 4 Reset dmem vw 1 49
v Default Camera mix on vw 4 DWE Forward EMEM 57
DVE Reverse EMEM 58
Mix Effect Videowall 1 Me 4 - Effect Memory PP -
Min. Cue delay 25 frames DSKNr 1 -
[ AUX Clicked preview |1
Min. Clip Mix delay 10 frames [~ Use DSK 1 onloff ™ Control DSK from Overlay Interface
™ Use DSK 2 on/off Owerlay DirectT ake control
FrameRate 25 frames persecond [~ |Jse DSK 3 onloff Active
Wirtual ME Physical ME [ Use DSK 4 on/off Inactive
[H3 inone) - -
™ AsRun log cross points in stand by
ME1 ME1 -
MEZ ME2 -
ME3 ME2 -
ME4 ME4 -

The exact appearance of the Vision Mixer tab depends on your selection from the Protocol drop-
down menu.

11.1.1 Vision Mixer Settings

There are several settings required for Viz Mosart to effectively control a specific video mixer.

Description of the Video Mixer Menu

A Note: Most devices, especially ones controlled through IP, often have their own config
interface (for example, accessible through a web interface) where various parameters such
as host/port can be inspected and modified as needed.

Values found in this device config interface should be used for setting their corresponding
properties that are described below.

Protocol (check box): Check the box to enable video switcher control.
Protocol: Select a protocol supported by your switcher:

ACUITY

CARBONITE

Copyright © 2022 Vizrt Page 298



Viz Mosart Administrator Guide - 5.0

- GVG200: GVG/Philips/Thomson
- GVG4000: Ross Synergy
- GVG4000 V2
- GV CPL
- GV DD35
- GV KAYENNE PRIMARY
- GV KAYENNE SECONDARY
- GV ZODIAK
KAHUNA: Snell Kahuna/Kula
KAHUNA IP: Grass Valley Kahuna/Kula
MASTERPIECE
NOVA700: Echolab
- SONY: Sony compatible video switchers
- SONY BVS: Support for legacy SONY DVS/BVS 300 series
- SONY MVS: An extension to the protocol for the SONY MVS8000
- SONY SERIAL TALLY
- VIZRT-IPS

- Comport videoswitcher: Defines the serial port the video switcher is connected to.

Host videoswitcher/Port videoswitcher: Defines the IP and port the video switcher is
connected to.
- This labeling on the settings page depends on what type of mixer is selected.
Host / Port is valid for mixers that are using TCP/IP protocol, or a com-port for serial
port communication, or a host- or client-port for UDP.
- Com-port / Host-port labeling depends on the mixer model. See Common Video Mixer

Connection Settings below.
- Auxiliary videowall 1: This is the auxiliary output from the video switcher to the video wall.
Default Camera mix on vw (check box): Enables the default camera in program when
entering video wall mode.
Default Camera mix on vw: Enter the camera number you want to use as the default camera
in program when entering video wall mode.
Mix Effect Videowall 1: Select the ME to use when enabling mixing in video wall mode.
Min. Cue delay: Value in frames which sets the minimum delay before Viz Mosart cues the
next template in preview.
Min. Clip Mix delay: Value in frames which sets the minimum delay from starting the server
to starting the video switcher transition.
FrameRate: Specify the number of video frames per second for the system.
Ini-EMEM: Initial register to recall when starting the automation. Depending on the Protocol
chosen, the caption may alternatively be Ini - DMEM or Ini - SNAPSHOT.
Reset EMEM vw 1: Register to recall to normalize the ME before entering video wall mode.
(Depending on the Protocol chosen, the caption may alternatively be Reset dmem vw 1 or
Reset snapshot vw 1).
DVE Forward EMEM: (not supported by Sony) EMEM to recall for running DVE forward.
(Depending on the Protocol chosen, the caption may alternatively be DVE Forward DMEM or
DVE Forward SNAPSHOT).
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DVE Reverse EMEM: (not supported by Sony) EMEM to recall for running DVE backward.
(Depending on the Protocol chosen, the caption may alternatively be DVE Reverse DMEM or
DVE Reverse SNAPSHOT).

Effect Memory: ME to use when recalling registers for Effect use.

DSKNr: Downstream keyer to use for the DSK on/off functionality.

- AUX Clicked preview (check box and number): Check the box to enable AUX clicked preview,

and specify the AUX bus connected to the preview monitor. When activated, it is possible to
click an element in the Viz Mosart rundown, to preview the source on the monitor, via the
specified AUX bus.

Use DSK n on/off: Enable or disable the on/off functionality for DSK 1-N, where N depends
on the protocol. Most protocols have 4 DSKs, but there could be as many as 8 DSKs.

- Control DSK from Overlay Interface: Check box to enable DSK to be on only when overlay

graphics is present.

- Overlay Direct Take control:

- Active: Viz Mosart will run the direct take entered here when an overlay graphic goes
On Air.
Inactive: Viz Mosart will run the direct take entered here when an overlay graphic goes
Off Air.

- AsRun log cross points in stand by (check box): Check box to set AsRun log in stand-by.

Common Video Mixer Connection Settings

The following table presents some recommended or additional values for a range of video mixer

drivers.
Driver Settings Config Interface Notes
GV CPL Port video switcher: 5000 This driver uses UDP protocol
Client Port video switcher: 6004 Additional client port property used for
receiving callbacks
Sony SonyVideoSwitcherConfig.xml ReadTimeout is possible to change via the
setting SonyVideoSwitcherConfig.xml

configuration file. Default set to 200

<item name="ReadTimeout" s
milliseconds

value="100" />

11.2 Video Servers

Viz Mosart is capable of controlling video servers from many different manufacturers. Although
the end result is the same, each video server type operates in a slightly different way.
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It is essential that the correct settings are defined in AV Automation for Viz Mosart to effectively
and correctly control your video servers. You reach these settings with
AVAutomation > Devices > Preferences.

From the Mosart Device Properties menu, select the Video Servers tab, to display the
configuration menu below.

Video server configuration Mosart port configuration

Add newwr server | Add new port | Main H I:'Zl MName: |Main
Quantel Properties = Eﬂ = m Maosart Port Group
EG:mnect[u = ] E|Dpt|nn .;

Config File ClipSererQua a012 B (sQ2-1) Mame

Initial Standby [ o Crder 0

4 W £

IOR hitpy/fquantel: - 2 El Misc

Serialio 20154 sG2:1 C: (531:2) IsDefault O

Server Type Quantel ~ 532:2 D (=Q2.2)

Slave

Tirmeout
El Description

Alias

Name s01

. e [ Semple | [ Resters |

Name=s01Type=0uantel Server=192 168.1.1:Pon=5258 Mode=FPlayer Config=ClipSeneruantel wml IDR=hitp Yquanel @132 168 1.1 ZoneManager ior. Sengl

The left side presents details of the physical servers, and any port configurations.

The example above presents a Quantel server, sQ1 (as selected from the Server Type drop-
down menu), and one other server (sQ2), which could also be a Quantel server.

Server sQ1 has 2 ports defined, sQ1:1 + sQ1:2.

Server sQ2 has 2 ports defined, sQ2:1 + sQ2:2.

The right side presents details of the virtual connection within Viz Mosart, with salvo
definitions.

This is described in Working with Mosart Port Configuration.

This rest of this section contains the following topics, presented according to the configuration
menu illustrated above, from left to right:

Working with Video Server Configurations
Video Server Properties
Common Settings
AirSpeed MultiStream
Grass Valley K2
Nexio
MVCP
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- Omneon
- Quantel
- VDCP
- Viz Engine
- Vizrt-ips
- Video Server Port Properties
- Working with Servers and Ports
- To Add a Server
- To Remove a Server
- To Add a Port
- To Remove a Port
Mosart Port Configurations
- Virtual Server Ports
- Working with Mosart Port Configurations
- To Add a Virtual Port Group
- To Remove a Virtual Port Group
- To Add a Virtual Port
- To Remove a Virtual Port
- Working with Salvos
- To Connect a Server Port to a Virtual Port
- To Clear Server Links in a Virtual Port Node
- To Add a Salvo
- To Remove a Salvo
- To Modify a Salvo

11.2.1 Working with Video Server Configurations

You can add or remove video servers to your Viz Mosart system, and modify the configuration of
existing hardware.

Viz Mosart supports a wide range of video servers. These can be viewed from the Server
Type drop-down menu.
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Video server configuration

Add mew server Add new port |
Quantel Properties
Config File ClipServerQua
Initial Standby J
I0R, httpyfiquantel:
Serialbo 20154
Server Type Quantel
Slawve
Timeout
El Description
Allias
WName s0Q1

& Note: Only compatible combinations of MediaAdmin and AVA drivers can be defined.
Please contact Vizrt Support for further details.

The Name property links the selected video server to a MediaAdmin properties line.

For an explanation of the various configuration properties, please refer to the specific video
server model, as presented in Video Server Properties below.

After configuration, restart Media Administrator and AV Automation, and ensure that the GUI
is connected to the K2 server(s).

Verify that all indicator lights for the video servers go green.

@ Tip: If you do not get green lights, and you see the following message in the Mosart log:
Failed connecting to video server K2:
The source was not found, but some or all event logs could not be searched.
Inaccessible logs: Security.
you can try to start AVAutomation as Administrator. This is a known issue in Grass Valley.
More info here: http://www.gvgdevelopers.com/concrete/apis/appserver_api/windows/

Video Server Properties

Here are some guidelines for common video servers that Viz Mosart can work with.

Common Settings

Several of the settings are always required, as listed here

Initial Standby: If selected, the server is forced to start in Standby mode.
Server: Defines the hostname or IP address of the video server.

& EVSXedio: This value is not required.
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Server Type: Name of supported video server. For example, AirSpace, AirSpeed, EVS LinX,
Orad OCIP.

- Alias: Defines the name of the server to display in the Viz Mosart GUI and Timing Display.
Name: Internal name of the server, for display in AV Automation.

The above settings are typical for
AirSpace, AirSpeed, EVS LinX, EVS Xedio, OradOcip video servers.

AirSpace Properties

B Connection

Initial Standby ]
Server

E Description
Alias Alias
Mame Mame

AirSpeed MultiStream

AirSpeed MultiStream Properties

= Connection

BasePort

Initial Standby L]

Server

Server Type AirSpeedh ~
E Description

Alias Alias

Marme Mame

BasePort: The first port Viz Mosart uses to communicate with the AirSpeed
MultiStream server. Default: 59451.

Grass Valley K2

Connection to K2 is initialized with a ping (ICMP) from Mosart to the server to confirm the
connection. Then it uses port 3811 to communicate with the K2 server. Both must be open for
Mosart to be able to connect.

Manus Admin uses a separate port when it connects: 49171 (a range is OK. Use 49168-49172)
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Grass Valley K2 Properties

B Connection
Clip Bin
Domain
Initial Standby ]

Pazs

Server
Server Type GrassValle
Suite
User
Wolurme
El Description
Alias Alias

Mame Mame

Clip Bin: This value, together with that of Volume (see below), defines the default server
location of clips to be played. This default location is used only when the location is not
provided by other means. (In particular, it is not used when the setting IgnoreBin (in Media
Administrator) is true for this server.) The value of Clip Bin should designate a bin in the
volume designated by the value of the Volume setting.
Domain: The domain as part of the user credentials.
Pass: The password as part of the user credentials.
Suite: Arbitrary value. However, follow these guidelines:
For each K2 server, two or even three unique Suite values must be used:

First, the values for Media Administrator and AV Automation must be different.

Second, in a redundancy setup with Main and Backup Mosart server, the

two values for Media Administrator must be different.

A Note: In this constellation,
(Whereas both Main and Backup AV Automation should use the same
value, different from the two Media Administrator values.)

User: The username as part of the user credentials.

Volume: This value, together with that of Clip Bin (see above), defines the default server
location of clips to be played. This default location is used only when the location is not
provided by other means. (In particular, it is not used when the setting IgnoreBin (in Media
Administrator) is true for this server.) The value of Volume should designate a server
volume.
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Nexio
HarrisMexio Properties
E Connection
Initial Standby ]
Port 1
Server
Sowrpe [T
E Description
Alias Alias
Mame Mame

Port: TCP/IP communication port to the Nexio server.

MVCP
MVCP Properties
E Connection
Initial Standby ]
Port 2558
Server
T e |
El Description
Alias Alias
Marme Marne

Port: TCP/IP communication port to the MVCP server.

Omneon

Omneon Properties

E Connection
Directory
ExtList
Initial Standby ]
Server
E Description
Alias Alias

Mame Mame
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Directory: Defines the directory where the clips are stored.
ExtList: The list of valid file extensions used when listing and querying files on the server.
The list is period separated and case sensitive.

Quantel

Quantel Properties

B Connection

Config File

Initial Standby ]
IOR

SerialMa

Slave

Timeout
El Description
Alias Alias

Mame Mame

Config File: The path to the XML configuration file used to define the Viz Mosart - Quantel
communication.

IOR: The HTTP link including hostname or IP address to the IOR resource on the Quantel ISA
manager. Example: http://192.168.100.50:2096/ZoneManager.ior

SerialNo: The serial number of the Quantel playout server.

Slave: The hostname or IP address of the slave/backup IOR.

- Timeout: Timeout value for requests from Viz Mosart to ISA manager. If the request exceeds

this timeout the server connection is reinitialized. Setting a value here should only be
needed for sites experiencing issues with the Quantel connections. Leaving a blank value
uses the default timeout.

Recording with Quantel Devices

Quantel requires a duration when preparing a recording. This duration can be set the following

ways:

As part of a template: Specified using markin and markout properties.
As part of a keyboard shortcut: Specified by trailing the ClipName property with

[,duration]. Similar to the examples under the general section Controlling Video Servers from
Mosart above.

As part of template control command: Specified as part of the Parameter property. Again,
see the general section above.
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VDCP
VDCP Properties
{E Connection
COM Port 1
Initial Standby ]
Server Type VDCP -
E Description
Alias Alias
MName MName

COM Port: The COM port co

VDCP(tcp) Properties

E Connection

Port 1

Initial Standby L]

Server

oo
E Description

Alias Alias

Marme Marne

Viz Mosart Administrator Guide - 5.0

nnected to the VDCP video server.

Port: The TCP/IP communication port connected to the VDCP video server.

Viz Engine
VizEngine Properties
E Connection
Port 1
Initial Standby ]
Server
VizEngine *
El Description
Alias Alias
Mame Mame

Port: The TCP/IP communication port connected to the Viz Engine video server.
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Vizrt-ips
vizrt-ips Properties

B Connection

Directory Di\Sessionsh\De
Initial Standby ]
Fort 5951
Server 192.168.1.1
E Description
Alias
Mame vizrt-ips

Directory: Defines the directory where the clips are stored. The following format can be
used: {volume}:/Sessions/{session_name}/Clips/Import
Port: The TCP/IP communication port connected to the vizrt-ips video server.

Video Server Port Properties

Server Port =

B AvConfig Quantel-1
Alias Quantel:2
Audio Channel 1 SVR A e

4 e
Audio Channel 2 [empty) ~
CrossPoint SVRA ¥ 2
Video port 1

El Description
Mame Cuantel:1

Alias

Audio Channel 1: The audio channel 1 for the selected video port.

Audio Channel 2: The audio channel 2 for the selected video port.

CrossPoint: The video crosspoint for the selected video port.

Video port: The actual port name/number on the video server. Please refer to the
documentation of your video server for information on how to find these.

Name
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11.2.2 Working with Servers and Ports

To Add a Server

1. Click the Add new server button
2. In the Properties pane on the left, select the Server Type and add additional

information such as Port and Server host.

To Remove a Server

In the Video Server Configuration tree, right-click a server node and select Remove.

To Add a Port

1. In the Video Server Configuration tree, select a server node
2. Click the Add new port button, or right-click the server node and select Add new port
3. In the property editor on the left, enter the port information.

To Remove a Port

In the Video Server Configuration tree, right-click a port node and select Remove.
11.2.3 Mosart Port Configurations

Virtual Server Ports

Mosart port configuration

Main L IZII Mame: | Main
5 m @Direcﬂakes

On swatch to:
A (Quantel:1
( ) On switch from
E: (Quantel-2) On mirror switch to backup

On mirrer switch from backup:

Mosart Port Group

El Name
Marme AB
B Misc
IsDefault B
Order 0

- Add new salvo: Use the + icon to add another empty virtual video server salvo.

5.0
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Remove a salvo: Use the - icon to remove/delete a virtual video server salvo.
Switch between salvos: Use the drop-down menu to select another virtual video server salvo.
If the Media Administrator setting Enable dynamic configuration (see Media Administrator
Properties Editor, Configuration) is True, selecting a salvo will also have the effect that Media
Administrator connects only to
those servers that are part of the salvo selected, and
those servers which have Static=True in the Media Administrator connection
string. (See Media Administrator Properties Editor, Connection Media Search Servers,
Video clip Server <n>.)
Name: Defines the name of the virtual video server salvo.

Direct Takes

On switch to: The Recall Nr (see Template Properties) of the direct take template that should
be taken when switching to this virtual server salvo.

On switch from: The Recall Nr of the direct take template that should be taken when
switching from this virtual server salvo.

On mirror switch to backup: The Recall Nr of the direct take template that should be taken
when switching to a backup server using this virtual server salvo.

On mirror switch from backup: The Recall Nr of the direct take template that should be
taken when switching from a backup server using this virtual server salvo.

Mosart Port Group

Name: The name of the virtual server group. This name is displayed in the server part of the
templates.

IsDefault: Enable to set the default and preferred video port group for assets residing on
multiple systems.

Order: See the documentation of the Media Router. If the Media Router is not used, this
value can be left to the default 0.

Mosart Port

B AvConfig :
Audio Channel 1 (empty) *~
Audio Channel 2 (empty) *~

CrossPoint (empty) *~
B Description
Mame A
B Server ports
Main Cuantel:1
Mirror n/a

Mosart Port
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- Audio Channel 1: The virtual audio fader 1 for the selected video port. If nothing is selected
here, the audio fader from the physical part is used. Default: Empty

- Audio Channel 2: The virtual audio fader 2 for the selected video port. If nothing is selected
here, the audio fader from the physical part is used. Default: Empty
CrossPoint: The virtual video crosspoint for the selected video port. If nothing is selected
here, the video crosspoint from the physical part is used. Default: Empty
Name: The name of the virtual server port, this name is displayed in the server part of the
templates.
Main: Auto-generated display name of the main video port.
Mirror: Auto-generated display name of the mirror video port.

Working with Mosart Port Configurations

The panel on the right-side of the details presented in the Video Servers tab lists any configured
ports. This represents a virtual configuration, presented as Viz Mosart port groupings, or salvos. A
salvo is a configured constellation of virtual ports (see Working with Salvos below).

Mosart port configuration

Main v |:|Z| Mame: |Main

4 Maszart Part Group
G, Enﬂcnptlnn ..
B: (sG21) ame E
Order +]
= & Misc
C: (sQ1:3) lsDefault L |
e (s02=2)

To Add a Virtual Port Group

1. Right-click in the Mosart Port Configuration tree (not on a node) and select either:

- Add virtual ripple group to add a new virtual ripple group. The default ripple group
names are A/B, C/D, E/F etc.

- Add virtual preview group to add a new green virtual preview group node to be used
for preview ports. The default preview group name is P.

- Add virtual recording group to add a new red virtual recording group node to be used
for recording ports. The default recording group name is Rec .

You can edit or rename the selected group using the Properties Editor on the right.

To Remove a Virtual Port Group

You can remove a virtual ripple group, preview group or recording group.
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1. In the Mosart Port Configuration tree, right-click any ripple/preview/recording group node
and select Remove group <name>.
Alternatively, select a node and press the Delete key.

2. When prompted, select Yes to confirm that you want to remove the group from all salvos.

To Add a Virtual Port
1. In the Mosart Port Configuration tree, right-click any group node and select Add virtual port.

If the port was added to a preview group, the added port will be a preview port with default name
P. If the port was added to a recording group, the added port will be a recording port with default
name Rec.

& Note: Do not change the name Rec!

To Remove a Virtual Port

1. In the Mosart Port Configuration tree, right-click any virtual port node and select Remove
<name>. Alternatively, select a node and press the Delete key.
2. When prompted, select Yes to confirm that you want to remove the group from all salvos.

Working with Salvos

Salvos are used to switch between server setups. They are used when the operator needs to switch
between server parks, for example, when switching to a backup salvo.

Salvos can also be used if different video servers are used in different parts of the show, for
instance, sports and news, but you still want to use the same ports.

& Note: It is recommended that the default Main and Backup salvos are not renamed.

To Connect a Server Port to a Virtual Port
You can connect a server port to a virtual port:

Select the server port (in the left-hand, Video server configuration part) you want to connect,
and drag it to the virtual port (in the right-hand Mosart port configuration part) that you use
to represent the port in the selected salvo.

& Note: If the virtual port is a recording port (in the recording group), the server port to
connect must also be a recording port: The physical server must have recording
capabilities (and the chosen Server Type must allow for recording).

To connect two server ports to one virtual port, causing mirroring:

1. Select a server port and drag it to the virtual port that you use to represent the port in the
selected salvo.
2. Select another server port and drag it to the same virtual port.

& Note: Only two ports can be mirrored.
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To Clear Server Links in a Virtual Port Node

Right-click the virtual port node and select Clear links.

To Add a Salvo
Click the Add =] button.

To Remove a Salvo
Click the Delete E| button.

To Modify a Salvo

- Click the drop down box above the Mosart Port Configuration tree and select the salvo you
want to edit.
Rename the selected salvo in the Name textbox.

11.3 Graphics

Viz Mosart is capable of connecting to a variety of Graphic Engines available from many different
manufacturers. AV Automation handles full frame graphics playout, from a primary template type
in the rundown.

The properties available depend on the system to be used:

- Vizrt Settings
General Tab
- Show Tab
Deko Settings
- XPression Settings
Orad Settings
Pixel Power Settings
Chyron Settings
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11.3.1 Vizrt Settings

Wigion Mb-:srl Video Servers Graphics lﬁu.ldin l Camera Robotics | Light Cortrol l Hnuterl Subt'rtlesl GPIAO l Talky l Wirtual Set l W

General | Shows

|VIZRT | [~ Use MSE Backup
Engines
Host Port  Handler name MSE Host Encoding Clicked Preview Auto Preview Preview engine

W 1 [10.211.11456100 |6100 |viz_background_a [10.211.1145 |UTF-8 v r 1T -
[ 2 | |E'| L1] |Vi2_|:uau:kgr0unu:|_|:u |I|:u:th|:|st |L|TF-E~ [+ B 2 -
[ 3 | |E1DD |Vi2_|:uau:kgr0unu:|_u: |I|:u:th|:|st |L|TF-E~ [+ B 1 -
[ 4 | |E'| L1] |Vi2_|:uau:kgr0unu:|_u:| |I|:u:th|:|st |L|TF-E~ [+ B 4 -
[ 5 | |E1DD |Vi2_|:uau:kgr0und_e |I|:u:th|:|st |L|TF-E~ [+ B g -
[ atabase Mizcelaneous
[ Configure MSE database settings Mos Playlist

|NE‘.".|'S.ON-;’-‘~.IH-NE‘.".|'S
lser |t

Path Externals
Password ||:'i|':|t |eadema|x"pilntdl:ufelements
Datasource |"’imdt‘ Local Media Sequencer Engine [ Start MSE if not running
Sehema |F‘ILOT “LPROGRAMFILES . wizrt Media Sequencer Engine®launcher exe

[~ Use Concept Override

Translate Cue for Transition Logic elements:
* MNotranslate { Take 1 Takeout

Wiz Content Pilot
[~ Connect to VCP client host

|I|:u:all'u:|st Port |G424

[ Take out full screen graphics v Apply Channel Name to Elements

General Tab

Use MSE Backup: Uses Media Sequencer backup engine when starting the system when
checked.

Engines: Enables connection to each Viz Engine. Viz Mosart supports five graphics engine
connections when checked.
Host: Hostname or IP address to Viz Engine.

A Note: A port other than the default (6100) should be added as an appendix to
the host. For example: 127.0.0.1:6101 and not to the Port field.

Mirroring
You can add multiple Vizrt Viz Engines to any of the five graphics connections.
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- Separate the engine name with a comma ().
For example: enginel:portl, engine2:port2, engine3:port3

a - All mirrored engines will share the same MSE.

- You can add up to 9 engines.
Port: PDB only: Port to communicate with the Viz Engine. Default: 6100 .
Handler name: Media Sequencer only: Internal Media Sequencer handler name.
MSE Host: Media Sequencer only: Hostname or IP address to the machine running the
Media Sequencer.

& Note: For Media Sequencer, both Handler name and MSE Host must be
specified.
& Creating a backup MSE
You can define a backup MSE here by adding a second IP after a ;"

Encoding: Font encoding for the Viz Engine. Default: UTF-8.
Clicked Preview: Enables the “click on full screen graphic element” to be taken on the
preview engine.

- Auto Preview: Enable to automatically take all full screen graphic elements in the
preview engine.
Preview engine: The number of the Viz Engine that is selected to be the preview
engine.

Database

Configure MSE database settings: Enable to update the database settings in the Media
Sequencer with the details below.
User: Username on the Oracle database. Default: pilot.
Password: Password on the Oracle database. Default: pilot.
Datasource: TNS name or connection string of the Oracle database. Default: vizrtdb.

- Schema: Oracle database schema for the Viz Pilot connection. Default: PILOT.

- Viz Content Pilot

Connect to VCP client host (check-box):

When checked, enables playout of Viz Pilot elements directly through a Viz Pilot
client .

Use of Viz Pilot must be assigned for each template, and the special Viz Pilot
macros mosart_load, mosart_start and mosart_continue must exist in Viz
Pilot.

Please refer to the ‘Shows’ fields in the Engines Setup Tab.

& Note: The "Display name" of both configurations must be exactly the same

Host: Hostname or IP address to the Viz Pilot client.
Port: Port to connect to the Viz Pilot macro port.

Miscellaneous
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Mos Playlist: Playlist in VCP that is populated through the Vizrt MOS gateway. Default:
NEWS.ON-AIR-NEWS

(@ Info: The playlist name used here cannot be the same as that used in Trio
Interface > Engines Setup Tab > Playlist > Playlist name.

Path Externals: Internal Media Sequencer path to the location for handling database
elements. Default: external/pilotdb/elements
Local Media Sequencer Engine: Path to the launcher.exe in the Media Sequencer
program files folder (only if Media Sequencer is running as a console application on
the same machine).
Start MSE if not running: If checked and the Media Sequencer is not running, then AV
Automation will try to execute it from the location given below.
Use Concept Override: If the full screen graphics concept should change when a new
Graphics Profile is selected, this is configured here. Check to enable the Vizrt Concept
Override if your scenes are prepared for this. Requires Viz Pilot 5.2 or later.
- Translate Cue for Transition Logic elements: Only applicable when using Transition
Logic full screen graphics as the Media Sequnecer ignores a normal cue command for
these items.

No translate: Send cue command to the Media Sequencer (on Media Sequencer

versions below 1.20 no cue will be performed).

Take: Use a take command when cuing.

- Take out: Use a take out command when cuing.

- Take out full screen graphics: Check to take out full screen graphics. By default, Viz
Mosart will not do a takeout for full screen graphics.
- Apply Channel Name to Elements: This will send the Channel name to be displayed
with the graphic elements in the GUI.

Copyright © 2022 Vizrt Page 317



Viz Mosart Administrator Guide - 5.0

Show Tab

% Viz Mosart - AV Automation | PCR1 (Funcspec)

HA K FM L2 L2

JINGLE

Mic2 Mic 3 Whlic 1 WMic2  WMic3 LIVE1 VEZ2 VEA VEE TEL1 TEL2Z ELAYER

Device Properties

Vision Mier | Video Servers Graphics | Aucio | Camera Robotics | Liht Control | Router | Subteles | GPIIO | Tally | vVitual Set | Westher | video wal | e« » |

General | Im |
—Shows
Digplay name | Show path YCP concept It
)4_ Masart/Overdays/ Yellow Yellow [
I Green Masart/Overays/Green Green

[

-I-ITI-l?:E‘

A It is mandatory to have an exclusive (non-null) value for Show path configured!

11.3.2 Deko Settings
|DEKO =l [~ Enable Mirrering

I Engines |

COMPort  Mach.ld  Default directory Clicked Preview Auto Preview Preview engine
1| ~|| 8100 |Di\news ¥ r [ =]
r2 [ few | g rE
rs [ [ew | v r F
re [ few | v TF
rs [ ][ ew | v r F =

Engines: Enables the connections to the Deko engines. Viz Mosart supports five graphics
engine connections when checked.

COM port: Serial ports connected to the Deko engines.

Mach. Id: Machine IDs of the Deko engines. Valid range is © to 9 . Leave blank to send

global commands.
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Default Directory: The folder on the Deko engine that contains the graphics templates.
Clicked Preview: Click on full-screen graphic element to send to the Preview engine.
Auto Preview: Automatically send full-screen graphic element to the Preview engine.
Preview engine: Defines the Deko engine number.

11.3.3 XPression Settings

|XPRE

SSION |

Engines

I Enable Mirroring

Host Channel Channe list Default directory Clicked Preview Auto Preview Preview engine
1| | 6100 [viz_backgound_a [D:\news v r ]
2| | 6100 |viz_background b | v r 2 ]
3| | 6100 [viz_background ¢ | v ~ B ]
4| | 6100 |viz_background_d | v r 4 <]
5| | 6100 [viz_backgound e | v ~ B ~]

Engines: Check to enable the connections to the XPression engines. Viz Mosart supports five
graphics engine connections.

Host: Hostname or IP address to the XPression engine.

Channel: Output channel from the XPression engine. Use 0 for default channel.

Channel list: Output channel(s) to be cleared when Channel is set to 0.

Default directory: The folder on the XPression engine that contains the graphics templates.
Clicked Preview: Click on full-screen graphic element to send to the Preview engine.

Auto Preview: Automatically send full-screen graphic element to the Preview engine.

Preview engine: Defines the XPression engine number.
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11.3.4 Orad Settings

|ORAD E1 [ Enable Mirroring
Host  Channel Channel list Default directory Clicked Preview Auto Preview Preview engine
1] | 6100 |viz_background_a |D:\news v r o~
2| | 6100 |viz_background_b | ™ r 2~
3 | 6100 |viz_background_c | v r -]
4 | 6100 |viz_background d | ™ r 4~
[ 5| | 6100 |viz_background_e | v r -]

Engines: Check to enable the connections to the Orad engines. Viz Mosart supports five
graphics engine connections.
Host: Hostname or IP address to the Orad engine. Include the IP port number, for
example 172.20.51.55:10001.
Channel: Output channel from the Orad engine. Use 0 for default channel.
Channel list: Output channel(s) to be cleared when Channel is set to 0.
Default directory: The folder on the Orad engine that contains the graphics templates.
Clicked Preview: Click on full-screen graphic element to send to the Preview engine.

- Auto Preview: Automatically send full-screen graphic element to the Preview engine.
Preview engine: Defines the Orad engine number.

11.3.5 Pixel Power Settings

|PIXELPOWER |

Engines

Host Port System (roChannel) Default directory Clicked Preview Auto Preview Preview engine
1] [6100 [viz_backgound_a  |D:\news v r ]
2| |6100 |viz_background b | v r I
3 [6100 [viz_backgound_c | v |— B ]
4 |6100 |viz_background_d | v r 4 ]
5 [6100 |viz_backgound_e | v |— b+

Engines: Check to enable the connections to the Pixel Power engines. Viz Mosart supports
five graphics engine connections.
Host: Hostname or IP address to the Pixel Power engine.
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Port: Port to communicate with the Pixel Power engine.

Default directory: The folder on the Pixel Power engine that contains the graphics templates.
Clicked Preview: Click on full-screen graphic element to send to the Preview engine.

Auto Preview: Automatically send full-screen graphic element to the Preview engine.

Preview engine: Defines the Pixel Power engine number.

11.3.6 Chyron Settings

e x [ Enable Mirroring
Hest Channel Channel list Default directory  Clicked Preview Auto Preview Preview engine
1 | 6100 |viz_background_a [D:\news v N -]
2| | 6100 |viz_background b | v o 2~
3| | 6100 |viz_background_c | v o B -]
4| | 6100 |viz_background_d | v o 4 ~]
5| | 6100 |viz_background_= | v o -]

Engines: Check to enable the connections to the Chyron engines. Viz Mosart supports five
graphics engine connections.

Host: Hostname or IP address to the Chyron engine.

Channel: Output channel from the Chyron engine.

Channel list: Output channel(s) to be cleared when Channel is set to 0.

Default directory: The folder on the Chyron engine that contains the graphics templates.
Clicked Preview: Click on full-screen graphic element to send to the Preview engine.

Auto Preview: Automatically send full-screen graphic element to the Preview engine.
Preview engine: Defines the Chyron engine number.

11.4 Audio

Viz Mosart connects to a variety of audio devices, from various manufacturers.

Select the required audio device from AV Automation > Devices > Preferences > Audio.

Audio Mixer
Audio Player
Loudness Control

11.4.1 Audio Mixer

This tab enables setting-up of the main mixer and optionally, a backup.
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Audio mixer | Sound player | Loudness controller
Use Audio mixer | MIDIMIXER w MigiCh |1 v
Midi Input port
Midi Output port
[] Set user labels on console
Default fade time 200 Defaultsnapshot | |
Audio effect server VSN
Midi type MidiCh  Midiport
[[] Use Backup Audio Mixer 1
Send reset command on connect
Maximum visible audio faders

Use Audio mixer: Enables the audio mixer functionality.

Audio Mixer Types

Audio mixer  Protocol

CALCREC RAP

DHD DHD RM4200-D v2.02

EUPHONIX RAP

LAWO RMNOPL RemoteMNOPL Lawo mc?

LAWO ZIRKON  RAS, Lawo Zirkon subset

LAWO EMBER+ Ember+

MIDIMIXER Sanford.Multimedia

SSL Light Broadcast Automation
protocol, SSL Broadcast
Automation Control
Specification - v1.0
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Interface

RS-422, TCP/IP
(Artemis)

TCP/IP

COM

TCP/IP

RS-422 or TCP/IP

TCP/IP

MIDI

RS-422 or TCP/IP
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Audio mixer

STAGETEC

STUDER_3000

STUDER_VISTA

VIZENGINE

WHEATSTONE

YAMAHA_O2

vizrt-ips

Protocol

Stagetec Diamond RAS
protocol, Monitora RAS

Monitora + Ember, Ember
1.0

Ember

n/a

Wheatstone Mixer
Automation Protocol v.1.4

MIDI

NewTek

Viz Mosart Administrator Guide - 5.0

Supported hardware

Studer OnAir 3000

Studer Vista

Viz Opus only

Yamaha 01V96, DM1000,
DM2000, DME64N, O2V96,
LS9, CL5

Vizrt Group/NewTek
IPseries mixers. TriCaster,
VMC, Viz Verdi, Viz Vectar

Interface

COM

RS-232 or TCP/IP

TCP/IP

TCP/IP

TCP/IP

MIDI

TCP/IP

- Serial (Calrec, Lawo, Studer, etc.): Serial port connected to the audio mixer, when Serial radio
button is selected.
- TCP/IP: Hostname or IP address and port to communicate with the audio mixer, when TCP/IP
radio button is selected. Note that for Calrec it is possible to configure a main and backup
audio mixer by specifying two comma separated hostname values and port values.
Backup hostname and port (LAWO RMNOPL): Hostnhame (or IP address) and port to the
backup audio mixer console.
- Set user labels on console: When selected, user labels on the Lawo or Vista console are

overwritten.

MidiCh (MIDIMIXER and YAMAHA_O2): MIDI channel assigned to the audio mixer.

Midi Input port (MIDIMIXER and YAMAHA_O2): System MIDI input port to communicate with
the audio mixer.
Midi Output port (MIDIMIXER and YAMAHA_02): System MIDI output port to communicate
with the audio mixer.
Default fade time: Time in frames for fading open faders with the manual fade function

(CTRL+F).

Default snapshot: Snapshot to recall when starting the automation (MIDI parameter change).
- Audio effect server: Name for the Audio effect fader. This fader will open if effect transitions

are used.

- Send reset command on connect: Used for STUDER3000 SW 2.2, or lower. Recalls a default
setup for the Mixer panel.
- Visible audio faders: Maximum visible faders in AV Automation.
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AV Automation Audio Mixer Availability Table
Ser TCP Midi Midip Hostn Po Back Back Faderi Usee Compo
ial /IP Ch ort ame rr up up nput mber rt
host Port offset protoc audio

nam ol mixer
e

CALRE x X X X X

DHD X X X

EUPHO x X
NIX

LAWO X X X X X
RMNO
PL

LAWO X X X X X
ZIRKO

LAWO X X
EMBER

MIDI X X
MIXER

SSL X X X

STAGE x X X X X
TEC

STUDE x X X X X X

3000

STUDE X X X

VISTA
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Ser TCP Midi Midip Hostn Po Back Back Faderi Usee Compo

ial /IP Ch ort ame n up up nput mber rt
host Port offset protoc audio
nam ol mixer
e

VIZ X X X
ENGIN

WHEAT X X X
STONE

YAMA X X
HA
02

Vizrt X X X
ips

11.4.2 Audio Player

A basic audio player is always included as standard in a Viz Mosart.

Audio mixer Sound player Loudness controller

Use sound player Mosart Audio Player b
Host localhost
Default directory C:\Lydvignetter\Nyhetskanalen

Requirements

Refer to general section Prerequisites (section Viz Mosart Audio Player).

Setting Up an Audio Player

Refer to section Audio Players.

Operating an Audio Player

Refer to section Playing Audio in the Viz Mosart User guide.

11.4.3 Loudness Control

A loudness control from Junger.
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Audio mixer Sound player Loudness controller

v Lse loudness controller

Channels Hestport

WONGERTAP | 1-4 |
Triggers/levels &8 |
1 312 |
2
3 1316 |
: 1720 |
21-24 |

Use loudness controller: Check the box to enable loudness control.
Loudness controller type: JUNGER T*AP.

- Triggers/levels: Name of triggers or loudness levels, one for each line. These will appear in a
tool-tip menu in the Template editor, and must correspond to the configuration in the
loudness controller(s).

Channels: Fixed values. For Junger T*AP there are four stereo channels per host.
Connections to the audio faders are configured in A/V Setup/Edit/Audio config/Loudness
channel.

Host:port: Hostname or IP address and optional port number for each controller.

A Note: If the root node name is different than T*AP the name must be set in the AVA
configuration property JungerRoot .
See Also

Audio Player
Stagetec Driver Configuration

11.5 Camera Robotics

11.5.1 Configuring a Robotic Camera

From AV Automation > Devices > Properties > Camera Robotics tab, you can configure up to 4
robotic camera controllers.

Copyright © 2022 Vizrt Page 326



Viz Mosart Administrator Guide - 5.0

v Lse Robotic Cameras

Host Port Cameras
¥ Robotic Camera |VINTEN 200 | |10209.101.102 5000 |15
Host Port Cameras

[~ Robotic Camera |[TELEMETRICS — »| | | |

Use Robotic Cameras: Check to enable the robotic camera control functionality.

Robotic Camera: CAMBOTICS, CAMEROBOT, CINNEO, ELECTRIC FRIENDS, FX-MOTION,
PANASONIC, PANASONICNEW, PANASONIC TCP, SHOTOKU TR-T, SHOTOKU TR-T IP,
TECHNODOLLY, TELEMETRICS, VINTEN 200, .

Host: Hostname or IP address of the RCC (Robotic Camera Controller) server.

Hosts (FX-Motion and Technodolly): A comma separated list of names or IP addresses for the
camera robots starting from Camera 1. Missing robots are indicated by extra commas.

Port: Port to communicate with the RCC server.

& Note: When using PANASONIC TCP, you may or may not specify a port here. If no
port is specified, the default port 80 is used.

- Com port: For serial communication with the RCC server.

& Note: When using PANASONIC or PANASONICNEW you must select the Com port to
use. Only one controller can be connected to each Com port.

- Cameras: List of robotic cameras for individual stand-by control and for matching against
the Camera Number in Robotic Camera Control in Template Device Functions. List members
are separated by commas, or by hyphens indicating ranges.

& Note: When using PANASONIC, PANASONICNEW, or PANASONIC TCP, the connection
goes through a controller. The Cameras value is used to set the controller, so only
enter one number here.

Camerobot Camera Systems

Viz Mosart can control anchor dependent shots for the Camerobot camera system. For details,
please refer to Control Commands in Templates, section Command Values and Parameters,
DEVICE_PROPERTY, CAMERA CONTROL.

Robotic Camera Configuration Files

For both general and device-specific settings, see section Robotic Camera Configuration Files.
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11.6 Light Control

11.6.1 MIDI Show Control

I¥  Light Control
Diriver ||"-'||D| Show Control j

Midipart | =]
Midi Show Control (MSCID) 0

Custom command Frefix w00 =00

Custom command Suffix ‘w00

Light Control: Enables the Light control through MIDI Show Control.

Midiport: System MIDI port to communicate with the Light board.

Midi Show Control (MSCID): The MIDI Show Control ID that is used for communicating with
the Light board. Default: 0.

- Custom command Prefix: This is the prefix test sent with the MIDI Show Control command.
Characters can be escaped using the x00 where 00 is replaced by the numeric value of the
character. Default: \x00CY\x00 .

- Custom command Suffix: This is the suffix sent with the MIDI Show Control command.
Characters can be escaped using the x00 where 00 is replaced by the numeric value of the
character. Default: \x00 .

11.7 Router

W Use Router |SW-P-08 TCF/IP |

Haost Paort
Main | |

Backup | |

Additional parameters |

- Use Router: Check to enable router control and select protocol from the list.
Router type: EVERTZ QUARTZ, GVG G-SMS7000, SW-P-08 TCP/IP, SW-P-08 SERIAL, VENUS,
VIKINX SERIAL or VIKINX TCP/IP.
Port: Serial port (GVG G-SMS7000, Venus, SW-P-08 serial, and Vikinx serial).
Bit rate: Selectable serial bit rate (GVG G-SMS7000).
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Parity: Parity bit, default None (GVG G-SMS7000).
Main Host: Hostname or IP address of the main router (EVERTZ QUARTZ, SW-P-08 TCP/IP and
Vikinx TCP/IP).
Main Port: IP port of the main router (EVERTZ QUARTZ, SW-P-08 TCP/IP and Vikinx TCP/IP).
Backup Host: Hostname or IP address of the backup router (SW-P-08 TCP/IP).
Backup Port: IP port of the backup router (SW-P-08 TCP/IP).

- Additional parameters: For future use.

11.8 Subtitles

Host Part
W Use Subtitle |SCREEN ~| |10.208.101.102 1043

Back to back play delay | 0  frames

- Use Subtitle: Check to enable Screen Polystream subtitling.
- Subtitling type: SCREEN, SVT
Host: Hostname or IP address of the subtitling system.
Port: Defines the IP communication port.
Back to back play delay: Delay in frames on the play command to the subtitling system when
playing subtitle files back to back.

11.9 GPIO

GPI functionality supports triggering any template from the currently active template set and
including a selection of control commands.
Adding GPI/O control to a device is performed in Viz Mosart AvAutomation.

Direct takes via GPI
- Syntax
Configuring
- Verifying
- To Trigger Direct Take Templates via a GPI
- Syntax for GPI 5-11
- Sample Configuration (W&T Web-10)
GPI 0-4
GPI 5-11
Hardware Configuration
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Haost Port Password
GPO (1-12) 10.209.101.102 49153 |

GPO (13-24) [10.209.101.102 49153 |

GPO (25-36) | 49153 |

GPO (37 - 48) | 45153

GPI 0 (Reload rundown)
GPI 1 (Start/continue rundown)

GPI 2 (Start rundown from top)
GPl 3 (Rehearsal mode OFF)
GPl 4 (Rehearsal mode ON)
GPI 5 (Fire Template) |
GPI & (Fire Template) |
GPI 7 (Fire Template) |
GP! 8 (Fire Template) |
|
|
|

GPI 5 (Fire Template)
GPI 10 (Fire Template)
GPI 11 (Fire Template)

L OISO P I IS I S L]

Min Time Between GPls (ms) 300

- GPO (1-12): Enables a WeblO box for the first 12 GPO when checked. Note that this has to be
configured for GPI 0-11 to be enabled.

- GPO (13-24): Enables a WeblO box for the second 12 GPO when checked.

- GPO (25-36): Enables a WeblO box for the third 12 GPO when checked.

- GPO (37-48): Enables a WeblO box for the fourth 12 GPO when checked.
Host: Hostname or IP address to the WeblO GPI/O box.
Port: Port to communicate with the WeblO GPI/O box.
If configured as 80, Mosart will use the HTTP WeblO protocol, while for other Port values
Mosart will use the Binary WeblO protocol.
Password: Defines the password, if needed.

- GPI 0 (check box): Enables initialize Viz Mosart rundown when the external pulse is received.

- GPI 1 (check box): Enables start/continue the Viz Mosart timeline from an external pulse.

- GPI 2 (check box): Enables starting Viz Mosart rundown on the first story on the external
pulse.

- GPI 3 (check box): Enables rehearsal mode off.

- GPI 4 (check box): Enables rehearsal mode on.

- GPI 5-11 (check boxes/custom): Enables firing of the template or command given in the text
box.
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11.9.1 Direct takes via GPI

As taking a template using one of GPIs 5 to 11 (Fire Template) would add the corresponding
template to the timeline, which is not always wanted, you can instead use a DIRECTTAKE control
command, as explained below.

Syntax

DIRECTTAKE|<the Recall Nr of the direct take>
Example: DIRECTTAKE[99
Triggers direct take 99

Configuring

The figure below connected GPI 9 to firing direct take 999
Mosart Device Properties

Vision I'u'Iixerl Video Servers l Graphics ] Audio l Camera Robotics ] Light Control ] Routerl Subtitles  GPI/O ITthr l Virtual Set l Weathe

Host Port Password
GPO (1-12) [172.27.39.138 |20 |

<l

GPO (13-24) | | |

GPO (25-36) | | |

GPO (37 - 48) | 49153

= a

GPI 0 (Reload rundown)
GPI 1 (Start/continue rundown) INVOKE DIRECTAKE 9909 FROM
GPI 2 (Start rundown from top) GP19

GPl 3 (Rehearsal mode OFF)

GFPIl 4 [(Rehearsal mode ON)

GPI 5 (Fire Template) |PL:'-‘\YCUEDVIDEOSEFWEH

GPI & (Fire Template) |STOPPL-'—‘\YINGVIDEOSEHVEH
GP| 7 (Fire Template) |PAUSEPLAYING‘«"IDEOSEFWEF~!
GFI 8 (Fire Template) |RECUECUEDVIDEOSERVER
GPI 3 (Fire Template) |DIRECTTAKEIS9S

GPI 10 (Fire Template) |

GPI 11 (Fire Template) |

< 71717

<l

<l

<

<l

<l

<l

1 T

Verifying

Assign a direct take to a GPI between 5 and 11

Restart AvA

Trigger this GPI from the external device connected to this GPI.

For testing this can also be done for GPIs 0 to 9 from within AvAutomation by pressing
SHIFT+CTRL+<no> where <no> is the GPI number + 1 (modulo 10).

For example, SHIFT+CTRL+0 will invoke GPI 9
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Verify on the Mosart server that the corresponding GPI is executed. One way to do this is in
Av Automation, since Direct takes are shown in the Av Automation Log window (lower left)

when taken.

To Trigger Direct Take Templates via a GPI

To trigger a direct take from a GPI (which can then further trigger multiple control
commands) use the GPI/O tab in Av Automation > Devices > Properties as shown in the

figure below.

<l

GPO (1-12)
GPO (13-24)
GPO (25-36)
GPO (37 - 48)

101 T

GPI 0 (Reload rundown)

GPI 1 (Start/continue rundown)
GPI 2 (Start rundown from top)
GPI 3 (Rehearsal mode OFF)
GFl 4 (Rehearsal mode ON)
GFI 5 (Fire Template)

GPI 6 (Fire Template)

GFI 7 (Fire Template)

A N R B .

LU

Mosart Device Properties n
Vision Mixer] Video Servers l Graphics ] Audio l Camera Robatics l Light Contral l Routerl Subtites  GFPI/O lTth' l Virtual Set l Weatherl Video Wall ] Int 4| »
Host Port Password
[10.55.199.153 30 mosart
[10.55.199.154 30 mosart
[10.55.199.155 30 mosart
| 43153
|Direct Takel810
|Direct Take811
|Direct Takeld 12
|Direct Takel813

<l

GPI 8 (Fire Template)
GFI 3 (Fire Template)
GFI 10 (Fire Template)
GPI 11 (Fire Template)

. .

Min Time Between GPls (ms)

300

Syntax for GPI 5-11

DIRECTTAKE| <the Recall Nr of the direct take>

Close

& Note: A GPI/GPO device must first be configured. The configuration of GPI/GPO devices is
done in AV Automation Devices - GPIO.
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@ Testing GPI signals without the use of GPI

If a GPI/GPO device is configured, as shown in the figure above, any GPI signals 0-9 may be
simulated using the keyboard sequence CTRL+SHIFT+<number> inside AvAutomation to
trigger a corresponding GPI.

This is an easy way to test the GPI configuration.

For example: CTRL+SHIFT+6 will trigger GPI 5

11.9.2 Sample Configuration (W&T Web-I0)

W&T's Web-10 products enable TCP/IP Ethernet-based switching signals for control, acquisition and
monitoring. Their products are accessed using APl queries from, for example, a standard web
browser, or in our case, Viz Mosart.

From the Web-10 side, GPI is enabled by attaching a device capable of sending GPI signals to Viz
Mosart. The configuration below shows configuration of a W&T Web-10 device capable of 24 GPI/
GPO connections.

This configuration uses at a maximum 24 GPO signals. A maximum of 12 GPI signals can be used
to control Viz Mosart.

GPI 0-4

The first 5 GPI signals are connected to fixed Viz Mosart commands for backward compatibility.

The signals are as follows:

GPI O - Reload rundown, Will trigger a rundown reload event. l.e. the timeline will be stopped and
the current rundown will be reloaded from the NCS cache.

GPI 1 - Start/continue rundown. Will trigger the TAKE-NEXT event and with that start the timeline or
advance to the next timeline element

GPI 2 - Start rundown from top. Will start the rundown from the first story

GPI 3 - Disable rehearsal mode

GPI 4 - Enable rehearsal mode

GPI 5-11

Each of the GPI signals 5-11 may be assigned to either trigger a Viz Mosart control command,
trigger an arbitrary template from the active template set or trigger a direct take, as follows.

Triggering Mosart Control Commands

To trigger a Mosart Control Command enter a valid command in the text field associated with the
GPI signal.
Supported commands:

ClearForegroundGraphics - Removes all CGs

SkipNextStory - Skips next story item

UnskipNextStory - Unskips next story item

TakelLastGraphicsOut - Removes last CG

TakeManualGraphicsOut - Removes manual CGs

PlayCuedVideoServer - Plays out the last cued clip on a video server
PausePlayingVideoServer - Pauses the currently playing clip on a video server
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StopPlayingVideoServer - Stops the currently playing clip on a video server
RecueCuedVideoServer - Recues the last cued clip on a video server

Triggering a Mosart Template

This can be used to trigger a Mosart template from the active template set:
Syntax: [TemplateType]|[Variant]

Example: Camerall

Triggering a Direct Take

This can be used to trigger a direct take:

Syntax: DIRECTTAKE|<the Recall Nr of the direct take>

Example: DIRECTTAKE[99
triggers direct take 99.

Hardware Configuration

5.0

For this example, you configure the in and out ports as required for the GPIO system, by following

their own specifications.
The Web-10 physical device can be configured via a browser pointed to the box’ IP address.

- To get into the configuration menus select
Config > Login > Administrator login
from the Start page.

& Note: Configuration changes are only saved after clicking the Logout button.

Mosart IAT/SAT

For testing from Mosart, the new configuration is either directly loaded, or inspected and

used for setting the inport 0 manually.

Inspection and comparison may be necessary should the load fail. If necessary reset the box

to factory settings before using the configuration below.
Under the inport nodes in the menu tree
Set the port minimum pulse filter to 100ms
Set the input type to positive pulse (three separate settings).
If you use port 0O it is easier to test Viz Mosart, as this port is hardwired to the Reload
Rundown function.

Preparation of Test Circuit

- This requires two pieces of wire, ~20cm, stripped (and preferably tinned) at the end.

- To set up the box for generating an input test pulse, interconnect the terminal strip ground
connector for power supply ground (the outermost VCC connector) with the outermost GND
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connector, across the box. This establishes a common ground between power supply side
and the input logic circuits.

A Note:
- It is not possible to simply take the output of one output port and feed it

directly back to the input side, as the outputs are intended to drive relay

circuits (these are also known as current drivers, they operate at a very low

voltage)

- The 12 in 12 out version requires an external relay.

- The inputs requires 8V referred to GND to detect a pulse.

Testing GPI O

- To generate the input pulse, connect a piece of wire from the other VCC connector and
briefly touch the connector for Inport 0 (the pulse must be >100ms).

- A green light beside the connector will briefly light up if successfully triggered. Given that
AV Automation has GPIO enabled and is also enabled for Input 0, any loaded rundown will
reload, clearly visible on the Mosart GUI.

Configure GPIO with the file containing the working configuration.

@ A sample xml file is listed in the Appendix section here.

If the GPIO will not import the configuration file directly, a workaround is to save the current
configuration and using Notepad++ (or similar) to compare the difference between the new
configuration and the existing configuration. Amend the configuration on the existing
configuration to match the new settings.

11.10 Tally

W Enable Protocol  |GVG200 |

Arguments |C|:|m Port=COM1

Enable: Check to enable tally functionality.
Protocol: GVG200 or SONY MVS
- Arguments: ComPort=COMx
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11.11 Virtual Set

WV Virtual Set |BRAINSTORM =/

Connection string

- Virtual Set: Check to enable virtual set control.
- Virtual Set: BRAINSTORM, Viz Virtual Studio.
- Connection string: Server=hostname; [port=portnumber;] [mode=mixmode;].

11.11.1  Connection String Parameters for Viz Virtual Studio

- Server: IP address or network name of machine where Viz Tracking Hub is running.
Required.
Port: TCP/IP port Viz Tracking Hub accepts connections. Optional.
Default value is 20000.
LocallP: IP address of local network interface. Optional. Default value is first Ethernet
interface.
Router: Router name configured in Viz Tracking Hub. Optional.
Default value is first router in Viz Tracking Hub.

Sample Connection string: Server=10.45.0.15;Port=20000

Camera set index enumeration starts from 1. This means that if a router has two camera sets
configured, their indices will be 1 and 2.

A Known Issue: Driver cannot detect when hub server is going offline. For example, if you kill
the server, the driver keeps sending messages to server without an error being raised.

11.12 Weather

W  |VIZWEATHER ~|

MSE Hostname MSE Port Host Viz|\weather Default concept
localhost 2594 1127.0.0.1 I

Use Weather: Check to enable control of a weather control.
- Weather controls: VIZ WEATHER or WEATHER ONE
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MSE Hostname (Viz Weather): Hostname or IP address to the Media Sequencer controlling the
Weather Control engine.

Hostname (Weather One): Hostname or IP address of the Borealis Weather One engine.

MSE Port (Viz Weather): Port to communicate with the Media Sequencer.

Port (Weather One): Port to communicate with the Borealis Weather One engine.

Host Viz Weather (Viz Weather): Hostname or IP address to the Viz Weather engine.

Default concept: The weather concept to be used as default.

11.13 Video Wall

W \Video wall type |SPYDER -

Server address: |I|:u:th|:|st

- Video wall type: Check to enable video wall control.

- Video wall controls: ENCORE, PANDORA, SPYDER, WATCHOUT (Version 5.2, DISPLAY
CLUSTER PROTOCOL).
Port (Encore): Serial port.
Bit rate (Encore): Serial bit rate.

- Server address (Pandora, Spyder, Watchout): Hostname or IP address of the video wall server.
For Pandora, the server is the PB Widget Designer.
For WATCHOUT, full connection string. For details see Watchout Connection String.
Backup (Pandora): Hostname or IP address of the backup PB Widget Designer.

See also

- Jupiter Systems PixelNet Video Wall Control

11.14 Integrated Engine

Mosart Device Properties ﬂ

Taly | Vitual Set | Weather | Video Wall Integrated Engine | General | 4| »

Connection string

- Connection string: For details, see the Viz Opus documentation.
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11.15 General

Mosart Device Properties

Graphics l Audio l Camera Robotics l Light Control l Router] Subtitles l GPI/O l Talky l Virtual Set l Weatherl Video Wall l Integrated Engine

Standby at startup Show in Console Redundancy
™ Vision Mixer ™ Autotake timing ™ UseMirroring  Hostname
[ Video Server Port 8099
™ Graphics Diagnostics
™ Audio Mixer [ Trace
: Media Router
I~ Camera Robotics ™ Verbose .
™ Light contral [ Video Servers
™ Router o . [~ Graphics
. irecttakes
™ Subtitles [ Overlay Graphics
™ GPIO Directtzke On Reload [ Camera Robotics
™ Weather system ER e e e e ™ Light Control
A ™ Video \wiall
Llidechal Directtake On Become Idle ’— ! eo ) @
[ Sound player [ Subtitling
™ Virtual set Configuration
M Loud o Crossover
oudness contra Name Mosart 1 Port [8099
LIiTally Directtake On Activate Connect Salve [Cument
Directtake On Inactivate Active Salvo Slave

Idle Salvo ReleaseAl

Standby at startup: Selector for drivers that will start in standby mode. These selections
must then be manually reset from standby mode, either using the Viz Mosart GUI or from AV
Automation.

& Note: Whenever a Viz Mosart GUI is operational or if a backup Viz Mosart server is
operational, they will override any standby settings made here. Standby settings
applied in this menu only take affect at complete restart of all Viz Mosart
applications. See the Standby description under Main Menu of the Viz Mosart User
Guide for further details..

Show in Console
Autotake timing: Adds timing to the log window. Used for debugging purposes.
Diagnostics
Trace: Adds logging information to console used for dbugview.
Verbose: Increases logging information from AV Automation to the log file.
Directtakes
Directtake On Reload: The Recall Nr (see Template Properties) of the direct take
template to be fired upon re-loading the rundown.
Directtake On Become Active: The Recall Nr of the direct take template to be fired
when the server becomes active from idle, when switching between main and backup
Viz Mosart servers.
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Directtake On Become Idle: The Recall Nr of the direct take template to be fired when
the server becomes idle from active, when switching between main and backup Viz
Mosart servers.

Crossover
Directtake on Activate: The Recall Nr of the direct take template to be taken when this
server goes active in crossover switch.
Directtake on Inactivate: The Recall Nr of the direct take template to be taken when
this server goes inactive in crossover switch.

Redundancy

- UseMirroring: Check to enable mirroring. Upon enabling mirroring on both main and
backup server, the settings are synchronized.
Hostname: Hostname or IP address of the Backup Server if using Main Server, and vice
versa.
- Port: IP port number of the Backup Server if using Main Server, and vice versa.

Media Router
Use for: Select which controls should be used by the Media Router. (Also see MMR
Tab).
Name: Media router’s hostname or IP address.
Port: Media router’s connection port number.
Connect Salvo: The salvo name to be taken when this server connects after restart.
Default: Current.
Active Salvo: The salvo name to be taken when this server becomes the active server
from being idle. Default: Slave.
Idle Salvo: The salvo name to be taken when this server becomes idle after being
active. Default: ReleaseAll.
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12 Device Connection Strings

This section contains an overview of Device Configuration Strings for connection to equipment in
your broadcast environment.

A device in this context is a physical unit, such as an Viz Engine or a video server. The device
driver is the code that provides Viz Mosart the ability to handle and control the actual device. The
Device Connection string is a textual description that identify the type, name and various other
parameters required for Viz Mosart control the device. In some cases, you need to provide
additional parameters for the device, typically specified in an XML file, in addition to the
Connection String.

This section contains the following topics:

- Video Server, MAM and Database Connection Strings
Video Wall Connection Strings

12.1 Video Server, MAM And Database Connection Strings

A connection string contains parameters needed for connecting a studio device to Viz Mosart. The
string always comprises two parts:

Standard Connection String Properties
For example Name, Type, Server, Config (Config is the name of the associated file that
contains custom settings).

Device-specific Connection String Parameters
Driver-specific configurations. For example, what to log in error situations, manipulation of
standard commands, or timeout behavior.

Connection strings are used both in the Media Administrator configuration and, in some cases, AV
Automation.

In AV Automation:

Connection strings get autogenerated when configured in the video server GUI.
- You can enter additional device parameters to match specific control room parameters.

This section describes the following connection string types:

System-level Location of Device Configuration Files
Standard Connection String Properties
Viz Mosart Video Server Connection String
General Configuration File Properties
General Search Configuration File Properties
Device-specific Connection String Parameters
- AirSpeed Classic Connection String
- AirSpeed Multi Stream / AirSpeed 5000 Connection Strings
- AirSpeed Multi Stream Search
- Amadeus Connection String
EVS LinX Connection String
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EVS Xedio Connection String
Grass Valley K2 Connection String
Harris Nexio Connection String

- JupiterWebService Connection String
MVCP Connection String
Omneon Connection String
Omnibus OPUS Connection String
Orad OCIP Connection String
Quantel Connection String
ScreenLL Connection String
SimpleTestPlayer Connection String
SQL Database Connection String
VDCP Connection String
Viz Engine Connection String
Viz One and Media Service Connection String

12.1.1 System-level Location of Device Configuration Files

In a connection string where no path is provided as a value to the Config parameter, Viz
Mosart searches for the file in the following order of folders:

$ALLUSERSPROFILE%\Mosart Medialab\ConfigurationFiles\
C:\ChannelTemplates\

{Application path}\

{Application path}\ConfigurationFiles

{Current folder}\ConfigurationFiles

12.1.2 Standard Connection String Properties
Irrespective of device type, several values are standard parameters:

Viz Mosart Video Server Connection String
General Configuration File Properties
General Search Configuration File Properties.

Viz Mosart Video Server Connection String

Parameters not recognized by the driver in question will simply be ignored.

Name=myServerName; Type=myServerType; Server=myServerAddress; Config=myConfigFile.xml

Name: A logical name consistently associated with the device, allowing the device to be
uniquely recognized throughout the system setup.

All Media Administrator connection strings contain a name, which forms a distinction for
Media Administrator, when handling multiple clip metadata sources and video servers.

Copyright © 2022 Vizrt Page 341



Viz Mosart Administrator Guide - 5.0

If the same video server also is to be controlled by AV Automation, the Name in AV
Automation should be the same as here.
- Type: Specifies a driver to be used for connecting to the server. Potential values are:
- AirSpace: AirSpace video driver.
- AirSpeed: AirSpeed video driver.
- AirSpeed Search: As AirSpeed driver, but contains search functionality only.
- AirSpeedMultiStream: AirSpeed Multi Stream driver, also Airspeed 5000.
- AirSpeedMultiStreamSearch: As AirSpeed Multi Stream driver, but only search
functionality.
- Amadeus: Amadeus MAM driver.
EVS LinX: EVS LinX driver.
EVSXedio: EVS Xedio driver, used by AV Automation.
EVSXedioSearch: EVS Xedio driver for search functionality, used by Media
Administration.
GrassValleyK2: Grass Valley K2 driver.
HarrisNexio: Harris Nexio driver.
- Jupiter: Jupiter web service driver.
MVCP: MVCP driver.
OPUS: Omnibus MAM driver using OPUS interchange.
Omneon: Omneon video driver.
OmneonSearch: As Omneon driver, but contains search functionality only. Used by
Media Administrator to obtain clip status from an Omneon video server.
Orad OCIP: Orad OCIP driver.
Quantel: Quantel video driver.
- ScreenlLL: Screen LingualLib search driver.
- SglMediaSearch: SQK database driver.

- Server: Specifies the server name or the IP address of the video server.

- Config: Specifies a configuration file containing custom configuration for a particular video
server driver. Editing these files is typically done during installation.

- Static: (Effective for Media Administrator only) If true, Media Administrator always connects
to this MAM system (or video server), also when Enable dynamic configuration (see Media
Administrator Properties Editor, Configuration) is true, and this MAM system (or video
server) is not part of the salvo selected in AV Automation (see section Virtual Server Ports
in Automation Devices Video Servers).

& Normally, a MAM system will not be part of any salvo, so this setting is mostly used
for MAM systems which should always be connected, regardless of the selected
salvo. Default: false.

General Configuration File Properties

- VerifyClipDelay (integer): Delay in frames to wait before verifying new clips from server.
KeepCache (boolean): When set to true, the internal Media Administrator clip cache is kept
on reconnect (Default: false).
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RefreshOnUpdate (boolean): If set to true, any clip update message received from the video
server results in a clip refresh operation (Default: false).

ReleasePortOnDispose (boolean): If true, the assigned video port is released when server
connection is closed (Default: true).

- SupportSearchUsingObjSlug (boolean): Activates searching using objSlug (Default: true).

- SupportSearchUsingRefID (boolean): Activates searching using ReflD (Default: false).

- VerifyModifiedClips (boolean): If true, clip modified/update events for all clips trigger a
complete verification (for example treated as the clip was created). If false, only clips
currently in the cache are verified. (Default: false).

- CueTimeout (integer): Specifies the maximum time in milliseconds for AV Automation to
wait for a cue operation to complete. (Default: 7000 msec).

PlayTimeout (integer): Specifies the maximum time in milliseconds for AV Automation to
wait for a play operation to complete. (Default: 0).

- SetLoopDelay (integer): Specifies the time when to set the clip to play in loop after a
successful cue operation, in milliseconds. (Default: 1000 msec).

NextPingDelay (integer): Specifies the interval (in milliseconds) at which AV Automation
issues a 'Ping' operation (verifying that the connection is still OK) against the server. The
nature of the 'Ping' operation depends on the driver chosen. (To modify the ping interval for
Media Administrator see Media Administrator Properties Editor > Ping Delay.)
NextServerAttemptDelay (integer): In case of failure, specifies the time between trying to
reconnecting to the video server, in milliseconds. (Default: 5000 msec).
MirrorActivePortTimeout (integer): For mirroring setups. Specifies the time to wait for the
active port to complete before waiting for any of the ports, in milliseconds. (Default: 100
msecs).

IgnoreCase (boolean): If true, searching for clips is done case insensitive. Must be used in
combination with <MatchExpression ignoreCase="true" /> from General Search
Configuration File Properties.

- AssetToMediaMap: Choose from two ways of mapping Asset to MediaObject. UseTitleAsSlug
or UseMamldAsSlug.

MaxClipNameLength: Naming standard for recordings.

- ClipNamePattern: When recording a file, the system can be configured to use a predefined
pattern for filenames. The pattern shall be defined in the associated config file for the video
server. The following variables are available for injecting into the clip name:

Variable name Description

clipname The value given in the recording dialogues, or from
custom template commands.

gallery The name of the gallery.
templateset The name of the currently selected template set.
timestamp The current time. This value can be formatted using the

patterns from MSDN.
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(® Example

Gallery = MyGallery

Current template set = MyTemplateSet
Clipname = MyClipName

Current Time = 21 September 2016 12:00:00

Config File for Video Server

<DeviceConfig xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:xsd="
http://www.w3.0rg/2001/XMLSchema'">
<Properties>
<item name="ClipNamePattern" value="{gallery}_{templateset}_{clipname}
_{timestamp:yymmdd}" />
</Properties>
</DeviceConfig>

The file name sent to recording is MyGallery_MyTemplateSet_MyClipName_160921.

General Search Configuration File Properties

HitSortOrder (enum): Specifies how to sort a list of multiple hits for a single search. Used in
combination with the BestMatchMethod property.
Options:

- Ascending: The list of hits are sorted ascending alphabetically.

Descending: The list of hits are sorted descending alphabetically.

Unspecified (Default): No sorting is applied to the resulting hits.

Example: <HitSortOrder>Descending</HitSortOrder>
BestMatchMethod (enum): Method used to determine single search result if a search results
in multiple hits. Options:

First: The hits are sorted alphabetically and the first hit is returned.

Last: The hits are sorted alphabetically and the last hit is returned.

Filter (Default): Returns the first hit evaluated true from a MatchExpression filter.
MatchExpressions (list): List of filters to be used for narrowing searches that may result in
multiple hits.

Each MatchExpression filter is constructed from three attributes:

ignoreCase: (boolean) True if the filter is case insensitive. Must be used in

combination with property "IgnoreCase" from General Configuration File Properties.

expression: (string, regex) Expression used to create a regular expression to be
applied to the given clip name. Use the pattern attribute to extract parts of the
original clip name to search for. (Default: Empty = exact search).

pattern: (string) Regular expression used to extract information from the clip name.

(Default: The original clip name).

An empty MatchExpressions list results in an exact case sensitive search.

The following example sets up a regular expression filter searching:
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MatchExpressions

<MatchExpressions>

<!-- Returns true for all hits with clip names starting with the given clip name
-—>

<MatchExpression expression="A$1.%x$"/>

<!-- Returns true for all hits with identical clip name but case insensitive -->
<MatchExpression ignoreCase=true/>

<!-- Returns true for all hits with clip names containing leading or trailing
spaces -->
<MatchExpression pattern = "A\sx(.*x)\s*x$" expression = "$1"/>

</MatchExpressions>

12.1.3 Device-specific Connection String Parameters

AirSpeed Classic Connection String

Applies to Models

AirSpeed
AirSpace

Connection String Properties

Type: AirSpeed and AirSpace.

Name: Defines the ID of this connection (Default: AirSpeed).
Server: Defines the hostname or IP-address of the server.
Config: Defines the name of the configuration file.

Examples
AV Automation:

Name=HAR; Type=AirSpeed; Server=192.168.1.1; Config=ClipServerAirspeed.xml

Configuration File Properties
Configuration file properties can be overridden by connection string properties.

KeepCache (boolean): How often (in seconds) to look for clip changes. value=1 is the default
value if not configured here (Default: false).
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RefreshOnUpdate (boolean): When set to true, the cache is updated on each update clip
message from the server (Default: true).

- VerifyClipDelay (integer): Delay in frames to wait before verifying new clips from server.
ReceiveTimeout (integer): Time in seconds to wait for response from AirSpeed (Default: 70).

- ChangeCheckinterval (integer): Time in seconds how often to poll AirSpeed for clip changes
(Default: 2).
HeartbeatInterval (integer): Time in seconds to send out a heartbeat in case of no
communication detected from AirSpeed (Default: 30).

- GetMinimumlList (boolean): Set to true to retrieve only clip names when initializing database
(Default: false).
DelayGetClipData (boolean): Delay getting detailed clip information. Information is retrieved
for clips in rundown only (Default: true).
DelayEventsOnDatabaselnitialization (boolean): If true, all clip handling during database load
is postponed until last clip is received (Default: false).

- SignalDatabaseReady (boolean): Refreshes all clips after database has been built instead of
refreshing for every item in the database (Default: true).

- VerifyModifiedClips (boolean): If true, all modified clip events for clip not in cache are
verified, as if they were created (Default: true).
ReceiveBufferSize (integer): Set buffer size used for receiving date from AMS. Default 16384

= two times default buffer size of Net.Socket (Default: 16384).

Encoding (string): Set to encoding used for send/receive from AMS (Default: UTF-8).
- SupportSearchUsingObjSlug: Ignores search for objSlug if set to false (Default: true).
- SupportSearchUsingRefID: Ignores search for refID if set to false (Default: false).

Use for debugging purposes only:

- VerboselLogging (boolean): Set to true to enable logging of received messages from AMS
(Default: false).
DatabaseCache (boolean): If set to a valid filename, initial load database stores the content
in this file (Default: false).
DatabaseCacheUpdate (boolean): Determines when the debug database cache is updated
(either [Never,Always,Initial]).
LoadDatabase: Specifies whether the AirSpeed clip database should be initially loaded and
maintained by the Media Administrator. Setting this attribute to true is required if any search
should be possible using an AirSpeed video server.

AirSpeed Multi Stream / AirSpeed 5000 Connection Strings

The AirSpeed Multi Stream drivers supports up to six multiple player ports per connection.

Applies to Models

- AirSpeed Multi Stream 1.8
- AirSpeed 5000
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Connection String Properties

- Type:
- AV Automation: AirSpeedMultiStream
Media Administrator: AirSpeedMultiStreamSearch
Name: See Standard Connection String Properties above.
Server: See Standard Connection String Properties above.
Config: See Standard Connection String Properties above. The installed xml config file is
ClipServerMultiStream.xml. Unless changed, the value of Config should be
ClipServerMultiStream.xml. See Examples below.

Optional

BasePort*: Specifies the number of the lowest-numbered port on the server.
(Default: 59451). For AV Automation, six consecutive player ports, starting at this one, are
available for playout. (They should be referred to by numbers 1 to 6 in AV Automation.)
For Media Administrator, refer to Player and the note below for how the actual port number
is calculated.
- AV Automation only
LoopPostRoll: (only used when NewLooping is true) No. of frames before clip-end to
restart loop. Should probably be set to a positive value to obtain smooth looping.
(Default: 4).
NewLooping: Whether to use an alternative looping mechanism. Must be true if
MPEG-2 HD clips are involved. (Default: false).
OpenSomePlayerAfterConnect: By default, server connection is considered successful
('green') without connecting to any players. If this setting is enabled, also connection
to some configured player will be necessary. (Default: false).
Set to true if connection problems are experienced, e.g.
i. Green server line
ii. Unsuccessful port connect (red port line)
iii. Reconnect
iv. ...andsoon...
OpenPlayerAfterConnectTimeout: (only used when OpenSomePlayerAfterConnect is
true) Timeout (in milliseconds) for the above OpenSomePlayerAfterConnect
functionality (Default: 2000).
RecordEjectFirst: If true, initiating a recording on a channel/port will first eject any
existing clips (Default: false).
RecordOverwrite: If true, any recording initiated on an existing clip will delete the
existing clip before creating the new (Default: true).
RecordUseNameAsClipld: If true, the clip name is also used as clip id when preparing a
recording. Otherwise the airspeed will automatically assign clip ids (Default: true).

& Note: The asterisk (*) above denotes the TCP port to connect to becomes BasePort + Player
- 1.
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AV Automation:

Name=AMS;

Type=AirSpeedMultiStream; Server=192.168.1.1;

Config=ClipServerMultiStream.xml

Configuration File Properties

With a few exceptions (Type, Name, Config), the connection string properties described above may
alternatively be specified in the configuration file. (A connection string setting overrides a
corresponding file setting.)

In addition the following properties may be specified in the configuration file:

Media Administrator only

DelayEventsOnDatabaselnitialization (boolean): If true, all clip handling during
database load is postponed until last clip is received (Default: false).
DelayGetClipData (boolean): Delay getting detailed clip information. Information is
retrieved for clips in rundown only (Default: true).

Encoding (string): Set to encoding used for send/receive from AMS (Default: UTF-8).

- GetMinimumlList (boolean): Set to true to retrieve only clip names when initializing

database (Default: false).

IgnoreCase: Whether clip search is case-insensitive (Default: false).

NumClips (integer):Number of clips to receive for each server query (Default: 50).
ReceiveBufferSize (integer): Set buffer size used for receiving date from AMS. Default
16384 = two times default buffer size of Net.Socket (Default: 16384 ).

- SignalDatabaseReady (boolean): Refreshes all clips after database has been built

instead of refreshing for every item in the database (Default: true).

Use for troubleshooting only:
DatabaseCache (boolean): If set to a valid filename, initial load database stores
the content in this file (Default: false).
DatabaseCacheUpdate : Determines when the debug database cache is updated
(either [Never,Always,Initiall).

- VerboselLogging (boolean): Set to true to enable logging of received messages

from AMS (Default: false).
Effective only if Verbose logging is turned on in Media Administrator.

- AV Automation only

ReadTimeout: Time in seconds to wait for response from AirSpeed (Default: 5).

AirSpeed Multi Stream Search

This driver is similar to the AirSpeed Multi Stream driver, but contains search functionality only.
It is used by Media Administrator for obtaining clip status from an AirSpeed Multi Stream or 5000
video server.

BasePort*: The lowest port number to connect to (Default: 59457).
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Player*: The player number (1-6). Used for setting the TCP port (Default: 7).
ChangeChecklinterval: Time in seconds how often to poll AirSpeed for clip changes
(Default: 1).

ReceiveTimeout: Time in seconds to wait for response from AirSpeed (Default: 10).
Heartbeatinterval: Time in seconds to send out a heartbeat in case of no communication
detected from AirSpeed (Default: 30).

& Note: The asterisk (*) above denotes the TCP port to connect to becomes BasePort +
Player - 1.

Example

Name=AMS; Type=AirSpeedMultiStreamSearch; Server=192.168.1.1; BasePort:59451; Player=2;
ChangeCheckInterval=5; ReceiveTimeout=5; HeartbeatInterval=20;
Config=ClipServerMultiStream.xml

Amadeus Connection String

Name=HTC-DB; Type=Amadeus; Port=[port]; Config=ClipServerAmadeus.xml

Connection String Properties

Name: Amadeus ID for database
- Type: Defines the Amadeus driver for clip handling.
Port: Set to port to listen for an Amadeus connection.

Optional

Port: Defines the connection port (Default: 2202).

ResponseReadTimeout: Defines the wait time until timeout (default: 5000).
PollintervalClips: Defines the time between polling (Default: 15). Set to 0 to disable.
RundownPrefix: Defines the prefix to add for the rundown name (Default: ””).

GetAllICGs: If true, METAREQ_ALLCGS message type is used when getting clip info (Default:
"). For more details, see the Amadeus documentation.

LowerCaseRundowns: If true, then the rundown name is always generated with lower case
(Default: false).

IgnoreSTEG: If true, all messages from Amadeus starting with STEG are ignored

(Default: true). For more details, see the Amadeus documentation.
StegCommandIfSubtitled: Sends the specified STEG command if clip is subtitled (Default:
KLOCKA INVOKEOFF).

For more details, see the Amadeus documentation.

SubtitleStegOutOn: Sets the graphics_out_on xml value in the STEG command set to
Amadeus (Default: BACKGROUNDEND).
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PurgeCachelnterval: Use hh:mm:ss format (Default: 00:00:00).
PurgeCacheAge: Use hh:mm:ss format (Default: 00:05:00).

EVS LinX Connection String

This connection string is used for EVS video servers controlled by the LinX protocol (as opposed to
EVS Xedio systems, see EVS Xedio Connection String).

Type=EVS LinX; Name=[name]; Server=[IPaddress]; LoadDatabase=true;
Config=ClipServerEvsLinX.xml

Example

Type=EVS LinX; Name=EvsLinXName; Server=192.168.62.6; LoadDatabase=true;
Config=ClipServerEvsLinX.xml

Connection String Parameters

- Type: EVS LinX or EVS (EVS is retained purely for backward compatibility).
Name: Defines a unique name for the server.

- Server: Defines the IP address of the server.
LoadDatabase: If true, loads all clip metadata into local cache (Default: false). Use true for
Media Administrator.

- Config: Configuration file containing further configuration settings.

Optional

LogOutput: The LinX log file created for the LogFlag option 0x00000003. The files for the
other options are in the same folder, and with names derived from LogOutput (see LogFlag
below for details.) The folder should exist in advance, and the Viz Mosart user should have
permission to create and write files.
AV Automation and Media Administrator should log to different files, so LogOutput should
be specified (with different folders) in the respective connection strings rather than in this
file.

- VeryVerbose: If true (and the Viz Mosart application issues verbose logging), then some
extra log messages are issued (Default: false).

Config File Parameters

- SupportSearchUsingObjSlug: Search by ‘slug’ (clip name) is supported (Default: true).

- SupportSearchUsingRefID: Search by a configurable clip property (given by the
SearchPropertyName parameter; see below) is supported (Default: false).
HeartbeatTimeout: The time (in milliseconds) after which the server connection may close if
there is no activity (Default: 712000).

KeepAlivelntervalDivisor: In case of connection problems, multiply both HeartbeatTimeout
and KeepAlivelntervalDivisor by the same factor (for example, two) (Default: 8).
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LocalMtpclpAddress: Necessary only if the Viz Mosart server has several network adapters,
e.g. a virtual adapter (or several virtual adapters) in addition to the physical adapter, e.qg.
when VMWare (or similar) is installed on a demo PC, or when connecting through VPN. In
this case, use the IP address (in the usual format of four dot(.)-separated groups of one to
three decimal digits) of the network adapter connected to the EVS servers.

LogFlag: Bitmask specifying LinX log level. Available options are listed in the table below. (In
addition, linxFunctions.log is produced.) The options may be combined. For example,
OXFFFFFFFF produces all log files.

Bitmask Description Log file, given
LogOutput=...\linx.log

0x00000003 Function entry and exit points, linx.log
with parameters and return code

0x00000010 Connections linxConnect.log
0x00000200 Keeping alive linxKeepAlive.log
0x00000400 Databases linx_Archive.log
0x00008000 Debug linxDebug.log
0x01000000 Tools linxTool.log

MaxTries: Obsolete. Instead, use SharedNbMaxConnectRetry and SharedConnectTimeout,
described below. (The maximum number of times to try to synchronize the database
(Default: 10).

NbMaxLinxConnection: The maximum number of connections. The default is 18, to
accommodate two EVS servers. Add 9 for each additional server.

- OsdDefine00 - OsdDefine11: Defines the 12 OSD lines.
- OsdShowHideError: Defines whether or not to show OSD.

- OsdShowHideErrorSignals: Defines whether or not to show OSD. (For further details of these
and other OSD settings, please see the default configuration file.)

- SearchPropertyName: Clip property that may be used for clip search. The default is Varid (a
LinX specific clip ID that may be used to identify clips in the NRCS). If some other property is
needed, please ask Viz Mosart personnel for a list of available values.

- SharedNbMaxConnectRetry: Maximum number of retries in case of connect error on a
shared connection. Increase if the error code 'Too many retries' is encountered, e.g. when
synchronizing the database. (Default: 76).

- SharedConnectTimeout: Maximum time in milliseconds to execute connection request on a
shared connection. Consider increasing if the error code 'Too many retries' is encountered,
e.g. when synchronizing the database. (Default: 500).
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Applies to Models

- XS family (6U, 4U)
XT family (XT2+, XT3, not nano)

Device Prerequisites

Multicam 10.03, or later
LinX license code
Channels to be controlled by Viz Mosart must have Main CTRL LinX.
- The network, including any firewalls, connecting the Viz Mosart server(s) and the EVS
server(s) must support and allow TCP (ports 50000 - 50002 ) and UDP (unicast and

multicast, ports 50100 - 50108 ).

EVS Xedio Connection String

These connection strings are used for EVS Xedio video servers (as opposed to EVS video servers
controlled by the LinX protocol, see EVS LinX Connection String).

From a Viz Mosart perspective, a Xedio system has three parts:

One or more playout servers
- A control center
- A DB connected to through ODBC.

AV Automation controls the playout servers, whereas Media Administrator connects to the control
center and the database. Consequently, the connection strings for AV Automation and Media
Administrator are somewhat different.

AV Automation Connection String

Type=EvsXedio; Name=[name]; Config=ClipServerEvsXedio.xml

Example:

Type=EvsXedio; Name=EvsXedioName; Config=ClipServerEvsXedio.xml

AV Automation Connection String Parameters

- Type: EvsXedio.
Name: Defines the unique name for the server.
Config: Defines the configuration file containing further details.

A Note: The parameters mentioned so far are insufficient to connect to a playout server. The
IP address and port number are also required.
These are specified (separated with : ) in the Video port field(s) in AV Automation Device
Properties, for example 192.168.76.11:4021.
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Media Administrator Connection String

Type=EvsXedioSearch; Name=[name]; Server=[IPaddress]; Config=ClipServerEvsXedio.xml

Example:

Type=EvsXedioSearch; Name=EvsXedioSearchName; Server=192.168.76.10;
Config=ClipServerEvsXedio.xml

Media Administrator Connection String Parameters

- Type: EvsXedioSearch.
Name: Defines a unique name for the server.
- Server: Defines the IP address for the Control center.
- Config: Defines the configuration file containing further details.

A Parameters mentioned so far are insufficient to connect to the database. Additional
parameters DataSourceName, User, and Password are required.
The defaults are probably sufficient. If not, these are more conveniently set as
configuration file parameters, described below.

Configuration File Parameters

PrefixTypeEdit: MOS objlDs with this prefix are treated as 'edits' (Default: EVSE).
PrefixTypeMedia: MOS objlDs with this prefix are treated as 'media’ (Default: EVSM).

Relevant for AV Automation Only

- TimeOut: Defines the timeout in milliseconds (Default: 7).

Relevant for Media Administrator Only

5.0

- AcceptHighResolutionOnly: Whether only high resolution clips are accepted (Default: false).

DataSourceName: ODBC System DSN entry for the CleanEdit DB (Default: CleanEditDB).

MonitorClipinterval: The interval (in seconds) at which found clips are monitored (Default:

60). Used only if MonitorFoundClips is true, see below.
MonitorFoundClips: Whether found clips are monitored (Default: false).
Password: Password for the CleanEdit DB.

PrefixCheckltemReturnAllltemHiResPresent: The prefix added to the Description of a hi-res

clip (Default: HIRES-).

PrefixCheckltemReturnError: The prefix added to the Description of an error clip (Default:

ERROR>).

PrefixCheckltemReturnNotPlayable: The prefix added to the Description of non-playable clip

(Default: NOTPLAYABLE-).
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PrefixCheckltemReturnOnlyltemLowResPresent: The prefix added to the Description of a lo-
res clip (Default: LORES-).

- SkipGetDuration: Whether to skip getting clip duration. Note that this operation may be slow
and MAY be rendered unnecessary by future Media Administrator dev (Default: false).

- User: User for the CleanEdit DB.

Debug Parameters, Relevant for Media Administrator Only
LogFile: CleanEditOcx log file (Default=C:\EvsLogs\CleanEditOcx\CleanEditOcx.log).

Grass Valley K2 Connection String

Applies to Models

K2
- Summit

Connection String Properties

- Type: GrassValleyK2 (selects the Grass Valley K2 driver for clip handling).
Name: See Standard Connection String Properties above.

- Config: See Standard Connection String Properties above. The installed xml config file is
ClipServerGrassValleyK2.xml. Unless changed, the value of Config should be
ClipServerGrassValleyK2.xml, cp. the examples below.

Bin: When LoadDatabase (see below) is true, a 'cache'/'database' of server clips is built and
maintained. Unless IgnoreBin (see below) is true, this 'cache'/'database' comprises the clips
in the bin designated by the two settings Volume (see below) and Bin. (The Bin setting must
designate a bin in the volume designated by the Volume setting.) (The default value is the
string default. Yes, there is normally a bin named default.)

Domain: The domain as part of the user credentials.

DontUsePath: (Media Administrator only) For each clip and server, Media Administrator
keeps track of the 'id" of that clip on that server. By default (DontUsePath false), that id is the
full path and name of the clip on the server. When DontUsePath is true , the id is the clip
name only. The default false may be used in most cases. For a Stratus system, changing to
true may be considered. (However, this should not be combined with setting IgnoreBin (see
below) to true.)

EnsureUniqueObjSlug: (default false) This may be left at the default false in most
circumstances. However, if the clip_hirespath from NCS is the full clip path, e.qg. edl/cmf//
BGO-LAB-K2SUMMI/C:/default/Clip, this should be set to true. (But if IgnoreBin (see below) is
true, it is not necessary to also set EnsureUniqueObjSlug.)

FilterGetXmlIChanges: (Media Administrator only) If true, only clip changes involving the bin
selected by the properties Volume and Bin will be handled. Otherwise (false), all changes are
handled. The default false may be used in most cases. For a Stratus system, changing to
true may be considered. (However, this should not be combined with setting IgnoreBin (see
below) to true.)
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IgnoreBin: (default false) If true, the Bin setting (see above) is ignored, and the
‘cache'/'database' of server clips (see LoadDatabase above) will comprise all clips in the
server volume designated by the Volume setting. (See below.) In this case, the clip_hirespath
from NCS must be the full clip path, e.g. edl/cmf//BGO-LAB-K2SUMMI/C:./default/Clip. (Clips
in different bins may have the same name, so the path is necessary to select a particular
clip.)

LoadDatabase: Whether to maintain a 'cache'/'database' of server clips. Default false. For AV

Automation, keep the default false. For Media Administrator, use true. By default,

this 'cache'/'database’ comprises the clips in the bin designated by the two settings Volume

(see below) and Bin (see above). However, if the setting IgnoreBin (see below) is true, the

‘cache'/'database’ will comprise all clips in the server volume designated by the Volume

setting.

Modificationsinterval : (Media Administrator only; valid only when LoadDatabase is true)

Interval (in ms) for checking for server change.

Pass: The password as part of the user credentials.

Server: The IP address/hostname of the Grass Valley K2 server.

Suite: This value may be chosen arbitrarily. However, these guidelines should be followed:
For each K2 server, two, or even three, different Suite values should be used: First, the
values for Media Administrator and AV Automation should be different.

Second, in a redundancy setup with Main and Backup Mosart server the two values for
Media Administrator should be different.

(Whereas both Main and Backup AV Automation should use the same value, different
from the two Media Administrator values.)

For further info wrt. the redundancy setup, refer to Failover with K2 Servers.

User: The username as part of the user credentials.

- Volume: When LoadDatabase (see above) is true, a 'cache'/'database’ of server clips is built

and maintained. This 'cache'/'database’ is limited to clips in the volume designated by the

Volume setting. If IgnoreBin (see above) is true, this 'cache'/'database’' comprises all clips in

that volume. If IgnoreBin is false, the 'cache'/'database’ comprises the clips in the bin

designated by the Bin setting (see above) only. (The Bin setting must designate a bin in the

volume designated by the Volume setting.) (The default value is V)

Examples

AV Automation:

Name=Summit; Type=GrassValleyK2; Server=K2SERVER1;
Config=ClipServerGrassValleyK2.xml; Bin=default; User=GVAdmin; Pass=GVPass;
Volume=V:; Suite=AVA; Domain=K2SERVER1

Media Administrator:

You also need to add the connection string in Mosart Media Administrator. This is the same
connection string as in AVAutomation, except that you need to

add LoadDatabase=true at the end
use another value for the Suite property.
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Name=Summit; Type=GrassValleyK2; Server=K2SERVER1;
Config=ClipServerGrassValleyK2.xml; Bin=default; User=GVAdmin; Pass=GVPass;
Volume=V:; Suite=GVAdmin; Domain=K2SERVER1;LoadDatabase=true;

Configuration File Properties

KeepCache: See General Configuration File Properties above.
RefreshOnUpdate: See General Configuration File Properties above.

- VerifyClipDelay: See General Configuration File Properties above.

- VerifyModifiedClips: See General Configuration File Properties above.
BypassRetrieveServerConfig (Boolean, default: false): (AV Automation only) Whether to
bypass retrieval of channel configuration from the server. Set to true if there are problems
connecting to one or more channels (red line).

CloseChannels (Boolean, default true): (AV Automation only) Whether channels are closed at
disconnect. Use false in a redundancy setup with Main and Backup Mosart servers to prevent
clip ejection on failover. Otherwise, use true. (See Failover with K2 Servers below.)
MaxCueRetries: Maximum number of cue/load attempts. Default: J.

RecordingBin (string): (AV Automation only) The server bin where clips are to be recorded.
(This bin must be in the volume specified by RecordingVolume.) Both RecordingBin and
RecordingVolume must be specified if clips are to be recorded in a specific bin. Otherwise,
the recording location is undefined.

RecordingVolume (string): (AV Automation only) The server volume where clips are to be
recorded. Both RecordingBin and RecordingVolume must be specified if clips are to be
recorded in a specific bin. Otherwise, the recording location is undefined.
SuspendConnection (Boolean, default false): (AV Automation only) See Failover with K2
Servers below. Use true in a redundancy setup with Main and Backup Mosart servers to
prevent clip ejection on failover. Otherwise, use false.

UseExtendedLogging (Boolean, default false): Adds some more logging. Valid only if Verbose
logging is turned on. Should normally be kept at the default false.

UseMovieAddedNotice (Boolean, default false): Whether to utilize the MovieAddedNotice
element when processing a MovieAdded notice.

A Note: This setting was introduced to handle added clips at an installation with rather
old GV firmware. In the default ClipServerGrassValleyK2.xml, this setting is true. (But
if the setting is removed altogether, the actual default value is false.) Change to false
(or remove setting) if added clips are not handled correctly (for example, if a clip
added on the GV server does not turn solid blue in the Viz Mosart GUI).

UseVideoFormatFromServer (Boolean, default true): Set to false if clip durations (for
example, as shown in GUI) are incorrect.
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Failover with K2 Servers

When GVG K2 servers are connected to both main and backup Mosart servers, any cued or playing
clips would be ejected from the K2 ports during failover.

This is not desirable, so a further layer of configuration file properties have been provided for
avoiding this:

CloseChannels: (Default: true)
SuspendConnection: (Default: false).

For a redundancy setup with Main and Backup Mosart servers, use instead these settings:

<item name="CloseChannels" value="false" />
<item name="SuspendConnection" value="true" />

With these settings, the outgoing Mosart server (e.g. main) will disconnect in a way that allows the
incoming Mosart server (e.g. backup) to retake the same connections and channels.
This ensures that no clips are ejected in the process.

The prerequisite for this to work is that the Connection String Properties on main and backup are
set up with identical Suite names (for AV Automation).

Stratus
The two connection string properties

DontUsePath
FilterGetXmlIChanges

were introduced at installations with a Stratus system to ensure that deleted clips appeared
chequered in the Mosart GUI.

The default value of both settings is false, and that has, as far as we know, worked for all other
installations. We recommend the following:

1. Start using the default value false for both settings.
2. If problems of the type indicated (deleted clips stay solid blue in GUI) are encountered,
change both settings to true.

Other combinations (than both false and both true) have not been tested.

Harris Nexio Connection String

The Harris Nexio driver supports Binary-Coded Decimal TCP/IP transport. The driver can be
configured to be case sensitive on searches and use Unicode encoding. The Harris Nexio driver
supports recording.

Control via RS-422 can be done through VDCP.
Maximum five video server units.

Connection String Properties

Type: Harris Nexio
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Name®*: Defines the ID of this connection.
Server*: Defines the hostname or IP-address of the server.
Config: Defines the name of the configuration file.

Optional

Port*: TCP port to connect to (Default: 557).

Encoding:* Set to U or Unicode if it should be Unicode.

Case*: Set to B to be case sensitive on clip name searches.

ClipNames:* Property for using exact clip names. If set to EXACT, clip names are case-
sensitive (Default: EXACT).

ChangeChecklinterval: Defines the number of seconds between checks for clip changes.
LoadDatabase (boolean):* Set to true to build internal database of clips present on server
and enable clip monitoring (Default: false).

& Note: The asterisk (*) above denotes the configuration file set property can be
overridden by a connection string parameter.

Examples
AV Automation:

Name=HAR; Type=HarrisNexio; Server=192.168.1.1; Port=557; Config=ClipServerHarris.xml

Media Administrator:

Name=Harrisl; Type=HarrisNexio; Server=192.168.1.1; Port=557; LoadDatabase=true;
Encoding=UTF-8; ClipNames=UNEXACT; ChangeCheckInterval=15;
Config=ClipServerHarris.xml

Configuration File Properties

ChangeCheckinterval (integer): Time in seconds how often to poll HarrisNexio for clip
changes (Default: 5).
Port (integer): Defines the default connection port (Default: 557).
Encoding (string): (Default: ANSI).
Case (string): (Default: UPPER).
ClipNames (string): Property for using exact clip names. If set to EXACT, clip names are case-
sensitive (Default: EXACT).
KeepCache (boolean): When set to false, the cache is cleared on reconnects (Default: false).
RefreshOnUpdate (boolean): When set to true, the cache is updated on each update clip
message from the server (Default: true).

- VerifyClipDelay (integer): Delay in frames to wait before verifying new clips from server
(Default: 0).
SupportSearchUsingObjSlug: Ignores search for objSlug if set to false (Default: true).
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- SupportSearchUsingRefID: Ignores search for reflD if set to false (Default: false).
MaxCueTime (integer): Maximum milliseconds to wait for cue (Default: 5000).
- ClipNamePattern: See General Configuration File Properties.

JupiterWebService Connection String

JupiterWebService is a customer-specific asset management system.

Name=myServerName; Type=Jupiter; Url=myConfigFile

Example:

Name=Jupiter; Type=Jupiter; Url=ClipServerJupiter.xml

This server type does not support any additional parameters in the connection string. The
following settings must be added in the configuration file.

Configuration File Properties

- Server (string): Defines the hostname or IP-address of the server (Default: localhost).
Port (integer): Defines the TCP port to connect to (Default: 8102).

- ServiceName (string): Default: JupiterService.svc.

- Service (string): Default: http://\{Server}.{Port}/{ServiceName}].

- GetStatusCommand (string): Default: {Service}/clipstatus/{0}.

- GetKeyFramesCommand (string): Default: {Service}/keyframes/{0}.
PollintervalStatus (string): Default: {Service}/keyframes/{0}.

MVCP Connection String

MVCP (Multiport Video Computer Protocol) is a simple request/response protocol, which is
implemented over a TCP byte-stream connection (for example, a stream socket).

Applies to Models

- Vizrt Xlator.
- SVT F2C file name conversion service.

Connection String Properties

- Type: MVCP
Name: Defines the ID of this connection (Default: MVCP).

- Server: Defines the hostname or IP-address of the server (Default: localhost).
Port: Defines the TCP port to connect to (Default: 5250).

5.0
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Configuration File Properties

CustomSearch*: (Example) Set to a unique string like SVT to enable a custom search named
SVT on objSlug.
SetNameAsRefld*: Set clip name as ref ID in the media object (Default: false)for re-use in
other clip servers (Default: false).

- WriteTimeOut: Sets the amount of time in milliseconds that a write operation blocks waiting
for data from the server (Default: 5000).
ReadTimeOut: Sets the amount of time in milliseconds that a read operation blocks waiting
for data to the server (Default: 5000).

- AppendExtension*: A file extension used when sending messages to the MVCP interface

(Default: ™).
RemoveExtension*: Used to strip the extension of a clip name from the MVCP interface
(Default: ™).

ClipNamePattern: See General Configuration File Properties.
& Note: The asterisk (*) above denotes a custom search called SVT, where in this
example SVT is set up to process file names with 36 characters. As Nexio only

supports 32 characters, SVT will expose a mapping proxy with an MVCP interface
and a custom command F2C which translates a long name to a shorter one.

Examples
AV Automation:

Name=MVCP1; Type=MVCP; Server=192.165.4.1; Port=5250

Media Administrator:

Name=MVCP2; Type=MVCPSearch; Server=192.165.4.1; Port=5251

Omneon Connection String

Applies to Models

Models with Omneon Spectrum
& Note: Viz Mosart is incompatible with Omneon Spectrum versions earlier than 4.6.
Additionally, in some cases, clip length is not updated when using Omneon

Spectrum 6.4.3 or earlier.
It is recommended to upgrade to Omneon firmware version 7.9.x or later.
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Connection String Properties

Type: Connection type: Omneon or OmneonSearch.

Name: ID of this connection.

Server: Hostname or IP-address of the server.

Player: Performs searches associated with directory for the given player if set. If not set, the
Directory option should be used to identify the search directory (optional).

Directory: Specifies the search directory (optional).

ExtList: File extensions to be used. List of case sensitive extensions separated by periods.
ClipDir: Clip directory to monitor for files.

LoadDatabase (boolean): Set to true to build internal database of clips present on server and
enable clip monitoring (Default: false).

Config: Name of the configuration file (ClipServerOmneon.xm]).

UseFullPath: If true, the Media Administrator returns full clip paths. The clip ID contains both
the Omneon server directory, as well as the clip name. Setting this property to true is
mandatory if multiple directories are used on a single Omneon server. (Default: false).

Examples
AV Automation:

Type=Omneon; Name=Omneon; Server=10.211.114.104; ExtList=.mov.MOV.mxf.MXF;
UseFullPath=true; Config=ClipServerOmneon.xml

Media Administrator:

Type=OmneonSearch; Name=Omneon; Server=10.211.114.104; Player=Playl; clipdir=/fs0/
media; ExtList=.mov.mxf; LoadDatabase=True; Config=ClipServerOmneon.xml

Configuration File Properties

KeepCache (boolean): When set to false, the cache is cleared on reconnects (Default: false).
RefreshOnUpdate (boolean): When set to true, the cache is updated on each update clip
message from the server (Default: true).

VerifyClipDelay (integer): Delay in frames to wait before verifying new clips from server
(Default: 0).

DescriptionPattern (string): Makes it possible to extract a description from the object slug
(objSlug) based on this Regex pattern (Default: [A_]*_(.%)).

DescriptionReplacement (string): Regex expression referring to first matched group. Used
when replacing object slug (objSlug). (Default: $§7)

InvokeServerOnGetClipinfo (boolean): If true (non-zero), a request is sent to the video server
when doing clip search. If true, all modified clip events for clip not in cache are verified (as if
they were created) (Default: false).
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VerifyModifiedClips (boolean): If true, all modified clip events for clip not in cache are
verified (as if they were created) (Default: false).

IgnoreCase: If true, searching for clips is done case insensitive. Must be used in combination
with <MatchExpression ignoreCase=true /> from General Search Configuration File
Properties .

GoToTimeCodeTimeOut (integer): Maximum time to wait (in milliseconds) for successful
execution of command to play clip from a given time code (Default: 6000).
UseNativeGoToTimeCode (boolean): If true, it uses GoToTimeCode method available in
Omneon API. This may take a longer time to cue a clip at a specified position (Default: false).
UseStopOnCue: If true, the timeline is stopped, not paused (play with speed 0) when cuing a
new clip. This causes cuing to take longer than usual.

ClipNamePattern: see General Configuration File Properties.

Search Properties: See General Search Configuration File Properties.

Omnibus OPUS Connection String

Name=myServerName; Type=0PUS; Url=myUrl; Config=myConfigFile.xml

Url: Specifies the URL of the OPUS Interchange web service.

Orad OCIP Connection String

This connection string is used for video servers controlled by OCIP (Open Control Interface
Protocol).

Type=Orad OCIP; Name=[Name]; Server=[hostname/IP address]; Port=[Port];
LoadDatabase=true; Config=ClipServerOradOcip.xml

Example:

Type=Orad OCIP; Name=0OradVJ; Server=192.168.15.1; Port=10001; LoadDatabase=true;
Config=ClipServerOradOcip.xml

Connection String Parameters

Type: Orad OCIP.

Server: Defines the server hostname.

Name: See Standard Connection String Properties above.

Port: Defines the server port. By default, the four ports 10001 , 10002 , 10003 , and
10004 are configured on an OCIP-controlled Orad server. We recommend using different

ports for AV Automation and Media Administrator.
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(® Example: 710002 for AV Automation and 10003 for Media Administrator.

LoadDatabase: If true, the server database is loaded at start-up (Default: false). Use true for
Media Administrator.
- Config: Configuration file containing further configuration settings.

Configuration File Parameters

- AllowSetPosition: Whether to enable 'scrubbing'/'scrolling’ the in-point of a cued clip in the
GUL. Default: false. Effective only for servers supporting OCIP 3.0.0 or higher. (Only tested
with OCIP 4.0.0.)

- CopyObjSlug: Whether the value of the clip 'slug’ (the slug is the value of the OCIP item
parameter set in ObjSlugParameter) shall be copied 'upwards' (to Media Admin). Default:
false.

& The value for CopyObjSlug in the installed ClipServerOradOcip.xml file, is initially set
to true. This will be the value for new installations.

If problems are experienced when a clip is first deleted and then re-created with the same
Sourceld (assuming that is the value of the ObjSlugParameter setting), but a different Id,
make sure this setting is true.
IgnoreGrowingltems: Whether clips with growing parameter set to true will be ignored.
When set, this implies that growing clips are processed as non-existent and are unavailable.
Available for Avid FastServe running FSP 2018.8 or higher. The RequestGrowing setting must
be true for this to have effect.
LoopPostRoll: Number of frames before clip-end to restart loop. Set to a positive value to
obtain smooth looping.
- ObjSlugParameter: The OCIP item parameter to use for clip 'slug'. The values of this
parameter should match the values of the 'clip_hirespath’' newsroom tag.
Default 'Name'. This default value has worked for the video server Orad VJ. Other workflows,
especially using Avid FastServe, require using the value 'Sourceld'. Other values are not
verified as supported.
RequestGrowing: Whether to request the Growing parameter from the server. Default: false.
Set to true if the IgnoreGrowingltems feature is to be used.
- SetInAndOutPoint: How a clip's in-point and out-point are set. Available values:
FromServer: (Default) From the item's In and Out parameters. This may yield incorrect
results if the In parameter is different from 0.
- ZeroAndDuration: (Value in the installed ClipServerOradOcip.xml file, so this will be
the value for new installations.) As 0 and the item's Duration parameter.
Dont: For future/internal Vizrt Support use. Do not use this value.
- SkipAbortinLoadClip: If true, skip the ChannelAbort command at cue (Default: false).
- TimeoutDefault: Timeout in milliseconds for commands with no specific timeout set
(Default: 000 which is 1 second).
- TimeoutChannelAbort: Timeout in milliseconds for the ChannelAbort command performed
at cue.
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- TimeoutChannelJog: Timeout in milliseconds for the Jog command performed at
'scrubbing'/'scrolling' (See AllowSetPosition).

- TimeoutChannelPause: Timeout in milliseconds for the ChannelPause command.

- TimeoutChannelPlay: Timeout in milliseconds for the ChannelPlay command performed at
cue.

- TimeoutChannelPlaylnit: Timeout in milliseconds for the ChannelPlaylnit command
performed at cue (Default: 4000 (4 seconds)).

- TimeoutChannelSetSpeed: Timeout in milliseconds for the ChannelSetSpeed command
performed at play.

- TimeoutChannelStatus: Timeout in milliseconds for the ChannelStatus command.

- TimeoutCreateCallbackltem: Timeout in milliseconds for the CreateCallbackltem command
at start-up (Default: 2000 (2 seconds)).

- TimeoutltemCheck: Timeout in milliseconds for the ltemCheck command occasionally
performed at cue.

- TimeoutltemGet: Timeout in milliseconds for the ltemGet command occasionally performed
at cue, and also for getting status.

- TimeoutListChannel: Timeout in milliseconds for the ListChannel command at start-up.

- TimeoutListltem: Timeout in milliseconds for the Listitem command at start-up
(Default: 2000 (2 seconds)).
UpdatelnAndOutPoint: Whether clip in-point and out-point should be copied 'upwards' (to
MediaAdmin) for clips with growing duration.
Default: false. Change to true if such clips are not shown with correct duration in GUL.
UseHashKey: If true, the item Id will be used as clip 'id'. If false, clip 'slug’ will be used. (See
settings ObjSlugParameter and CopyObjSlug above.)
Default: false. However, the value in the installed ClipServerOradOcip.xml file is true, so this
will be the value for new installations.
If problems are experienced when a clip is first deleted and then re-created with the same
Sourceld (assuming that is the value of the ObjSlugParameter setting), but a different Id,
make sure this setting is true.

- UsePingOcipOperation (boolean): If true, use an OCIP operation for Ping instead of the
default TcplpClient ping (Default: false).

Debug Parameters

KeepSpeed: For Vizrt Support use. Default: false.
Do not change!
- WSACancelBlockingCallExceptionTraceEventType: The TraceEventType for the
WSACancelBlockingCall exception.
Options: Critical, Error, Warning, Information, Verbose (Default: Error).

Applies to Models

- Orad V]
- Avid FastServe
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Device Prerequisites

OCIP 1.0.4. Some features require OCIP 3.0.0.
Avid FastServe. Some features require FSP 2018.8.

Quantel Connection String

Applies to Models

Connects to Quantel using Quantel CORBA interface.

Device Prerequisites

Requires Quantel CORBA services to run.
Serial numbers of playout servers, normally obtained via Quantel Web interface.

Quantel Video Server Connection String

Name=myServerName; Type=Quantel; Mode=Player; SerialNo=mySerialNo; IOR=myQuantelIOR;
Slave=mySlaveAddress; Timeout=10; Config=myConfigFile.xml

Connection String Properties

Name: Specifies a logical name to be associated with the video server. This is used to
identify the server across AV Automation and Media Administrator configurations.
- Type: Specifies which driver to be used for connecting to the server. This should be set to
Quantel for both AV Automation and Media Administrator.
Mode: Specifies whether the Quantel connection is used for playing clips or searching
(Default: Search):
Mode=Player: The Quantel connection is used for playing clips (AV Automation).
Mode=Search: The Quantel connection is used for searching (Media Administrator).
SerialNo: Specifies the serial number of the Quantel video server. This number is used to
recognize the particular video server within a Quantel zone portal. Serial numbers may be
obtained via the Quantel Web interface.
IOR: Specifies the Corba IOR used to establish connection with a Quantel server. This IOR is
normally obtained from the system administrator.
Slave: Specifies an optional slave address. Used when Quantel is configured in a redundancy
setup.
- Timeout: Specifies the timeout in seconds when initially connecting to the Quantel zone
portal (ISA manager). Default is 10 seconds.
Config: Specifies a configuration file containing custom configuration for the Quantel server
driver. Normally set to ClipServerQuantel.xml, which contains the default configuration.
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Examples

AV Automation:

Name=sQ7; Type=Quantel; SerialNo=19343; Mode=Player; IOR=http://
quantel:@192.168.60.33/ZoneManager.ior; Config=ClipServerQuantel.xml
Media Administrator:

Name=sQ7; Type=Quantel; SerialNo=19343; Mode=Search; IOR=http://
quantel:@192.168.60.33/ZoneManager.ior; Config=ClipServerQuantel.xm

Quantel Configuration File Properties

DefaultTakenPortAction (enum): Action when not able to take a port when owned by
someone else (Default: Steal).
Options:

Steal: Takes control over the port even if in use by someone else.

Share: Shares control with the other user. Not recommended.

Cancel: Cancels the operation. Port is still in control by other user.

5.0

IssueRequestForTakenPorts (boolean): If true, the user is prompted to confirm taking a port

in use by someone else (Default: true). A dialog box appears in AV Automation, warning
about taking a port that is currently in use. Only applicable when
DefaultTakenPortAction=Steal.

ReleasePortsWithNoAssignedChannels (boolean): If true, any unassigned ports (with no
assigned channels) are released on player initiation (Default: true).

ServerPollFrequency (integer): Polling frequency for server, in seconds. This is used as

heartbeat between Viz Mosart and Quantel. Note that heartbeats are not issued if data has

been received from Quantel since last heartbeat. (Default: 30).

ClipNamelsValidNumber (boolean): If true then it is possible to search from Viz Mosart GUI

using valid Quantel ClipIDs directly (Default: false).

QuantelSlugColumn (string): Specifies the Quantel database column that is used for the clip

slug (Default: Title).

QuantelClipIDColumn (string): Specifies the Quantel database column that is used for the

clip ID (Default: ClipID).

QuantelSearchColumn (string): Specifies the Quantel database column that is used for the

clip searches (Default: Title).

MaxPingAttempts (integer): Maximum ping attempts before a lost connection is detected

(Default: 1). When Viz Mosart detects a lost connection, the current connection is closed
followed by attempts to reconnect. For playout servers only (AV Automation).

QuantelRefIDColumn (string): Specifies the Quantel database column that is used for the clip

RefID. Used if SupportSearchUsingRefID is set to true. (Default: Title).
SearchUsingServerldOnly (boolean): Forces AV Automation to only search for clips using
Quantel Clipld’s obtained from Media Administrator if true.

ClipNamePattern: see General Configuration File Properties.
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Quantel Failure Handling Properties

QuantelStatusinterval (integer): Interval in seconds for the Quantel server to send regular
status messages. These messages are only sent when the Quantel server is idle. (Default: 2
seconds).

QuantelCommErrorNumRetries (integer): The number of retries in case of a Quantel CORBA
operation results in a CORBA_COMM_FAILURE. (Default: 7).

QuantelCommeErrorTimeout (integer): The timeout in milliseconds between retries in case of
a Quantel CORBA operation results in a CORBA_COMM_FAILURE. (Default: 7100 msec).

Quantel Search Filters

It is possible to define a set of dedicated filters used to either exclude or include hits returned
from the Quantel ISA manager. Note that the Quantel ISA manager returns hits for all attached
pools. It is necessary to filter out the clips not available on the pools used by the corresponding
video servers.

The Quantel search filters are defined in the Quantel configuration file as a list of Filter elements
within a SearchFilter element. The following XML structure defines the default filters:

<SearchFilters>
<Filter property="Category" pattern="TEMPORARY CLONE" qinclude="false" />
<Filter property="PoolID" pattern="[PoolID]" include="true" />
<Filter property="IgnoreCase" pattern="true" />

</SearchFilters>

Each filter has the following attributes:

property (string): Name of a Quantel database column. A special property= IgnoreCase is
available to specify case insensitive or case sensitive searches.
pattern (string): Regular expression applied on the resulting property.
include (boolean): Action to take if the regular expression results in a match:
include=false, the hit is excluded from the search.
include=true, the hit is returned as part of the search.
The default example given above shall be interpreted as follows:

All clips stored in the Quantel database with Category=TEMPORARY CLONE are ignored.
Only clips in the Quantel database with a PoolID that matches the pool identity of the
corresponding video servers are returned.

All searches are case insensitive.

ScreenLL Connection String

Screen Lingualib Connection String, used by Media Administrator.
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Name=myServerName; Type=ScreenlLL; Server=myMainServerlLocator;
BackupServer=myBackupServerLocator; ServerUsage=myServerUsageMode;
Config=myConfigFile.xml

Name: Not important, used for logging purposes only.
Type=ScreenLL: Defines the Screen Lingua Lib search driver for clip handling.
Server=path: Defines where subtitle clips are located on the main subtitle server.
BackupServer=path: Defines where subtitle clips are located on the backup subtitle server, if
applicable.
ServerUsage=mode: Specifies how availability status is updated based on (main) server and
backup server clip status:

0: available if clip is present on main server.

1: available if clip is present on backup server.

2: available if clip is present on either main or backup server.

- 3: available if clip is present on both main and backup server.

Config=ClipServerScreenLL.xml

SimpleTestPlayer Connection String
The SimpleTestPlayer may be used in either of two modes:

File mode: A specified file contains clip metadata. The file is read at start-up and is
monitored for changes.

Folder mode: A specified folder contains actual clip files. The folder is read at start-up and is
monitored for changes.

Connection String Properties

Type: SimpleTestPlayer
File: The clip metadata file (used in File mode). See below.
Folder: The clip folder (used in Folder mode)

Clip File

The file must be in this format:

<ClipDB>
<clips>
<clip slug="..." status="0" dur="..."/>
</clips>
</ClipDB>
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Attribute
slug

status

dur

objid

description
mark_in
mark_out

pdur
statusdescription
rights

refid

timestamp

type

Mamld

Mandatory Value

Yes String

Yes 0

Yes Positive integer

No

No

No

No

No

No

No

No

No

No

No

String
String
String
String
String
String
String
String
String
String

String
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Comment

If missing or other value, the clip
is considered missing

Duration in frames. Should be
greater than the value of the
MinimumClipLength setting.

Additionally, the ClipDB element may have a serverDown attribute. This is for testing purposes

only, and should not be used.

Configuration File Properties (Folder mode only)

InternalBufferSize: The size (in bytes) of the internal buffer. For details, see Microsoft's

article: InternalBufferSize.

IncludeSubdirectories: Whether subdirectories should be monitored

MedialnfoMethod: May have one of these two values:

Medialnfo (default): Use Medialnfo to retrieve clip file data
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VDCPProxy: In this case, the 'clip files' are regarded as VDCP proxy files. For further
details, contact Viz Mosart Support, quoting MOSART-6143.
- SkipExtension: Whether the file extension is not to be part of the clip slug
- AlwaysGetDuration: Whether the actual clip duration is retrieved from the clip file
UseObjSlugAsServerld: Whether to use the slug as the server ID. (Otherwise, the path is
used.)
UseDurationAsMarkOut: Whether to set InPoint (=0) and OutPoint (=Duration) from Duration

SQL Database Connection String

This connection string (in Media Administrator) is for the SglMediaSearch driver, for reading clip
metadata from an RDBMS (Relational DataBase Management System) using SQL, and then
computing clip properties based on:

- SQL query results.
Existing clip properties (referred to as properties of 'the clip sent down to the
SglMediaSearch driver').

It is assumed that

- All metadata resides in a single database table (the clip table).
- The metadata of a single clip is found in a single row (the clip row) in this table.

The driver is designed to be used in conjunction with one or more video servers, to provide
additional metadata about clips residing on the server(s). The presence of clip metadata in the
database is not considered proof of clip existence. Only clips that exist on a video server appear as
blue in the viz Mosart GUI.

Place this connection string above (for example, in Video clip Server 1) that/those of the video
server(s).

Applicable Models

The driver has been designed to interact with any RDBMS (Relational Database Management
System) using SQL. However, it has only been verified with following versions of Microsoft SQL
Server:

Microsoft SQL Server 2012 (SP1) - 11.0.3000.0 (X64)
Microsoft SQL Server Express (64-bit) - 11.0.2218.0

Device Prerequisites
Create a DB user with:

Read access to the table containing clip data.
No write or admin access. (As no attempts to prevent SQL injection have been done, this is
necessary to prevent unauthorized changes to the DB).

General Format

Name=DB; Type=SglMediaSearch; ProviderName=System.Data.SglClient;Config=ClipServerSgl.xml;D
bConnectionString="..."
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Connection String Parameters

Name: See Viz Mosart Video Server Connection String above.
Type: SqlMediaSearch.
Config: See Viz Mosart Video Server Connection String above. A configuration file
ClipServerSql.xml is installed. Use the name of this file (ClipServerSql.xml unless changed).
ProviderName: The 'invariant name' of a .NET Framework data provider. At least the
following providers are installed with the .NET Framework:

System.Data.SqlClient

System.Data.Odbc

System.Data.OleDb

System.Data.OracleClient.

Others may have been installed. Only System.Data.SqlClient has been verified.

DbConnectionString: The connection string (containing connection settings) sent to the
chosen provider. The format depends on the chosen ProviderName.

For System.Data.SqlClient (the only verified provider) the format is documented in https://
msdn.microsoft.com/en-us/library/
system.data.sqlclient.sglconnection.connectionstring(v=vs.110).aspx.

Quotes in the value have not been tested and may not work as expected.
FileClipProperties: Same as the ClipServerSql.xml parameter. As this is set

in ClipServerSql.xml, see below.

FileSelectStatements: Same as the ClipServerSgl.xml parameter. As this is set

in ClipServerSql.xml, see below.

LogResult: Same as the ClipServerSqgl.xml parameter. As this is set

in ClipServerSql.xml, see below.

DefaultTableName: Same as the ClipServerSqgl.xml parameter. As this is set

in ClipServerSql.xml, see below.

MonitorFoundClips: Same as the ClipServerSqgl.xml parameter. As this is set in
ClipServerSql.xml, see below.

MonitorCliplinterval: Same as the ClipServerSql.xml parameter. As this is set

in ClipServerSql.xml, see below.

Example

Name=DB; Type=SqlMediaSearch;ProviderName=System.Data.SqlClient;Config=ClipServerSql.x
ml;DbConnectionString="Persist Security Info=True;Initial Catalog=HarrisDBTest;Data
Source=BGO-OFRENGINE\SQLEXPRESS;Failover Partner=aut-db-srv03.fs-
pn.vizrtnet.int\harris;User ID=test;Password=test;"

Configuration Files
There are three configuration files:

ClipServerSql.xml
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SelectStatements.xml
ClipProperties.xml

When the Mosart Server is installed, these files are placed in the ConfigurationFiles sub-folder
of the installation folder. If any file shall be be changed, follow the standard procedure:

Copy the file to c:\channeltemplates, and change the copy .

If you choose to change the name, you must also change (accordingly):
If the name of ClipServerSql.xml is changed: The Config connection string parameter.
If the name of SelectStatements.xml is changed: The FileSelectStatements parameter in
ClipServerSql.xml (below).
If the name of ClipProperties.xml is changed: The FileClipProperties parameter in
ClipServerSql.xml (below).

ClipServerSql.xml
This is the main configuration file for the driver. These configuration parameters are available:

FileClipProperties: The name of the file containing clip properties to be pulled from DB.
Default: ClipProperties.xml, as described below.

FileSelectStatements: The name of the file containing the SELECT statements to be used.
Default: SelectStatements.xml, as described below.

LogResult: Whether query results should be logged (in Media Administrator console and in
Viz Mosart log). Default true. Set to false if everything works fine, and the messages are
superfluous.

DefaultTableName: The name of the outer XML element shown when using LogResult. The
default (dummy) is usually OK.

MonitorFoundClips: Whether found clips should be monitored. Default true. If set to false,
missing or changed clips are not detected.

MonitorClipinterval: If the value is X (and if MonitorFoundClips is true), each found clip is re-
queried every X seconds. Increase if DB traffic is too high.

DbConnectionString: Same as the connection string parameter; As this is set in the
connection string parameters, see above.

ProviderName: Same as the connection string parameter; see above. Should be set in the
connection string.

In addition, these 'common'/'standard' parameters are available:

- SupportSearchUsingObjSlug: See General Configuration File Properties above.
- SupportSearchUsingReflD: See General Configuration File Properties above.

SelectStatements.xml

If the name of this file is changed, the configuration parameter FileSelectStatements in
ClipServerSql.xml must be changed accordingly.

To further understand this configuration, please study the examples provided in the installed file.
This file defines the SQL SELECT statements that are executed when:

- The DB is queried for data on a single clip.
- The DB is searched for clips satisfying a given search criterion.
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Each of these two SQL SELECT statements is defined by a SelectStatement element. For technical
reasons, the two SelectStatement elements are enclosed in a Statements element, which in turn is
enclosed in a SelectStatements element.

A SelectStatement element has these attributes:

Attribute Value(s) Description

type Single/Multiple Distinguishing between the two types of
SQL SELECT statements.

database The DB name.
schema The schema name.
table The table name.

A SelectStatement element has these sub-elements:

Sub-element Description

SelectColumns The columns in the SELECT clause of the SQL
statement.

WhereColumn The WHERE clause column to be searched for the

(variable) search criterion.

AdditionalWhereColumns Additional WHERE clause columns being searched for
constant values.

The SelectColumns element has one or more SelectColumn sub-elements, each with these
attributes (and no sub-elements):

Attribute Value(s) Description

name The DB column name

type String/Int The DB column data type. For Microsoft SQL
Server,

String is used for char and varchar columns.
Int is used for int columns.
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Attribute Value(s) Description
format Default/ How a column value is to be interpreted:
HhMmSsFfPackedBCD

Default: The value is passed as is. (And this
is default, so it is used if no format attribute
is present.)

HhMmSsFfPackedBCD: The (four-byte) int
value is interpreted as the packed BCD
representation of a time code hh:mm:ss:ff.
This is converted to the total number of
frames. E.g., the int (decimal) 404310278 is
hex 18194906, corresponding to the time
code 18:19:49:06, in total 1649731 frames.

The AdditionalWhereColumns element has one or more WhereColumn sub-elements.

A WhereColumn element (either as a direct sub-element of SelectStatement, or as a sub-element of
AdditionalWhereColumns) has these attributes:

Attribute Value(s) Description Comment
name The DB column name
type String/Int The DB column data type. Only String has been

For Microsoft SQL Server, tested.

- String is used for char
and varchar columns.
Int is used for int

columns.
value The value to search for Used only for WhereColumn
elements which are sub-
elements of

AdditionalWhereColumns.

For the WhereColumn sub-
element of SelectStatement,
the value to search for is
given by context.
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Attribute Value(s) Description Comment

searchMethod BeginsWith/ How the column value Only IsEqualTo makes
IsEqualTo/EndsWith/  (c) is compared to the sense for Int.
Contains value to search for (s ):

EndsWith and Contains
IskqualTo: ¢ must be have not been tested.

exactly equal to s IsEqualTo has not been
BeginsWith: ¢ must tested for Int.

begin with s

EndsWith: ¢ must end

with s

Contains: ¢ must

contain s

ClipProperties.xml

If the name of this file is changed, the configuration parameter FileClipProperties in
ClipServerSql.xml must be changed accordingly.

To further understand this configuration, please study the examples provided in the installed file.

This file defines the clip properties computed by the driver. Each of these properties is defined by
a Property element. For technical reasons, the Property elements are enclosed in a Properties
element, which in turn is enclosed in a ClipProperties element.

A Property element has one attribute:

Attribute Description Comment

name The property name Only these have been implemented:

Description (the clip description as shown
in the GUI (if selected by the setting Video
clips should be presented with there))
InPoint (the clip in point as shown in the
GUI Preview window)

ObjSlug (the clip slug as shown in the GUI
Media pool Search tab)

OutPoint (the clip out point as shown in
the GUI Preview window)

A Property element has one sub-element, an expression. The principal feature of an expression is

that it may be evaluated to yield a value. There are four kinds of expression elements (so a
Property element has one of these as a sub-element):
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element

ClipExpressi
on

DbExpressio
n

ConstantEx
pression

OperationEx
pression

Description

The value of a ClipExpression depends only
on a property of the clip as sent down to
the SglMediaSearch driver.

The value of a DbExpression depends only
on the value of a column in the clip row (the
DB row pertaining to the clip).

The value of a ConstantExpression is (as
strongly indicated by the name) constant , it
depends neither on the clip as sent down to
the SglMediaSearch driver, nor on the DB.

An OperationExpression is used to combine
other (simpler) expressions by performing
an operation, which means applying an
operator to the values of its operands (sub-
expressions). Each operand/sub-expression
may be of any of the four kinds of
expression listed in this table. In particular,
OperationExpressions may be nested to any
depth.

A ConstantExpression element has one attribute:

Attribute

value

Both a ClipExpression and a DbExpression has two attributes:

Attribute

name

default

Description

Viz Mosart Administrator Guide - 5.0

Comment

The clip properties available
depend on the video server
driver(s) used together with
SqlMediaSearch. Only the BasePoint
property (start timecode in frames,
available for the HarrisNexio
driver) has been tested.

The column has to be defined by a
SelectColumn element as
described in the
SelectStatements.xml section
above.

ConstantExpressions were
introduced for internal purposes,
and have not been real-life tested.

The (constant) value of the ConstantExpression

Description

See table below

The value to be used if evaluating the expression as described in
the table below doesn’t make sense in the given context
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The name attribute and expression evaluation is described in more detail for each of the two kinds

of expressions:

Expression Description of the Expression value

kind name attribute

ClipExpression  The name of a clip The value of the
property property for the given

clip

DbExpression The name of a The value of the
column in the DB clip  column for the clip
table row

An OperationExpression element has one attribute:

Attribute Value(s) Description

operator Minus/Plus The operator to be applied to
the values of the operands.
Details are given in the table
below.

An OperationExpression element has one sub-element: Operands.

attributes, but any number of expression sub-elements, meaning

Comment

Only the BasePoint property
(start timecode in frames,
available for the HarrisNexio
driver) has been tested.

The column has to be
defined by a SelectColumn
element as described in the
SelectStatements.xml section
above.

Comment

Both operators make sense for
numerical arguments only, and
have been implemented for
integer arguments only.

An Operands element has no
any number of ClipExpression,

DbExpression, ConstantExpression, and OperationExpression sub-elements.

These sub-elements are the operands / sub-expressions of the OperationExpression.

Some further details on each operator:

Operator Expression value

Minus If there is one operand, the negation

of the value of that operand. If

there are two (or more) operands, the difference between the values
of the first operand (minuend) and the second operand (subtrahend).

Plus For any number of operands, the sum of the values of the operands.
(As a special case, the ‘sum’ of no operands is zero. However, the
Operands sub-element itself must be present.

so <ConstantExpression value=0 />
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VDCP Connection String

The VDCP driver supports both serial and TCP as transport. Video Disk Communications Protocol
(VDCP) is also known as Louth protocol. The driver can be configured to run in eight character or
variable character mode. (See the UseLongClipNames setting below.)

& Note: Standard VDCP does not support looping of clips. For a very limited number of
servers, a customized solution has been introduced to support looping over VDCP, if
described in the server model's configurations.

Applies to Models

Dalet BRIO
EVS XT-VIA
Ross Blackstorm
- Vector MultiPlay VServer

Device Prerequisites - VDCP

Dalet BRIO
- Single VDCP connection configuration per port - does not support multiple control
ports per connection.
- Only clips in folders added to the BRIO VDCP configuration are visible for Viz Mosart
to monitor and play-out.
Duration of video files is only available if the VDCP connection is configured to use a
physical play-out port.

Connection String Properties - VDCP

- Type: VDCP (serial) or VDCPtcp (Ethernet).
Name: See Standard Connection String Properties above.
- Server: Hosthame or IP-address of the server (for Type=VDCPtcp only).
Port:
- Serial port (Type=VDCP, Default: COMT)
- Server side TCP port to connect to (Type=VDCPtcp, Default: 5205).
LoadDatabase: If true, builds internal database of clips present on server and enables clip
monitoring (Default: false).
- Config: Name of the configuration file. At installation the file ClipServerVDCP.xml is

copied to the ConfigurationFiles subfolder of the installation folder. Unless you rename this
file, use Config=ClipServerVDCP.xml. (You may need to copy and rename if you have several
VDCP servers which should be configured differently.) This file may be taken as a starting
point for custom configuration, See Configuration File Properties - VDCP below.
DisableHeartbeat (boolean): Whether the 'Ping' operation (see NextPingDelay above) is just a
simple connection check. If false, the Ping operation sends a command to the server. For
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some servers, this is necessary to prevent the server from closing the connection. This
applies to at least the Ross Blackstorm server.

Examples
AV Automation: VDCP (serial)

Type=VDCP; Name=Serverl; Port=COM1l; Config=ClipServerVDCP.xml

AV Automation: VDCPtcp (Ethernet)

Type=VDCPtcp; Name=Serverl; Server=192.168.42.42; Port=10001;
Config=ClipServerVDCP.xml

Media Administrator: VDCP (serial)

Type=VDCP; Name=Serverl; Port=COM2; LoadDatabase=true; Config=ClipServerVDCP.xml

Media Administrator: VDCPtcp (Ethernet)

Type=VDCPtcp; Name=Serverl; Server=192.168.42.42; Port=10002; LoadDatabase=true;
Config=ClipServerVDCP.xml

Configuration File Properties - VDCP

DefaultRecordinglLength (integer): Default duration of recorded video files in frames
(Default: 1000).

DelayGetClipDuration (Boolean): Enable to build the initial playlist without getting the file

duration (Default: false).

IgnoreClipExistence (Boolean): Enable to ignore requesting clip presence on the server.
LogMessages (Boolean): If true, log any messages that are sent and received. Verbose
logging must be activated for this to have effect (Default: false).

MaxClipList (integer): The maximum amount of clips to hold in cache. When this limit is

5.0

reached, there are no more clips added to the cache. Setting this to a low value reduces load

time, but might cause invalid clip status if non-cached clips are in the rundown.

RequestPortStatus123 (Boolean): Whether to request more status from the VDCP server. May

safely be left at false for normal production. Change to true for debugging purposes if
advised to by Vizrt Support.
SendStillWhenCueDone (Boolean): When the server has cued a clip, whether to send a

command making sure that the first frame is shown on the server output. Change to true if

supposedly cued clips are not shown on the server output.

StopShouldCheckForldle (Boolean): Whether stopping a clip should make sure that the port is

idle. Change to true if cuing problems are encountered.
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- TimeoutPlay (integer): The time (in ms) for the server to acknowledge that it is playing the
cued clip. Used only if VerifyPlay (see below) is true (or if EnableLoopingDaletBrio (see below)
is true, and the cued clip should loop).

UseAddedClipsCommand (Boolean): Enable to retrieve a list of new files added to the video
server.

UseFixedPortStatusBitMap (Boolean): Whether to force Mosart to use a fixed bit map when
requesting port status. Change to true for new installations. In general, CHANGE the value if
problems are encountered, in particular problems related to cuing.

UselnternalPlayerState (Boolean): Enable to ignore requesting presence of the clip on the
play-out device using the ID REQUEST message.

UseLongClipNames (Boolean): If true, use messages supporting variable length file names
(maximum length 80 characters). If false, use fixed eight character files names padded with
spaces if less than eight characters.

- VerifyPlay (Boolean): Whether to verify that the server is actually playing.

- WaitTimeoutPlay (Boolean): The time (in ms) to wait between each server playing status
polling. Used only if VerifyPlay (see above) is true (or if EnableLoopingDaletBrio (see below)
is true, and the cued clip should loop).

Configuration File Properties - Dalet BRIO only
The following properties are used for the looping functionality of the Dalet BRIO:

EnableLoopingDaletBrio (Boolean): Whether to enable the looping mechanism for Dalet
Brio. Set to true only if this file is for a Dalet BRIO, and you want looping (Default: false).

- TimeoutDaletBrioLoop (Boolean): The time (in ms) to wait for the server to acknowledge that
looping has been turned on/off.

- WaitTimeoutDaletBrioLoop (Boolean): The time (in ms) to wait between each server looping
status polling.

Viz Engine Connection String

Viz Engine Connection String, used by Media Administrator and AV Automation.

Connection String Properties

- Type: VizEngine.
Name: Defines the ID of this connection.

- Server: Defines the hostname or IP-address of the server (for Type=VizEngine only).
Port: Defines the port.

- Config: Defines the name of the configuration file.

Folder: Location of the Viz Mosart configuration files. Either in %ProgramFiles (x86)%
\Mosart Medialab\Mosart Server\ConfigurationFiles or with the video
configurations in C:\channeltemplates .
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Examples

Connection string for Integrated Engine (Viz Engine connection in AV Automation):
Type=VizEngine;Server=localhost;Config=VizEngineSwitcherConfig.xml (Port=6100
is optional)

Connection string for Video Server (Viz Engine connection in AV Automation):
Name=Vizrt;Type=VizEngine;Server=1localhost;Port=6100;Config=
ClipServerVizEngine.xml

Connection string for Media Administrator:
Name=VizEngine;Type=SimpleTestPlayer;Folder=D:

\ ;SkipExtension=true;Config=ClipServerVizEngine.xml

Configuration File Properties

- AlwaysGetDuration (Default: false):
- When false, only files in the active Viz Mosart rundown get the actual video duration.
- When true, get the video duration from all files in the monitored folder. Note that
setting this value to true impacts the startup time of the SimpleTestPlayer driver in
Media Administrator for folders with a large number of video files.

Viz One and Media Service Connection String
This connection string is used by Viz One and Media Administrator for Media Service.

Viz Mosart can search for clips in Viz One and initiate transfer of Viz One clips to a specified
playout storage. The driver uses the REST-based Viz One Third party API to execute tasks.

Device Prerequisites (Viz One)
For further details, please consult the Viz One Administrator Guide.

At least one Viz One user at least one publishing point must be configured.

Connection String Properties

Naming Examples Description

Name VizOne Name of connection. Should be equal the
VizEngine name of the video server in AV
MediaSearch Automation.

Type VizOne Type of connection. Must be VizOne to use

the Viz One Clip Administrators.
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Naming

UserName

Password

Server

PublishingPoints

ValidDuration

AutoTransfer

Examples

vizmse

vizmse

10.211.112.213
bgogavizone

vve2-1
vizengine-1
MediaService

26

true
false
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Description

Viz One only

Username for user that connects to third
party API.

Please look at separate section in this
document on how to create a dedicated
user for Viz Mosart to access Viz One.

admin as username and password may be
used for testing, but should not be set in
production.

Viz One only
Password for user that connects to third
party API

IP address or host name of Viz One server

A publishing point is a playout storage
defined in Viz One. This can be accessed
through Administration menu on the Web
interface.

Comma separated list of publishing point
identifiers where the clip administrator
should ensure assets are present.

If MediaService is specified for
PublishingPoints, Media Service and not
Viz One is used to search for clips.

Viz One only

Duration for which an asset should be
present on the publishing point from time
of transfer. Value is in hours.

Default: 24

Viz One only

true: Any assets in the playlist that is
present in Viz One, but not on the
publishing points will be transferred.
false: Assets are marked as not present.
true is default value.
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Naming Examples Description
PublishingPointAsObjld  true true: An Objectld will be set for each
false publishing point as well as Name from

connection string (an additional server ID
is set for each publishing point).

false: Use Name from connection string as
Objld (only one server ID is set: for Name).
false is default and most common.

Port 21099 Media Service only
MediaService requires port to be specified.
Default port is 271099 for MediaService.
See also Configure Media Service section
in the Media Service guide.
(Viz One does not require this field).

Config ClipServerVizOne.xml Name of configuration file located in
ChannelTemplates folder.
See also Standard Video Server Connection
String.

Example (Media Service)

Name=VizEngine; Type=VizOne; Server=localhost;Port=21099;PublishingPoints=MEDIASERVICE; Conf
ig=ClipServerVizOne.xml

Example (Viz One)

Name=VizOne;Type=VizOne;UserName=username;Password=password;Server=10.211.112.2
13;PublishingPoints=vizengine-1;ValidDuration=26;AutoTransfer=true;PublishingPoi

ntAsObjId=false;Config=ClipServerVizOne.xml

& Note: The differences between ClipServerVizEngine.xml and ClipServerVizOne.xml is that
the first one handles video server in configuration Av Automation and second is only for
establishing clip searches in Media Administrator.

12.2 Video Wall Connection Strings

Video wall connection strings are used by AV Automation. This section contains Connection String
types.

& Note: For general information on connection strings, see Video Server, MAM and Database
Connection Strings.
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12.2.1 Watchout Connection String
This connection string is used for WATCHOUT video walls.

Modes of Operation

The driver may operate in any of three different modes. (For the sake of simplicity, assume that at
least two commands are to be performed in one operation).

default: A driver operation sends the commands one after the other. It waits for WATCHOUT
to respond finally (or time-out) before sending the next command. If a command fails, the
rest is skipped. The advantage is that when the driver operation finishes, the entire
operation is complete (or has failed). However, as driver calls may arrive in different threads,
and therefore simultaneously or overlapping, problems may occur. (The driver is made for
performing (sending and feedback-waiting) one command at a time.)
SequenceRecallAndMixes: A driver operation queues the commands to be performed as a
unit (without interference from other such units), possibly at a later time. The problem
mentioned above is solved, however at the cost of the driver operation possibly finishing
before the commands are complete.

SequencelndividualCommands: A driver operation queues the first command (to be
performed without interference from other commands). If successful, the next command is
queued, and so on. This may be useful if WATCHOUT is able to keep several shows loaded at
the same time (and is able to use the run timeline argument to choose between them).

Examples

AV Automation Connection String:

AuthenticateTimeout=[authenticateTimeout] ;BufferSize=[bufferSize] ;BusyNonCommandTimeo
ut=[busyNonCommandTimeout] ;BusyTimeout=[busyTimeout];GetStatusThreshold=[getStatusThr
eshold] ;LoadTimeout=[loadTimeout];PingInterval=[pingInterval];PingTimeout=[pingTimeou
t];Port=[port];ReconnectInterval=[reconnectInterval];ResetAnyway=[resetAnyway];ResetT
imeout=[resetTimeout];RunTimeout=[runTimeout];SequenceIndividualCommands=[sequenceIlnd
ividualCommands] ;SequenceRecallAndMixes=[sequenceRecallAndMixes];Server=[server];UseG
etStatus=[useGetStatus]

Example:

Server=192.168.97.129;AuthenticateTimeout=200;RunTimeout=40
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Connection String Properties — Watchout

String

AuthenticateTimeout

BufferSize

BusyNonCommandTim
eout

BusyTimeout

GetStatusThreshold

LoadTimeout

PingInterval

Type

integer>0

integer>0

integer>0

integer>0

integer

integer>0

integer>0

Description Default

The time (in ms) allowed for 2000
WATCHOUT to process an

authenticate command and

respond with Ready.

The maximum number of bytes 1024
to receive from WATCHOUT at a

time.

Should be set at least as large as

the longest conceivable

WATCHOUT response.

The time (in ms) allowed for 10000
WATCHOUT to return to normal

operation after a non-command

Busy.

The time (in ms) allowed for 60000
WATCHOUT to increase the % of
otherwise equivalent Busy

responses.

The highest acceptable value of 1 (Suboptimal)

the third parameter of the Reply
feedback to the getStatus
command

General health status of the
cluster:

0: OK

1: Suboptimal
2: Problems
3: Dead

The time (in ms) allowed for 10000
WATCHOUT to process a load

command and respond with

Ready.

The time (in ms) between ping 10000
commands sent to WATCHOUT.

Copyright © 2022 Vizrt

Page 385



Viz Mosart Administrator Guide - 5.0

String Type Description Default

PingTimeout integer>0 The time (in ms) allowed for 10000
WATCHOUT to process a ping
command and respond with

Ready.
Port integer>0 The port to connect to. 3039
ResetAnyway true/false Whether reset commands are false

always sent before run
commands even if not present in
the RecallAndMix argument.

ResetTimeout integer>0 The time (in ms) allowed for 10000
WATCHOUT to process a reset
command and respond with
Ready.

RunTimeout integer>0 The time (in ms) allowed for 10000
WATCHOUT to process a run
command and respond with
Ready.

Reconnectinterval integer>0 The amount of time (in ms) to 10000
wait to reconnect after a failed
connect or authenticate.

SequencelndividualCo true/false Whether the driver should false
mmands operate in that mode. Has no
effect when
SequenceRecallAndMixes=true.

SequenceRecallAndMix  true/false Whether the driver should false

es operate in that mode.

Server string The DNS name of WATCHOUT. localhost
UseGetStatus true/false Whether the Ping operation false

should use the getStatus
command instead of the ping
command.
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13 Device Configuration Files

The device configuration files are located in the following directory: %ProgramfFiles(x86)%\Mosart
Medialab\Mosart Server\ConfigurationFiles.

A Note: Do not modify any files at this location, as they are overwritten by the next
installation. Copy any files that must be modified to the " %ProgramData%\Mosart

Medialab\ConfigurationFiles" directory, and modify them there. This ensures that
configurations remain valid after system upgrades or downgrades. Note that historically,
C:\channeltemplates has been the folder to copy to, but with a few exceptions, Viz

Mosart applications will look in %ProgramData% before checking C:\channeltemplates
for configuration files.

(® Name of the configuration file(s)

In the following sections, the configuration files are shown with their default names. For
some device types it is possible to specify a different configuration file name in the device
connection string.

This makes it possible to use different configurations for various devices of the same type,
for example when you have two slightly different settings for two video servers of the
same type and brand.

There must be a 1:1 match between the name of the configuration file and the name
referred to in the device connection string.

This section contains the following topics:

Robotic Camera Configuration Files
Graphics Configuration Files
Subtitling Configuration Files

- Video Router Configuration Files

- Audio Mixer Configuration Files

- Vision Mixer Configuration Files

Information about Video Server Configuration Files is in section, Video Server, MAM and Database
Connection Strings.

13.1 Robotic Camera Configuration Files

This section contains the Robotic Camera types:

Shotoku
FxMotion

- Vinten 200 Radamec
Cambotics Configuration File
Cinneo Configuration File

Copyright © 2022 Vizrt Page 387



Viz Mosart Administrator Guide - 5.0

- Technodolly Configuration File
Panasonic (serial) Configuration File
Panasonic TCP Configuration File
Electric Friends Configuration File

All configuration files are by default stored at C:\Program Files (x86)\Mosart

Medialab\Mosart Server\ConfigurationFiles)\ . Please refer to the Note in Device
Configuration Files for information on copying the files before changing.

13.1.1 Shotoku

Specific Shotoku parameters are found in RoboticCameraConfiguration.xml.

You can control behavior of the connection to Shotoku when switching Viz Mosart from main to
backup, or at an AVA restart. Ensure the following properties are managed in the configuration
file:
ShotokuForwardStandbyCommands (boolean) - If set to true, standby state will be forwared
to Shotoku controller. Default false.
ShotokuDisableHeartbeat (boolean) - If set to true, the heartbeat mechanism is disabled.
Default true.
ShotokuDisconnectinStandby (boolean) - If set to true, disconnect controller when in
standby. Default false.

The above settings govern the two situations:

1. Whether the sending of a disable command (when AVA restarts or when the active Mosart
server is switched) to the Shotoku controller will block all automation commands until an
enable command is received.

2. Whether instead of timing-out, Mosart shall stay connect to the Shotoku controller when in
standby/idle.

In addition, the HeartbeatInterval property also applies to Shotoku. Refer to the configuration
for file for information.

13.1.2 FxMotion

Specific FxMotion parameters are found in RoboticCameraConfiguration.xml . Refer to the
configuration for file for information.

Heartbeatlnterval
FxMotionReceiveTimeout

13.1.3 Vinten 200 Radamec

Specific Vinten 200 Radamec parameters are found in RoboticCameraConfiguration.xml.
Refer to the configuration for file for information.

Heartbeatlnterval
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Vinten200ShowfFilterValue
Vinten200DisconnectInStandby
Vinten200MinSendInterval

13.1.4 Cambotics Configuration File

The integration between Viz Mosart and Cambotics Camera Robotics Control Systems supports
moving to a stored position. Camera Robotics control is handled by AV Automation.

For details on the Cambotics (Ross CamBot) Protocol, refer to the product documentation written
by Ross Video (www.rossvideo.com).

The Cambotics configuration file is located in the program-folder under \Mosart
Medialab\Mosart server\ConfigurationFiles\CamboticsConfiguration.xml.
The following configurations are available:

Heartbeat: (keep connection alive) interval: Default 2000 ms.
Connection timeout: Default 1500 ms.

ConnectionAttempts: Default 5 tries.

ConnectionDelay: Default 60000 ms.

& Note: To integrate with Cambotics (Ross Cambot) Camera Robotics, you must also
configure it in Camera Robotics. Select the router protocol CAMBOTICS, set the IP

address of the camera controller, and the Port number (default is set to 2050 ).

& Note: For more information on setting up templates for Cambotics, see the section
on Robotic Camera Control in the Viz Mosart User Guide.

13.1.5 Cinneo Configuration File

Cinneo configuration is contained within the general device configuration file DeviceConfig.xml.

<item name="cinneoSceneFileTimeout" value="30000" />

cinneoSceneFileTimeout: The value is given in milliseconds.

13.1.6 Technodolly Configuration File

The Technodolly configuration file is named TechnodollyConfig.xml.

<DeviceConfig name="TechnodollyConfiguration" connectionString="1localhost">

<Properties>
<!-- Connection parameters, may be overridden -->

<item name="Port" value="15243" />
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<item name="HeartbeatInterval" value="20" />
<item name="MaxQueuelLength" value="2" />
<item name="ProtectInPreview" value="cut,move" />
<item name="ProtectInProgram" value="-" />
</Properties>
</DeviceConfig>

Port: Contains the default value, it is not used.

HeartbeatInterval: Defines how often Viz Mosart should check if the connection to
Technodolly is OK. The value is given in seconds.

MaxQueuelength: Restricts queuing of commands to Technodolly. A value of 1 means only

one prepare or one run. A value of 2 means one prepare and/or one run. A value greater

than 2 means no queuing restrictions.

ProtectinPreview: Defines which commands should not be sent to Technodolly in preview
when a mixer cross-point is protected. Valid values are "-" for none, "cut" for prepare, "move"
for run, and "cut,move" for both prepare and run.

ProtectinProgram: Defines which commands should not be sent to Technodolly in program
when a mixer cross-point is protected. The values have the same meaning as for
ProtectinPreview.

13.1.7 Panasonic (serial) Configuration File

The Panasonic configuration file (used for PANASONIC and PANASONICNEW) is named
PanasonicConfiguration.xml.

<?xml version="1.0" encoding="utf-8" 7>
<DeviceConfig name="PanasonicConfiguration">
<Properties>
<!-- Connection parameters, may be overridden -->
<item name="HeartbeatInterval" value="2000" />
<item name="DisableHeartbeat" value="false" />
</Properties>
</DeviceConfig>

Heartbeatinterval: Time between heartbeats, in milliseconds. Integer >= 0. Default = 2.

DisableHeartbeat: If false, heartbeats are sent. This checks the connection and sends a keep
alive message to the controller. If true, no heartbeats are sent. Default = False.

13.1.8 Panasonic TCP Configuration File

The Panasonic TCP configuration file is named PanasonicTcpConfiguration.xml.

<?xml version="1.0" encoding="utf-8" 7>
<DeviceConfig name="PanasonicConfiguration" connectionString="localhost">
<Properties>
<!-- Connection parameters, may be overridden -->
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<!--Whether to disable pings. If true, pings are still sent if no response is
received for a request.-->
<item name="DisablePing" value="false" />

<!--The path component of the Request-URI. Do not change.-->
<item name="Path" value="cgi-bin/aw_cam" />

<!--Time between pings in ms-->
<item name="PingInterval" value="2000" />

<!--In case of connection loss, a ping will be sent after this many ms-->
<jitem name="ReconnectInterval" value="1000" />

<!--The number of ms to wait for a response for a Ping command-->
<item name="TimeoutPing" value="500"/>

<!--The number of ms to wait for a response for a SelectPort command-->
<item name="TimeoutSelectPort" value="10"/>

<!--The number of ms to wait for a response for a PlayPreset command-->
<item name="TimeoutPlayPreset" value="10"/>
</Properties>
</DeviceConfig>

DisablePing: Whether to disable pings. If true, pings are still sent if no response is received
for a request.

Path: The path component of the Request-URI. Do not change.

Pinginterval: Time between pings in ms.

Reconnectinterval: In case of connection loss, a ping will be sent after this many ms.
TimeoutPing: The number of ms to wait for a response for a Ping command.
TimeoutSelectPort: The number of ms to wait for a response for a SelectPort command.
TimeoutPlayPreset: The number of ms to wait for a response for a PlayPreset command.

13.1.9 Electric Friends Configuration File

The configuration file for Electric Friends should be saved as ElectricFriendsConfiguration.xml
normally stored in C:\ChannelTemplates

& Note: For more information on setting up templates in AV Automation, see the section on
Robotic Camera Control in the Viz Mosart User Guide.

Example configuration:

{{
<?xml version="1.0" encoding="UTF\-8"?>}}{{
<DeviceConfig name="ElectricFriendsConfiguration" connectionString="1localhost">}} {{
<Properties>1}} {{
<!\-- Connection parameters, may be overridden \-->}1} {{
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<item name="HeartbeatInterval" value="2000" />}} {{
<I\-- Time between heartbeats in ms \-->}1} {{
<item name="PollDataInterval" value="10000" />}} {{

<!\-- Time between renewing list of shows, cameras and shots, in ms \-->}} {{

<item name="UseJsonWorkaround" value="true" />}} {{

<I\-- Early development. Timed move command needs a workaround for correct

response to server. Please let the value remain true \-->}} {{
<item name="PollRunningStatus" value="200" />}} {{

<I\-- Time between polls in ms. This will check to see if camera movement is

finished before starting a new move \-->3}3} {{
<item name="PollTimeout" value="5000" />}} {{

<!\-- Time the poll 1is allowed to run before dignoring the play command, in ms

\-—>}1 {{
<item name="DefaultPort" value="9000" />}} {{

<I\-- If no port 1is set, use this value. The ElectricFriends default port is

9000 \-->}} {{
</Properties>}}{{
</DeviceConfig>}}

13.2 Graphics Configuration Files

This section contains the graphics type:

Pixel Power Control Center (PPCC) Configuration File
Pixel Power (Clarity) Configuration File

Vizrt Graphics Configuration File

Vizrt Media Sequencer VDom Logic Macros

Chyron Configuration File

Deko, Orad, Xpression Configuration File

13.2.1 Pixel Power Control Center (PPCC) Configuration File

The PPCC configuration file is called PPCCConfiguration.xml|

<?xml version="1.0" encoding="utf-8" ?>

<DeviceConfig name="PixelPowerConfiguration" connectionString="1localhost:0">

<Properties>
<!-- Default channel nubmer to use -->
<item name="SystemNumber" value="1"/>
<item name="ClientApplication" value="Overlay Graphics"/>
<item name="ClientName" value="Vizrt Mosart"/>
<item name="DefaultOverlaysTriggerCount" value="2"/>
<item name="EnableOutputBlackOnTakeOut" value="true"/>
<item name="PreventPreloadOverlayIfItemsAreOnAir" value="true"/>
<item name="RundownPrefix" value=""/>
<item name="ConvertStoryIdToDecimal" value="false"/>
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<item name="ConnectedWhenIdle" value="false" />
<item name="ConnectedWhenInStandBy" value="false" />
</Properties>
</DeviceConfig>

Properties

DefaultOverlaysTriggerCount: Number of triggers used for take-in and take-out from PPCC in
overlays.

EnableOutputBlackOnTakeOut: True if OutputBlack should be sent when continue points still
exist on item.

PreventPreloadOverlaylfltemsAreOnAir: Will prevent selecte page of next overlay if the
engine currently has items on air (only overlays).

RundownPrefix: The prefix to be used in the rold of the commands. (The same as set in the
mosconfig.xml file in the Avid MOS Gateway.

ConvertStoryldToDecimal: Specifies whether the story id should be converted from Hex to
Decimal value.

ConnectedWhenldle: This value determines if the connection to the graphic devices are
maintained while Viz Mosart Server is in Idle mode.

True = Maintain connection to graphic devices while in Idle mode. This setting will also
initialize a connection to devices if Viz Mosart Server is started in Idle.

False = Do not start/maintain connection while in ldle mode.

ConnectedWhenlInStandBy: This value determines if the connection to the graphic devices are
maintained while Mosart is in Standby mode.

True = Maintain connection to graphic devices while in Standby mode. This setting will also
initialize a connection to devices if Mosart is started inStandby.

False = Do not start/maintain connection while in Standby mode.

A Note:
- You can specify Channel on the PPCC for each PPCC engine in AV Automation and

Overlay Graphics.

This channel will only be used for OutputBlack messages (clearing an engine).

It's possible to define multiple channels using both comma and semicolon as

separator.

Be aware that the channel will be cleared on the PPCC regardless of the connection

information.

For example, clearing channel 1 clears all graphics on this channel.

13.2.2 Pixel Power (Clarity) Configuration File

The Pixel Power (Clarity) configuration file is named PixelPowerConfiguration.xml.

<?xml version="1.0" encoding="utf-8" 7>
<DeviceConfig name="PixelPowerConfiguration" connectionString="1localhost:0">
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<Properties>
<!-- Connection parameters, may be overridden -->
<item name="Server" value="localhost" /> <!-- Not in use -->
<item name="Port" value="10220" /> <!-- Not in use -->
<item name="DefaultTakeOutPage" value=""/> <!-- Not in use -->
<item name="OQutputBlack" value="false"/> <!-- Not in use -->
<item name="JobPath" value="c:\Pixel_Power\Jobs\"/> <!-- Not in use -->
<item name="Extension" value=".pjz"/>
<item name="LowPageRange" value="1-999"/> <!-- Not in use -->

<item name="FullScreenPageRange" value="1000-1999"/>
<item name="CgPageRange" value="2000-9999"/>
<item name="ClarityProtocolVersion" value="1.0"/>
<item name="UseAsUpdateJob" value="false"/>
<item name="CreatePageMode" value="true"/>
<item name="WaitHandle" value='"2000"/>
<item name="HeartbeatInterval" value="10"/>
<item name="PathCriteria" value=":"/>
<item name="DisableAVAutomationLoadJob" value="true"/>
<item name="DefaultOverlayPage" value="999" />
<item name="UseDefaultPageChannel" value="true" />
<item name="WaitForStories" value="3000"/>
<item name="AskPageInfo" value="false"/>
<item name="AskPageImage" value="false"/>
<item name="AskFieldInfo" value="false"/>
<item name="ConnectedwWhenIdle" value="false" />
<item name="ConnectedWhenInStandBy" value="false" />
</Properties>
</DeviceConfig>

& Note: Items that are no longer supported for Viz Mosart’s Pixel Power implementation are
noted with <!-- Not in use -->.

Properties

Extension: The file extension for the Pixel Power job to be loaded.

FullScreenPageRange: Defines the range of Pixel Power page numbers used by Viz Mosart for
full screen pages.

CgPageRange: Defines the range of Pixel Power page numbers used by Viz Mosart for CG
(lower third) pages.

UseAsUpdateJob: Set if Pixel Power is to treat the loaded job as an update job.
CreatePageMode: Informs Pixel Power to create the page from Viz Mosart or not.
WaitHandle: Defines how long Viz Mosart should wait before removing a layer from the cued
page after sending a trigger animation char command to Pixel Power.

Heartbeatinterval: Defines how often Viz Mosart should check if the connection to Pixel
Power is valid. The value is given in seconds.

PathCriteria: Defines criteria that must be met (if any) for a job path to be valid.
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DisableAVAutomationLoadJob: If this value is set to true, only Overlay Graphics will load jobs
on Pixel Power. Note that the current implementation will not handle other job/page logic
from AV Automation (such as delete pages). This value is expected to be true.
DefaultOverlayPage: Defines the overlay page to use as default on which to add layers to.
This is the CG page that will be transferred on taking overlay graphics.
UseDefaultPageChannel: Lets the pages created use the default page channel defined in
Pixel Power. If set to false, the pages created will use the channel defined in engine settings.
WaitForStories: Defines how many seconds Viz Mosart should wait for a story before deleting
old/non-existing pages (handles shortcut keys from Viz Mosart GUI).

ConnectedWhenldle: This value determines if the connection to the graphic devices are
maintained while Mosart is in Idle mode.

True = Maintain connection to graphic devices while in Idle mode. This setting will also
initialize a connection to devices if Mosart is started in Idle.

False = Do not start/maintain connection while in ldle mode.

ConnectedWheninStandBy: This value determines if the connection to the graphic devices are
maintained while Viz Mosart is in Standby mode.

True = Maintain connection to graphic devices while in Standby mode. This setting will also
initialize a connection to devices if Viz Mosart is started in Standby.

False = Do not start/maintain connection while in Standby mode.

AskPagelnfo: Defines whether Viz Mosart requests Pixel Power for page info when creating a
page.

AskPagelmage: Defines whether Viz Mosart requests Pixel Power for page image when
creating a page.

AskFieldInfo: Defines whether Viz Mosart requests Pixel Power for a pages field info when
creating a page.

A Note: It is not necessary to ask for the last three items when creating a page.

13.2.3 Vizrt Graphics Configuration File

The Vizrt Graphics Configuration file is named VizrtGraphicsConfiguration.xml.

<?xml version="1.0" encoding="utf-8" ?>
<DeviceConfig name="VizrtGraphicsConfiguration">
<Properties>
<item name="default_effect_dsk" value=""/>
<item name="default_effect_wall" value=""/>
<item name="default_effect_fulll" value=""/>
<item name="allowUpdateOfOnAirItems" value="true"/>
<item name="RemoveUnusedChannelsOutputs" value="true"/>
<item name="SetConceptOnOutputChannel" value="true"/>
<item name="TakeInCommand" value="" />
<item name="TakeOutCommand" value=""/>
</Properties>
</DeviceConfig>
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Properties

- default_effect_dsk: Default effect to be used on the dsk handler (must be lower case)

- default_effect_wall: Default effect to be used on the wall handler (must be lower case)

- default_effect_full1: Default effect to be used on the fullscreen graphics engine 1 (must be
lower case)

- allowUpdateOfOnAirltems: Allows an item to be updated even if it is onair (default = true)
RemoveUnusedChannelsOutputs: When enabled, MSE Mosart Profile will synchronize to the
Overlay Graphics Configuration, i.e. all outputs that are not used in Viz Mosart will be
deleted. (default = true)

- SetConceptOnOutputChannel: Current Concept Override functionality sets a context
environment variable named "alternative_concept"” when scheduling an operation to the MSE.
This variable will override any Concepts defined for an Output in the VCP/Trio profile editor.
In a setup where there are multiple outputs assigned to a Channel where each output has
Concepts assigned except the first, all outputs will run with the main concept. The following
setting will set the Concept of all outputs under Mosart control in the Profile to the currently
selected Concept and this will be the default behavior. The old way of sending the value in
the environment for ScheduleElement can still be used by setting the property
SetConceptOnOutputChannel to false. (default = true)

The following Viz Trio properties are used when connecting to Viz Trio. They were originally
stored in VizTrioConfig.xml. Viz Trio connections must use port 6200.

- TakelnCommand: Used to override take in commands. Use this if you require something
other than page:take

- TakeOutCommand: Used to override take out commands if you require something other
than page:takeout

13.2.4 Vizrt Media Sequencer VDom Logic Macros

It is possible to send custom commands to the Media Sequencer. This can be done by VDom logic
which can run on the Media Sequencer as macros from Viz Mosart.

An optional VizrtUserMacros.xml file should be created and placed in the config files folder
with the following format:

Macro file format:
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<macros>
<macro name="myMacroName'">
<!-- Place a single VDom element here, for instance <env /> -->
</macro>
<macro name="StartScene'">
<env>
<viz>RENDERER*STAGE START</viz>
</env>
</macro>
</macros>

The macros are executed with the following variables:

Variable Value Comment
profile /config/profiles/MOSART
viz The viz handler for the engine

targeted in the MACRO call

channel The profile channel name for the Only send if channel names are
engine targeted in the MACRO call applied to elements

13.2.5 Chyron Configuration File
The Chyron configuration file is named ChyronConfig.xml.

The configurable parameters are documented with self-explanatory values in the code below.

<DeviceConfig name="DeviceConfig">
<Properties>
<!-- Macro for taking out graphics on Chyron channel x -->
<item name="TakeOutMacrol" value="BREAKOUT_A" />
<item name="TakeOutMacro2" value="BREAKOUT_B" />

<!-- Configure settings for taking out with transition graphics on Chyron channel
x for Intelligent Interface Rules Engine (IIRE).

Specify the transition to be used to effect out the graphic. In the examples
below, 2 take out commands have been defined for port 1 and 2

with tranistion "animate". {GraphicID} is a placeholder and must be given 1in the
specified format. -->

<item name="IIRETakeOutMacrol" value="L\{GraphicID}\animate" />

<item name="IIRETakeOutMacro2" value="L\{GraphicID}\animate" />

<l==
Encoding: Default encoding utf-16
Page containing valid .Net encodings:
http://blogs.msdn.com/b/shawnste/archive/2009/08/18/alternate-encoding-
names-recognized-by-net-ie.aspx
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-—>

<item name="Encoding" value="utf-16"/>

<!-- If true the connection to the graphics devices are maintained while Mosart
is in idle mode -->

<item name="ConnectedWhenIdle" value="false" />

<!-- If true the connection to the graphics devices are maintained while Mosart
is in standby or idle modes -->

<item name="ConnectedWhenInStandBy" value="false" />

<!--Whether to send the NEW Check Existence command. (Requires Lyric build 2021
or higher. Use Help / About Lyric to find out.)-->
<item name="ShouldCheckExistence" value="false"/>

<!--Timeout for the NEW Check Existence command-->
<item name="TimeoutCheckExistence" value="1000"/>

<l--
Enable the PreviewOnOutput to keep the old behavior of cueing and taking an
item for preview.
Leave as false for previewing on the local preview output of the Chyron. Note
that when the below
setting is enabled, preview of CGs will be taken directly to air and is a
misconfiguration of the system.
-—>
<item name="PreviewOnOutput" value="false"/>
</Properties>
</DeviceConfig>

13.2.6 Deko, Orad, Xpression Configuration File

Several graphics drivers use variants of the common config file
IntelligentInterfaceConfiguration.xml. These include

Deko
Orad
Xpression

Their respective parameters are documented with self-explanatory values in the code below.

<?xml version="1.0" encoding="utf-8" 7>
<DeviceConfig name="IntelligentInterfaceConfiguration">
<Properties>
<!-- Config file for all Intelligent Interface Graphics Devices -->
<item name="IgnoreCreateCommandInStandby" value="false" />
<item name="LoadInBackground" value="false"/>

<!-- Encoding to be used for communication. Typical values: "utf-16", "utf-8" -->
<item name="Encoding" value="utf-16"/>
<!-- The name of the Xml attribute containing the graphics id used when

communicating with the graphics devices -->
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<item name="GraphicsIdAttribute" value="graphics_id" />

<!-- If true the connection to the graphics devices are maintained while Mosart
is in idle mode -->

<item name="ConnectedWhenIdle" value="false" />

<!-- If true the connection to the graphics devices are maintained while Mosart
is in idle mode -->

<item name="ConnectedWhenInStandBy" value="false" />

<!-- DEKO -->

<item name="UseEffectsAttachedToTemplates" value="true"/>
<item name="TakeInWithCueAndTransferKeyCodes" value="false"/>
<item name="IgnoreKeyCodesOnTakeIn" value="false"/>

<item name="ClearScene" value=""/>

<I--<item name="TakeInPrefixFileName" value="\xF7"/>

<item name="TakeInPostfixFileName" value="\xF8\xF7"/>-->

<!-- XPRESSION -->

<item name="XpressionResumeBeforeTakeOffline" value="false" />
<!--true/false-->

<item name="XpressionTakeOfflineDelay" value="2000" />
<!I--milliseconds (req. XpressionResumeBeforeTakeOffline to be true)-->
<item name="XpressionSuppressAlfanumericTemplates" value="false" />
<!--true/false-->

<item name="XpressionRetryIndexGenerator" value="10" />
<!--true/false-->

<item name="XpressionOverlayIndexLimit" value="100000" />
<!--true/false-->

<!-- GRAPHICS : ORAD -->

<!-- Activates preload in preview for given destinations.

Syntax: comma separeted list of destinations: Example "DSK,WALL" -->
<item name="OradPreloadDestinations" value="" />
<!-- Either [1,2]. The number of response message expected after a preload

command V\5\13. Default 1-->
<item name="OradPreloadNumResponses" value="1" />
<!-- Orad Heartbeat 1interval in seconds. Set to 0 to disable -->
<item name="OradPollInterval" value="60" />
<l--seconds-->
<!== Minimum time to wait after take command before sending new commands to Orad

<item name="OradTakeBlocks" value="10" />
<!--milliseconds-->
<!-== Minimum time to wait after cue command before sending new commands to Orad

<item name="OradMaxWaitTillCued" value="6000" />

<!--milliseconds-->

<!-- Obsolete: Use general Encoding property instead -->

<!--<item name="OradEncoding" value="unicode" />-->

<item name="OradSkipRecue" value="never" />

<!-- Either [last,loaded,never]. Controls when to skip recue-->

<!-- If set, responses from last preview operation will be stored. Corresponding
play will not take place if cue is not verified -->

<item name="OradEnableCueVerification" value="false" />
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<I-- If set, a Select Output command is sent as part of preview. Complient with
Orad/CII protocol, section 4.13-->
<item name="OradEnableSelectOutput" value="false" />
</Properties>
</DeviceConfig>

13.3 Subtitling Configuration Files

13.3.1 ScreenLL Configuration File

The ScreenlLL configuration file is named ClipServerScreenLL.xml.

<?xml version="1.0" encoding="utf-8" ?>

<MediaServerConfig xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:xsd="
http://www.w3.0rg/2001/XMLSchema'">

<Properties>
<!-- Language code to look for to decide clip availability -->
<item name="AvailabilitylLanguageCode" value="OPN" />
<!== First Incue Time code that 1indicates dinvalidated clip -->
<item name="InvalidatedFirstIncueTime" value="--:--:--:-=-" />

</Properties>
</MediaServerConfig>

Properties

AvailabilityLanguageCode: Specifies which language code must be present in order for a clip
to be marked as available. The language code is a three letter text string, which relates to a
list of language codes found in the file PoliSTLServerLangs.Ist, which must be present on the
ScreenLL subtitle file server.

InvalidatedFirstincueTime: Specifies the First Incue Time value that will indicate that a
subtitle clip has been invalidated (is not available even if it matches the
AvailabilityLanguageCode).

Other configuration items are customer-specific or for Vizrt internal use only.

13.4 Video Router Configuration Files

Miranda NVision Configuration File
EvertzQuartz
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13.4.1 Miranda NVision Configuration File

The integration between Viz Mosart and Miranda NVision video routers supports setting cross
points on the router.

Viz Mosart will interface directly with the NVISION 5128 Router.
Router Control is handled by AV Automaton.
Testing can be done using the Viz Mosart TestRouterControl application.

The config file is called VideoRouterMirandaNV9000.xml, located at \\Mosart Medialab\Mosart
Server\ConfigurationFiles

<?xml version="1.0" encoding="utf-8" 7>
<DeviceConfig name="MirandaNvV9000Config">

<Properties>
<!--The amount of time (in ms) to wait before reconnection after unsuccessful

connect or lost connection-->
<item name="ReconnectInterval" value="10000"/>

<!--The Take mode parameter to the Take commands. Refer to the NV900O spec pp. 8-9
for details. The default value is Automatic take mode.-->
<item name="TakeMode" value="0x00000001"/>

<!--Not used-->
<item name="TimeoutSetCrossPoint" value="1000"/>

<!--The User ID. Available 1in the NV9000 DB. Alternatively the client IP address
as a network byte order (big-endian) 32 bit word. E.g., the (hex) IP address
FE.DC.BA.98 should be written

OXFEDCBA98.—-->

<item name="UserID" value="OxFEDCBA98"/>

<!--Whether (True/False) to use the Take Source To Destination command. If False,
use the Take Input To Output command +instead. Default True.-->
<item name="UseTakeSourceToDestination" value="True"/>
</Properties>
</DeviceConfig>

Protocol Details

For details on the NV900O0 protocol, refer to the GrassValley product documentation (https://
community.grassvalley.com/support/s/).

File Location

The Miranda Nvision configuration file is located in the program-folder under \Mosart

Medialab\Mosart server\ConfigurationFiles\VideoRouterMirandaNV9000.xml .
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Properties

Reconnectinterval: The amount of time (in milliseconds) to wait before reconnection after
unsuccessful connect or lost connection. Default: 10000 .

- TakeMode: The Take mode parameter to the Take commands. Default: 9x00000001
(Automatic take mode).
UserID: The User ID. This can be fetched from the NV9000 database, or can be created by
converting the client IP address to a network byte order (big-endian) 32 bit word. Default:
OXFEDCBA9S8 .
For example, the (hex) IP address FE.DC.BA.98 should be written OxFEDCBA98.
UseTakeSourceToDestination: This value determines which protocol commands to use for

setting a crosspoint:
- True = 0x0000 3000 Take Source To Destination (default).
False = 0x0000 3001 Take Input To Output.

A Note:
- To integrate with Miranda NVision video routers, you must also

configure it in Router.
Select the router protocol MIRANDA NV9000.

Set the IP address of the router, and the Port number (use 9193 ).

13.4.2 EvertzQuartz

The config file is called VideoRouterEvertzQuartz.xml, located at \\Mosart Medialab\Mosart
Server\ConfigurationFiles

13.5 Audio Mixer Configuration Files

13.5.1 Calrec TCP/IP Configuration File

The Calrec TCP/IP configuration file is named AudioMixerCalrec.xml.

<?xml version="1.0" encoding="utf-8" ?>
<DeviceConfig name="AudioMixerCalrec">
<Properties>
<!I-- If set to true, controller stays connected when 1in idle. Note that in a
redundancy setup,on both main and backup Viz Mosart servers this option must be set
to false. -—>
<item name="ConnectedWhenIdle" value="false"/>
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<!-- If set to true, AvAutomation waits for Ack after sending command to the

driver.

Note that this configuration will overwrite the general configuration with same
name from AvAutomation settings (Ctrl+Shift+S).

If commented, the general configuration from AvAutomation will be taken 1into
consideration.-->

<item name="AudioWaitForAck" value="true"/>

<!-- Max wait time for receiving Ack -->
<item name="AckTime" value="199"/>

<!-- Wait time before trying to reconnect -->
<item name="ConWait" value="1000"/>

<!-- Interval to set fader levels on the audio driver. If set to 0, the
operation will not be re-scheduled.

Note that this configuration will overwrite the general configuration with same
name from AvAutomation settings (Ctrl+Shift+S).

If commented, the genral configuration from AvAutomation will be taken into
consideration.-->

<jitem name="AudioPollInterval" value="0"/>

<!-- Interval to send an heartbeat to the driver (number of counts until next
heartbeat will be sent). Set this to -1 to disable sending the heartbeat.
In this case, AvAutomation will not be able to detect when audio driver

connection goes down, for example. -->
<item name="HeartbeatInterval" value="1000"/>
</Properties>
</DeviceConfig>

13.5.2 SSL Configuration File

The SSL configuration file is the same as used for Calrec TCP/IP Configuration File.

13.5.3 Lawo Ember+ Configuration File

The Lawo Ember+ configuration file is named AudioMixerLawoEmberPlus.xml. Please see the file
for the available settings and their documentation.

13.6 Vision Mixer Configuration Files

The configuration files for the following vision mixers (switchers) are listed here for convenience.
See the inline commenting for parameter explanation:

GvgVideoSwitcherConfig.xml
GrassValleyCPLVideoSwitcherConfig.xml
RossVideoSwitcherConfig.xml
SonyVideoSwitcherConfig.xml
VizEngineSwitcherConfig.xml
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13.6.1

GvgVideoSwitcherConfig.xml

<DeviceConfig name="GvgVideoSwitcherConfig">
<Properties>

<item name="SendBreak" value="true" />

<item name="EnableHeartbeat" value="true" />

</Prope

rties>

</DeviceConfig>
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SendBreak: All GVG 4000 protocol switchers requires a break before connecting (but there
are switchers which do not need this).
EnableHeartbeat: When no commands are issued, a heartbeat is sent to the vision mixer with
an interval equal to the configured heartbeat interval.

13.6.2 GrassValleyCPLVideoSwitcherConfig.xml

<DeviceConfig name="GrassValleyVideSwithcerConfig">

<Properties>
<!-- Interval in seconds when to test for a valid connection when not connected
-->
<item name="ConnectionCheckIntervalInSecondsNotConnected" value="5" />
<!-- Interval in seconds when to test for a valid connection when connected -->
<item name="ConnectionCheckIntervalInSecondsConnected" value="10" />
</Properties>
</DeviceConfig>

13.6.3 RossVideoSwitcherConfig.xml

& Note: This config replaces CarboniteVideoSwitcherConfig.xml.

<DeviceConfig name="CarboniteVideoSwitcherConfig">

<Properties>
<!-- The properties below is the virtual cross point mapping for internal Ross
Carbonite sources. Alias can be anything. Value s the virtual assigned crosspoint to

be set in AV Config XML. Name is the RossTalk command for the -item.

-—>
<item
<item
<item
<item

alias="MediaStorel"
alias="MediaStore2"
alias="MediaStore3"
alias="MediaStore4"

value="1001"
value="1002"
value="1003"
value="1004"

name="MS:1"
name="MS:2"
name="MS:3"
name="MS:4"
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<item alias="Black" value="1008" name="BK" />
<item alias="MatteColor" value="1009" name="BG" />
<item alias="ME1" value="1011" name="ME:1" />
<item alias="ME2" value="1012" name="ME:2" />
<item alias="MiniME1l" value="1021" name="MME:1" />
<item alias="MiniME2" value="1022" name="MME:2" />
<jitem alias="MiniME3" value="1023" name="MME:3" />
<item alias="MiniME4" value="1024" name="MME:4" />
<item alias="MuliScreenl" value="1031" name="MSC:1" />
<item alias="MuliScreen2" value="1032" name="MSC:2" />
</Properties>
</DeviceConfig>

13.6.4 SonyVideoSwitcherConfig.xml

<DeviceConfig name="SonySwitcherConfig">

<Properties>
<!-- Truns the heartbeat mechanism on/off. -->
<!-- ditem name="EnableHeartbeat" value="false" / -->
<!-- The number of milliseconds before a time-out occurs when a read operation

does not finish.
If set less than zero the time-out will be 1infinite -->

<!-- jtem name="ReadTimeout" value="100" / -->

<!-- ComPort2 1is used for the SonySerialTallyDriver in split mode, using the
second serialport for the SCU connection -->

<!-- <item name="ComPort2" value="COM23" /> -->

<!-- The properties below routes the different commands sets to either the

standard or the extra COM port
None: always com port 1,
Partial: com port 1 if the crosspoint range or mix effect range is supported
by com port 2, otherwise com port 2
Full: always com port 2
-—>
<l--
<item name="AutoTransComPort2" value="None" />
<item name="SetCrossPointComPort2" value="Full" />
<item name="SetCrossPointComPort2" value="Full" />
<item name="SetAuxCrossPointComPort2" value="Full" />
<item name="SetKeyFillCrossPointComPort2" value="Full" />
<item name="SetKeyerComPort2" value="Full" />
<item name="SetDskComPort2" value="Partial" />
<item name="SetTransTypeComPort2" value="Full" />
<item name="RecallRegionComPort2" value="None" />
-—>
</Properties>
</DeviceConfig>
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13.6.5 VizEngineSwitcherConfig.xml

<DeviceConfig xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:xsd="http:/
/www.w3.0rg/2001/XMLSchema'">
<Properties>
<item name="ControlScenePath" value="Vizrt/VizOpus/ControlScenes/switcher" />
<item name="ControlScenelLayer" value="Back" />

<item name="NumberOfKeyBuses'" value="8"/> <!-- Number of key buses in template
editor (default value is 4, only other valid option 1is 8) -->
</Properties>
</DeviceConfig>

13.6.6 VizrtlpSystemsVideoSwitcherConfig.xml

<DeviceConfig name="VizrtIpSystemsVideoSwitcherConfig">
<Properties>
<!-- The path where EMEMs are stored —-->
<item name="PathToEmem" value='"D:\Sessions\SessionName\emem\" />

<!-- Set this to true if the crosspoint names should be sent in the command to
the driver instead of the physical inputs for the NDI Outputs. Default: true.-->

<item name="UseOutputCrosspointNames" value="true" />

</Properties>
</DeviceConfig>
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14 Viz Mosart Template Database

With the Viz Mosart Template Database (TDB), template information can be shared among the
following clients:

Between galleries automated with Viz Mosart (where templates are shared across galleries
and Mosart servers).
Between a Mosart main and backup server, in a redundancy setup.
- To NRCS clients using Mosart ActiveX.
- To NRCS clients using custom ActiveX.

The following Template Database topics are covered:

- Architecture

- Template Properties
Information Stored in the Template Database
Prerequisites for Connecting to TDB

14.1 Architecture

- The template database is stored in a MySQL relational database (or a valid MySQL equivalent

such as MariaDb).

- The database may be installed separately for the Mosart servers or as a part (schema) of an

in-house or cloud database, or even be virtualized.
- The only main requirement that the database must be MySQL compliant.

14.2 Template Properties

A Mosart template as stored in the template database has the following properties:

Property Description

Gallery The Mosart gallery naming where this template is
implemented, and 'owner' of the templates.

& Global Template Set Naming
A special global gallery is used for TDB templates
that are shared, replicated and available between
all galleries.
This dedicated virtual gallery name for a global
template set is by default named “SHARED”.
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Property Description

Template set The Mosart template set which the template belongs to.
Can be shared or local

& Local Template Characteristics
A local template is gallery-specific meaning it is
'owned' by the corresponding gallery and is
independent and not visible to any all other
galleries.

A Directtakes
The special Mosart template set Directtakes must
be defined as a shared template set.

Template type The Mosart template type. l.e. like CAMERA, CLIP, DVE, ...

Template variant The Mosart template variant. l.e. like which camera
(CAMERA+3)

Template description Common attributes for the template which is shared

among all galleries. The template description also
contains a list of input fields normally known as
newsroomtags.

Template implementation Gallery specific information which is used to control
systems using Mosart automation. This is the main part of
the template and has to be implemented in every gallery.

14.3 Information Stored In The Template Database

Details from the template database are stored in two Mosart server applications:

- AvAutomation
Stores templates and AvConfig.
ManusAdministrator
Stores NRCS aliases as configured in the Newsroom settings dialog.

& No other information in newsroomsettings.xml is stored in the database.
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14.4 Prerequisites For Connecting To TDB

© Before connecting to the template database the first time, make a backup
of channeltemplates.xml, AvConfig.xml and newsroomsettings.xml

Both AvAutomation and ManusAdministrator extract their information from the database
and store the information locally in channeltemplates.xml, AvConfig.xml and

newsroomsettings.xml respectively.
Any existing files are overwritten.

This section continues with:

Installing the Viz Mosart Template Database
Creating and Upgrading a Viz Mosart Template Database
Configuring Viz Mosart Server
Backup and Recovery
Database Maintenance
- Viz Mosart Template Database Specification

14.5 Installing The Viz Mosart Template Database

This section presents both installing and creating a database for Viz Mosart templates.

MySQL Database Servers and Clients
MySQL Users
Initial Mosart Template Database
File Location
Creating an Initial Template Database

Prerequisites

- A MySQL or equivalent, database server (MariaDB, AWS Aurora MySQL) installed and
accessible from the Mosart server.
This database server can be either dedicated to the Mosart automation servers or be an
existing in-house or cloud-based server.

- A database user with credentials sufficient for creating and altering the database. This is
also mandatory for Av Automation, which automatically updates the template database.

- A local MySQL client or tool that can connect and run sql scripts towards the database.

A Note: The Viz Mosart server can operate with both MySQL 5.x and 8.x.
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MySQL Database Servers and Clients

- Wampserver: A complete Windows web development environment using Apache2 and PHP. It

Refer

contains both MySQL and MariaDb database servers and supports PhpMyAdmin or Adminer
for database management and configuration.

A Note: Wampserver contains MySQL 5.x

This method is recommended when installing a dedicated template database for the Mosart
automation servers. It provides remote access to the database, via http.

MySQL server: Use the MySQL Installer to install the last native MySQL database server.
Recommended to also install the MySQL Workbench as a client for managing and configuring
the database server.

MySQL Workbench: Provides an integrated tools environment for database management and
administration.

MariaDB: Open source equivalent of MySQL server.

HeidiSQL: Simple free MySql/ProgreSQL/Microsoft SQL client.

dbVisualizer: Client for multiple database servers.

to section Prerequisites for details of supported versions.

Verify the connection to the template database

Before configuring the Mosart Server, verify the connection between the template database
and the Mosart Server, using a MySql client.
Typical issues at this stage relate to firewall and credentials/permissions.

14.5.2 MySQL Users

There are four types of users of a Mosart template database:

Role

Server management

Database management

Description Application

Full rights, at least the possibility
to create and alter databases

Minimum rights for AV
Automation

Full rights within a single
database / schema

Database use (read/write)

Database use (read only)

Needs CRUD operations on a
single database

Only need read operations on a
single database
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@ Itis recommend is to create two users for Mosart automation.
- One for the Mosart Server (AvAutomation and ManusAdmin) will full admin rights on the

Mosart database.
- One for the Mosart ActiveX, which only requires rights to perform read operations.

14.5.3 Initial Mosart Template Database

File Location
The initial database is located in the Sqg/ directory as part of the Mosart Server installation.

Pick the .sql file with the highest version number.
In this example, 1.0.5:

InitialMosartTemplateDatabase_1.0.5.sql

This sql file (containing the initial Mosart Template Database) is used to create the initial database
on the database server.

Creating an Initial Template Database

To Create a Template Database

You can create the initial template database in one of two ways:

1. By importing the initial database sql file using a database client, All MySql database clients
given above supports import of sql scripts. Normally requires root access.

2. Using the MySQL command line tool mysql.exe. The script RunDbScripts.cmd contains
command lines to import the initial database using mysql. This script is located in
the BatchFiles directory as part of the Mosart Server installation.

& Option 2 (below) requires that you have first created an empty database
mosarttemplatedb .

RunDbScripts.cmd

RunDbScripts.cmd:
:: Command script to upload an initial and empty database as the Mosart

template database:

:: Option 1: Invoke mysql with user credentials on the command line.
Note localhost is assumed 1if host 1is not given.
mysql [--host=hostname] --user=username --password=password mosarttemplatedb
< ../Sql/InitialMosartTemplateDatabase_1.0.5.sql
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:: Option 2: Invoke mysql with user credentials from the corresponding
mysql.ini file.

mysql --defaults-extra-file=mysql.ini < ../Sql/
InitialMosartTemplateDatabase_1.0.5.sql

3. After import, a database mosarttemplatedb is created

@ mysgl.exe
mysql.exe is part of MySQL Server, MySQL Workbench or Wampserver installations

5.0

14.6 Creating And Upgrading A Viz Mosart Template
Database

The Viz Mosart Template Database uses a schema called mosarttemplatedb.

Prerequisties

Before continuing, ensure Viz Mosart has been installed. Refer to section Installation, and

the latest Release Notes.

A Viz Mosart installation includes an essential database creation batch file RunDbScripts.cmd

written to: %ProgramfFiles%\Mosart Medialab\Mosart Server\BatchFiles.
- An installed WampServer (refer to section Installing WampServer).

This section contains the following topics:

Upgrading MySQL 5.x to MySQL 8.x
- Verifying the WampServer

Running Database Scripts

Running Scripts Automatically

Running Scripts Manually

14.6.1 Upgrading MySQL 5.x to MySQL 8.x

Migrating the Mosart templatedb

In connection with the migration of the template database to the new version of the database
server, it will be necessary to transfer all data from the old, following the recommendations in

Template Database section Backup and Recovery.

To Migrate the Template Data

1. Transfer tables and data to the new server.
2. Run the command below.
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ALTER USER ‘username’@’*’ IDENTIFIED WITH ‘mysql_native_password’ BY
‘password’;

replacing ¢‘username’ and ‘password’ placeholders to their actual values.
14.6.2 Verifying the WampServer

To Verify WampServer is Running

1. Check the WampServer icon is present in the system tray.
a. If not, start WampServer from the Start menu.
b. It should then appear green in the System tray.
2. If the WampServer icon is not green, click the icon and select Start All Services.

14.6.3 Running Database Scripts
The Viz Mosart Database can be created automatically using the Db0OCreate.sql script.
Location of Script

Navigate to the following locations, for x86 and x64 machines respectively:
%ProgramFiles%\Mosart Medialab\Mosart Server\Sql
%ProgramFiles(x86)%\Mosart Medialab\Mosart Server\Sql

There are also several upgrade scripts:

Db0O1Change....sql
Db02Change....sql
and so on

Database changes are implemented as upgrade scripts rather than as new versions of the create
script. This is to avoid destroying existing data.

- Scripts may also be run manually. It is recommended to run scripts automatically.
If problems arise when running scripts automatically, more information on manually running
scripts can be found later in this section.

14.6.4 Running Scripts Automatically

Scripts run from a batch file, RunDbScripts.cmd.

Location of Scripts

Navigate to the following locations, for x86 and x64 machines respectively:

%ProgramfFiles%\Mosart Medialab\Mosart Server\BatchFiles\
%ProgramfFiles(x86)%\Mosart Medialab\Mosart Server\BatchFiles\

The file refers to the MySQL command line tool mysqgl and an .ini file used by that tool.
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- The .ini file is installed into the same folder as the batch file, but contents should be verified
and amended as needed.
- The reference to the tool itself should also be verified.

To Run the Database Scripts

1. Edit, do not open, RunDbScripts.cmd. File contents should be similar to the following:

REM This file MUST be saved with Encoding = ANSI

for %%f in (<file list>) do C:\wamp\bin\mysql\mysql5.5.8\bin\mysql --defaults-
extra-file=mysql.ini < %%f

pause

2. Check if the stated folder (in this example, C:\wamp\bin\mysql\mysql5.5.8\bin) exists and
contains mysql.exe.
If so, continue with step 5. If not, continue to step 3.

3. Locate mysgl.exe and change the contents of RunDbScripts.cmd accordingly.

4. Save RunDbScripts.cmd with ANSI encoding.
For example, in Notepad, choose File > Save As, then Encoding: ANSI.

5. Edit, do not open, mysql.ini. File contents should be similar to the following:

[mysql] host=1localhost database=mosarttemplatedb user=root password=

6. Verify entries in the file and change if necessary:
host=1localhost : If MySql is running on another PC, replace localhost by the name
or IP address of this other PC.
database= mosarttemplatedb : Should not be changed.
user=root : This is the default admin user. If you want to run the scripts with
another user, replace with the name of a user with sufficient privileges.
password= : The default root password is empty. Replace if you have changed the

root password or have replaced root.
7. Save the file if you have changed it.

14.6.5 Running Scripts Manually

To Run the Database Scripts Manually

1. Start phpMyAdmin.

2. Create the database, mosarttemplatedb, if not already done.

3. Upgrade the database using the scripts from the appropriate location:
%ProgramfFiles%\Mosart Medialab\Mosart Server\Sql

%ProgramfFiles(x86)%\Mosart Medialab\Mosart Server\Sql
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14.7 Configuring Viz Mosart Server

Both AV Automation and Manus Administrator can be configured to use the Viz Mosart Template
Database.

- AV Automation: For storing templates and AvConfig.
Manus Administrator: For storing NRCS template type aliases as configured in the
newsroomsettings dialog.

A All other information in newsroomsettings.xml is not stored in the database.

Both applications will extract information from the database and store the information locally on
file:
- AV Automation: channeltemplates.xml and AvConfig.xml.
Manus Administrator: newsroomsettings.xml.

& Any existing files will be overwritten. Before connecting to the database for the first
time, always back-up these files.

Connecting AV Automation to the Mosart Template Database
Manual Verification of a AV Automation Database Connection
Manual Import of channeltemplates.xml to the Template Database
Manual Import of AvConfig.xml to the Template Database
Connecting Manus Administrator to the Mosart Template Database
Manual Import of newsroomsettings.xml Content to the Template Database
- Viz Mosart Template Database and Viz Mosart ActiveX

14.7.1 Connecting AV Automation to the Mosart Template Database

Connecting AV Automation to the Viz Mosart Template Database is done using the following
settings in the general settings dialog (CTRL + SHIFT + S):
UseTemplateDb: Set to true to enable connection to the Viz Mosart Template Database.
- ThisGallery: The name of the gallery. Should be unique among galleries but identical for
Mosart main and backup servers.
- TemplateDbConnectionString: Contains the database connection string to the database:

server=hostname;User Id=username;Password=password;database=mosarttemplatedb

- TemplateDbDefaultinserter: Identifies what entity is responsible for a database update. Only
visible in the database itself where the _insertedby and _updatedby columns are populated
with this property.

Recommended set equal to ThisGallery + main/backup, to identify main and backup servers
respectively.
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- TemplateDbEnableAutoSynchronize: Set to true (default) if the AV Automation shall
automatically synchronize with the database so that any changes in the database are read
immediately by AV Automation.

Recommend set to true unless intensive show design with frequent template changes
occurs.

& Only idle servers will update automatically. Live servers requires a manual operation,
like opening the template editor, clicking on the status bar or restarting AV
Automation.

- TemplateDbPollintervalSeconds: Number of seconds between polling the database for
updates. Set to a higher value than the default (5 seconds) if multiple frequent template
changes occurs.

- TemplateDbEnableLocking (deprecated): Leave default value (true).

- TemplateDbProviderName: Leave the default value for MySq/ (MySql.Data.MySqlClient).

For initial connection open the settings dialog and set the

properties UseTemplateDb, ThisGallery, TemplateDbConnectionString and
TemplateDbDefaultInserter then restart AV Automation. If everything goes fine an entry for the
gallery should be added to the database and initial templates (channeltemplates.xml) and AvConfig
(avconfig.xml) uploaded.

Manual Verification of a AV Automation Database Connection

1. Do the initial connection steps as outlined in the former section.
2. Using any MySql database client, verify the content of the ga_gallery table. This table shall
now contain a single row where ga_name=ThisGallery.

Manual Import of channeltemplates.xml to the Template Database

You can use a ready-made template set, stored as an XML-file. and manually import to the
database. This is useful to populate the template database with the content from a
channeltemplates.xml file. Either initially or as backup / transfer operation.

Import channeltemplates.xml file via the Template Editor in AV Automation. From inside the
Template Editor:

1. Open any channeltemplates.xml from file.
a. Select File >Open

4% Template Editor | 6PM MUL

File v| Template ~ Template Se
Mew...
Open...
Save Ctrl+5 -

Save To Database

Save As,.,

Revert...
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b. Select the preferred XML-file from the list, and click Open.

a5 Open ChannelTemplates *
4N » ThisPC » Windows (C:) » channeltemplates v D Search channelternplates R
Organise = MNew folder = [ @
MName - Date modified Type Size

& Quick access

| | AsRunLogRepositoryConfig.xml XML Document

B3 This PC | | avcenfigaml XML Document
ects channeltemplates.xm AML Document

3D Obj h Iternpl | KMLD
[ Desktop | | ChannelTemplatesLastSavexml ¥ML Document

| | ChannelTemplatesLastTemplateSetxml
| | keyboard_shertcuts.xml

= Documents XML Document

XML Document

4 Downloads

) | | LogRepositoryConfigaxml XML Document
‘b Music | | MosartGlobalSettings.xml XML Document
=] Pictures | | MosLogRepositoryConfigaml AML Document
B Videos || newsroomsettings.xml AML Document
‘i Windows (C:)

== FinanceBGO (\\bgo
== Installers (\\bgo-mt
= common (\WBGOFS
== CenterNorway (\\B(

¥ Metwork

File name: || -

Cance'

A After opening a template file in this way, File > Save will not save to the database,
but to the opened file.
Only after completing step [2] below, File > Save To Database does this operation
save to the template database.

2. Select the File > Save To Database. The content of the selected channeltemplates.xml file is
now uploaded to the Template Database.

Note: When importing a channeltemplates.xml to the database any existing templates
will be overwritten. No templates are deleted from the database.

Manual Import of AvConfig.xml to the Template Database

It is possible to manually import AvConfig.xml to the database. AvConfig.xml is stored entirely
related to the gallery. Additionally, the lists of vision mixer crosspoints and effects are extracted
and stored as global lists within the database. This information is used by the Viz Mosart ActiveX

Import AvConfig.xml via the A/V Setup dialog in AV Automation. From the A/V Setup dialog:

1. Open any AvConfig.xml file using the File > Open menu option.
2. Select the File > Save menu option. The content of the selected AvConfig.xml file is now
stored in the template database.
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Note: The content of the AvConfig.xml file is stored as it is, as a string, in the ga_gallery table.

14.7.2 Connecting Manus Administrator to the Mosart
Template Database

The only information stored in the database from Manus Administrator is the newsroom aliases for
the Mosart template types. This is done to make the newsroom aliases the same for all galleries
connected to the database. This information is global and shared among all galleries. Therefore
there is no gallery-specific setting necessary within Manus Administrator (unlike ThisGallery for AV
Automation)

Connecting Manus Administrator to the Mosart Template Database is done using the following
settings in the general settings dialog (CTRL + SHIFT + S):

Use template database: Set to true to enable connection to the Mosart Template Database.
ConnectionString: Contains the database connection string to the database:

server=hostname;User Id=username;Password=password;database=mosarttemplatedb

Default inserter: Identifies which entity is responsible for a database update.
Provider name: Leave the default value for MySql (MySql.Data.MySqlClient)

Manual Import of newsroomsettings.xml Content to the Template Database

It is possible to manually import the NRCS template type aliases located in newsroomsettings.xml
to the database.

1. In Manus Administrator, type newsroomsettings.
This opens a dialog menu.

2. Open any newsroomsettings.xml using with File > Open.

3. Select the File > Save. The newsroom aliases for template types are now uploaded to the
Template Database.

Note: It is only the template type aliases that are stored in the template database. All other
information remains locally as is the newsroomsettings.xml.

14.7.3 Viz Mosart Template Database and Viz Mosart ActiveX
The Viz Mosart ActiveX is used to insert Viz Mosart template information into the NRCS script.

- The user selects a Viz Mosart type and variant to create an entry in the Viz Mosart rundown.
- When the script is saved, information is pushed to Manus Administrator and onto the active
rundown in the Viz Mosart GUI.

For the ActiveX to function correctly, some parameters are required to be set that link the ActiveX
content to your Viz Mosart Server installation.

There are two ways to link the ActiveX to your Viz Mosart Server installation:,
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1. The Template Database
2. Directly to the Viz Mosart Server.

For more information, see Connecting the ActiveX to Viz Mosart Server.

14.8 Backup And Recovery

The Viz Mosart Template Database is stored in a MySQL database and any backup and recovering
strategies offered by the database vendor is valid.

In addition, most MySQL clients offers the possibility to backup and restore the entire database
from a single .sql file.

In this section, the MySQL command line tools mysqldump and mysqglare used for backup and
restoring respectively.

@ Tip: mysql.exe and mysqldump.exe are part of MySQL Server, MySQL Workbench or
Wampserver installations.

- Working with the Server Database
Database Backup
Database Restore
- Working with Database Clients
Backup and Restore from a MySQL Client

14.8.1 Working with the Server Database

Database Backup
To backup using mysqldump

- The command above creates a single .sql file containing the entire Viz Mosart Template
Database.

mysqldump [--host=hostname] --user=username --password=password --add-drop-database
mosarttemplatedb > backupfile.sql

Database Restore

To Restore using mysql

- The command below restores the Viz Mosart Template Database from a single .sql file as
created using the mysqgldump command shown in the former section.
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mysql [--host=hostname] --user=username --password=password mosarttemplatedb <
backupfile.sql

14.8.2 Working with Database Clients

Backup and Restore from a MySQL Client

Backup and restore operations using the mysqgldump and mysql tools are also available in all
recommended MySQL client applications.

When using a client application ensure the following:

Database schema = mosarttemplatedb.
Export to a single file. The entire database must be saved to a single file.
Include drop and create functions. This ensures that the database is restored as stored on

the file.
Example: Backup from MySQL Workbench

1. In MySQL Workbench navigate to Server > Data Export > Export
This opens the Data Export dialog menu.
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2. Follow recommended options highlighted in the figure below:

- O X
® Mosart @google fest) x Local instance MySQLST =
File Edit View Query Database Server Tools Scripting Help
: = : =]
o JEFHFHE & @ Dl
Navigator::- : Query 1 SQAL File 1= Administration - Data Export
MANAGEMENT &
e Server Status Local instance MySQLST o AT
vanced Options...
_tl Client Connections Data EXpOlt
4§ Users and Privileges Object Selection  Export Progress
Status and System Variables Tables to Export
J; Data Export
Ja Data Import/Restore | Evr auema Exp  Schema Objects
| —| mosarttemplatedb
— X
INSTANCE [ gakile
@ startup / shutdown O osys
D = world
A Server Logs -
f' Options File
PERFORMANCE
@' Dashboard
f: Performance Reports
G\ Performance Schema Setup
SCHEMAS LU
Q ‘Fi\ter objects
¥ = mosarttemplatedb -
w B Tables
[3 db_database
» em_enumerationmen
> en enumeration v Refresh Select Views Select Tables Unselect Al
< >
Information ::- ArzEEaEy
[ bump Stored Procedures and Functions [ bump Events [ pump Triggers
Schema: mosarttemplatedb
Export Options
Export to Dump Project Folder C:\Users\torki\OneDrive\Dokumenter\dumps\Dump2018 10 10
Xpol p Froj
(®) Export to Self Contained File C:\Users\torki\OneDrive\Dokumenter\dumps\Dump20181010-L.sgl
All selected database objects will be exported into a single, self-contained file.
[#] create Dump in a Single Transaction (self-contzined file only) [ indude Create Schema
Export Completed Start Export
Object Info ~ Session
3. Restore from a single .sql file in MySQL Workbench.

Navigate to Server > Data Import.
4. Select the .sql file as created during backup.
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1. Navigate to Tools > Export database as SQL.
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® Tabletools — O
v [m T mosat@google (test) #° Maintenance #8 Findtet |3 SOLexport | Bulktable editor
O Ll information sch.ema 1600 KiB Database(s): @ Droptt Create Help
£ | mosarttemplatedb 3 740 KB Table(s): _’7|Drop!! [ Create
] 0 mysqr 5,9 MiB —
0O performance_schema Data: Delete + insert (truncate existing data) ~
O sys Max INSERT size: |1 024 KB({0=¢ Options |v
Qutput: Single =gl file Vl
Filename: |C:\Users\torki\Projects\Mosart\TDB\BBC_HEIDI.sc v| L
Database Table Rows
mosarttemplatedb tt_templatetype W0 4
mosarttemplatedb vtefi_connection
mosarttemplatedb vtefi_connection W
< >
Selected ebjects size: V04,0 KiB Export Clese

2. Ensure the following:

a. For both Database(s) and Table(s), Drop and Create are selected

b. Data: is set to Delete + insert (truncate existing data)

¢. Output: is set to Single .sql file.
3. Navigate to File > Run SQL file
and restore from a single .sql file in HeidiSQL.

14.9 Database Maintenance

After initialization, most changes to the Viz Mosart Template Database are performed in

AvAutomation and the Template Editor.

These changes may include upgrading the database, adding and removing galleries, adding and
removing template sets and adding, removing and editing templates.

This section presents the following topics:

Upgrading the Database

Upgrade History
Viz Mosart Template Editor
TemplateSetEditor

Configuration of TemplateSetEditor

Configuring the Required Template Database
Configuring an External Tool for Displaying Differences
Configuring an External Editor for XML Content in a Single Template

TemplateSetEditor Commands
Compare [set1] [set2] [type] [template]
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Upgrading the Database

AvAutomation will automatically upgrade the database. All upgrades and current database version
are stored in the db_database table.

A Note: Automatic upgrades shall never delete or modify any content in the database. The
database should be kept backward compatible at all times.
Upgrades normally add new functionality to the database

Upgrade History

The following table summarizes the upgrade history of the Viz Mosart Template Database:

Versio

n

0.1.0

1.0.0

1.0.1

1.0.2

1.0.3

1.0.4

1.0.5

1.1.0

Date

01.06.201
2

01.12.201
2

01.10.201
3

07.05.201
3

27.06.201
3

05.09.201
3

26.08.201
4

17.01.201
6

Versio

n

3.2

3.2

3.2

3.3

3.3

3.5

3.5

4.0

Description

Initial version.

First version of automatic upgrade. New table: db_database.

Added support for sequences. New table: sq_sequence.

Added templateset properties. New table:
tsp_templatesetproperties.

Verified default transitions: Added initial content to the
tr_transition table.

Added order field in tdfi_connection table. New column:
tdfi_order.

Added scope to ta_templatetypealias table. New column:
ta_scope.

Added support for hierarchical template sets. New columns in
ts_templateset table: ts_basedon, ts_hidefromuser.

14.9.2 Viz Mosart Template Editor

The Viz Mosart Template Editor is normally used to add, delete and modify Viz Mosart templates.
When attached to a Mosart Template database every save operation pushes the changes

incrementally to the database.
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Use the Template Editor for the following changes:

- Adding and removing template sets. Note when adding a new template set it is possible to
choose whether the template set shall be shared or gallery specific (local). It is not possible
to change this afterwards.

- Adding, removing and editing templates. This is the normal use case of the template editor.

14.9.3 TemplateSetEditor

TemplateSetEditor is a console application that is part of the Mosart Test Suite. This application
may be useful for simple maintenance and is currently the only way to remove galleries from the
database.

The TemplateSetEditor was made as part of adding hierarchical templates to the database.

A Note: As of Viz Mosart 4.0, the TemplateSetEditor is a standard component.

Configuration of TemplateSetEditor

@ Tip: Configuration of TemplateSetEditor is done in the application configuration file,
TemplateSetEditor.exe.config

userSettings
Within the application configuration file locate the userSettings sections where you can:

Select an external tool for showing differences. Used by the compare function

Select an external tool for viewing single templates or template sets in XML. Used by

the edit function.

Select the template database to use with corresponding credentials (connectionstring).
Select template respository (future). Only C:\channeltemplates.xml is currently supported.

Configuring the Required Template Database
You can register three different databases to connect to.

1. Enter the respective connectionstrings using the
properties Databasel, Database2 and Database3.

2. Select which database to use by assigning the desired server (hostname) to
the Database property.

Example

Databasel: gallery=StudioE;server=localhost;User
Id=user;password=password;database=mosarttemplatedb
Database?2: gallery=StudioE;server=146.148.9.188;User
Id=user;password=password;database=mosarttemplatedb
Database 3. <empty> (not used)
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Setting the property Database to localhost makes use of the connectionstring given in
the Databasel property, setting the Database property to 146.148.9.188 makes use of the
connectionstring given in Database?2.

Configuring an External Tool for Displaying Differences

You can reveal differences to template sets or templates by comparing their corresponding XML
representations. This is used by the compare function. Register up to three different tools for
comparison using the properties DiffTool1, DiffTool2 and DiffTool3.

Use {0} and {1} as placeholders for the two different contents to compare. Then select which tool
to use by setting the property DiffTool to the name of the desired tool.

Example
Tool Code Example
DiffTool1: Visual Studio Code Name=VSCode;Program=C:\Program Files\Microsoft VS
Code\Code.exe;Args=--diff {0} {1}
DiffTool2: Beyond Compare Name=BComp;Program=C:\Program Files\Beyond
Compare 4\BCompare.exe;Args={0} {1}
DiffTool3: ExamXml Name=ExamXml;Program=C:\Program

Files\ExamXMLPro\examxmlpro.exe;Args=--diff {0} {1}

Setting the property DiffTool to BComp makes use of Beyond Compare as the external tool to use
for the comparison.

Configuring an External Editor for XML Content in a Single Template
You can edit or view the XML content of a single template.

Register up to three different tools for editing xml using the

properties EditTool1, EditTool2 and EditTool3.

Use {0} as placeholder for the content to edit. Then select which tool to use by setting the
property EditTool to the name of the desired tool.

Example
Tool Code Example
EditTool1: Visual Studio Code Name=VSCode;Program=C:\Program Files\Microsoft VS
Code\Code.exe;Args={0}
EditTool2: XmIMarker Name=XmlMarker;Program=C:\Program Files (x86)\XML

Marker\xmlmarker.exe;Args={0}
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Tool Code Example

EditTool3: Notepad++ Name=Notepad++;Program=C:\Program Files\Notepad++
\hotepad++.exe;Args={0}

Setting the property EditTool to VSCode makes use of Visual Studio Code as the external tool to
use for editing.

TemplateSetEditor Commands

Below is a list of commands available in the TemplateSetEditor:

TemplateSetEditor help message

TemplateSetEditor

/? Outputs this help message

Clear Clears the console window

CleanUp Clean up templates, removes depricated stuff etc.

Compare [set] [baseset] [type] [template] Compares template sets or a single
template

Copy [set] [newset] Makes a copy of set with name equals newset

Edit [set] [type] [template] Opens a single template in an external xml
editor

End Terminates Mosart Template Set Editor

Equals [set] [baseset] [type] [regex] Performs equality test on templateset
or set of templates

Exit Terminates Mosart Template Set Editor

Flatten [set] [type] [template] Flattens a templateset or a single template
Gallery [gallery|add|select|delete|rename|list] [gallery] [newname] Gallery
operation when using template database, default select

Help Outputs this help message

Info [set] [type] [template] Outputs 1information of a templateset or a
single template

List [set] [type] [regex] List templates / template sets

Open {filename} Opens the given channeltemplates file

Quit Terminates Mosart Template Set Editor

Rebase [set] [baseset] [-c] [-f] Bases a templateset upon another set
Remove [set] [type] [template] Removes templateset or a single template
Rename [set] [newname] Renames templateset

Save Saves channeltemplates

SaveAs [filename] [ChangesOnly] Saves channeltemplates to the given
filename. If ChangesOnly is given only changed templates are saved.

Verbose Turns verbose logging to console on/off

Compare [setl] [set2] [type] [template]

Compares two template sets or a single template between two template sets. If any differences are
encountered an external diff tool is launched to investigate the differences. Configuration of diff
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tool is done via the application configuration file, TemplateSetEditor.exe.config.
Syntax:

set1: Name of template set one.

set2: Name of template set two.

type: Template type of single template (optional).
template: Name or variant of single template (optional).

Example Compare

# Compares template sets LDN and LDN2

compare LDN LDN2

# Compares template Camera+l from template sets LDN and LDN2
compare LDN LDN2 0 1

compare LDN LDN2 Camera 1

Copy [set] [newset]

Makes a copy of a template set with name equal to newset.

Equals [set1] [set2] [type] [template]

Performs the equality test on two template sets or for a single template.
Syntax:

set1: Name of template set one.

set2: Name of template set two.

type: Template type of single template (optional).
template: Name or variant of single template (optional).

Example Equals

# Performs the equality test on the template sets LDN and LDN2

equals LDN LDN2

# Performs the equality test on template Camera+l from template sets LDN and LDN2
equals LDN LDN2 0 1

equals LDN LDN2 Camera 1

Edit [set] [type] [template]

Opens a single template in an external xml editor. The tool to use is configured in the application
configuration file, TemplateSetEditor.exe.config
Syntax:

set: Name of template set.
type: Template type of single template.
template: Name or variant of single template.
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Example: Edit

# Opens template Camera+l in template sets LDN in an external xml editor
edit LDN 0 1
edit LDN Camera 1

Flatten [set] [type] [template]

Flattens an entire templateset to its base set or a single template.
Syntax:

set: Name of template set to flatten.
type: Optional: Template type of single template (optional).
template: Name or variant of single template (optional).

Example: Flatten

# Flattens template set LDN

flatten LDN

# Flattens template Camera+l in template sets LDN
flatten LDN 0 1

flatten LDN Camera 1

Gallery [gallery|add|select|delete|rename]list] [gallery] [newname]

Gallery operations. Requires template database.

@ Tip: The recommended way to remove a gallery from the template database. Currently not
possible from the template editor.

Syntax:

operation: Gallery operation. Either add,select,delete,rename or list. Default = select.
gallery: Name of gallery in the Mosart template database.
newname: New gallery name when operation=rename.

Example: Gallery

# List all galleries in the template database

gallery list

# Selects StudioC as the current gallery, both examples are valid
gallery StudioC

gallery select StudioC

# Add StudioR as new gallery to the template database

gallery add StudioR
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# Deletes StudioC from the template database. This operation removes all content
related to the gallery.

gallery delete StudioC

# Renames StudioB to StudioB2

gallery rename StudioB StudioB2

Info [set] [type] [template]

Outputs the XML content of a templateset or a single template to the console and the Windows
clipboard.

@ Tip: Copies the XML content of a single template to the Windows clipboard.

Syntax:

set: Name of template set.
type: Template type of single template (optional).
template: Name or variant of single template (optional).

Example: Info

# Outputs information of template set LDN

info LDN

# Outputs information of template Camera+l in template sets LDN
info LDN 0 1

info LDN Camera 1

List [set] [type] [regex] [file=filename]

List all templates sets or templates within a template sets.
Syntax:

set: Template set to list templates from (optional).
type: Restrict listing to templates of given types (optional).
' = All types
Comma separated list of valid types.
regex: Restrict listing to templates matching the given regular expression (optional).
filename: filename to store listed templates (optional).

Example: List

# List all template sets within the current channeltemplates.xml file
list

# List all templates within template set LDN

list LDN

# List all camera templates within template set LDN
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list LDN O

list LDN Camera

# List all camera templates within template set LDN where name contains "RIGHT"
list LDN O RIGHT

list LDN Camera RIGHT

# List all camera and live templates within template set LDN where name contains
"RIGHT"

list LDN 0,3 RIGHT

list LDN Camera,Live RIGHT

# List all templates within template set LDN where name contains "RIGHT"

list LDN * RIGHT

Open [filename]

Opens tempateset / channeltemplates.xml file. Default: C:
\channeltemplates\ChannelTemplates.xml.

Rebase [set] [baseset] [-c] [-f]

Bases a template set upon another template set. If a baseset is not given, the given template set is
made 'stand alone' (i.e. not based upon any other template set).
Syntax:

set: The template set to rebase.

baseset: The template set to used as the baseset.

-c: Makes a copy of the baseset if the given templateset does not exist.
-f: Flattens template set after the rebase operation.

Example: Rebase

# Bases template set LDN2 to template set LDN

rebase LDN2 LDN

# Bases template set LDN2 to template set LDN.

# If LDN2 does not exist, a copy of LDN 1is made before rebasing

rebase LDN2 LDN -c

# Bases template set LDN2 to template set LDN.

# After rebase, a flattening templateset operation is performed

rebase LDN2 LDN -f

# Makes template set LDN2 'stand alone' (i.e. not based upon any other template set).
rebase LDN2

Remove [set] [type] [template]
Removes the given template set or a single template.
Syntax:

set: Name of template set
type: Template type of single template (optional).
template: Name or variant of single template (optional).
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Example: Remove

# Removes template set LDN

remove LDN

# Removes template Camera+l from template sets LDN
remove LDN O 1

remove LDN Camera 1

Rename [set] [newname]

Renames the given template set to the given new name.

Save

Saves any changes to the template database and the current channeltemplates.xml file.

SaveAs [filename]

Saves the current templatesets to the given filename.

5.0

14.10 Viz Mosart Template Database Specification

This section provides database specifications for the Viz Mosart Template Database:

Introductions and Notations
Viz Mosart Database Tables

14.10.1 Entity Relationships

The following figure shows the relationships between the most important tables within the
database.
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14.10.2 Introductions and Notations

By default Mosart organizes all templates in a single file, C:
\ChannelTemplates\channeltemplates.xml. The template database makes it possible to store the
templates in a MySQL database. The main benefits for this is follows:

1. To share templates among Mosart installations and galleries.
2. To provide synchronized template sets between Mosart main and backup servers.

Viz Mosart Template database tables

Table name Prefix Short description

db_database db Mosart Template Database update table.
Contains an overview of database update.

em_enumerationmember em The enumeration members that may be used
as values for template fields of enumeration
type.

en_enumeration en The enumerations that may be used as types

(i.e. sets of admissible values) for template
fields.

fi_field fi The fields used as template inputs.
ga_gallery ga The galleries.

lo_lock lo Contains locks for editing database content.
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Table name

sg_sequence

ta_templatetypealias

td_templatedescription

tdfi_connection

te_template

ti_templateimplementation

tr_transition

ts_templateset

tsp_templatesetproperties

tt_templatetype

sq

ta

td

tdfi

te

ti

tr

ts

tsp

it

Conventions and notations

Table prefix

Prefix

Viz Mosart Administrator Guide - 5.0

Short description

Contains sequences stored as part of the
Mosart template sets.

The template type aliases (a template type may
be referred to by several aliases).

The template descriptions. Input fields and
transition input fields. A template may have
different descriptions for different galleries.

Relation, relating template description and
fields.

The templates.

The template implementations. A template
may have different implementations for
different galleries.

Available transitions to be applied between
templates.

The template sets (the templates are organized
in sets).

Template set properties

The Mosart template types.

Each table has a unique prefix consisting abbreviating the rest of the table name followed by an
underscore (_). This prefix is used both in the table name and for all columns in the table. Using
the prefix helps identifying relationships between column names and tables.

Syntax :

Table
Column

Foreign key

<prefix>_<columnName>

<prefix>_<foreignColumnName>
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ts_templateset
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ts_ga_recno
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Each table has an integer column ..._recno (with ... representing the prefix, except the _)
representing an Primary key, and thereby as value of foreign keys, where applicable.

Foreign keys

A foreign key (referencing a ..._recno column of some table) usually has the name ..._..._recno
(with the two ...s representing the prefixes, still except the _, of the containing and referenced
tables, respectively). (In the case that one table has more than one foreign key to the same table,

other names have to be invented.)

Data types

The following data types are used in this specification:

Type

datetime

varchar(n)
integer

smallint

longtext

Fixed columns

Comment

Data type capable of storing a point in time (date and time
of day).

Variable length string.
General integer.

Small integer, normally used to store boolean values
(0 =false, 1 =true).

Data type capable of storing a Unicode string of virtually
any length.

Every table contains the following four fixed columns to store update and insert information for
the individual rows. Note that these columns are not stated in the forthcoming table descriptions.

Name

<prefix>_ins
erteddate

<prefix>_ins
ertedby

T

V4
p

dateti
me

varchar
(32)

Allow Description

Null

No

No

The point in time at which the row was inserted.

Mosart server responsible for the insert. Given by
AvAutomation TemplateDbDefaultinserter property.
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Name

<prefix>_up
dateddate

<prefix>_up
datedby

o T <

dateti
me

varchar
(32)

Allow
Null

No

No
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Description

The point in time at which the row was last updated (or
inserted).

Mosart server responsible for the insert. Given by
AvAutomation TemplateDbDefaultinserter property.

14.10.3 Viz Mosart Database Tables

This section contains a brief overview of all tables contained in the Viz Mosart Database schema.

db_database
em_enumerationmember
en_enumeration

fi_field

ga_gallery

lo_lock

sg_sequence
ta_templatetypealias

td_templatedescription
te_template

ti_templateimplementation

ts_templateset
tt_templatetype
tdfi_connection
tr_transition
tsp_templatesetproperties

db_database

The db_database table is a maintenance table that contains the current version of the Viz Mosart
Template Database along with all its upgrades.

The table is used by Mosart AvAutomation to verify whether an automatic upgrade is required.

Name

db_recno

db_version

Type
integer

integer

Allow Null Description
No Primary key.
No The database version number.
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Name

db_versiondate

db_mosartversion

Type Allow Null
varchar(32) No
varchar(32) Yes

em_enumerationmember
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Description

The date when the upgrade was
introduced to the Mosart
Template Database.

The Viz Mosart version number
responsible for doing the
upgrade.

The em_enumerationmember contains the enumeration values for the corresponding enumeration

types.

Name
em_recno

em_en_recno

em_value

em_description

en_enumeration

Type Allow Null
integer No
integer No
varchar(32) No
varchar(128) Yes

Description
Primary key.

Foreign key referencing the
corresponding enumeration in
the en_enumeration table.

The value of the enumeration
member. Normally presented to
the users.

Optional enumeration member
description.

The table en_enumeration contains all enumerations used to set values for template fields.

Name
en_recno

en_name

en_description

Type Allow Null
integer No
varchar(32) No
varchar(128) Yes
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Description
Primary key.

The enumeration name. Normally
used in drop-down lists
presented to users.

Optional enumeration
description.
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The table fi_field contains valid fields or newsroomtags used by Mosart templates for receiving
user input. Normally these fields are exposed to the uses in the NRCS via dedicated ActiveX
components. Note that a single field can be shared by many templates.

Name
fi_recno

fi_name

fi_description

fi_type

fi_en_recno

fi_mask

ga_gallery

Type
integer

varchar(32)

varchar(128)

varchar(32)

integer

varchar(128)

Allow Null

No

No

Yes

No

Yes

Yes

Description
Primary key.

The field name. Normally
presented to users.

Optional field description.

The field type. Supported values
are ‘ENUMERATION’, ‘NUMBER’,
‘STRING’.

Optional foreign key for
ENUMERATION fields.

If set, referencing the
corresponding enumeration in
the en_enumeration table.

Optional input mask. Used for
STRING fields only.

The table ga_gallery contains all Mosart galleries using the database.

A Note: In Mosart AvAutomation the property ThisGallery shall reflect the gallery name as

stored in the ga_name column.
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Description

Primary key.
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Description

Set to true (1) for the shared gallery. The shared gallery may be used by clients
to obtain all shared template sets within the database. Only one gallery shall be
used as the shared gallery. By default, a virtual gallery named SHARED is used
for this purpose.

The gallery name.

Optional gallery description.

The XML formatted contents of the avconfig.xml file used in this gallery.

Optional foreign key referencing the ‘default’ template set of the gallery.

The database version used by the Mosart applications for the gallery. This
database version reflects the current Mosart version.

& Note: One row only should have ga_shared = 1. The name of this gallery is by default set
to ‘SHARED’. All shared templates belong to this gallery.

lo_lock

The table lo_lock contains information used to restrict editing access to a template. The template
database locks at template level (i.e. only one user may edit a single template at any time).
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The lock table also contains rows used to store timestamps for last updates within a single gallery
or the database overall. These values may be used to poll the database for changes. These
timestamps are stored in the lo_updatedate field.

Note that the lo_insertedby field is used to identify the lock type:

- Template: This is a true lock, locking the corresponding template. The template is identified
by the value in the lo_recno column which contains a foreign key to the te_recno value in the
te_template table.
Gallery: Contains a timestamp when the corresponding gallery was last updated. The gallery
is identified by the lo_recno which for gallery types contains a foreign key to the
corresponding gallery, ga_recno in the ga_gallery table. The foreign key is a function of the
lo_recno value as follows: ga_recno = 10 - lo_recno
Database: Contains a timestamp when the database was last updated.

Other values are deprecated.

Name

lo_recno

lo_ga_rec
no

lo_ga_na
me

lo_insert
edby

Type

integer

integer

varchar

(32)

varchar
(32)

sg_sequence

Allow

Null

No

Yes

Yes

No

Description

Primary key. Also used to identify either a gallery or a template
depending upon the lock type. See description above.

Optional foreign key referencing the gallery owning the lock.

The name of the gallery owning the lock.

Contains the lock type. Either Template, Gallery or Database. See
description above.

The sqg_sequence table contains recorded sequences from a Viz Mosart Automation. Sequences are
gallery dependent and related to the template set in use when recorded. A sequence makes it
possible to record any sequence from a rundown in Viz Mosart automation for later playback.

Name

sg_recno

sg_ga_recno

Type

integer

integer

Allow Null Description
No Primary key.
No Foreign key referencing the

corresponding gallery ga_recno in
the ga_gallery table.
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Name

sq_ts_recno

sg_name

sq_description

sq_xml
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Type Allow Null Description

integer No Foreign key referencing the
corresponding template set
ts_recno in the ts_templateset

table.
varchar(32) No Name of sequence.
varchar(128) Yes Optional description of the
sequence.
longtext No The gallery specific

implementation of the sequence.
Stored as received from Mosart
Automation in XML.

ta_templatetypealias

The ta_templatetypealias table contains custom user aliases for the Mosart template types. These
aliases are used by Mosart ManusAdministrator to translate user aliases to the corresponding
Mosart template types.

Nam Typ All
e e ow
Nu

ta_re inte No
cno ger

ta_n varc No
ame  har(
32)

ta_d varc Ye
escri  har( s
ption 128)

ta_tt inte No
_rec ger
no

ta_.d sma Ye
efaul llint s

Description

Primary key.

The template type alias name. Should be unique, as this is presented to the
users.

Optional template type alias description.

Foreign key referencing the corresponding Mosart template type in the
tt_templatetype table.

A value of 1 is used for the ‘default’ alias among those belonging to the
same template type. For each template type, exactly one alias belonging to

that type should have ta_default = 1.
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( Information: The ta_templatetypealias table is the only table that is maintained and used
by Mosart ManusAdministrator containing the NRCS template type aliases.

td_templatedescription

The table td_templatedescription contains template information to be presented to users that may
differ among the galleries (i.e. this information is gallery dependent).

Name Type Allow Null Description
td_recno integer No Primary key.
td_te_recno integer No Foreign key referencing the

corresponding template te_recno in
the te_template table.

td_ga_recno integer No Foreign key referencing the
corresponding gallery ga_recno in
the ga_gallery table

td_tr_recno integer Yes Optional foreign key referencing a
transition tr_recno in the
tr_transition table.

td_default varchar(128) Yes Optional default value for
transitions not of type
ENUMERATION. Normally for MIX
and WIPE transitions.

td_em_recno integer Yes Optional foreign key for the default
value for ENUMERATION transition
types. Normally EFFECT transition.
Reference to a enumeration value
em_recno in the
em_enumerationmember table.

td_descriptionupdate Datetime No (deprecated)
ddate

Note that the overall template description is stored in three parts / tables:

1. td_templatedescription: The base template description.

2. tr_transition: The transition used by the template. In Mosart this equals the transition when
taking the template. Normally either Mix, Wipe or Effect.

3. tdfi_connection: Relation that list all fields (or newsroomtags) used by the templates. A
newsroomtag is a template property allowing users to input information to the template.
Normally newsroomtags are exposed to the users in the NCS.
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te_template

The table te_template contains the individual templates with information that is shared among all
galleries.

Note that information regarding a single template is divided into three parts / tables:

1. te_template: Contains basic template information. This information is shared among all
galleries (i.e. gallery independent).

2. td_templatedescription: Contains typically template information to be presented to users
that is gallery dependent.

3. ti_templateimplementation: Contains the template implementation as created by the Mosart
template editor. This information is gallery dependent.

Name Type Allow Null Description
te_recno integer No Primary key.
te_ts_recno integer No Foreign key referencing the

corresponding template set in the
ts_templateset table.

te_tt_recno integer No Foreign key referencing the
corresponding template type in
the tt_templatetype table.

te_variant varchar(32) No The Mosart template variant.
te_description varchar(128) Yes Optional template description.
te_hidden smallint Yes Set to true (1) if this template is

to be hidden from any user
presentations.

te_name varchar(128) Yes Optional template name.

te_sendtoncs smallint Yes Set to true (1) if the template
implementation is to be sent to
NCS. Used by some NCS only.

ti_templateimplementation

The table ti_templateimplementation contains the gallery specific template implementation as
created by the Mosart template editor (i.e. this information is gallery dependent).
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Name Type Allow Null
ti_recno integer No
ti_te_recno integer No
ti_ga_recno integer No
ti_xml longtext Yes

Viz Mosart Administrator Guide - 5.0

Description
Primary key.

Foreign key referencing the
corresponding template te_recno in
the te_template table.

Foreign key referencing the
corresponding gallery ga_recno in
the ga_gallery table.

The actual xml-formatted template
implementation as created by the
Mosart template editor.

( Information: The template implementation must be created per gallery and is stored using
its native XML representation, as received from the Mosart template editor

ts_templateset

The table ts_templateset contains the template sets.

Name Type Allow Null
ts_recno integer No
ts_ga_recno integer No
ts_name varchar(64) No
ts_global smallint Yes
ts_description varchar(128) Yes

Copyright © 2022 Vizrt

Description
Primary key.

Foreign key referencing the
corresponding gallery in the
ga_gallery table.

Template sets belonging to the
shared gallery (ga_shared=1) are
by definition shared template sets.
Shared template sets will be
present in all galleries.

Template sets belonging to any
other gallery are by definition
private template sets owned by
the corresponding gallery.

The name of the template set.
(deprecated)

Optional template set description.
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Name

ts_ga_updating

ts_basedon

ts_hidefromuser

tt_templatetype
The table tt_templatetype contains the Mosart template types.

Name

tt_recno

tt_name

tt_description

Type
integer

varchar(64)

smallint

Allow Null

Yes

Yes

Yes

Type Allow Null
integer No
varchar(32) No
varchar(128) Yes

The Mosart template types

Id: tt_recno

Name: tt_name

UNKNOWN

CAMERA

PACKAGE

VOICEOVER

LIVE

FULLSCREENGRAPHICS

Copyright © 2022 Vizrt
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Description
(deprecated)

Hierarchical template sets.
Specifies the base template set, if
applicable.

Non-zero (true) if the template set
shall be hidden from users (i.e.
from Mosart GUI and NCS
presentations).

Description
Primary key.

The template type name. Should
be unique, as this is presented to
the users.

Optional template type
description.

Description
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Id: tt_recno Name: tt_name Description
5 DVE
6 JINGLE
7 TELEPHONEINTERVIEW
8 ADLIBPIX
9 BREAK
10 MACRO
17 VIDEOWALL
25 CLIP
100 LOWERTHIRDS
110 OVERSHOULDERGRAPHICS
215 PLAYSOUND
216 SETSOUNDLEVEL
217 LIGHT
220 ACCESSORIES
250 SETCROSSPOINT
275 COMMAND
310 EXTERNALCOMMAND
320 TEXTTELEPROMPTER
330 CLIPDUR
331 ENDFRASE
332 STORYNR
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Id: tt_recno
333
334
335
340
350
360

999

tdfi_connection

Name: tt_hame

ATTACHA

CLIPSTART

CLIPHIRESPATH

GRAPHICSID

MARKER

TIMINGINFO

IGNORE
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Description

The table tdfi_connection which contains a list of fields (or newsroomtags) that corresponds to a
template description. See also information given in the td_templatedescription table.

This is a relation table defining a many-to-many relationship between the td_templatedescription

and fi_field tables.

Name
tdfi_recno

tdfi_td_recno

tdfi_fi_recno

tdfi_default

tdfi_em_recno

Type
integer

integer

integer

varchar(128)

integer

Allow Null

No

No

No

Yes

Yes

Copyright © 2022 Vizrt

Description
Primary key.

Foreign key referencing the
corresponding template
description td_recno in the
td_templatedescription table.

Foreign key referencing the
corresponding field fi_recno in the
fi_field table.

Optional default value for fields not
of type ENUMERATION. |.e for
STRING and NUMBER types.

Optional foreign key for the default
value for ENUMERATION field
types. Reference to a enumeration
value em_recno in the
em_enumerationmember table.
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tr_transition

The table tr_transition contains the transition types available for Mosart templates. A transition is
defined as the transition to take when taking a template (i.e. the transition from the former
template).

Name Type Allow Null Description

tr_recno integer No Primary key.

tr_name varchar(32) No The transition name.
tr_description varchar(128) Yes Optional transition description.
tr_fi_recno integer Yes Optional foreign key

referencing an input field,
fi_recno in the fi_field table.

tsp_templatesetproperties

The tsp_templatesetproperties table contains some optional gallery specific template set
properties.

Name Type Allow Null Description
tsp_recno integer No Primary key.
tsp_ga_recno integer No Foreign key referencing the

corresponding gallery ga_recno in
the ga_gallery table.

tsp_ts_recnho integer No Foreign key referencing the
corresponding template set
ts_recno in the ts_templateset
table.

tsp_recallonselect varchar(32) Yes Optional direct take to be recalled
when the template is selected in
Viz Mosart automation.

tsp_recallonunselect varchar(32) Yes Optional direct take to be recalled
when the template is unselected
in Viz Mosart automation.

tsp_recalloninitializatio = varchar(32) Yes Optional direct take to be recalled
n when a rundown is reloaded.
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Name Type Allow Null Description
tsp_recallgraphicsprofil varchar(32) Yes Optional direct take to be recalled
e when a graphics profile (or

graphics concept) is selected in
Viz Mosart automation.

Copyright © 2022 Vizrt Page 448



Viz Mosart Administrator Guide - 5.0

15 Maintenance

This section contains an overview of log configuration and maintenance procedures that may help
streamline aspects of your broadcast environment.

This section contains the following topics:

System Logging

Server Maintenance

General Advice on System Operations
Redundancy

15.1 System Logging

All logging in Viz Mosart is done through the Log Service. This service typically runs on the server
hosting the Viz Mosart Server and is accessed through Windows Services.

All applications transmit log events to the server, including Viz Mosart GUI.
There are three distinct log streams available:

- The Technical Log, which contains the normal logging from all applications.

- The As-run Log, which contains information about on-air events.

- The MOS Log, which contains information about MOS communication between NCS (MOS
based) and Manus Administrator.

& Note: For setups where several Mosart applications are installed on the same
machine and these are using their own logging service (for example, Viz Mosart Ul,
Viz Mosart Audio Player and Viz Mosart Server), if logging services do not provide
the expected results, please ensure that the Viz Mosart Server was the last
component to be installed and that Mosart Logging Service points to the Mosart
Server installation folder. This is mainly relevant if one of the log adapters supported
by Mosart is used. See section Log Adapters.

This section contains the following topics:

Log Viewer
Log File Characteristics
Log Content
Log Adapters
Configuring Logging
Starting-up a Log Adapter
- Troubleshooting Log Adapters
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15.1.1 Log Viewer

A Viz Mosart installation includes a dedicated log file viewing utility. Log Viewer is in the Viz
Mosart Server installation directory and is also available from Vizrt Support as a separate
installation package.

@ Tip: To improve filtering and visualization, the XML log files are readable in Microsoft
Excel.

15.1.2 Log File Characteristics

Location
Viz Mosart logs' default directory is:

C:\MMLogs

The technical log stream is located at the root of this directory, while the other two log
streams have their own corresponding subdirectories.

The location is configurable.

Format
All Viz Mosart logs are stored as XML files.

File Naming

Log file names are configurable, but typically follow the pattern:

{0}.{1:yyyyMMdd-hhmmss}.xml

Where:

- {0}- User configurable prefix.
Default: Log, AsRunLog and MosLog for the three logs respectively.
- {11}-File creation time. “year-month-day hour-minutes-seconds”

Current and Historical
There are two sets of log files:

- The current, active log file.
For efficiency purposes, this log is divided into two separate files; one XML file and
one log file.
- When reading the current file it is recommended to open the XML, as this contains a
reference to the corresponding log file.
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Historical log files.
When a new log file starts, the current active log is merged into a single XML. The
figure below illustrates a default setup, with a list of log files belonging to the
technical log and two directories, each containing similar log files for as-run and MOS
logs respectively.

_Mavn | Skgrre, .. | Type I Endret dato - |
F.éf] Log.20101011-101246,lag ‘ 4 kR 11,10,2010 10:29
LDg.EDlDlDll-101246.xm| 1 kK Current I 11.10.,2010 10012

fEmhLog. 20101007-101245, i 240 kB ¥ML-dokument  08.10.2010 10:12
E@hlog. 20101006-101245,xml  1,235LE WMl dobumant  07,10,2010 10:12

fEmhLog. 20101005-101244, xml <=s73 Older 06.10,2010 10:12
I5)AsRunLag RIE S 11.10,2010 10:13
[_JMosLog Filmappe 11102010 10:12

15.1.3 Log Content

Technical Log

This log contains standard log events, as produced by the running Viz Mosart Applications.

& Note: This logging includes any Viz Mosart application normally run on other host
machines, but belonging to the same control room.

Event Types
All events in the technical log stream are classified according to the event types as below:

AsRunLogger: See AsRun Log Stream.

AudioMixer: Events to/from the audio mixer.

AudioPlayer: Events from the Audio Player and messages from AV Automation to Audio
Player.

AvAutomation: General events issued from AV Automation.

ConsoleController: Used by default by GenericController. For generic console applications
(services).

Crossover: Events to/from the Crossover component.

Database: Events associated with the SNMP Service.

Generalinfo: General events not assigned to any device or application.

GPIControl: Events to/from the GPI control.

Graphics: Events related to control of graphics.

GUI: Events from the Viz Mosart GUI, such as mouse and button events.

GUILocal: Used to log messages to the local log service from the Viz Mosart GUI. This is an
extended set of local GUI events, logged to local GUI PC. Excludes pressed keys, these are
sent to the Server log.

INewsWebServices: Events associated with iNews web service.

IntegratedEngine: Events to/from the integrated engine.
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Instrumentation: Events related to the Instrumentation component in AV Automation.
LightControl: Events to/from the light control.

Loudness: Events to/from the loudness control.

ManusAdministrator: General events issued from Manus Administrator.
MediaAdministrator: General events issued from Media Administrator.
MediaAssetManagement: Used principally for the Amadeus component.
MediaRouter: Media router events.

Mimic: Events associated with Mimic functionality.

MosartRemote: Events related to remote control of Viz Mosart.
MosConnection: MOS events between MOS based NCS and Viz Mosart.
RoboticCameraControl: Events to/from the robotic camera control.
RouterControl: Events to/from the router control.

SoundFilePlayer: Events to/from the Sound File Player.

SpeakNoticer: Events associated with the Asio Speak Notifier (for Mimic).
Tally: Events to/from the tally control.

TemplateSharing: Template sharing events.

Texting: Events to/from the subtitles control.

TimeDisplay: Events associated with Timing Info display.

Timing: For Timing Display logging.

UserMessage: Logs user messages from Control Commands.
VideoServer: Events to/from the video server controllers.
VideoSwitcher: Events to/from the video switcher control.
VideoWallController: Events to/from the video wall control.

VirtualSet: Principally for BrainstormVS component.

WeatherControl: Events to/from the weather control.

Verbose Properties

All Viz Mosart Applications have a set of configuration properties to control what events are
passed to the Log Service:

Verbose:
Turns on/off verbose logging.

VerboselgnoreEvents:
A comma separated list of log event types to ignore during verbose logging.
Default: <empty> (no events are ignored).

VerbosePassEvents:
A comma separated list of log event types that are passed during verbose logging.
Default: <empty> (all events are passed).

® Example: Setting VerbosePassEvents = “VideoServer,AudioMixer?”

ensures that only verbose events to/from video servers and audio mixer are
passed to the Log Service.
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As-run Log

This log stream contains events connected to content that has been on-air, typically all video and
graphic content. The Log Service may be configured to extract information from the as-run log, for
input into media asset management or presentation automation systems. All events in the as-run
log stream are classified according to the event type, as shown below:

- CROSSPOINT: Issued as response to a crosspoint change from a tally feedback.
LOG: Issued at start and stop of logging to the as-run log stream.
NEXT_STORY: Issued when the next story element for on-air is changed.

- RUNDOWN_RELOAD: Issued when the rundown is reloaded.

- STORY_ENDED: Issued when the current story is ended.

- STORY_STARTED: Issued when the current story is started.

- TAKE_EXTERNALS: Issued when externals are taken on air.

- TAKE_ITEM: Issued when a story item is taken on air.

& Note: Customer specific as-run Log Adapters will use a unique syntax.

MOS Log

This log stream contains events communicated between a MOS-based Newsroom Control System
and Manus Administrator.

15.1.4 Log Adapters

Each log stream may be processed simultaneously by a set of log adapters as illustrated in the
figure below:

Log Streams  Log Adapters

BasicXmlFile |
Log

BasicxmiFile
AsRun

=Custom=
s BasicXmiFile |

In this example, three log streams are configured as follows:

- The Technical Log Stream has one adapter:
BasicXmlFile: A default adapter that creates XML-based log files.
- The AsRun Log Stream has two adapters:
BasicXmlFile: As above, the default adapter for creating XML-based log files.
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Custom adapter: Processes the as-run log stream according to site specific-
requirements. These adapters are custom built, and not included in the Viz Mosart
installer.

The MOS Log Stream has one adapter:
BasicXmlFile: As above.

15.1.5 Configuring Logging
You can configure log content, granularity and naming.

Configuration Files

Configuration of Log Adapters
Configuration of Log Filters
Customizing an As-run Log Adapter

Configuration Files

Each log has its own configuration file, enabling adjustment of log properties like filename, or how
often a new log file is generated.
The log configuration files are located in the following directory:

%ProgramFiles%\Mosart Medialab\Mosart Server\ConfigurationFiles

The log configuration files are named as follows:

Technical log: LogRepositoryConfig.xml.

MOS log: MosLogRepositoryConfig.xml.

This log file comprises three segments:
Adapters: Configuration of one or more log adapters.
FilterBank: Configuration of optional log filters.
Properties: Configuration of log properties.

As-run log: AsRunLogRepositoryConfig.xml.

Example of an As-run Log

A sample log configuration file for the as-run log stream:

<?xml version=”1.0” encoding=“utf-8¢ ?>

<LogRepositoryConfig>

<!- No specified adapters shall result in default adapter -->
<Adapters>

<!- Default adapter -->

<Adapter type=“BasicXmlFileAdapter® name=“AsRunLog* />

<!- Custom adapter -->

<Adapter type=“LogAdapterDRMorpheus® name=“DRMorpheus*
configuration=“DRMorpheusAsRunLogConfig.xml“ assembly=“LogAdapterDRMorpheus.dll¢ />
</Adapters>

<!-- Empty filter bank shall result in logging of all events -->
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<FilterBank>

<LogFilter event=“TAKE_ITEM“ pattern=“%“ action=“Log“ />
<LogFilter event=“LOG* pattern=“%“ action=“Ignore% />
<LogFilter event=“LOG“ pattern=“.xbreak.*“ action=“Break® />
</FilterBank>

<Properties>

<item name=“AdapterType“ value=“BasicXmlFileAdapter® />
<item name=“RepositoryPath® value=“C:\MMLogs\AsRunLog* />
<item name=“FilePrefix% value=“AsRunLog* />

<item name=“MaxDaysInRepository® value=“60% />

<item name=“MaxFileNumberOfEvents“ value=“10000% />

<item name=“MaxFileTimePeriodHours% value=%24¢% />
</Properties>

</LogRepositoryConfig>

@ Tip: For customer specific as-run log files, see section Custom-built AsRunLog Adapters.

Configuration File Properties
All configuration files have the same set of properties:

AdapterType: The default log adapter. Default: BasicXmliFileAdapter.

RepositoryPath: The directory where the log files are stored. Default: C:\MMLogs, C:
\MMLogs\AsRunLog, C:\MMLogs\MosLog.

FilePrefix: Custom file prefix for the log file names. Default: Log, AsRunLog, MosLog.
MaxDaysInRepository: Maximum number of days before the logfile is automatically deleted.
Default: 60.

MaxFileNumberOfEvents: Maximum number of log events before a new lodfile is created.
Default: 10000.

MaxFileTimePeriodHours: Maximum number of hours before a new lodfile is created.
Default: 24.

UseExtendedLogging: Logs verbosely. See example in Grass Valley K2

UselLocalTime: If set to true, all timestamps are converted from UTC to local time before
being passed to the log adapter. Default: False.

Configuration of Log Adapters

A log stream may have one, or several, log adapters. These are configured in the Adapters section
as shown in Example of an As-run Log above.
If the Adapters section is omitted, or empty, one single log adapter of the default type is created.

& mportant note: When initially configuring a new log adapter, after an installation or
upgrade, you must complete all configurations before installing and starting the Mosart
Server.

If this sequence is not observed, the log adapter will not perform as expected.
See Troubleshooting Log Adapters.
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The default log adapter type is configurable in the Properties section, but is normally set to
BasicXmlFileAdapter .

A single adapter has the following attributes:

type: The adapter type.

name: Name used for identifying the log activities associated with the adapter.
configuration: Optional configuration file for the log adapter. If no configuration file is given
the log adapter inherits the values from the current configuration file.

assembly: Optional .Net assembly (.dll) containing the log adapter. This enables dynamic log
adapters, loaded at run-time.

Configuration of Log Filters

A log adapter may have a set of filters that remove log events before they are handled by the
adapter.

If no filters are defined, or the filter bank is empty, all events pass to the event handling log
adapter.

Each filter has three attributes:

event: Which event the filter applies to. Events are listed in sections Technical Log Stream
and AsRun Log Stream. Setting this attribute to “DEFAULT" changes the settings for the
default filter bank. The default filter is used for all events that do not have a designated filter
bank.
pattern: Optional regular expression pattern that is applied to the log event value. The filter
only returns the corresponding action if the pattern returns a match. If no pattern is given,
the corresponding action is returned for all events.
action: The action to return. The following actions are available:

Ignore: The event is ignored.

Log: The event is logged (forwarded to the log adapter).

Break: The event is treated as a break event.

Example of Filtering a Technical Log Stream

<!- Empty filter bank, passes all log events -->

<FilterBank />

<!- Only passes events of type “MosConnection® -->

<FilterBank>

<LogFilter event=“DEFAULT® action=“Ignore“ />

<LogFilter event=“MosConnection®“ action=%“Log% />

</FilterBank>

<!- Passes all log events, but treats “InstantCollect® events and all Events
containing the word “break® as a break event -->

<FilterBank>

<LogFilter event=“InstantCollect“ pattern=“” action=“Break® />
<LogFilter event=“DEFAULT“ pattern=“.*break.*“ action=“Break® />
</FilterBank>
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<!- Passes all log events, but ignores all GUI events -->
<FilterBank>

<LogFilter event=“Gui“ pattern=“” action=“Ignore*“ />
</FilterBank>

Customizing an As-run Log Adapter

Customizing is performed on a site-specific basis, by Vizrt staff. Some samples are presented

below for reference.

Customization is based on the standard AsRunLogRepositoryConfig.xml as presented in Example
of an As-run Log, and then include two more configuration files that can contain elements that

override this standard configuration file.

xxxAsRunLogConfig.xml, (Overrides AsRunlogRepositoryConfig)
xxxSchedulerConfig.xml, (Overrides xxxAsRunLogConfig)

A Note: xxx is here substituted for the actual customer’s name.

Customization Example: xxxAsRunLogConfig.xml

<?xml version=”1.0% encoding=“utf-8% 7>

<LogRepositoryConfig>

<FilterBank>

<!-- Triggers all “NEXT_BREAK* events as breaks... -->

<LogFilter event=“NEXT_BREAK* pattern=%” action=“Break®“ />
<LogFilter event=“STORY_STARTED* pattern=“BREAK* action=“Break® />
<LogFilter event=“STORY_ENDED“ pattern=“BREAK“ action=“Break* />
</FilterBank>

<Properties>

<!-- Special configuration for the xxx log adapter -->
<item name=“SchedulerConfig® value=“xxxSchedulerConfig.xml* />
<!-- These values may be overridden in SchedulerConfig -->

<item name=“RepositoryPath® value=“C:\MMLOGS\AsRunLog\xxx* />
<item name=“FilePrefix“ value=“UPD% />

<!-- Set to true to use local time codes instead of UTC -->
<item name=“UselLocalTime“ value=“True“ />

<!-- Clean up command for files. Set to 0 if no cleanup -->
<item name=“MaxDaysInRepository“ value=“0“ />

</Properties>

</LogRepositoryConfig>

Customization Example: xxxSchedulerConfig.xm/

<?xml version=“1.0% encoding=“utf-8% ?>
<SchedulerConfig>
<ShowPrefix>xxx</ShowPrefix>

Copyright © 2022 Vizrt

Page 457



Viz Mosart Administrator Guide - 5.0

<FilePattern>{Name}_{Prefix}_{Date}_{DayOfWeek}_{Intimel}_{Rundown}_{StoryTitle}
_{StoryId}_{StoryIndex}</FilePattern>
<Directory>C:\MMLOGS\AsRunLog\xxx</Directory>

<Extension>xml</Extension>

<DayOfWeek>Dim, Lun,Mar,Mer,Jeu,Ven,Sam</DayOfWeek>
<!--<DayOfWeek>Dimanche,Lundi,Mardi,Mercredi,Jeudi,Vendredi,Samedi</DayOfWeek> -->

<NoLoggingDuringRehearsal>true</NoLoggingDuringRehearsal> <!-- If false, logging are
permitted during rehearsal -->

<UseAbsoluteTime>true</UseAbsoluteTime> <!-- If false, time codes are relative to
show start -->

<MinLogDelay>-1</MinLogDelay> <!-- Specifies a minimum logging delay after configured
show start (in seconds) -->

<OneFilePerStory>true</OneFilePerStory> <!-- True if a file is to be generated per
story —-->

<FlushAtStoryEnd>false</FlushAtStoryEnd> <!-- True 1if file should be flushed when
story ends. Default when show ends. -->

<IgnoreEmptyShows>true</IgnoreEmptyShows> <!-- True if file should be flushed when
story ends. Default when show ends. -->

</SchedulerConfig>

15.1.6 Starting-up a Log Adapter

After modifying or creating your log adapter as described in the sections above, you must ensure
that Mosart Logging Service is running on the machine where the Viz Mosart Ul and Viz Mosart
server are installed.

There are two alternatives:

1. Re-install (Ul) Mosart Logging Service or
2. Stop the (Ul) Mosart Logging Service and start the Mosart Logging Service as console, or
alternatively, configure to start it as as service.

15.1.7 Troubleshooting Log Adapters

Issues with log adapters usually appear in the Viz Mosart Ul with errors/warnings mentioning the
service Mosart Server Log as unavailable.

Log adapter configuration will usually be made after an initial installation or upgrade that is
introducing a requirement for a new/changed log adapter.

It is essential to wait with installation of the Mosart Server (from the installer bundle) till the
log adapter configuration is complete, and changed files saved in the C:

\ChannelTemplates folder.

If you did not observe this installation sequence, simply uninstall and re-install Mosart
Server.

Verifying Log Adapter Performance
If you have unexpected logging service events, you can check the status of a log adapter.

1. Stop Mosart Logging Service.
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2. Ensure that the affected logging configuration files, that initially reside in the Program

Files (x86)\Mosart Medialab\Mosart Server\ folder

AsRunLogRepositoryConfig.xml

LogAdapterxxxConfig.xml (here xxx is the naming of your new log adapter)
already exist in either:
- under \ProgramData\
or

- C:\ChanelTemplates folder
(but never in both places! Remove the oldest).
3. Ensure that in A sRunLogRepositoryConfig.xml, the section corresponding to your log

adapter (for example <!-- Adapter for Viz One -—- ...)

is uncommented around the config parameters.

4. Save the file if you had to make changes.

5. Open your log adapter config file (LogAdapterxxxConfig.xml) and ensure the configurations
match your system and save, if you made any changes.

6. In Program Files (x86)\Mosart Medialab\Mosart Server) , start the Mosart as-run

service, MMAsRunLogService.exe as a console.

7. In the console, check that your log adapter initialized, and that it has successfully read the
settings from the configuration file.

There is plenty of useful information in this readout. Example:
= MMLog LogStatus Logging started: Trace only

MainLogger MMAsRunLogService version=5.0.0.32224 Beta build=5.0.0.32224

MainLogger MMLogService Instansiated Mosart Log Service

AsRunLogger Initialize Initializes log service of type AsRunLogServer

AsRunLogger Initialize Configuration file: C:\ChannelTemplates\AsRunLogRepositoryConfig.xml

AsRunLogger Initialize Creating log repository of type AdapterContainer

AsRunLog XML File Log repository initialization:

AsRunLog RepositoryPath=C:\MMLogs\AsRunLog

AsRunLog MaxFileNumberOfEvents=10000 Start-up details

AsRunlLog MaxFileTimePeriodHours=2

AsRunLog MaxDaysInRepository=60

AsRunLogger Added log repository of type[BasicXml

AsRunlLog oS1

AsRunLog

AsRunlLog

AsRunLog Removes all logfi

LogAdapterStoryRecorder InltlallZE

AsRunLog Next

LogAdapterStoryRecorder ReadProperty PrerollTemplate PREROLL

LogAdapterStoryRecorder ReadProperty EdlWatchFolder: \\bgo-mos-server1\EDL\

LogAdapterStoryRecorder ReadProperty EdlLocalFolder: C:\MMLogs“\ET

LogAdapterStoryRecorder ReadProperty RecordingFolder: \\ & 34\fs@\clip.dir

LogAdapterStoryRecorder ReadProperty RecordingClipNamePrefix: SRVizrt

LogAdapterStoryRecorder ReadProperty RecordingRetentionDays: 10

LogAdapterStoryRecorder ReadProperty HandleGetSoMDelay: 2 seconds

LogAdapterStoryRecorder ReadProperty HandleTakeItemDelay: 2000 seconds

LogAdapterStoryRecorder ReadProperty SnippetGenerationRequestDelay: 15 seconds

LogAdapterStoryRecorder ReadProperty SnippetLengthForEachRecording: 00:00:05:00 seconds

LogAdapterStoryRecorder ReadProperty StoryRecorderSnippetClipsFolder: \\bgo-mos-serverl\StoryRecorderSnippef]

LogAdapterStoryRecorder ReadProperty EnableSrSe551onLngg1ng True

s

AN R N NNNE R R R R R R R e

LogAdapterStoryRecorder StartListening Listening to backup server at: bgo mos-serverl:5001
LogAdapterStoryRecorder Stop Stopped scheduled cleanup process for recordings
LogAdapterStoryRecorder Start Scheduling cleanup process for recordings r.”,.]ir.l c)
LogAdapterStoryRecorder Initialize Log adapter initialized E;
AsRunLogger Added log repository of type[lLogAdapterStoryRecorder]: LogAdapterStoryRecorder
LogAdapterStoryRecorder OnInitialize Requesting SERVER_IDLE_STATE.

AsRunlLogger Initialize Verifies service endpoint: net.tcp://localhost:8091/AsRunLog/
AsRunLogger Initialize Verifies service endpoint: net.tcp://localhost:8091/AsRunLog/mex
MainLogger MMLogService Instansiated Mosart Log Service

MainLogger Initialize Initializes log service of type LogServer

MainLogger Initialize Configuration file: C:\ChannelTemplates\LogRepositoryConfig.xml
MainLogger Initialize Creating log repository of type BasicXmlFileAdapter

MainLogger XML Flle Log rep051tory initialization:

Mainloge

verification step, close the console

B R R R R RRREROR PR R LR

('D W w W W W WW W W W WWWWWWWWWWWWWWWWWWwWwWwWwWwWwwWwwwwwwwwwwww

U\ e B B B B e B B e R e I I e e B e R e R e e I e e B e I e I e e I e e e A e A A I I A A

8. After th|
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9. Start MMAsRunLogService as a service.

15.2 Server Maintenance

This section describes various maintenance aspects of Viz Mosart, and is divided into the
following:

- Server File Structure
- Static Configurations
User Configurations
- Viz Mosart Applications and Services
Manus Administrator Repository
- Log Directory
Files for Backup
File Purging

15.2.1 Server File Structure

The Viz Mosart Server stores files in different locations on the workstation as indicated by the list
below:

Location Definition

C:\Program Files (x86)\Mosart Medialab Mosart applications. Various sub-directories for
components such as Mosart GUI, Mosart Server and
more. Either \Program Files or \Program Files
(x86).

C:\channelTemplates XML-files defining the channel templates. Normally
contains at a minimum channeltemplates.xml,
newsroomsettings.xml, AVConfig.xml.

C:\manus The Run-down (playlist) files fetched from the
Newsroom systems.

C:\MMLogs Default location for Log-files. Rotated.

C:\ProgramData\Mosart System-wide configuration settings (XML).
Medialab\ConfigurationFiles

C: User-specific application configuration files.
\Users\<USERNAMEHERE>\AppData\Local\
Mosart_Medialab
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& Note: The list above is an example and may differ for various installations and Windows
versions. See below for further details.

Static Configurations

This is configuration that is static and common to all versions of Viz Mosart installed on the
computer. Any upgrades do not overwrite any the content mentioned below but new configuration
parameters are appended if present.

Location: C:\channeltemplates.
- Type: Configuration.
Backup: Yes.
For Support: Yes.
Content:
- Video and audio setup.
Story templates.

User Configurations

This is configuration that is dependent upon the location and version of the application. Typically
under the location there is a set of directories each referring to a particular installation of a Viz
Mosart application. For example, for the Media Administrator:

%UserProfile%\Local Settings\Application
Data\Mosart_Medialab\MMConsoleAdmin_2007.exe_Url_<*>\<version number>. Any
upgrades create a new subdirectory name with the corresponding version number and do a
merge from the current version.

Location: %AppData%\Mosart_Medialab or %UserProfile%\Local Settings\Application
Data\Mosart_Medialab (i.e. for a particular non-roaming user: C:\Documents and
Settings\<User>\Local Settings\Application Data\Mosart_Medialab)

- Type: Configuration.
Backup: Yes.
For Support: Yes.
Content: Settings for all Viz Mosart Applications, for example the content of the various
settings dialogs.

Viz Mosart Applications and Services
This is the location where the Viz Mosart installers place program files.

Location: %ProgramFiles(x86)%/Mosart Medialab (i.e. for a default English language setup: C:
\Program Files(x86)\Mosart Medialab).

- Type: Applications.
Backup: Yes* - Most of the executables (.exe) files have corresponding configuration files.
Normally the content in there is static and is not changed during an upgrade. Nevertheless,
custom configuration is possible.
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For Support: No.
Content: One or several subdirectories. One for each Viz Mosart installer.

Manus Administrator Repository

The Manus Administrator repository contains all rundowns that have been loaded into Viz Mosart
from the newsroom system. All rundowns are stored in an XML format, making it possible to
extract rundown information to use for other purposes, for example video clip usage statistics.

Location: C:\manus.
- Type: Rundowns.
Backup: No* - Only for selected rundowns.
For Support: Yes.
Content: One or several subdirectories.

Log Directory
By default, log files are stored in C:\MMLogs.

Location: C:\MMLogs
- Type: Log.
Backup: No.
For Support: Yes.
Content: A set of log files from the various Viz Mosart Applications.

& Note: For support purposes, collect all log files with timestamps that cover the
period of time where an issue was discovered.

15.2.2 Files for Backup

All locations stated in Server File Structure should have a safety copy taken whenever changes are
made to the active Viz Mosart Server. It is recommended to copy files and corresponding
directories to a common share, outside Main and Backup Viz Mosart Servers, marked with Viz
Mosart version and dated when the backup was performed.

15.2.3 File Purging

The Manus Administrator Repository and the Log Directory above, have built in mechanisms for
purging files. The content of these directories grows unless a maintenance procedure is
established.

For the Manus Administrator Repository, the retention period can be configured in the Manus

Administrator by writing settings in the Manus Administrator console window, and then setting

the value ManusExpirationTime to any number of days. The default value for

ManusExpirationTime is 60 (days). If the manus files have an in-house maintenance procedure in
place, use -1 and Manus Administrator will not delete any files. 0 is not a legal value. Only xml files
auto-generated by Manus Admininstrator will be deleted.

Copyright © 2022 Vizrt Page 462



Viz Mosart Administrator Guide - 5.0

The Log Directory system is preset to a 60 days retention period, but this can be changed, see
System Logging.

15.3 General Advice On System Operations

This section contains the following topics:

Rebooting and Restarting - General Notes
Rebooting Machines

- Application Restart

- Viz Mosart Application Updates

- Windows Updates

- Viz Mosart Main/Backup Server Testing

15.3.1 Rebooting and Restarting - General Notes

All software system must be restarted occasionally. This applies to both the operating and Viz
Mosart system.

15.3.2 Rebooting Machines

The actual reboot frequency cannot be accurately determined up front, but good practice dictates
rebooting all Windows computers and servers at least once a month. Should any ill effects occur
periodically even with this monthly reboot interval, it is advised to reduce the interval to once a
week. Likewise, if there still are issues, the next step should be daily reboots. In this case, steps
should be taken to determine the problem cause.

15.3.3 Application Restart

For restart of the Viz Mosart Applications, we have not firmly stated any interval, as this depends
on the actual practice in the stations, the connected equipment and the total workflow. Just like for
system reboots, good practice dictates restarting the Viz Mosart Applications at least once a
month.

15.3.4 Viz Mosart Application Updates

Vizrt regularly provides feature and maintenance updates for Viz Mosart system

applications. Please review the associated Release Notes for each release to help with assessing
whether you should upgrade.

After an upgrade, we always recommend performing some test runs in between other transmission
schedules, focused on your mission-critical workflows.

However, if your operation is running according to your expectations, and is not dependent on the
published fixes of a specific update, or as long as you don't require the new functionality that the
update introduces, or when your servers are running in network isolation, then as long as your
system has a valid maintenance contract with Vizrt Support, there may not be a need to perform
an upgrade of your Viz Mosart system.
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15.3.5 Windows Updates

The interval for running Windows updates depends on the environment. If the computers are
accessible from other zones, both Windows and antivirus updates must be done just as any other
machine in the station’s network. Based on the possibility of antivirus runaway, it is not
recommended to run real-time virus scanning during transmissions. 24/7 stations must give this
possible issue thorough considerations.

& AV Automation Slow Start

There can be an approximately 30 second delay when starting AV Automation. This delay
is either caused by
1. The Viz Mosart SNMP service being enabled but with incorrect SNMP connection
settings.
2. A pending Windows update, queued to run.
In this case, follow the appropriate Microsoft procedure to update Windows, using
downloaded files (when you are not permitted to connect to the Internet).

15.3.6 Viz Mosart Main/Backup Server Testing

|Our recommended usage pattern is to alternate between main and backup every day, to make
sure that the vital backup server is ready to take over the day you really need it. This way, you are
continuously testing the backup function.

& Note: There can be an approximately 30 second delay when starting AV Automation. This
delay is either caused by
1. The Viz Mosart SNMP service being enabled but with incorrect SNMP connection
settings.
2. A pending Windows update, queued to run.
In this case, follow the appropriate Microsoft procedure to update Windows, using
downloaded files (when you are not permitted to connect to the Internet).

15.4 Redundancy

As all Viz Mosart applications and services are interconnected using TCP/IP, it is possible to run all
components on different computers, allowing multiple redundancy setup possibilities.

- Automation Server Mirroring
Connected GUIs
Graphical Interfaces
- AV Automation - The Engineering Interface
- Viz Mosart GUI (Operator's Interface)
Device-specific Redundancy
- Video server redundancy
- Video Switcher Backup
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Newsroom System Switch-over
Viz Mosart is based on a dual redundant server and a GUI PC configuration with dual redundant

connections (Network Teaming) to broadcast devices. The recommended redundancy setup is to
run a Main and Backup Viz Mosart Server with two workstations running the Viz Mosart GUI.

Viz Mosart GUls:

Viz Mosart servers: Server Main Server Backup
Active state Idle state

pRICes

Ay

e

Viz Mosart

An example of a recommended redundancy setup is shown schematically below (the actual
solution will depend on the characteristics of the connected devices):
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Audio Vision
Mixer Mixer
R5-422
Mosart Mosart MOXA
GUI TCPIP Server RS-422
Main Main
Mosart Mosart
GUI Server RS-422
Backup — Backup
TCP/P

IP Network (TCP/P)

Newsroom Broadcast Devices
System

The system in the example above has the following characteristics:

Dual redundant system.

- All Viz Mosart applications and services in the Viz Mosart Server suite are interconnected
and running on the same server.

Both main and backup Viz Mosart GUI applications are configured to both main and backup
Viz Mosart servers. Initially they use the main Viz Mosart Server.
Only one click is needed to instead connect them to the backup server.

- All external equipment and systems are shared between the main and backup servers.

- The vision mixer is connected using serial RS-422, with both main and standby cabling (as
the mixer supports multiple serial connections).

- The audio mixer in this example has only one serial connection. A serial/ethernet converter
(for example MOXA Terminal Server) has been used for enabling both servers to
communicate with the mixer.

- All other equipment is connected via TCP/IP on a common network. IP redundancy is
presumed on a network level through the use of Network Teaming.
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15.4.1 Automation Server Mirroring

The automation servers work in an active/idle setup, where the active server pushes the various
states to the idle server. If the active server fails, the GUI operator can manually select the idle
server, which then seamlessly takes over, becoming the active server.

In the case of a server failure, the servers operate independently of each other.

15.4.2 Connected GUIs

Viz Mosart supports an unlimited number of user interface clients. In the case of a server switch-
over, all GUI clients follow this switch-over.

15.4.3 Graphical Interfaces

Viz Mosart has two main interfaces that expose redundancy features of the system to operators:

AV Automation - The Engineering Interface

AV Automation provides connection statuses of the connected devices and enables the user to
access several functions connected to system redundancy. AV Automation runs on each of the two

automation servers.
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Viz Mosart GUI (Operator's Interface)

While the GUI primarily is for on air operation, the lower part of the interface allows the operator
to do the following:

Switch between the automation servers (while the system is on air)
Set video server salvos (for example main to backup salvo)

Switch to the mirrored video servers seamlessly

Switch to backup graphics controller.
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15.4.4 Device-specific Redundancy

Video server redundancy

Viz Mosart supports connection to unlimited amounts of video servers, configurable with the
following possibilities:

Multiple A/B ripple groups

Mirrored video playout in any group
Salvo setups for quick recalls of various video server control setups.
Vigleo server salyo sv.vitch.-ove.r is iI.Iustr.ated.bquw.

|
psk2 | psks | oscs | [T -]

Main

Switch

Graphics1: VIZ 192.168.100.100 0

Video Switcher Backup

Viz Mosart supports router control which can be used as an emergency video switcher. The system
allows the broadcaster to set crosspoints on the video router simultaneously with the video
switcher. This can be used as an emergency output at video switcher breakdown.
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Newsroom System Switch-over

Viz Mosart supports dual NRCS servers and will follow the backup switch-over mechanism of the
newsroom system.

c Viz Mosart

Main

Main
NRCS server

Backup
Automation server

Backup
NRCS server

See Also

Media Sequencer Redundancy
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16 Trio Interface

A Note: The Trio Interface is a legacy component, only retained for backward compatibility.
Please use the Overlay Graphics Interface for controlling and monitoring overlay graphics
for all Viz Mosart approved graphic engines.

The Trio Interface was used for controlling and monitoring overlay graphics for Viz Engines. It was
used with either Viz Trio or Viz Pilot, and required the use of the Media Sequencer to issue
commands to the Viz Engine.

16.1 User Interface

o)
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This section contains the following topics:
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Trio Interface Configuration
Media Sequencer Redundancy

16.2 Trio Interface Configuration

Installation
Configuration

Engines Setup Tab
Connections Setup Tab

16.2.1 Installation

For the Trio Interface to be available, you must select Vizrt when installing Mosart Server.

16.2.2 Configuration

Use the Properties menu of the Trio Interface Configuration window to access the configuration
options for the Trio Interface.

Navigate to Trio Interface > Settings > Properties.
The Properties window contains the Engines Setup tab and Connections Setup tab.

16.2.3 Engines Setup Tab

Open by navigating to Trio Interface > Settings > Properties > Engines setup tab.

(G| Properties - =

Engines setup | Connections setup

Wiz Engines
[] Use Media Router

Always Cont.

Handler name Host name Encoding Mewsroom channel alias takein TL scene Preview engine
[]|viz_backaround_a || 10.223.101.11) UTF-8 DSk 1 W
[]|viz_backaround_b ||localhost UTF-28 WALL 2 W
[ ]|viz_background_c | |localhost UTF-8 WaLL_2 3 W
[]|viz_background_d | |localhost UTF8 || TICKER 4 v
[ ]|viz_background_e | |localhost UTF-8 TICKER_Z 5 W

L3

[] Shared engines with A\Automation

]
4
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Viz Engines

- Viz Engines: Activates or deactivates connection to Viz Engines configured in the

corresponding row.

Use Media Router: Uses Media router when selected.

Handler name: Internal Media Sequencer handler name.

Host name: IP address or hostname of Viz Engine.

Encoding: Font encoding on the Viz Engine. Use UTF-8.

Newsroom channel alias: Alias provided by the NRCS for directing the lower third or video
wall element to the correct engine.

Shared engines with AVAutomation: Select when the Trio Interface and the AV Automation
are sharing play-out on the engines.

Once enabled, the Trio Interface will signal the AV Automation when there are no Viz Mosart-
controlled lower thirds on air, allowing for any cued full screen graphics controlled through
the AV Automation to re-cue.

The engine configuration must be the same in both applications.

- Always take in: Forces a take-in command to be sent.
- TL: Specifies that Transition Logic is used.

Cont. scene: Use Continue for takeout of scene-based graphics.

Preview engine: The Vizrt engine used for previewing overlays.

Shared engines with AVAutomation: This functionality has the prerequisite that the graphic
configuration in AV Automation is equal that of Viz Trio.

Viz Trio will protect the engine from being used by AV Automation when CG is active in Viz
Trio.

Shows
Shows
Dizplay name Show path VCP concept Default
# L]

Display name: The name of the show shown in the drop down list in the Viz Mosart GUIL.
Please note that when using Concept Override, this name must be identical to the Viz Pilot
concept.

Show path: Determines the Viz Trio path for the show.

A tis mandatory to configure an exclusive (non-null) value for Show path.

- VCP concept: Name of the Viz Pilot concept.

Default: Selects the row the default show for the gallery.
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Logic

- Transition Logic Configuration.
Logic
|Use Continue for take out of scene based graphics |Use Transition Logic aware take in/out commands

Take out delay |2 frames

Use Continue for take out of scene based graphics: Enable if all scene based graphics
has an out animation that can be triggered with a continue command to the Viz
Engine. Disable to force all take outs on scene based graphics to be taken out with a
cut.
Use Transition Logic aware take in/out commands: Activates the mode where Viz
Mosart reads out the Transition Logic state of all items and keeps track of whether an
item replaces another or is played back to back when checked.

- Take out delay: Delay before takeout. Default: Empty (ss:ff).

Playlist

Planylist
[] Use MOS VCP Playlist

Mosart_Crveray |Use Concept Ovemride

Use MOS VCP Playlist: Enable the Playlist check box when using Vizrt MOS items from the
newsroom system.

Playlist name: Viz Pilot Playlist on the Media Sequencer that Viz Mosart will populate with the
Vizrt MOS items.

& Note: The playlist name used here cannot be the same as used in AV Automation
Devices - Graphics > Vizrt Settings > Miscellaneous > Mos Playlist.

Use Concept override: Select this check box if your scenes have been prepared for the
Concept Override functionality in Viz Pilot 5.2 and later.

16.2.4 Connections Setup Tab

Open by navigating to Trio Interface > Settings > Properties > Connections setup tab.
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Mosart Server

Properties - =

Engines setup | Connections setup

Mosart server

Hostname | localhost

Hostname: Hostname or IP address of the computer running the Manus Administrator
application. Default: localhost.

Media Sequencer Engine
Media Sequencer Engine
Hostname |localhost Backup |localhost [] Use M5E backup

[] Stat MSE i not running

“PROGRAMFILES . \wizrt'\Viz Media Sequencer Engine‘scheduler exe

Hostname: Hostname or IP address of the primary Media Sequencer.

Backup: Hostname or IP address of the backup Media Sequencer.

Use MSE backup: Starts using the backup Media Sequencer instead of the primary
when checked.

Start MSE if not running: Attempts to start from the location described under (only
valid if the Media Sequencer is running as a console application on the same machine)
if the Media Sequencer is not running when Trio Interface is started.

Path: Determines the path to scheduler.exe in the Media Sequencer program files
folder (only if Media Sequencer is running as a console application on the same
machine).

MSE Database

MSE databasze
[ | Corfigure MSE DB settings

vizrtdb pilot pilot

Configure MSE DB settings: Updates the database settings in the Media Sequencer with the
details below if enabled.

Datasource: TNS name or connection string of the Oracle database.

User: Username on the Oracle database.

Password: Password on the Oracle database.
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Logging
Logging
Enable [] Verbose

Enable: Sends logging details to the logfile if enabled.
- Verbose: Activates verbose logging (increasing the details sent to the log) if enabled.

16.3 Maedia Sequencer Redundancy
This section describes the operation of the main/backup switching of the Media Sequencer.

Selecting the Media Sequencer
- Switching Media Sequencer from the Viz Mosart GUI

16.3.1 Selecting the Media Sequencer

It is possible to select the main or backup Media Sequencer, from Viz Mosart. See Switching
Media Sequencer from the Viz Mosart GUI.

- There may be a delay of several seconds after switching from one to the other, before the
Media Sequencer responds to Viz Mosart commands.

Configuration Alternatives

The diagrams below show the configuration and operations possibilities of the various
components in the Media Sequencer backup concept.
Gray arrows show which operations are available in each Viz Mosart module.
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16.3.2 Switching Media Sequencer from the Viz Mosart GUI

Search

. CAMERA 1

Use backup Graphics Controller?| Video server Omnecon | Directtake ver.3.6.3.18785

Switching between main and backup Media Sequencer is normally done in the Viz Mosart GUI.

To Switch Media Sequencer

- At the bottom right corner of the Viz Mosart Ul is the text: Use backup Graphic Controller.
This text is clickable and switches Viz Mosart to the backup Media Sequencer.
Once switched, a warning text on yellow background, Use main Graphics Controller visibly
alerts to the exceptional state.

During the switching process, the alarm indicators in AV Automation momentarily go red, but
return to green when the switching process is finished.

& Note: The Media Sequencer requires several seconds to initialize all parts, so it is
recommended to wait some time before continuing graphics operations.
The exact delay varies with graphics size and complexity.

Example: Configuration and Test

The sample setup below takes you through a typical configuration, and explains how to verify the
connection.
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To Configure two Media Sequencers

1. Use the fields marked in red to configure the use of two Media Sequencers; one main and
one backup.

A Note: In AV Automation, in the field MSE Host, specify the two IP addresses (one for
each Media Sequencer) separated with a semicolon (';"). In Trio Interface, there are
separate input fields for these addresses.

2. Use the check box Use MSE backup marked in blue if you want Viz Mosart to start on the
backup Media Sequencer after a restart.

MMtrio:

[ Engines setup | Connections setup
Mosart server
Hostname  localhost

Media Sequencer Engine
Hostname  192.168.97.109
[ Stat MSE # not running

Backup 192.168.97.113

@u MSE backup

AVautomation:
Device
Switcher setup | Server Setup  Graphic | Audio | Robatic Camera | Light Control | Router | Subttle Setup |

VIZRT [ UseMediaRouter [ Use Media Router for overlay graphics

" PDB @e MSE Backup
HOST andler name MSE Host E ing Enable Click

W 1 |bgo-1m203 \ |E‘IDU z_mosart_a [192.168.57.10¢ [WTF-8 v
™ 2 [192.168.97.120 [viz_background b [bgo- UTF-3 v

To Test and Debug two Media Sequencers

Both Trio Interface and AV Automation have a separate menu item that enable you to switch
each of them between the main and backup Media Sequencer.

This switching possibility is intended for testing and debugging purposes only.

It is recommended to use the main switch in the GUI instead.

A Note: The yellow background of the GUI Media Sequencer indicator only follows the setting
of the AV Automation Media Sequencer selector. The corresponding selector in Trio
Interface does not affect this indicator.
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1] MMTRIOI " ITERFAC

Use MSE backup I
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17 ActiveX

ItemEditor

Viz Mosart
Lo <] ,
|Funcspec j
CAMERS PACKAGE — Dezcription
FACKAGE CLIF name..
WOICEOWER 1 description ;I
0z 2
GRAFHICS S0T
WIDEOQ EFFECT 072 Ll
JINGLE FLILL —Transition
FPHOMNO LOOP
FLOAT ABCD
BREAK
YIDEOWALL
CG Mame “alue
SOUND clip_description  [MyClip
ACCESSORIES : - ;
COMMAND clip_hirespath ClipTest
Yerzion 3.8.1. 26384

ActiveX is used to insert Viz Mosart template information into the Newsroom System script. For
ActiveX to function correctly, some parameters are required to be set that link ActiveX content to
your Viz Mosart Server installation. ActiveX can be linked to the Viz Mosart Server either via the
Mosart Viz Mosart Template Database, or directly to the Viz Mosart Server.

A Note: invalid characters in XML 1.0 are also invalid characters when used with ActiveX and
newsroom tags. More information is available in XMI 1.0 documentation:
https://web.archive.org/web/20140228010526/http://validchar.com/d/xml10/
xml10_namestart
https://en.wikipedia.org/wiki/List_of _XML_and_HTML_character_entity_references
https://en.wikipedia.org/wiki/Valid_characters_in_XML

This section contains:

Setting up the Registry for Viz Mosart ActiveX
Connecting the ActiveX to Viz Mosart Server
ActiveX Notes
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17.1 Setting Up The Registry For Viz Mosart ActiveX

To enable ActiveX features between Viz Mosart and the NRCS, first make configuration in the Viz
Mosart machine's registry.

- Working with Viz Mosart Registry Keys
- Viz Mosart ActiveX Registry Properties
Configuring the Newsroom System

© This section assumes knowledge of, and access to the Windows Registry. Normally this
means you must run with elevated (Administrator) privileges. Always exercise extreme care
when editing the Windows registry.
It is recommended to either
- Create a Windows restore point (from the Start menu > Type create a restore point >
Create a restore point > Create or

- Create a backup of the registry with the regedit.exe application with File > Export
before you change any registry keys.

17.1.1 Working with Viz Mosart Registry Keys

Before continuing, see the Warning above.

Ascertaining Machine Architecture

Whilst the majority of machines in commercial service are 64-bit, you can rapidly verify this basic
architectural property.

To Verify 32 or 64 bit environment

- Windows 10
View the architecture with Start menu > Settings > System > About this PC.
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Windows 7
Navigate to Start menu > Control Panel > System and Security > System.

L= | i
P o il FanefSomiees s Securiny\ Sytherny v | g || Seach Contrat Bare o

o -
Caréral Fansl Home i _— .
Wiew basic infarmation about yauwr computer

¥ Dedce Masager
Wy Renile semings
# Tystem provedion

Windzwn editicn
Windawa T Frofmnicnal

Cogyigi £ 2008 Microroft Comentian, S nghts resensd,

# Acurced periem pethings Serice Pack 1
Syttem
Fating ﬂ...-.v“r sarence o
Frostsire [red{7) Eeon [F) TR U ESEN) @ 2400H: 240 GH: (3 pesessing)
staled rramary RAME 600 GB
Syremn tppe T-bn Dperating wyiem
Fan ard Touds: Mo Fan or Tawh bnpart v svsbas b dor S Digpley

Computer neme, doman, a=d seikgroup webling

Lamgutar rame bgedocmginal

B Charge esing
kol f A hip T AT, imeiral
Lo ey Sesod it Bl Ere el
Domaine vimtrtenl

Betion Cenfer

‘Windows Update Wemlgmy wothton

Ferdvrmance [nfarmatian ard I

Tozh Frodudt I0x D371 BEE-0ODOT-E500  Chasge produst key

Alternatively, run a script or the command line. The example below is a Powershell:

show architecture

if ((gwmi win32_operatingsystem | select osarchitecture).osarchitecture -eq
"64-bit") {

#64 bit logic here

Write "This PC is running a 64-bit 0S"
} else {

#32 bit logic here

Write "This PC is running a 32-bit 0S"

Modifying Registry Keys

To Browse or Change Registry Keys

From the Windows Start menu type regedit.
Registry settings for the Viz Mosart ActiveX on 32-bit machines are found under the
registry key:
HKEY_LOCAL_MACHINE/SOFTWARE/Mosart Medialab/Mosart ActiveX.
Registry settings for the Viz Mosart ActiveX on 64-bit machines (x64) are found under
the registry key:
HKEY_LOCAL_MACHINE/SOFTWARE/Wow6432Node/Mosart Medialab/Mosart ActiveX.
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17.1.2 Viz Mosart ActiveX Registry Properties

First navigate to the required keys, as described in Modifying Registry Keys above. This section
lists the keys and their values.

Mosart ActiveX Key

DefaultStudio: Optional. The entry of the studio setup in the Studios sub-key. A blank value
selects the (Default) entry.

FieldNameValuesToAbstract: Optional. A list of newsroom tags separated by colon or

semicolon used to create the content of the mosAbstract tag of a MOS object generated with
Mosart ActiveX. See also Newsroom Tags.

Example:

Here, the template type=PACKAGE and variant=1] with two newsroom tags, clip_hirespath and
clip_description:

ﬂ.

Viz Mosart

[ = .

Funcspec =

CAMERA PACKAGE [~ Description

PACKAGE CLP name...

VOICEOWER 1 descriptian =l
o3 2

GRAPHICS S0T

YIDED EFFECT S0T2 LI
JINGLE FULL — Transition

PHOMNO LOOP

FLOAT ABCD

BREAK

WIDEOWALL

CG MName Walue

SOUND clip_description

ACCESSORIES ; ; -

COMMAND clip_hirespath Wy Clip|

Werzion 3.8.1.26384

Ready Y1 Dawra  cop wom )

In the registry, FieldNameValuesToAbstract is set to clip_hirespath:
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" Registry Editor =101 %]
File Edit ‘iew Favorites Help
| Micrasoft o | | Mame Type [ Data
. Microsaft Corparation ab|(Default) REG_SZ (value nok set)
[ | Mission Critical Softvears ab|pefallrstudia REG_SZ Lah
- L Mosart Medialab e il dMamet alues Todbstrack REG_SZ clip_hirespath
-4 Elosangachizes 8| Farmattedabstract REG_DWORD 000000000 (0}
il Studios #%] GenerateUniqueChild REG_DWORD  0x00000000 (0
----- , Mosart .ﬁ.ctlﬂ_\fex Component .ﬁﬂHideﬁ.ddButtan REG DWORD  0x00000000 ()
----- | Mosart Audio Panel ab|MosId REC o7 ot
..... | Mosart Audio Player aB|Mosiersion REG_SZ
..... , Mosart GUI QE‘]SDH:X o REG_SZ
----- | Mosart Installation Administrator points —
..... | Mosart Lag Yiewer i‘_"]'-.-'erl:u:usemgging REG_SZ
----- , Mosark Server
----- J Mosart Showmaker
----- J Mosart Sound File Player

----- . Mosart Tesk Suite

- L Mozilla

- . mozila.org
- |, MozillaPlugins
- L) MyS0L AR
----- | Maotepad++

T+
sl

+H- | Muiek bl
<] | »|‘| a | ol
v

|Cu:umputer'l,HKE\"_LOC.ﬁ.L_MP.CHINE'I,SOFTW#RE'I,WDWMSZNDde'I,Musart MedialablMosart Activel

In the MOS object generated by Viz Mosart ActiveX, the tag mosAbstract contains the clip ID:

MOS object generated with Mosart ActiveX

<mos>
<ncsItem>
<item>
<itemID>0</itemID>

<objID>PACKAGE ;1</0objID>
<mosID>mosart</mosID>
<mosPlugInID>Mosart.ActiveX</mosPlugInID>
<mosItemBrowserProgID>Mosart.ActiveX</mosItemBrowserProgID>
<mosItemEditorProgID>Mosart.ActiveX</mosItemEditorProgID>
<mosAbstract>MyClip</mosAbstract>
<mosExternalMetadata>
<mosScope>PLAYLIST</mosScope>
<mosSchema>http://www.mosartmedialab.no/schema/mositem.dtd</mosSchema>
<mosPayload>
<mosarttemplate>
<type name="PACKAGE" category="">
<variants value="1" fieldtype="LIST">
<variant name="1">
<fields>
<field name="clip_description" default=""
fieldtype="TEXT" keylist="" />
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<field name="clip_hirespath" value="MyClip"
default="" fieldtype="TEXT" keylist="" />
</fields>
</variant>
</variants>
</type>
</mosarttemplate>
</mosPayload>
</mosExternalMetadata>
</item>
</ncsItem>
</mos>

If FieldNameValuesToAbstract=clip_hirespath;clip_description in the registry, and
clip_description is set to "Test"in Viz Mosart ActiveX for the same template taken as
example above, then mosAbstract is built using the value of clip_hirespath and
clip_description separated by space (<mosAbstract>MyClip Test</mosAbstract>).

If FieldNameValuesToAbstract is set to an invalid value (for example, a naming error in the
newsroom tag name), then mosAbstract tag is set to <template type> <template variant>
followed by the values of newsroom tags found on the template separated by space.
Following the example above, then mosAbstract is <mosAbstract>PACKAGE 1 MyClip Test</
mosAbstract>.

Value Descriptions

FormattedAbstract: Setting this value to 1 inserts HTML codes and newlines in the MOS
Abstract field of the MOS item. Use value 0 to have a plain format of the text from MOS
Abstract field. Optional. Valid values: 0 or 1.

- GenerateUniqueObijld: Enables (when set to 1) or disables (when setto © or blank)
generation of an unique objID for a MOS object. Set this to 1 for OpenMedia which

identifies a MOS object by objID and itemID. Optional. Valid values: 0 or 1.
HideAddButton: (Optional) Force use of only Drag&Drop functionality. When MOS-based
NCSs are used, setting to 1 hides the Add button in the Viz Mosart ActiveX and forces the
user to use Drag&Drop.
Default is 0 (false). Valid values: 0 or 1.
Mosld: This is the default MOS ID for the Viz Mosart ActiveX. For some NCSs like ENPS, no
value is required. For other NCSs like Avid iNews or Octopus, the value must be the MOS ID
as mapped in the respective NCS. See Configuring the Newsroom System below for how to
configure MOS ID in some of the NCSs.
MosVersion: Forces the Viz Mosart ActiveX to use the given version of the MOS protocol. A
version higher than 2.8 enables the Add/Apply button in the Viz Mosart ActiveX. Should be
set to 2.8.3 for all MOS-based newsroom systems, such as ENPS and OpenMedia.

- SortXpoints: For newsroom tags with a crosspoint value, specify the ordering of these
crosspoints as they appear in the drop-down menus.
By default, Viz Mosart ActiveX sorts the newsroom tags alphabetically (both in database and
channeltemplates.xml ).
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When enabled (value 1), the crosspoints are sorted based on the order in the
avconfig.xml when they were created. Optional.

Read more about newsroom tags in Other Template Functionality, section Newsroom Tags

Order .
% Viz Mosart - AVAutemation: StudioA (Funcspec)
Devices  Show  Studio setyl ;
Template properties
H' K& ‘EM 12 12
_Mic1 MiC General ] Control Command
i i ; Order the newsroom tags by rearranging the elements in the list below:
aC *Funcspec: CAMERA + BLABLACAME
xpoirt 1
File = Edit = Show - Test Template xpaint2 Up ]
Key 1 Keyfill Down
GRAFHIC /A
WIPE
0

==

-28
<hb>sahgdfjsghfsjk kh kldjhfl djk djsagdh

Requesting reconnect to ManusAdi
Connection to ManusAdmin failed:
Requesting reconnect to ManusAd
Connection to ManusAdmin failed:
Requesting reconnect to ManusAdi
Connection to ManusAdmin failed:

Verboselogging: Viz Mosart ActiveX logs using Microsoft trace mechanisms. The logging is
not written in the Viz Mosart main logs. Use Microsoft Sysinternals DebugView to monitor
the logging. When set to © or empty, only log events of type Information, Error and

Warning are logged. Setting VerboselLogging to 1 enables more elaborate logging.
Optional. Valid values: 0 or 1.

Studios Sub-key

Setting this sub-key enables configuration of a system with multiple control rooms.

Under Mosart ActiveX key select sub-key Studios.
A control room is defined by files residing in a specific folder (typically C:/

channeltemplates ) or in a database, as shown below.
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& Registry Editor =10l =l
File Edit ‘iew Favorites Help
£ | Microsoft ;I Marne | Type | Diaka

| Microsoft Carporation abiDefault) | REG_SZ C:\ChannelTemplates

| Mission Critical Software iﬁ]Lab REG_SZ Ctichannelternplates_lab

. Mosart Medialab b Test REG_57 WBGO-MOSART-MAIN| ChannelTemplates

« 1 Mosark Activex

i | Studios

----- . Mosart ActiveX Component

----- . Mosart Audio Panel

----- . Mosart dudio Player

----- . Masark GUI

----- . Mosart Installation Administrator
----- . Masart Log Yiewer

----- . Mosart Server

----- . Mosart Showmaker
----- . Mosart Sound File Player
----- Maosark Tesk Suite
- | Mozilla
B | mozilla.org
B | MozillaPlugins
B MySOL AB
----- . Motepad++
B MuGet -
<] I_>I_I J| | i3
|Com|:|uter'|,HKE‘."_LOCP.L_M.C\CHINE'|,SOFTW.D.RE'l,WDw6432NDde'|,MDsart MedialabiMosart ActiveriStudios i

The DefaultStudio option on the Mosart ActiveX key tells which control room to use by default or
set this as blank and configure the (Default) option on the Studios key:

On the Viz Mosart ActiveX page, two drop-down boxes can be found. The first one is a list of
control rooms as configured in the Studios sub-key from registry:
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temeditor |
Viz Mosart
| = \
Lak
Test 1 | [~ Description
JINGLE 2 | | Kamera1
%0 K] K.amera 1 ;I
EKSTERM 4
GRAFIE g
DVE 5 =~
YIDEOBOKS 7 —Transition
TELEFOM a
ADLIBFIA 10
COMNTIMUITY 11
kG 15
LYD 25
TELEMETRICS 35
KOk ANDO 45
53 b
ES
75
as
BREAKER
HvID -
Yerzion 3.8.1.26384

In this example, three sample control rooms are configured in Studios sub-key:

blank item (default control room)
Lab

- Test.
These items all be shown in the first drop-down box. Since DefaultStudio registry key was
set to blank, Viz Mosart ActiveX opens with blank item selected in the first drop-down box
and thus pointing to the control room whose configuration files can be found in the Viz
Mosart folder C:\ChannelTemplates .

17.1.3 Configuring the Newsroom System
Additional settings on the NRCS side. Here we describe configuration of:

- AP ENPS
- Avid iNEWS

AP ENPS

Configuring ENPS for Viz Mosart ActiveX

The following configuration applies to AP ENPS version 8.0+.

Copyright © 2022 Vizrt Page 489



Viz Mosart Administrator Guide - 5.0

Each Viz Mosart MOS device (the MOS identification of a Viz Mosart MOS connection- see
mosID property from Manus Administrator Configuration/ Settings Editor - MOS) needs the
following properties set in the MOS Configuration section from ENPS System Maintenance
application to be able to use Viz Mosart ActiveX in ENPS client:

[T System Maintenance =101 x|
=7
= 12:26:11
¥ Settings _
Home ¥
Intemnet Qutput Accounts
Description * i ActiveX Program Default Sattings MOS Version | Local DragDrop * |
Services
et e row
Wieb Search Engines DOC.GW.MOS @ DocTradummy  10.211.112.52 DOCTRA 28
Language Resources DOC. TRAINING.MOS @l DocTra Pilot Edge ENPSHTMLHost DOCTRA URL=http:/fbgodocengine:8177/appfpilctedge  2.8.4
Local Media FTP MOSART.LBU.MOS I Mesart@LBU 10.211.114.4 Mosart. ActiveX MOSART Studio=Test 281 off
MOSART.LBUMOSLAP  [I  Meosart@LBULAP  10.211.110.129 Maosart. ActiveX MOSART 2.84 off
MOS Configuration [
MOSART.MAS.MOS M Mosart@MAS 10.211.114.156  Mosart.ActiveX MOSART 284 off
Global Configuration Cptians _
MOSART.MHLMOS M Mosart@MHI 1021111426 MosartActiveX MOSART 284 off
MAC Addresses MOSART.OVAMOS M Mosart@OVA 10.211.114.18 Masart. ActiveX MOSART 281 off
System Fields OBE M OBEGWS 10.211.111.16 VCPAxFiller VCPTemplateFiller OBE 238
ENPS Fields OsH [l OSHGWS 10.211.111.6 VCPAXFiller VCPTemplateFiller OsH 28
RC-RHEL 0 rerhel 172.31.200.77 RHEL 283
Relational Databasa
VIZAX.MOS M Filot News 10.211.112.37  VCPAxFiller VCPTemplateFiller VIZRT 28 u
Security _
VIZPEMOS 0 Filot Edge ENPSHTMLHost VIZRT URL=http:{/bgo-eddie-vm.vizttintemal:8177/a... 2.84 |
Servers Kl ] 3
t
Gravps Required Ficlds
Staft Save Cancel

Colum Value
n
hame

Descri  Gives the Mosart ActiveX name in ENPS client.
ption

Active Mosart.ActiveX.
X

Default Blank or Studio=Studio name where “Studio name” is one of the studios defined in the
Setting Studios registry key above.

> If blank, the value of the DefaultStudion key attribute is used to open Viz Mosart
ActiveX with the given studio name selected in the first drop-down box .
If Studio option is given, Viz Mosart ActiveX opens with the given studio name selected
in the first drop-down box (in our example is "Test"). Note that DefaultStudio setting
from registry is ignored.

Local Off.

DragDr

op
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To open Mosart ActiveX from ENPS

- To open Mosart ActiveX from ENPS client:
Right-click on the MOS icon (bottom right) > Select the Mosart ActiveX (the name configured
in MOS Configuration, in this example Mosart@LBU).

If several Viz Mosart MOS devices are configured, any will open Viz Mosart ActiveX.

See the Viz Mosart User Guide, section Viz Mosart ActiveX under Mosart User Interface, for further
details of operator actions.

MOS FTP Status

Set default media control »
Sanity Check
Filot Edge

Pilot Mews

0O5H GWS

OBE GW 5
Mosart@Owva
Maosart@MHI
Mosart@MAS
Mosarb@LBEULAP
MaosartaLBU
DaocTra Pilot Edge

Open default [)

@ A A oA M S

Avid iNEWS

Always consult with the INEWS administrator before modifying these configurations.
Configuring iNews for Viz Mosart ActiveX

1. Set the Mosld in the registry needs to be set to the same value defined in the SYSTEM.MOS-
MAP rundown which can be opened from iNEWS client as any rundown.
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A user must have administrator privileges to access the SYSTEM.MOS-MAP rundown :

[IM3PEVRA]SY STER MO S- RSP hADS-RALR

Directery | project | SLUG Audio |CREATED |MoDIFED E
SHE |G B EEEE 20.09.2001 17:23:44 21.01.2018 16:0703 ||
[0 SHOWS
=+ SYSTEM
[l *HELP
[l AccounT
-0 AVID
~[7ff CAPTURE
G-C0) CLIENT
[l COLORS
-7 COMFIGURE < =
[l DBLINES 2LUG -
-7 DIALOGS
[+ DISTRIBUTION MOS-MAP
&-C7) FORMS ; |
g Z;SOUPS Ief-\udlo ”CREATED ”MODIFIED IIEIY v
< >
g ixi:gpw THUMNDER thunder =
- KEYBOARDS DEKO deka _
&7 LISTS ; mullpt\e calumbgs engine playout. This
-0 MALL : nextline for Omnilbus configured for
(il map : requires 1.41 client ar higher
[l MESSAGE : MOSID MOSGWHOSTNAME CH1 CH2 CH3
[ MOs-Map MOSGATE gamosgw chsl chs2 chsl
[} POST-TO-WEB PILOT pilat
-] PROPERTIES x:g AX MO pilot
WIZ
g EE?SUTECSEEARCH Ll RFEWIZ reviz
-] SCRIPT-TEMPLATES EIEA%OCSasn\fngS
~[7ff] SEARCHTAPE
-3l sEEK MOSARTMOS test
[l sER¥ICE _|I| DPEKOMOS dekomos
3| SHREDDER TweDKCLIP te2dkclip
&3 SITE camioserver KALYTEST
[ sPELL gvg.acnauroraplay.mos auroraclip
-0 STYLES WizOPUS 1a.mos guickey
[} TITLE-ENTRY || ORAD mos ORAD mos
[ TRAHSFER = DY ORAD mos D OFRAD mos "

2. The first value (MOSARTMOS) is the MOS ID that is

izOME mos VizOME mos

registry. The value is case-insensitive.

configured in the Viz Mosart ActiveX

@' Registry Editor

(=5 R )

File Edit View Favorites Help
b1 LogMelnine || Name Type Data
: bl Macromedia ab) (Default) REG_SZ (value not se
3 St W . 2F| DefaultStudio REG_SZ
mrj:i;"dpm”t Eerypdon ab| FieldNameValuesToAbstract REG_SZ
# : ! FormattedAbstract REG_DWORD 000000000 (
s~ Microsoft Corporation ; )
2l Mosart Medialab GenerateUniqueObjld REG_DWORD 000000000 (i
2+ Mo At e HideAddButton REG_DWORD 000000000
LB Studios :‘}_’ REG_SZ mosartmos
----- Mosart ActiveX Component "_E\!MUSVE“W” REG_SZ
----- Mosart Audio Panel ab|SortXpoints REG_SZ
----- , Mosart Audic Player ﬁ'—’\!""EbeSELUQQiHQ REG_SZ
----- , Mosart GUI
----- Muosart Installation Administrator
----- Maosart Log Viewer |=
-----  Mosart Server =
----- ) Mosart Sound File Player
----- Maosart Test Suite
, Mezilla
o , mozilla.org
b -1 MozillaPlugins b | (EEF ] | 3
Computer\HKEY_LOCAL MACHINE\SOFTWARE\Wowb432Node\Maosart Medialab\Mosart ActiveX
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3. The second value set in iINEWS SYSTEM.MOS-MAP (test) is used when adding the MOS object

into a story script as a grommet command:

Kl ]
PAGE MOSACTIVE DIRECTTAKE DT Mosart Type  Mosart Vari
Audio  TAL SLUG CAM SHOT FORMAT  GRAPHICS R
L [T L Ll I o
MODIFIED: MODEY:  EDITOR WRITER VID-D  CH  STATUS TAPE#
| 18.01 2018 15:04:00|[laura I | I [ I
Jl | i
“test CAMERA 1 )

o CAP HUM y

To open Mosart ActiveX from iNews

To open Viz Mosart ActiveX from iNEWS client, go to Tools > Plugins > Mosart Item Editor.

See the Viz Mosart User Guide, section Viz Mosart ActiveX under Mosart User Interface, for further

details of operator actions.

Troubleshooting

If you get an error message when dragging graphics/video or composite elements to iNews

rundown:
a

ew GoTo Story

Show XML {o be Ingested:

|

ESECIE
FEREERERE

VIDEO</0bjType:

<objTyps iType>
<createdBy>Plot Edge </createdsy>

<mosPluginiD>Pilot Edge</mosPluginiD>
<objpaths>

P |erapuics [cu

<objProxyPath techDescription="image jpeg"

QRQNGy | 171/

<objproxypath

“video/mp4'

</objpaths>

<mosID>PILOT</mosID>

<mosExternalMetadata>
<mosScope>PLAYLIST</mosScope>

<mosPavload>

Ensure that ShowActiveXLaunch is set to No.

—

Ghor rommr  d

CH

I

(When ShowActiveXLaunch is set to Yes, xml-related messages appear when dragging and

dropping elements to the rundown).
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SLUG CREATED MODIFIED
MOS-MAP |;;.‘ 2001 _‘:;-5::;:-||..5 2/2022 13

ShowActiveXLaunch = No
supdateliming = ves
TABLE-START DeviceTable
3SONY  sonyem

;SONY2  sonyem2

;SONY3  sonyem3

THUNDER thunder

PRSP [ T Y U T ———

@ Tip: More iNEWS MOS-mapping descriptions here, in Avid's knowledge base.

17.2 Connecting The ActiveX To Viz Mosart Server
There are two ways to link the ActiveX to your Viz Mosart Server installation:

Connecting the ActiveX Directly to Viz Mosart Server via folder sharing
Connecting the ActiveX to Viz Mosart Server via Template Database

17.2.1 Connecting the ActiveX Directly to Viz Mosart Server via folder
sharing
This method is for connecting the ActiveX directly to Viz Mosart Server.

1. Enable folder sharing of C:\ChannelTemplates on the Main Viz Mosart Server. Give read only
access to this folder to the appropriate users.

2. Configure the DefaultStudio registry value to be blank.

i !
i Registry Editor Elﬂlg
Eile Edit View Favorites Help
- Macromedia = [ Mame Type Data
- m'”““hf: b E ab] (Default) REG_SZ  (value not set)
4-d '”:‘1’t :pl.?:: PRI Octuitstudio REG_SZ
B D: . v %4 FormattedAbstract  REG_D..  0x00000000 (0)
: e ) Studies
5 : . ab| hMaosld REG_SZ MOSART
- ) MozillaPlugins
= MySOL AB &7
1| 1] | ¥ 1| 1] [ 3
Computer\HEKEY_LOCAL MACHINE\SOFTWARE\Mosart Medialab\Mosart ActiveX

A

3. Edit the (Default) entry in the Studios key and insert the path to the ChannelTemplates folder
you enabled sharing. For example, \mosart_main_server\ChannelTemplates.
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i h
&Y Registry Editor E@g
File Edit View Favorites Help
4- | Mosart Medialab | Mame Type Data
i : Mmartﬁdwex w i?itDefault] REG_5Z ‘“\mosart_main_server\ChannelTemplates
: : [l Studios I g e
+ - 1 MozillaPlugins
> - 0 MySQLAB
-, MVIDIA Corporation
I » - . QDBC 5
1 | m [ 1| m | 3
i Computer\HKEY_LOCAL MACHIME\SOFTWARE\Mosart Medialab'Mosart ActiveX)\Studios

L5 -
4. Export the now complete ActiveX registry entry and deploy this file using your deployment
tools for other workstations that require the ActiveX.

17.2.2 Connecting the ActiveX to Viz Mosart Server via Template
Database
This method is for connecting the ActiveX to Template Database.

1. Aread only database user is recommended for access from the ActiveX.
2. Configure the DefaultStudio registry value to be blank.

i ™y
i Registry Editor EM

Eile Edit View Favorites Help

- ; Macromedia = [ Mame Type Data
> Microsoft E ab] (Default) REG_SZ  (value not set)

- M”‘h:rt M:?::bex L oetautstudio REG_SZ
;4T VoSart AL t4 FormattedAbstract  REG_D.. 000000000 (0)

b | Studios
‘ . i ab| hMaosld REG_5Z MOSART
- ) MozillaPlugins
- - L) MySOL AR i
1| 1] | ¥ 1| 1] [ 3

Computer\HEKEY_LOCAL MACHINE\SOFTWARE\Mosart Medialab\Mosart ActiveX

L% A
3. Edit the (Default) entry in the Studios key and insert the connection string for Template
Database.

Type=Database;ProviderName=MySql.Data.MySqlClient;server=1localhost;Use

r Id=root;database=mosarttemplatedb
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Q Registry Editor

Eile Edit View Favorites Help

4 1

. Microsoft
. Microsoft Corporation
- MimarSinan

Muosart Medialab

- Muosart ActiveX

e L Studios

. Mosart ActiveX Componer ™

"

Name Type Data

REG_SZ Type=Database;ProviderName=My5ql.Data.MySqlClient; se

Fl 1 3

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Wowb432Node\Mosart Medialab\Mosart Activel\Studios

“

The connection string of the database contains the following fields:

Name

Type

ProviderName

Server
User Id

Password

Database

Gallery

UseSharedAvConfig

& ADO.Net Driver

Value
Database.

The qualified name for the .NET Component used for
database access. Currently on
MySql.Data.MySqlClient is provided in the installer.

IP-address or hostname of the database server.
User ID of the database

Optional. The password for the User ID to the
database.

The SQL database name on the database server.

Optional. Name of gallery to be addressed within the
database. Also extracts private galleries for that
gallery.

For selecting the source of the AvConfig file.

True: Build the AvConfig file from the shared
settings instead of the one stored for the gallery.
Example connection string:
Type=Database;ProviderName=MySql.Data.MySqlClie
nt;server=localhost;User
ld=activex;password=activex;database=mosarttempl
atedb;UseSharedAvConfig=true.

False: Use the template database.

For the Active X component to connect to a template database, an ADO.NET driver is
needed to be installed on each client. The driver can be downloaded from https://
dev.mysql.com/downloads/connector/net/.
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& Caching ChannelTemplates files

The Viz Mosart ActiveX stores a cached version of the ChannelTemplate files
(channeltemplates.xml, newsroomsettings.xml and avconfig.xml) in the system’s TEMP
folder: %localappdata%/Temp/Mosart Medialab/ChannelTemplates (Note the space
character!). This is done for both type of connections described above.

Changes are only downloaded if the timestamps on these files differ.

Deleting the cache folder forces Viz Mosart ActiveX to get the latest configuration files
from database or from the shared folder.

17.3 ActiveX Notes

ActiveX stores a cached version of ChannelTemplates in the system %Temp folder. Changes are
only copied if the cached ChannelTemplates time stamp differs to that of the Viz Mosart Server or

Template Database.

A forced refresh of ActiveX can be done by opening and closing the ActiveX twice within the host
application.
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18 General Configuration Files

This section contains:

Named Overlay Graphics

18.1 Named Overlay Graphics

Named CGs is a functionality allowing CGs (or overlay graphics) to be fired from within a template
or via a control command (keyboard shortcut). All named CGs are placed within the file
NamedOverlayGraphics.xml.

This section contains:

Named CGs (Named Overlay Graphics)
NCS Placeholders
Named CG Actions
- Required Fields in XML
- Adding the Named CG to a Template
- Obtaining a valid overlay graphics as a Named Overlay Candidate

18.1.1 Named CGs (Named Overlay Graphics)

Use of Named CGs

Named CGs is a functionality allowing CGs (or overlay graphics) to be fired from within a template
or via a control command (keyboard shortcut). These CGs are to be treated as constants but has
the ability to extract information from the current rundown.

Prerequisites

All named CGs must be placed within a single XML file named NamedOverlayGraphics.xml. This
file must be placed as part of the configuration files for the system, for example C:
\ChannelTemplates.

NamedOverlayGraphics.xml contains all CGs to be accessible from templates.
The CGs within this file have the following properties:

- The “slug” attribute is used as the ‘name’ of the CG (i.e. used in templates to refer to the
CG).

- The content of each CG shall be identical to the CG representation in Manus Administrator
files. In most circumstances only a small set of the attributes and elements are necessary.

- The “templatetype” attribute is used to identify the behaviour of the CG and should be
according to the lowerthird mapping found in newsroomtags.xml. Default mapping is
AUTOOUT.
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Setting “templatetype” to “STORYSTART” takes the corresponding CG on story transitions
(i.e. when the first item or background of the story is taken). Only one CG could be used for
this purpose.

NamedOverlayGraphics.xml Example

Below is an example showing two named CGs. One to be fired at every story transition
(MosartStoryStart) and one that could be triggered from a template (StrapsOff).

This example is created for BIGVIZ which makes use only of the <objParams> field.

<?xml version=”1.0” encoding="utf-8” 7>
<items>
<!--CG used to inform BigViz about story start -->
<item slug=“MosartStoryStart” templatetype=“STORYSTART” in=%0” dur=%25”
mosid=“BIGTED.W1.BBC.MOS” objid=“BIGTED”>
<content>
<storyItem>
<objParams>MOSART STORY START</objParams>
</storyItem>
</content>
</item>
<!--CG used to inform BigViz to take all CGs off air -->
<item slug=%“StrapsOff” templatetype=“AUTOOUT-DSK” in=%0” dur=%25”
mosid=“BIGTED.W1.BBC.MOS” objid=“BIGTED”>
<content>
<storyItem>
<objParams>STRAPS OFF</objParams>
</storyItem>
</content>
</item>
</items>

18.1.2 NCS Placeholders

Named CGs supports placeholders for NCS information. The following example shows a modified
“MosartStoryStart” Named CG making use of placeholders:
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<item slug=“MosartStoryStart” templatetype=“STORYSTART” in=%0” dur=%25”
mosid=“BIGTED.W1l.BBC.MOS” objid=“BIGTED”>
<content>
<storyItem>
<roID>{story:roid}</roID>
<storyID>{story:id}</storyID>
<storySlug>{story:slug}</storySlug>
<objParams>MOSART STORY START</objParams>
</storyItem>
</content>
</item>

Syntax: {[story|item]:[story_value|item_value|xpath]}
Where:

story: Obtains information from the current story:

roid: MOS rundown identity.

id: MOS story identity.

slug: MOS story slug.

xpath: Arbitrary xpath from Manus Administrator story element.
item: Obtains information from the current story item:

roid: MOS rundown identity.

id: MOS story identity.

slug: MOS story slug.

type: Viz Mosart type.

variant: Viz Mosart variant.

template: Viz Mosart type + Viz Mosart variant.

xpath: Arbitrary xpath from Manus Administrator story item element.

Examples of valid placeholders

{story:roid}: The rundown identity.

{story:id}: MOS story identity.

{story:slug}: MOS story slug.

{item:type}: MOS story item, Viz Mosart template type.

{item:variant}: MOS story item, Viz Mosart template variant.

{item:template}: MOS story item, Viz Mosart template type+variant.

{item:@templatetype}: xpath, Viz Mosart template variant.
{item:item[@type=100][1]/*/storyltem/objParams}: xpath, pics legend from first lowerthird
object within a story item.

18.1.3 Named CG Actions

It is possible to trigger defined actions within Overlay Graphics Interface when taking a Named CG.
The actions are specified within an action list of the CG. A typical reason for using such actions is
when the graphics systems require special graphics to be sent for taking out items.

A sample action list is defined in the XML as follows:
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<item slug=“LOGO OFF” templatetype=“AUTOOUT-DSK” in=%0” dur=¢%12” >
<actions>
<action name="takeOut” value=”[last]lastLocator]|lastManual” />
<action name="clear” />
</actions>
<content>
</content>
</item>

The following actions are available:

takeout: Takes out any stored On Air graphics matching the criteria specified in the value
field:

last: Takes the last taken graphics out.

lastLocator: Takes the last locator graphics out.

lastManual: Takes the last manual graphics out.
clear: Takes out all On Air graphics.

& Note: Named CG actions do not work with Trio Interface.

18.1.4 Required Fields in XML

Example of complete lower third graphics XML

Below is an example graphics XML extracted from a running order:

<item type="100" slug="In:00:00/LIVE// Mosart=L|00:00|B" source="1" index="100_NWATVN
T1;P_ATVNEWSWF_HOLD MOSART
TRAINING;AFD78EF5-3D19-48F1-860BBO9B2B53A679F_NWATVNT1;P_ATVNEWSWF_HOLD MOSART
TRAININGR_AFD78EF5-3D19-48F1-860BB9B2B53A679F ;21115F3E-B25A-46AD-89620E63F8077CCF_2"
idref="2" templatetype="BACKGROUNDEND-DSK" status="0" error="0" in="0" dur="500" pin="
0" pdur="500" rdur="0" externaleffect="" dntimeline="true" date_0="" accessory="False
" static="false" endfrase="" rundown="NWATVNT1;P_ATVNEWS\W\F_HOLD MOSART
TRAINING;AFD78EF5-3D19-48F1-860BB9B2B53A679F" storyid="NWATVNT1;P_ATVNEWS\W\F_HOLD
MOSART TRAINING\R_AFD78EF5-3D19-48F1-860BB9B2B53A679F;21115F3E-
B25A-46AD-89620E63F8077CCF" typetext="" mosid="PILOT.ATV.TEN.MOS" objid="1863809"
ismoselement="true" use_graphics_id="true" graphics_id="1863809" handler_name="DSK"
graphics_out_on="BACKGROUNDEND" description="(DSK) - In:00:00/LIVE// Mosart=L|00:00 |
B" owner="">
<fields>

<field name="graphics_description" fieldtype="TEXT" value="In:00:00/LIVE//
Mosart=L|00:00|B" />

<field name="graphics_id" fieldtype="TEXT" value="1863809" />

<field name="tc_dur" fieldtype="TIMECODE" -inputmask="mm:ss" default="00:00"
value="00:20" />

<field name="continuecount" value="-1" fieldtype="TEXT" />

<field name="tc_in" fieldtype="TIMECODE" inputmask="mm:ss" default="00:00" value="
00:00" />
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</fields>
</item>
Required fields: slug, templatetype, in, dur, use_graphics_id, graphics_id,

handler_name, graphics_out_on, description.

Extracted XML example

The required fields extracted look like this, please note that the slug and description have
changed:

<items>
<!--LIVE ON -->

<item slug="LIVE ON" in="0" dur="125" use_graphics_id="true" graphics_1id="1863809
" handler_name="DSK" graphics_out_on="BACKGROUNDEND" description="(DSK) - LIVE ON"/>
</items>

For the above example the name used to recall the Named CG is “LIVE ON”.

18.1.5 Adding the Named CG to a Template

SLUG is where we name the overlay for our use - and we can now recall the super from a template
as shown below:

W Command On Take | Control commands Take
Command Value Parameter

p LU IENECGIENT -~ | TAKE_NAMED_OVERLAY +| LIVEON

OVERLAY_GRAPHICS ll TAKE_NAMED_G‘-."ERLA‘F:I LOGO BUGON

18.1.6 Obtaining a valid overlay graphics as a Named Overlay
Candidate

A tip to obtain candidates for named overlays is as follows:

1. Forward the graphics you want to be part of named overlay as ordinary overlay graphics (i.e.
by assigning them in the NRCS). Mosart now reads these as part of overlays in a rundown.

2. Verify that the named overlay candidates appear in OverlayGraphics in the left column. All
active overlay graphics in the rundown appears here.

3. Select a named overlay candidate in the OverlayGraphics left column and press the
Info button below.

4. Now you see the XML representation of that particular overlay candidate. Copy this XML to
the clipboard.

5. Paste the content of the clipboard into the named overlay XML file, C:
\ChannelTemplates\NamedOverlayGraphics.xml.

6. Optionally, remove not required fields as described in the former section Required fields in
XML.
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19 Appendix

This section covers the following topics:

- Avid iNews Web Service for Status Feedback
- GPIO Sample XML Config

- Jupiter Systems PixelNet Video Wall Control
- Stagetec Driver Configuration

- Structure of MOS objects sent to NRCS

19.1 Avid INews Web Service For Status Feedback

This section shows how to set up and use Viz Mosart with Avid iNews Web Services in order to get
stories status updates in the NCS. This section covers the following topics:

- Terminology
Introduction
- Configuration
- API Session Limits
- Configuration in Viz Mosart Manus Administrator
- Configuration Unrelated to iNews Web Service
- Configuration in AvidlnewsWebServiceConfig.xml
- Operation
- Status for Stories Containing More Than One Item
- Status of an Off-air Story Containing Multiple Clips
- Troubleshooting and Known Issues
Not able to access Web Service page after installation
“No sessions available on X” - Maximum session
“Cannot write to iNews Webservice, connect before selectQueue”
- Cannot get any status feedback in iNews
- Avid iNews Web Service Installation
- Checking the Current Version of Tomcat
Useful Links

19.1.1 Terminology

NCS Newsroom Computer System (also "NRCS")
JRE Java Runtime Environment

MOS Protocol Media Object Server Protocol

FTP File Transfer Protocol
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Manus Admin MMManusAdministrator. Application controlling the Viz
Mosart Rundown.

GUlI Viz Mosart GUI. Main user control application

19.1.2 Introduction

Avid iNews Web Service can be configured with Viz Mosart connected to iNews through FTP. The
purpose is mainly to send status for stories that contain clips (Online/Offline for clip availability,
Cued, Play or Stop), but the system can also be configured to send status for all types of events
(Cameras, DVEs etc.).

19.1.3 Configuration

1. Open iNews client and add the Avid iNews Web Service version in first story of rundown
SYSTEM.CLIENT.API-VERSIONS.
The version number should match the version of Avid iNews web service you are running
(see section Checking the Current Version of Tomcat).
For example:

sweb services
1.0.0.182

1.1.1.49

; run offline; configure -n; online after doing changes in iNews server console
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2. On the iNews server console, execute the following commands one by one:

offline, configure -n and online.
Brevs | o MO e s S s o« SRS s

File Edit View GoTo Story Format Tools Communicate Window Project Help
= 1

[Bl[&]v[8][a] w[alEe] |

o] | =

[IN3PSVVM]SYSTEM.CLIENT API-VERSIONS.api-versions X

Directory | Project |sLuG | Audio sLuG
= SYSTEM [«]l| [epi-versions | ‘ api-versions

2o

£ cLENT T :
[Tl API-VERSIONS
{1 com web services
(il COMMUNITY-VERSIONS [} 1.0.0.182
il msTmveT 11149
- 3| MOBILE-IDS - 1121
- {i! MOBILE-VERSIONS 16.05
[l REMOTE-SEARCH
il VERSIONS
[ WEB-VERSIONS
- coLors
[#{°] CONFIGURE
(il DBLINES
i) £ DIALOGS
#1-{7] DISTRIBUTION
[#-{C] FORMS =« m -

Ready B AP NUM LI 4
=

3. Enable Refresh for the rundown used for receiving status updates.

Click on the rundown name, choose Properties/User Interface.

Queue Properties E]
[IN3PSVVM]SHOW MOSART TEST
| Forms | Groups I Maintain
User Interface | Interplay Server I Locks
Preview Lines
Inverted Batch Allowed
Sequential Prirtable
Refresh () Corfirm Edit
Watch Appends () Text Timing Clocks
[ Moritored
| Copy From Template |
| ok | | cancel |

& Note: From iNews Setup and Configuration Guide: Use the Refresh trait only on
important queues, like rundown queues that are often modified by multiple users
simultaneously.

To automatically refresh a queue, your system must spend a lot of time monitoring
workstations where users are viewing that queue.

Assigning the refresh trait to too many queues that are often accessed at the same
time greatly increases the amount of work your system has to do and may severely
degrade its overall performance.
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4. Make sure the Status (field type “event-status”) and Air-Date (field type “air-date”) fields are
added in the story form.

fudn|PAGE| TAL [suG | camlsHoT|FoRuar  |creprics | cH|wioin EETATEY| Rean|zoT. | ToralasckTvg] oo| appRoviER DATE
il ] T e 3@ Die s 36H 15 16 30 53
= 53 OFFLIME (00 008 0 CILCN s (RER IR ]
| L EFT JoHuME o6 008 06 by BENES 164011
i8] S2new 000 000 MO s SIS 125713
o+ AlZN} CUED DM 000 R4 Lwa I3 114200
=3 AlT4 o6 000 6 | lawa | 19T 13219
=5 03 000 03
a7 20 OFFLME 014 000 D14
B =5 ADNT  OMUME D01 000 0O
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API Session Limits

Maximum API-session connections to iNews Server

The default licence for Avid iNews Web Service is for five concurrent API- sessions.
These are not the same as the iNews workstation licenses.

Type "/exc/list type=api c" at the INEWS server to see the number configured.

Additional concurrent API-session licence is available from Avid.

Viz Mosart will use a maximum of two API-sessions (in a redundancy setup).

If you experience issues with no available API-session, please see section Troubleshooting
and Known Issues.
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Configuration in Viz Mosart Manus Administrator

From the Manus Admin Console, type settings and configure the following parameters:
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InewsWebServiceConnectionString
Leave the field blank if you do not wish to connect to any web service.

The connection string must be given in the format:
attribute_1=value_1;attribute_2=value_2;...attribute_n=value_n
Required attributes are:
WebServiceServer (host:port). Only the host can be provided if the default port (8080)
is used.
iNewsServer Only one iNews server can be used by the WebService, specify which
iNews server the WebService should connect through. This field is optional if only one
iNews server is set in the iNews Configuration.

Optional attributes are:

iNewsUsername Optional as it can be taken from iNews Configuration.
iNewsPassword Optional as it can be taken from iNews Configuration.
UseltemStatusToNCS (default: false)

Set to true to update clip status (Online/Offline etc.) when Media Administrator is
running.

IgnoreSendCueStatustoNCSforOfflineClips
If True, first story does not get Cued for Offline clips if timeline is running.
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Configuration Unrelated to iNews Web Service

IgnoreUpdateslifNoChanges (default: false)

If enabled, stories with no relevant changes will not be processed by Viz Mosart. This is to
avoid issues with story updates from GUI to be ignored. Later changes in Viz Mosart iNews
Web Services API prevented such problems, but for future changes is good to keep in mind
this setting together with StoryComparelgnoreAttributes which is explained below.

- StoryComparelgnoreAttributes (default: empty)
List of xml attributes to ignore during comparison. Default set to [date_0, date_1,
timestamp] .

When Viz Mosart receives a story in NSML format, it will parse the story and create its own
XML format. When irrelevant updates comes from NCS, some attributes in the Viz Mosart
XML story are updated. Currently these are date_0, date_1 and timestamp (see the format of
a Viz Mosart XML story in any xml file in C:\manus folder). Attribute date_0 was recently
added to the default attributes to be ignored due to the problems with updates caused by
Viz Mosart iNews Web Services.

In future if other attributes cause such issues, than they can be added to the list of
attributes to be ignored.

RefreshMediaOnNCSUpdate (default: false)

If enabled, it forces updating clips when story is changed in NCS. This is an old setting
introduced before Viz Mosart iNews Web Services.

KeepStoryStatusOnNcsUpdate (default: false)

If enabled, will keep the story status on an NCS update, thus keeping the on-air status. The
content of the story will be updated, but the story will be gray in the Mosart GUI. This is also
an old setting introduced before Viz Mosart iNews Web Services.

Configuration in AvidlnewsWebServiceConfig.xml

Copy the configuration file from in Mosart Installation folder\Mosart Server\ConfigurationFiles to
the ChannelTemplates folder on C:\.

- SendUpdateStatusForAllltems (default: false)
By default, only status of items containing clips will be sent (Online/Offline/Cued/Play/Stop).
Not only clips given through Package or Voiceover are taken into consideration, but also
Adlibpix or other ways to insert clip into a story. So for example if a story contains a
Camera and an Adlibpix, than the story gets status.

- ClearStatusWhenReload (default: false)
If enabled, only status column is cleared on reload of the rundown. This is to avoid
inconsistent status if, for example, stories failed to be updated because of a crash of Viz
Mosart or iNews or Viz Mosart is closed while rundown is playing etc.

- ClearStatusWhenUnload (default: false)
If enabled, the status will be cleared when rundown is unloaded.
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Set to false to disable setting the AIR-DATE field and moving the "aired line" (the blue line).
Note that the color of the line can be changed from Tools/Options/Colors in the iNews client
and choose “Aired” from drop-down box. By default this is blue.

ClearAirDateWhenReload (default: false)

If enabled, the air-date field will be cleared during reload of the rundown (empty status).

Note that this setting is taken into consideration only if SetStoryAirDate is true.

ClearAirDateWhenUnload (default: false)

If enabled, the air-date field will be cleared during unload of the rundown (empty status).

Note that this setting is taken into consideration only if SetStoryAirDate is true.

Color index attributes

The following parameters are colour index referring to values defined in SYSTEM.COLORS on

the iNews system.

The AIR-DATE field needs to be empty in order to see the correct color for the STATUS field:

Urgencylndex (default 1)

UrgencylndexONLINE (default 1) - set color for Online status
UrgencylndexOFFLINE (default 4 - purple) - set color for Offline status

UrgencylndexCUED (default 2 - green) - set color for Cued status

UrgencylndexPLAY (default 3 - yellow) - set color for Play status

UrgencylndexSTOP (default 1) - set color for Stop status

Audio [PAGE|TAL [SLUG  |cAM|SHOT|FORMAT |GRAPHICS [CH|vIDID  |STATUS |READ|SOT: |[TOTA|AIR-DATE -
] 51 STOP 000 000 000
I 52 A1200  [PEAV j000 000 000
B 53 Invalid CUED 000 000 000
|| 54 ONLINE 000 000 000
| Testl 000 000 000
|| Test4 A1500 ONLINE 000 000 000
El Story2 Invalidd  ONLINE 014 000 014
= Testh Invalidb 0:.00 000 000
| Test2 A1200 ONLINE 000 000 000
| Test3 Invalid 0:00 000 000
| Story3 Invalid2 011 000 oM =
|| Story1 Invalidl 000 000 000
| Story16 000 000 000
|| Story15 200K 0:00 000 0:00
|| Start A1200 ONLINE 000 000 000
= Story4 0:05 0:00 0:05
N Storys A101 o0 o000 000
|| Story7 Invalidd ~ OFFLINE 001 000 oM
| Story8 0.00 000 0:00
| ] Story9d A400 ONLINE 008 000 008
| Story10 001 000 o
|| Story11 0.00 000 000
| Story12 001 000 001
|| Stary13 ONLINE 000 000 000
| Story14 0:00 000 000
|| Cameras 005 000 005
| Packages A0 013 000 013
|| Voiceovers A0 009 000 009
Live 002 000 002
] Fullerraen n 014 00 014 =
4 mn 2
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LockFormSectionOnly (default: true)

If true will issue a lock on the FORM section of a story, if false will lock the complete story.
Heartbeatinterval (default: 3 seconds)

Interval to check Avid Web Service heartbeat.

UpdateStoriesCachelnterval (default: 1 second)

RetryStoryUpdateStatusinterval (default: 5 seconds)

When a story failed to be updated (either because the story is locked for editing, the
WebService is down or the iNews server is down), an error message will be displayed in
console.

The retrial to update the story status will continue until the problem is fixed or Manus
Admin is closed.

NoOfStoriesToGet (default: 50) - number of stories to get from iNews for caching

Operation

When the connection to the Avid Web Service is successful the following message will appear in
Manus Admin console: <iNews Web Services <host:port> connected>.
The connection will be made after loading a rundown in the GUL.

# ° Maosart ManusAdministrator 3.4.0.0 |ﬂ|&]

Build 3.4.8.8 1816812 -
RemotePanelServiceConnected MosartRemoteService
AC19-12-2013 B9 :45 45 ><{ServerStarted >version><{B>{1016812 >
<Inews ftp server iz 172_.168.134_130>

MEWSROOMSETTINGS = c:channeltemplates“newsroomsettings.xml
Manus Directory is cismanus

loading avConfigFile File

loading ChannelTemplates File

Current Studiosetup is KRLY

settings

<ClipAdministrator Connected P

IdleMode set to: False

m

iNeu {localhost:18088> connected. >
SITE FORMAT=Znsml.

< Inews ftpzerveril1?2_168_.134_.130> connectedX>{>
MCEStatus set iMews 192.168.134.138 True

Clearing media cache

Unreferencing all clips in media cache <item count=8>
Engqueuing purge of media cache in B8:88:18

Initialize manus

Clearing media cache

Unreferencing all clips in media cache <(item count=8>
NClearing user peference sections for all clips in media cache <item count=8>
<A-U Automation disconnected pi ]

L &

The following statuses will be shown in iNews:
Cued, Play, Stop, Online and Offline.

& Note: Offline status also will be assigned for a clip that is to be cued but will fail cuing.

Users can move stories in iNews up or down. If rundown is on-air and user has been changed a
position of On-Air or Next stories statuses of clips will be changed also according its statuses.
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& Note: If an iNews story with status OFFLINE due to "cue failed" is moved in the iNews
playlist (even if it will be the Next story), it will be still OFFLINE and the status should stay
as OFFLINE. Check iNews server settings (MCS dictionary located at /site/dict/mcs) to
translate the statuses shown in iNews client to local statuses.

& Note: No status will be sent for overlays.

The table below shows an example of status behavior when SendUpdateStatusForAllltems is
enabled and disabled. ClearStatusWhenReload should be set to true to clean up old history. Last
line in the table below means that after the story has been run but the rundown is still on-air, the
clip is no longer monitored, so if the clip subsequently becomes available or unavailable, this will
NOT be reflected in iNEWS. Only after the rundown will be reloaded, clip status will be updated.If
SendUpdateStatusForAllltems is false the whole column for “Story without video clips” will be
cleared, i.e. no status will be sent for these stories.

Operational Status

Time sequence Story with video Story without video clips Story without video
clips (SendUpdateStatusForAll clips
Items = true) (SendUpdateStatusForAll

Items = false)

Before On air ONLINE/OFFLINE

Next story CUED CUED
Story On air PLAY PLAY
SForyjust taken Off  STOP STOP
air

Sfcory has been On STOP STOP
air

Air-date is also updated to the NCS if the parameter SetStoryAirDate is set to true in the
AvidlnewsWebServiceConfig.xml file. When the parameter for SendUpdateStatusForAllltems is false,
only air-date for stories that do not contain any clips will be updated.

Below are three examples of status behavior:
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Abobe, the rundown is off-air. Stories S2, S3 and S4 were updated with status of the clip it
contains.

@ s 11 s s

File Edit View GoTo Story Format Tools Communicste Window Project Help
-@ ‘ Rundown Show Studio setups TemplateTest Graphics profiles Standby Mosart3
Ele@e] | =
e OSART.TEST.S1 oot
Directory | project SLUG  [sTATUS |AIR-DATE VID-D 11:36:40 00:35  00:14 _
ST PN | =5 ] 19/12/2013 11:36:40
39 roos 52 CUED 08/12/2013 16:40:00 11:36:54 00:00 [N
E g:‘w s3 ONLINE 04/12/2013 11:4201 CLIPG s2
& 6m 54 ONLINE 08/12/2013 16:40:11 ABD 11:36:54 :
£ 10pm S5 09/12/2013 11:40:29 5
{3 11PM 852 19/11/201310:32.19 All4 = -
il vivEo-D S6 11:37:08 00:05 SOV -
oo MO omne 20
& pusiro-ac—| | |58 ONLINE A_D01 11:37:13 00:00 -1 BOX CG(] FS4 1
& mosaar = 2
i TEST S0
[ MORTEN 1
B s12
[/ TOrRBIOR 513
- (1) ANTON
- [ cecLLIE s
- [ PAL s15
- s S16
{1 DEVICES s17
g g‘gf s18 ONLINE A_002
E 519 ONLINE A_003
- [ MADS2 520 A_004
3/ GUNNAR s21 116
i/ LAURA 22
O Ecn2
£ TEsT 523 oo
) MORTEN Break
7 RoGER S04 OFFLINE A3
| ) svsTEM LAl | OFFLINE
| £ wiRES = |s2e OFFLINE A3
[ i

Ready

Above, the rundown is on-air. Story S1 is currently playing, but the status was not sent to NCS.
Since S2 contains a clip, its status is set to “Cued”.
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File Edit View GoTo Story Format Tools Communicate Window Project Help
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Rundown Show  Studio setups TemplateTest  Graphics profiles

00:30

D0:00 HJANIM EAM
S2

00:26

Standby Mosart3

00:00:33

11:58:59 00:14 WELAVED
S3

11:59:13 00:05 |[SOTVD

54
00:00 “ 11 BOXCG(] Fs4 16,

11:59:18
55,

In the illustration above, Story S2 is playing and S3 is “Cued”. Since the first item in S3 is a camera
the “Cued” status is not sent unless SendUpdateStatusForAllltems is set to true.

w  Project Help
él.f}" | (el allallo]le
|=

H| SLUG [vipio [ sTaTus |[d
STORTI hadal  STOP
STORY2 thaded | STOP
STORY3 thadad  PLAY
| R Jthadad |CLED
STORY4 thadah | OFFLINE
STORYE thadsf | OFFLINE

17:43:42 2837 (000
174342
LTORYS

174342 (e i)

174342 (ke i)

il

STORYG u

Above, Story 3 is now playing and Story 5 is “Cued”. Clip thada5 for Story 4 is broken and will be

failed during cuing
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SLUG VID-D |STAT

STORY1 thadal STOP

STORY2 thada2 STOP
STORY3 thada3 STOP
STORYS thada3 PLAY
STORY4 thada5 OFFLIN
[ETORY6 |thada6  OFFLIN |

SITURY 2

STORY3

STORYS

11:32:55

STORY4

STORY®
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5 00 thada3

00:00

And finally, Story 5 is playing and clip from Story 4 should be cued. Zebra stripes in GUI showed
the problem and Story 4 marked as Offline in iNews

Status for Stories Containing More Than One Item

If a story has more than one items the following statuses are sent when the story is on-air

(remember that if SendUpdateStatusForAllltems is false the status is not sent if the story does not

contain clips):

Play for first item, Cued for next item => thus the story status will be Cued (regardless of

SendUpdateStatusForAllltems value)
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Above illustrates when the first item (camera) in S3 is playing no “Play” status is sent. The Next
item is a Package so “Cued” status is sent. In this case, even if SendUpdateStatusForAllltems is
true, the “Cued” status will still be sent for the story.

When F12 is pressed Stop is sent for the first item, Play for the second item and Cued for the
third item => thus the story end-up with Cued status (regardless of
SendUpdateStatusForAllltems value)
And this will go on until we reach the last item in the story.
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It is only the last item that will send the status Play. At any time it is possible to check the
Air-Date to identify the story currently on-air.

Continuing this example (2 screenshots below), the story S3 has only two items, a Camera and a
Package. When we play the clip in the Package, the story will get Play status.

The Package from S3 is playing, this is the last item in the story so “Play” status is set. Story S4 will
get “Cued” because it contains a clip.
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Search

Story S4 containing only a clip is playing. No “Cued” status has been sent for next story since
SendUpdateStatusForAllltems is set to false.
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Example 2

Story S5 is playing and since the story does not contain any clips no status will be seen for this

unless SendUpdateStatusForAllltems is set to true.
Only the “Air-Date” field shows that this story is on-air.
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Example 3

Play status could not be sent for story S4.
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When Viz Mosart is doing the updates it locks the form of the story or the entire story depending
on the value for LockFormSectionOnly parameter and unlocks the story after the update is
performed. If the story form is locked by an iNews user a message in Manus Admin console will be
shown to warn the user that the status could not be sent because the story form is locked. Once
the story form is unlocked, the status is updated (see Example 4 ).
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Example 4
Story S4 is now unlocked in iNews and “Play” status has been sent.
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If the timeline is not running and the first story is floated, you may have to reload the rundown in
GUl in order to set Cued status for the new first story.
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Status of an Off-air Story Containing Multiple Clips
The status of an off-air story that contains more than one clip is given by the first clip in the story.

Consider the following example: a story with VID-ID set and containing two clip items. First clip
item has id given by the VID-ID field and it’s an Online clip. Second clip item is given an id, for
example, through clip_hirespath attribute (Mosart ActiveX) and it is an Offline clip. The story will
have the status depending on the availability of the first clip (see Figure 16), i.e. Online. If the
position of the clips is changed, then the first clip will get 2 IDs, the one from VID-ID and the one
given through Mosart ActiveX. The id given through Mosart ActiveX will give the status of the
story, i.e. Offline.

|| | ) L : ==

[

P e

L0: 1807

Story S2 gets the status of the first clip.
19.1.4 Troubleshooting and Known Issues

Not able to access Web Service page after installation

If you have problems accessing the Web Services page after installation and deployment (http://
<server>:8080/inewswebservice/services), try to delete the Tomcat cache as follow:

1. Stop the Tomcat service.

2. Delete folder Tomcat installation\webapps\inewswebservice (only the folder, not the war
file). You may replace the war file, for example, with a new one when upgrading. (This
solution is same as deploying from Tomcat manager).

3. Delete folder Tomcat installation\work\Catalina\localhost\inewswebservice

4. Start Tomcat service and try again to access the Web Services page.
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“No sessions available on X’ - Maximum session

If the following error is shown in Manus’s console or the log:
“No sessions available on X7,

where X is the iNews server IP address or hostname,

refer to the section API Session Limits.

If this is not the case, then most probably the problem occurred because Manus Admin console
failed to release the occupied api-session to connect to iNews server through Avid Web Services
when this was closed.

Workaround: there are two solutions for this problem. Either restart Apache Tomcat Service or
reduce the session timeout in Tomcat to 1 min so that this will free up the api-session after 1 min
since Manus was closed. If Manus is closed and opened more than maximum api-sessions allowed
in 1 min, it will reconnect automatically to Web Service after 1 min when at least one session has
been released.

To change the session timeout interval do the following:

1. Stop tomcat service.
2. Change Tomcat session timeout interval in Tomcat installation/conf/web.xml to 1 min:
<session-config>
<session-timeout>1</session-timeout>
</session-config>
3. Start tomcat service.

“Cannot write to iNews Webservice, connect before selectQueue”

If you get the error message “cannot write to iNews Webservice, connect before selectQueue” you
should check that the version of Web Service running corresponds with the version set in iNews.
See section Checking the Current Version of Tomcat.

Cannot get any status feedback in iNews

If after setting up everything as described in the document no status is written in the Status field,
check the following:

The Status field has write permissions for the user used to connect Viz Mosart to the iNews
system.
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- The type of the Status field is “event-status”
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- The queue must not be monitored with the iNews Monitor tool

Avid iNews Web Service Installation
Supported Avid iNews Web Service is 1.6.0.5 or later.

Tested by Viz Mosart with Windows 7, Java 1.7 and Tomcat 6.0.37.
Tested by Avid with Windows Server 2008 R2 SP1, Java 1.7.0_07 and Tomcat 7.0.32.

Refer also to the documentation that comes with Avid iNews Web Service installation package.

1. Download and install the latest JRE, available from oracle.com (Windows offline (64-bit)).

2. Run the executable JRE installation file (e.g. jre-7u7-windows-x64.exe)

3. Download and install the latest stable Tomcat version, available from tomcat.apache.org
(32bit/64-bit windows service installer). Recommended tested versions.

4. Run the executable Tomcat installation file (e.g. apache-tomcat-7.0.32.exe)

1. Select “Normal” installation type.
2. Create a Tomcat Administrator login user name and password (Do not call the user tomcat!).
3. Select the JRE installation path if it is not already selected (e.g. C:\Program Files\Java\jre7).

Allow C:\Program Files\Apache Software Foundation\Tomcat 7.0\bin\Tomcat7.exe through
the Windows Firewall.
After the Tomcat installation is finished and has started the Tomcat management page
should be available at http://<server>:8080/manager/html.

- To login on the Tomcat management page, user name and password were defined during
Tomcat installation at step 4. b.
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- The default connector port can be modified in Tomcat’s .\conf\server.xml file.

Thus if port 8080 is used by other applications, this can be changed in Tomcat Installation/config/
server.xml file:

<Connector port="8080" protocol="HTTP/1.1" connectionTimeout="20000"
redirectPort="8443" />

Tomcat Service must be restarted after port changed from Services.msc or from Start/All
Programs/Apache Tomcat/Monitor Tomcat. An icon will be created in the Windows Taskbar. When
right clicking on the icon, a list will pop up with actions to start and stop Tomcat service.

f—

Deploy inews web service.war

- After deployment, the iNews Web Service should be available at http://<server>:8080/

inewswebservice/services.

Note: If you have problems accessing the Web Services page (http://<server>:8080/
inewswebservice/services), try deleting Tomcat cache by following the four steps below.

. Stop the Tomcat service.

Delete folder Tomcat installation\webapps\inewswebservice (only the folder, not the war
file).

You may replace the war file, for example, with a new one when upgrading. (This solution is
same as deploying from Tomcat manager).

Delete folder Tomcat installation\work\Catalina\localhost\inewswebservice

Start Tomcat service and try again to access the Web Services page.

Note: Config files for Tomcat are found here: C:\Program Files\Apache Software
Foundation\Tomcat 8.5\conf.

Checking the Current Version of Tomcat

- Go to the Apache Tomcat installation folder /webapps/inewswebservice/META-INF and open

Manifest.mf.

- Check the Implementation-version. This version number should be identical the version

number specified in the Note above.

C:\Program Files\Apache Software Foundation\Tomcat
8.5\webapps\inewswebservice\META-INF
Recommended version is 1.6.0.5 or later.

It should look like this:

Manifest-Version: 1.0

Ant-Version: Apache Ant 1.7.0

Created-By: 24.0-b49 (Oracle Corporation)

Implementation-Build: MSN_INEWS_WEB_SERVICE_1.6.0.5

Copyright © 2022 Vizrt Page 521



Viz Mosart Administrator Guide - 5.0

Implementation-Title: Avid iNEWS Web Service
Implementation-Version: 1.6.0.5
Implementation-Vendor: Avid Technology, Inc.

Copyright: Copyright (c) 2009-2013 Avid Technology, Inc.

Useful Links

http://tomcat.apache.org/whichversion.html
http://java.com/en/download/index.jsp

iNews Mos Gateway Installation and Operations Manual v2.6.0
iNews Mos Gateway v4.0 ReadMe

iNews v4.5 Setup and Configuration Guide

Introduction to iNews Workstation

19.2 GPIO Sample XML Config

Working configuration from Viz Mosart Lab 1in Bergen, October 2014
<?xml version="1.0" encoding="IS0-8859-1"?>
<l==
V2.30, Aug 1 2013, 12:55:23
-—>
<jo-Digitall2x12.3>
<Config>
<Device>
<Text>
<DeviceName>WEBIO-<wutl></DeviceName>
<DeviceText> From the terminal block directly to the network </
DeviceText>
<Location></Location>
<Contact></Contact>
</Text>
<Time_Date>
<TimeZone>
<UTCoffset>01:00</UTCoffset>
<Enable>
<Apply_Time_Zone>ON</Apply_Time_Zone>
</Enable>
<Summertime>
<UTCoffset>02:00</UTCoffset>
<Enable>
<Apply_Summertime>ON</Apply_Summertime>
</Enable>
<Start>
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<Month>
<January>0FF</January>
<February>0FF</February>
<March>0N</March>
<April>OFF</April>
<May>OFF</May>
<June>0FF</June>
<July>OFF</July>
<August>0OFF</August>
<September>0FF</September>
<October>0FF</October>
<November>0FF</November>
<December>0FF</December>

</Month>

<Mode>
<first>0FF</first>
<second>0FF</second>
<third>0FF</third>
<fourth>0FF</fourth>
<last>ON</last>

</Mode>

<Weekday>
<Sunday>ON</Sunday>
<Monday>0FF</Monday>
<Tuesday>OFF</Tuesday>
<Wednesday>0FF</Wednesday>
<Thursday>0FF</Thursday>
<Friday>0OFF</Friday>
<Saturday>0FF</Saturday>

</Weekday>

<Time>02:00</Time>

</Start>
<Stop>

<Month>
<January>0FF</January>
<February>0FF</February>
<March>0FF</March>
<April>OFF</April>
<May>OFF</May>
<June>0FF</June>
<July>OFF</July>
<August>0OFF</August>
<September>0FF</September>
<October>0ON</October>
<November>0FF</November>
<December>0FF</December>

</Month>

<Mode>
<first>0FF</first>
<second>0FF</second>
<third>0FF</third>
<fourth>0FF</fourth>
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<last>ON</last>
</Mode>
<Weekday>
<Sunday>ON</Sunday>
<Monday>0FF</Monday>
<Tuesday>O0OFF</Tuesday>
<Wednesday>0FF</Wednesday>
<Thursday>0FF</Thursday>
<Friday>0OFF</Friday>
<Saturday>OFF</Saturday>
</Weekday>
<Time>03:00</Time>
</Stop>
</Summertime>
</TimeZone>
<TimeServer>
<UTCServerl>de.pool.ntp.org</UTCServerl>
<UTCServer2>europe.pool.ntp.org</UTCServer2>
<SyncTime>0</SyncTime>
<Enable>
<Apply_TimeServer>0FF</Apply_TimeServer>
</Enable>
</TimeServer>
<DeviceClock>
<Time>15:56</Time>
<Day>01</Day>
<Month>01</Month>
<Year>2004</Year>
</DeviceClock>
</Time_Date>
<BasicSettings>
<Network>
<IP_Addr>10.211.114.124</IP_Addr>
<Subnet_Mask>255.255.255.00</Subnet_Mask>
<Gateway>10.211.114.01</Gateway>
<BOOTPClient>
<STATIC>ON</STATIC>
<BOOTP_enable>0FF</BOOTP_enable>
<DHCP_enable>0FF</DHCP_enable>
</BOOTPClient>
<DnsServerl></DnsServerl>
<DnsServer2></DnsServer2>
<KeepAliveTime>00</KeepAliveTime>
</Network>
<HTTP_Set>
<Startup>
<index.htm>0ON</index.htm>
<home.htm>0FF</home.htm>
<user.htm>0FF</user.htm>
</Startup>
<Enable>
<GET_Header_enable>0FF</GET_Header_enable>
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<GET_HTTP_enable>0FF</GET_HTTP_enable>
</Enable>
<_HTTP_Port>80</_HTTP_Port>
<InputTrigger>
<Input_0>ON</Input_0>
<Input_1>ON</Input_1>
<Input_2>ON</Input_2>
<Input_3>ON</Input_3>
<Input_4>0ON</Input_4>
<Input_5>0ON</Input_5>
<Input_6>0ON</Input_6>
<Input_7>ON</Input_7>
<Input_8>0ON</Input_8>
<Input_9>0ON</Input_9>
<Input_10>ON</Input_10>
<Input_11>ON</Input_11>
</InputTrigger>
</HTTP_Set>
<HTTP_Client>
<HTTP_Client>
<HTTP_Client_enable>0FF</HTTP_Client_enable>
</HTTP_Client>
<Enable>
<GET_Header_enable>0FF</GET_Header_enable>
<GET_HTTP_enable>0FF</GET_HTTP_enable>
</Enable>
<LocalPort>AUTO</LocalPort>
<ServerPort></ServerPort>
<Server_IP_Addr></Server_IP_Addr>
<ServerUrl></ServerUrl>
<InactiveTimeout></InactiveTimeout>
<InputTrigger>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputTrigger>
<Timer_Cron></Timer_Cron>
</HTTP_Client>
<Mail>
<Name>Web-IO 12xDigital</Name>
<ReplyAddr>Web-I0O@no.reply</ReplyAddr>
<MailServer></MailServer>
<Authentication>
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<_SMTP_authentication_off>ON</_SMTP_authentication_off>
<_ESMTP>OFF</_ESMTP>
<_SMTP_after_POP3>0FF</_SMTP_after_POP3>
</Authentication>
<User></User>
<Password></Password>
<POP3_Server></POP3_Server>
<Enable>
<Mail_enable>0FF</Mail_enable>
</Enable>
</Mail>
<SNMP>
<Community_String_Read></Community_String_Read>
<Community_String_Read_Write></Community_String_Read_Write>
<Manager_IP></Manager_IP>
<SystemTraps>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>
<Diag_Messages>0FF</Diag_Messages>
</SystemTraps>
<Enable>
<SNMP_enable>0ON</SNMP_enable>
</Enable>
</SNMP>
<UDP>
<Port>42279</Port>
<RemotePort></RemotePort>
<Enable>
<UDP_enable>0FF</UDP_enable>
</Enable>
</UDP>
<Syslog>
<SyslogServerIP></SyslogServerIP>
<SyslogServerPort>514</SyslogServerPort>
<SystemMessages>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>
<Diag_Messages>0FF</Diag_Messages>
</SystemMessages>
<Enable>
<System_Messages_enable>0FF</System_Messages_enable>
</Enable>
</Syslog>
<FTP>
<FtpServerIP></FtpServerIP>
<FtpControlPort>21</FtpControlPort>
<User></User>
<Password></Password>
<FtpAccount></FtpAccount>
<Options>
<PASV>OFF</PASV>
</Options>
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<Enable>
<FTP_enable>0FF</FTP_enable>
</Enable>
</FTP>
<Binaryl>
<OperationMode>
<TCP_Server>0ON</TCP_Server>
<TCP_Client>0FF</TCP_Client>
<UDP_Peer>0FF</UDP_Peer>
</OperationMode>
<Enable>
<Enable_BINARY_1>ON</Enable_BINARY_1>
</Enable>
<TcpServerl>
<LocalPort>49153</LocalPort>
<Client_HTTP_Port>80</Client_HTTP_Port>
<InputTrigger>
<Input_0>ON</Input_0>
<Input_1>ON</Input_1>
<Input_2>ON</Input_2>
<Input_3>ON</Input_3>
<Input_4>0ON</Input_4>
<Input_5>0ON</Input_5>
<Input_6>0ON</Input_6>
<Input_7>ON</Input_7>
<Input_8>0ON</Input_8>
<Input_9>0ON</Input_9>
<Input_10>ON</Input_10>
<Input_11>ON</Input_11>
</InputTrigger>
<ApplicationModel>
<Socket_device>ON</Socket_device>
<Compatible_50xxx>0FF</Compatible_50xxx>
<Box2Box_Slave>0FF</Box2Box_Slave>
<OPC_Device>0FF</0OPC_Device>
</ApplicationModel>
</TcpServerl>
<TcpClientl>
<LocalPort>AUTO</LocalPort>
<ServerPort>49153</ServerPort>
<Server_HTTP_Port>80</Server_HTTP_Port>
<Server_IP_Addr></Server_IP_Addr>
<ServerPassword></ServerPassword>
<InactiveTimeout>30</InactiveTimeout>
<InputTrigger>
<Input_0>ON</Input_0>
<Input_1>ON</Input_1>
<Input_2>ON</Input_2>
<Input_3>ON</Input_3>
<Input_4>0ON</Input_4>
<Input_5>0ON</Input_5>
<Input_6>0ON</Input_6>
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<Input_7>ON</Input_7>
<Input_8>0ON</Input_8>
<Input_9>0ON</Input_9>
<Input_10>ON</Input_10>
<Input_11>ON</Input_11>
</InputTrigger>
<Interval></Interval>
<ApplicationMode2>
<Socket_device>ON</Socket_device>
<Compatible_50xxx>0FF</Compatible_50xxx>
<Box2Box_Master>0FF</Box2Box_Master>
<ILOface>OFF</ILOface>
</ApplicationMode2>
</TcpClientl>
<UdpPeer1>
<LocalPort>45889</LocalPort>
<RemotePort>45889</RemotePort>
<Remote_IP_Addr></Remote_IP_Addr>
<InputTrigger>
<Input_0>ON</Input_0>
<Input_1>ON</Input_1>
<Input_2>ON</Input_2>
<Input_3>ON</Input_3>
<Input_4>0ON</Input_4>
<Input_5>0ON</Input_5>
<Input_6>0ON</Input_6>
<Input_7>ON</Input_7>
<Input_8>0ON</Input_8>
<Input_9>0ON</Input_9>
<Input_10>ON</Input_10>
<Input_11>ON</Input_11>
</InputTrigger>
<Interval></Interval>
<ApplicationMode3>
<Socket_device>ON</Socket_device>
<Compatible_50xxx>0FF</Compatible_50xxx>
</ApplicationMode3>
</UdpPeerl>
</Binaryl>
<Binary2>
<OperationMode>
<TCP_Server>0ON</TCP_Server>
<TCP_Client>0FF</TCP_Client>
<UDP_Peer>0FF</UDP_Peer>
</OperationMode>
<Enable>
<Enable_BINARY_2>ON</Enable_BINARY_2>
</Enable>
<TcpServer2>
<LocalPort>49154</LocalPort>
<Client_HTTP_Port>80</Client_HTTP_Port>
<InputTrigger>

Copyright © 2022 Vizrt Page 528



Viz Mosart Administrator Guide - 5.0

<Input_0>ON</Input_0>
<Input_1>ON</Input_1>
<Input_2>ON</Input_2>
<Input_3>ON</Input_3>
<Input_4>0ON</Input_4>
<Input_5>0ON</Input_5>
<Input_6>0ON</Input_6>
<Input_7>ON</Input_7>
<Input_8>0ON</Input_8>
<Input_9>0ON</Input_9>
<Input_10>ON</Input_10>
<Input_11>ON</Input_11>
</InputTrigger>
<ApplicationModel>
<Socket_device>ON</Socket_device>
<Compatible_50xxx>0FF</Compatible_50xxx>
<Box2Box_Slave>0FF</Box2Box_Slave>
<OPC_Device>0FF</0OPC_Device>
</ApplicationModel>
</TcpServer2>
<TcpClient2>
<LocalPort>AUTO</LocalPort>
<ServerPort>49154</ServerPort>
<Server_HTTP_Port>80</Server_HTTP_Port>
<Server_IP_Addr></Server_IP_Addr>
<ServerPassword></ServerPassword>
<InactiveTimeout>30</InactiveTimeout>
<InputTrigger>
<Input_0>ON</Input_0>
<Input_1>ON</Input_1>
<Input_2>ON</Input_2>
<Input_3>ON</Input_3>
<Input_4>0ON</Input_4>
<Input_5>0ON</Input_5>
<Input_6>0ON</Input_6>
<Input_7>ON</Input_7>
<Input_8>0ON</Input_8>
<Input_9>0ON</Input_9>
<Input_10>ON</Input_10>
<Input_11>ON</Input_11>
</InputTrigger>
<Interval></Interval>
<ApplicationMode2>
<Socket_device>ON</Socket_device>
<Compatible_50xxx>0FF</Compatible_50xxx>
<Box2Box_Master>0FF</Box2Box_Master>
<ILOface>OFF</ILOface>
</ApplicationMode2>
</TcpClient2>
<UdpPeer2>
<LocalPort>45890</LocalPort>
<RemotePort>45890</RemotePort>
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<Remote_IP_Addr></Remote_IP_Addr>
<InputTrigger>
<Input_0>ON</Input_0>
<Input_1>ON</Input_1>
<Input_2>ON</Input_2>
<Input_3>ON</Input_3>
<Input_4>0ON</Input_4>
<Input_5>0ON</Input_5>
<Input_6>0ON</Input_6>
<Input_7>ON</Input_7>
<Input_8>0ON</Input_8>
<Input_9>0ON</Input_9>
<Input_10>ON</Input_10>
<Input_11>ON</Input_11>
</InputTrigger>
<Interval></Interval>
<ApplicationMode3>
<Socket_device>ON</Socket_device>
<Compatible_50xxx>0FF</Compatible_50xxx>
</ApplicationMode3>
</UdpPeer2>
</Binary2>
</BasicSettings>
<QutputMode>
<Outputo>
<_HTTP>ON</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
<Binary_1>0FF</Binary_1>
<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>
</Output6>
<Outputl>
<_HTTP>ON</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
<Binary_1>0FF</Binary_1>
<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>
</Outputl>
<Output2>
<_HTTP>ON</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
<Binary_1>0FF</Binary_1>
<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>
</Output2>
<Output3>
<_HTTP>ON</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
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<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>

</Output3>

<Output4>
<_HTTP>ON</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
<Binary_1>0FF</Binary_1>
<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>

</Output4>

<Output5>
<_HTTP>ON</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
<Binary_1>0FF</Binary_1>
<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>

</Output5>

<Output6>
<_HTTP>OFF</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
<Binary_1>0ON</Binary_1>
<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>

</Output6>

<OQutput7>
<_HTTP>OFF</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
<Binary_1>0ON</Binary_1>
<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>

</Output7>

<Output8>
<_HTTP>OFF</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
<Binary_1>0ON</Binary_1>
<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>

</Output8>

<Output9>
<_HTTP>OFF</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
<Binary_1>0ON</Binary_1>
<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>

</Output9>
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<Qutputlo>
<_HTTP>OFF</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
<Binary_1>0ON</Binary_1>
<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>
</Outputlo>
<Qutputll>
<_HTTP>OFF</_HTTP>
<_UDP_ASCII>OFF</_UDP_ASCII>
<_SNMP>OFF</_SNMP>
<Binary_1>0ON</Binary_1>
<Binary_2>0FF</Binary_2>
<_Logic>0FF</_Logic>
</Outputll>
<Safety_Timeout></Safety_Timeout>
<Enable>
<Load_Control_enable>0FF</Load_Control_enable>
</Enable>
</OutputMode>
<Alarm>
<Alarml>
<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>
</InputTrigger>
<OutputTrigger>
<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l10><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>
</OutputTrigger>
<SystemTrigger>
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<Load_Control>0FF</Load_Control>
<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>
</SystemTrigger>
<MaxCounterValue></MaxCounterValue>
<Interval></Interval>
<Timer_Cron></Timer_Cron>
<AlarmEnable>
<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</
Send_special_alarm_to_pending_TCP_connections>
<TCP_Client_enable>0FF</TCP_Client_enable>
<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
<FTP_Client_enable>0FF</FTP_Client_enable>
</AlarmEnable>
<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
<Alarm_clear_text></Alarm_clear_text>
</Mail>
<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>
</SNMP>
<UDP>
<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>
</UDP>
<TCP>
<IP_Addr></IP_Addr>
<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>
</TCP>
<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
<SyslogText></SyslogText>
<Alarm_clear_text></Alarm_clear_text>
</Syslog>
<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
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<Alarm_clear_text></Alarm_clear_text>
<Options>
<STORE>OFF</STORE>
<APPEND>ON</APPEND>

</Options>

</FTP>

</Alarml>
<Alarm2>

<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>

</InputTrigger>

<OutputTrigger>
<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l0><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>

</OutputTrigger>

<SystemTrigger>
<Load_Control>0FF</Load_Control>
<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>

</SystemTrigger>

<MaxCounterValue></MaxCounterValue>

<Interval></Interval>

<Timer_Cron></Timer_Cron>

<AlarmEnable>
<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</

Send_special_alarm_to_pending_TCP_connections>

<TCP_Client_enable>0FF</TCP_Client_enable>
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<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
<FTP_Client_enable>0FF</FTP_Client_enable>

</AlarmEnable>

<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
<Alarm_clear_text></Alarm_clear_text>

</Mail>

<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>

</SNMP>

<UDP>
<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>

</UDP>

<TCP>
<IP_Addr></IP_Addr>
<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>

</TCP>

<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
<SyslogText></SyslogText>
<Alarm_clear_text></Alarm_clear_text>

</Syslog>

<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
<Alarm_clear_text></Alarm_clear_text>
<Options>

<STORE>OFF</STORE>
<APPEND>ON</APPEND>

</Options>

</FTP>

</Alarm2>
<Alarm3>

<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
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<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>

</InputTrigger>

<OutputTrigger>
<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l10><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>

</OutputTrigger>

<SystemTrigger>
<Load_Control>0FF</Load_Control>
<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>

</SystemTrigger>

<MaxCounterValue></MaxCounterValue>

<Interval></Interval>

<Timer_Cron></Timer_Cron>

<AlarmEnable>
<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</

Send_special_alarm_to_pending_TCP_connections>

<TCP_Client_enable>0FF</TCP_Client_enable>
<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
<FTP_Client_enable>0FF</FTP_Client_enable>

</AlarmEnable>

<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
<Alarm_clear_text></Alarm_clear_text>

</Mail>

<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>

</SNMP>
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<UDP>
<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>

</UDP>

<TCP>
<IP_Addr></IP_Addr>
<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>

</TCP>

<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
<SyslogText></SyslogText>
<Alarm_clear_text></Alarm_clear_text>

</Syslog>

<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
<Alarm_clear_text></Alarm_clear_text>
<Options>

<STORE>OFF</STORE>
<APPEND>ON</APPEND>

</Options>

</FTP>

</Alarm3>
<Alarm4>

<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>

</InputTrigger>

<OutputTrigger>
<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
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<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l0><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>

</OutputTrigger>

<SystemTrigger>
<Load_Control>0FF</Load_Control>
<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>

</SystemTrigger>

<MaxCounterValue></MaxCounterValue>

<Interval></Interval>

<Timer_Cron></Timer_Cron>

<AlarmEnable>
<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</

Send_special_alarm_to_pending_TCP_connections>

<TCP_Client_enable>0FF</TCP_Client_enable>
<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
<FTP_Client_enable>0FF</FTP_Client_enable>

</AlarmEnable>

<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
<Alarm_clear_text></Alarm_clear_text>

</Mail>

<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>

</SNMP>

<UDP>
<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>

</UDP>

<TCP>
<IP_Addr></IP_Addr>
<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>

</TCP>

<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
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<SyslogText></SyslogText>
<Alarm_clear_text></Alarm_clear_text>

</Syslog>

<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
<Alarm_clear_text></Alarm_clear_text>
<Options>

<STORE>OFF</STORE>
<APPEND>ON</APPEND>

</Options>

</FTP>

</Alarm4>
<Alarm5>

<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>

</InputTrigger>

<OutputTrigger>
<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l10><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>

</OutputTrigger>

<SystemTrigger>
<Load_Control>0FF</Load_Control>
<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>

</SystemTrigger>

<MaxCounterValue></MaxCounterValue>

<Interval></Interval>

<Timer_Cron></Timer_Cron>
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<AlarmEnable>
<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</
Send_special_alarm_to_pending_TCP_connections>
<TCP_Client_enable>0FF</TCP_Client_enable>
<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
<FTP_Client_enable>0FF</FTP_Client_enable>
</AlarmEnable>
<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
<Alarm_clear_text></Alarm_clear_text>
</Mail>
<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>
</SNMP>
<UDP>
<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>
</UDP>
<TCP>
<IP_Addr></IP_Addr>
<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>
</TCP>
<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
<SyslogText></SyslogText>
<Alarm_clear_text></Alarm_clear_text>
</Syslog>
<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
<Alarm_clear_text></Alarm_clear_text>
<Options>
<STORE>OFF</STORE>
<APPEND>ON</APPEND>
</Options>
</FTP>
</Alarm5>
<Alarmé>
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<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>

</InputTrigger>

<OutputTrigger>
<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l0><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>

</OutputTrigger>

<SystemTrigger>
<Load_Control>0FF</Load_Control>
<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>

</SystemTrigger>

<MaxCounterValue></MaxCounterValue>

<Interval></Interval>

<Timer_Cron></Timer_Cron>

<AlarmEnable>
<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</

Send_special_alarm_to_pending_TCP_connections>

<TCP_Client_enable>0FF</TCP_Client_enable>
<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
<FTP_Client_enable>0FF</FTP_Client_enable>

</AlarmEnable>

<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
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<Alarm_clear_text></Alarm_clear_text>

</Mail>

<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>

</SNMP>

<UDP>
<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>

</UDP>

<TCP>
<IP_Addr></IP_Addr>
<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>

</TCP>

<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
<SyslogText></SyslogText>
<Alarm_clear_text></Alarm_clear_text>

</Syslog>

<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
<Alarm_clear_text></Alarm_clear_text>
<Options>

<STORE>OFF</STORE>
<APPEND>ON</APPEND>

</Options>

</FTP>

</Alarmé>
<Alarm7>

<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>

</InputTrigger>

<OutputTrigger>
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<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l10><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>

</OutputTrigger>

<SystemTrigger>
<Load_Control>0FF</Load_Control>
<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>

</SystemTrigger>

<MaxCounterValue></MaxCounterValue>

<Interval></Interval>

<Timer_Cron></Timer_Cron>

<AlarmEnable>
<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</

Send_special_alarm_to_pending_TCP_connections>

<TCP_Client_enable>0FF</TCP_Client_enable>
<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
<FTP_Client_enable>0FF</FTP_Client_enable>

</AlarmEnable>

<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
<Alarm_clear_text></Alarm_clear_text>

</Mail>

<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>

</SNMP>

<UDP>
<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>

</UDP>

<TCP>
<IP_Addr></IP_Addr>
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<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>

</TCP>

<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
<SyslogText></SyslogText>
<Alarm_clear_text></Alarm_clear_text>

</Syslog>

<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
<Alarm_clear_text></Alarm_clear_text>
<Options>

<STORE>OFF</STORE>
<APPEND>ON</APPEND>

</Options>

</FTP>

</Alarm7>
<Alarm8>

<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>

</InputTrigger>

<OutputTrigger>
<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l10><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>

</OutputTrigger>

<SystemTrigger>
<Load_Control>0FF</Load_Control>
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<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>
</SystemTrigger>
<MaxCounterValue></MaxCounterValue>
<Interval></Interval>
<Timer_Cron></Timer_Cron>
<AlarmEnable>
<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</
Send_special_alarm_to_pending_TCP_connections>
<TCP_Client_enable>0FF</TCP_Client_enable>
<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
<FTP_Client_enable>0FF</FTP_Client_enable>
</AlarmEnable>
<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
<Alarm_clear_text></Alarm_clear_text>
</Mail>
<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>
</SNMP>
<UDP>
<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>
</UDP>
<TCP>
<IP_Addr></IP_Addr>
<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>
</TCP>
<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
<SyslogText></SyslogText>
<Alarm_clear_text></Alarm_clear_text>
</Syslog>
<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
<Alarm_clear_text></Alarm_clear_text>
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<Options>
<STORE>OFF</STORE>
<APPEND>ON</APPEND>

</Options>

</FTP>

</Alarm8>
<Alarm9>

<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>

</InputTrigger>

<OutputTrigger>
<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l0><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>

</OutputTrigger>

<SystemTrigger>
<Load_Control>0FF</Load_Control>
<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>

</SystemTrigger>

<MaxCounterValue></MaxCounterValue>

<Interval></Interval>

<Timer_Cron></Timer_Cron>

<AlarmEnable>
<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</

Send_special_alarm_to_pending_TCP_connections>

<TCP_Client_enable>0FF</TCP_Client_enable>
<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
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<FTP_Client_enable>0FF</FTP_Client_enable>

</AlarmEnable>

<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
<Alarm_clear_text></Alarm_clear_text>

</Mail>

<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>

</SNMP>

<UDP>
<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>

</UDP>

<TCP>
<IP_Addr></IP_Addr>
<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>

</TCP>

<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
<SyslogText></SyslogText>
<Alarm_clear_text></Alarm_clear_text>

</Syslog>

<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
<Alarm_clear_text></Alarm_clear_text>
<Options>

<STORE>OFF</STORE>
<APPEND>ON</APPEND>

</Options>

</FTP>

</Alarm9>
<Alarmlo>

<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
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<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>

</InputTrigger>

<OutputTrigger>
<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l10><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>

</OutputTrigger>

<SystemTrigger>
<Load_Control>0FF</Load_Control>
<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>

</SystemTrigger>

<MaxCounterValue></MaxCounterValue>

<Interval></Interval>

<Timer_Cron></Timer_Cron>

<AlarmEnable>
<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</

Send_special_alarm_to_pending_TCP_connections>

<TCP_Client_enable>0FF</TCP_Client_enable>
<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
<FTP_Client_enable>0FF</FTP_Client_enable>

</AlarmEnable>

<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
<Alarm_clear_text></Alarm_clear_text>

</Mail>

<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>

</SNMP>

<UDP>
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<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>

</UDP>

<TCP>
<IP_Addr></IP_Addr>
<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>

</TCP>

<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
<SyslogText></SyslogText>
<Alarm_clear_text></Alarm_clear_text>

</Syslog>

<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
<Alarm_clear_text></Alarm_clear_text>
<Options>

<STORE>OFF</STORE>
<APPEND>ON</APPEND>

</Options>

</FTP>

</Alarmlo>
<Alarmll>

<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>

</InputTrigger>

<OutputTrigger>
<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
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<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l0><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>

</OutputTrigger>

<SystemTrigger>
<Load_Control>0FF</Load_Control>
<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>

</SystemTrigger>

<MaxCounterValue></MaxCounterValue>

<Interval></Interval>

<Timer_Cron></Timer_Cron>

<AlarmEnable>
<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</

Send_special_alarm_to_pending_TCP_connections>

<TCP_Client_enable>0FF</TCP_Client_enable>
<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
<FTP_Client_enable>0FF</FTP_Client_enable>

</AlarmEnable>

<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
<Alarm_clear_text></Alarm_clear_text>

</Mail>

<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>

</SNMP>

<UDP>
<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>

</UDP>

<TCP>
<IP_Addr></IP_Addr>
<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>

</TCP>

<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
<SyslogText></SyslogText>
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<Alarm_clear_text></Alarm_clear_text>

</Syslog>

<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
<Alarm_clear_text></Alarm_clear_text>
<Options>

<STORE>OFF</STORE>
<APPEND>ON</APPEND>

</Options>

</FTP>

</Alarmll>
<Alarmi2>

<InputTrigger>
<Input_0><enable>0FF</enable><state>0FF</state></Input_0>
<Input_l><enable>0FF</enable><state>0FF</state></Input_1>
<Input_2><enable>0FF</enable><state>0FF</state></Input_2>
<Input_3><enable>0FF</enable><state>0FF</state></Input_3>
<Input_4><enable>0FF</enable><state>0FF</state></Input_4>
<Input_5><enable>0FF</enable><state>0FF</state></Input_5>
<Input_6><enable>0FF</enable><state>0FF</state></Input_6>
<Input_7><enable>0FF</enable><state>0FF</state></Input_7>
<Input_8><enable>0FF</enable><state>0FF</state></Input_8>
<Input_9><enable>0FF</enable><state>0FF</state></Input_9>
<Input_l0><enable>0FF</enable><state>0FF</state></Input_10>
<Input_l1><enable>0FF</enable><state>0FF</state></Input_11>

</InputTrigger>

<OutputTrigger>
<Output_0><enable>0FF</enable><state>0FF</state></Output_0>
<Output_1l><enable>0FF</enable><state>0FF</state></Output_1>
<Output_2><enable>0FF</enable><state>0FF</state></Output_2>
<Output_3><enable>0FF</enable><state>0FF</state></Output_3>
<Output_4><enable>0FF</enable><state>0FF</state></Output_4>
<Output_5><enable>0FF</enable><state>0FF</state></Output_5>
<Output_6><enable>0FF</enable><state>0FF</state></Output_6>
<Output_7><enable>0FF</enable><state>0FF</state></Output_7>
<Output_8><enable>0FF</enable><state>0FF</state></Output_8>
<Output_9><enable>0FF</enable><state>0FF</state></Output_9>
<Output_l10><enable>0FF</enable><state>0FF</state></Output_10>
<Output_l1><enable>0FF</enable><state>0FF</state></Output_11>

</OutputTrigger>

<SystemTrigger>
<Load_Control>0FF</Load_Control>
<Interval_Timer>0FF</Interval_Timer>
<Cold_Start>0FF</Cold_Start>
<Warm_Start>0FF</Warm_Start>

</SystemTrigger>

<MaxCounterValue></MaxCounterValue>

<Interval></Interval>

<Timer_Cron></Timer_Cron>

<AlarmEnable>
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<Mail_enable>0FF</Mail_enable>
<SNMP_Trap_enable>0FF</SNMP_Trap_enable>
<UDP_Client_enable>0FF</UDP_Client_enable>
<Send_special_alarm_to_pending_TCP_connections>0FF</
Send_special_alarm_to_pending_TCP_connections>
<TCP_Client_enable>0FF</TCP_Client_enable>
<Syslog_Messages_enable>0FF</Syslog_Messages_enable>
<FTP_Client_enable>0FF</FTP_Client_enable>
</AlarmEnable>
<Mail>
<E-Mail-Addr></E-Mail-Addr>
<Subject></Subject>
<Mailtext></Mailtext>
<Alarm_clear_subject></Alarm_clear_subject>
<Alarm_clear_text></Alarm_clear_text>
</Mail>
<SNMP>
<Manager_IP></Manager_IP>
<TrapText></TrapText>
<Alarm_clear_text></Alarm_clear_text>
</SNMP>
<UDP>
<IP_Addr></IP_Addr>
<Port></Port>
<UdpText></UdpText>
<Alarm_clear_text></Alarm_clear_text>
</UDP>
<TCP>
<IP_Addr></IP_Addr>
<Port></Port>
<TcpText></TcpText>
<Alarm_clear_text></Alarm_clear_text>
</TCP>
<Syslog>
<IP_Addr></IP_Addr>
<Port>514</Port>
<SyslogText></SyslogText>
<Alarm_clear_text></Alarm_clear_text>
</Syslog>
<FTP>
<FtpLocalDataPort>AUTO</FtpLocalDataPort>
<FileName></FileName>
<FtpAlarmText></FtpAlarmText>
<Alarm_clear_text></Alarm_clear_text>
<Options>
<STORE>OFF</STORE>
<APPEND>ON</APPEND>
</Options>
</FTP>
</Alarml2>
</Alarm>
</Device>
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<Ports>
<Inputs>
<Input06>
<Name>Input 0</Name>
<Text>Description Input 0</Text>
<Filter></Filter>
<InputMode>
<Short_Pulse_detection_enable>0FF</
Short_Pulse_detection_enable>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>ON</positive>
</PulsPolarity>
<InactiveTimeout>1</InactiveTimeout>
</Counter_Mode>
</Input0>
<Inputl>
<Name>Input 1</Name>
<Text>Description Input 1</Text>
<Filter></Filter>
<InputMode>
<Short_Pulse_detection_enable>0FF</
Short_Pulse_detection_enable>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>ON</positive>
</PulsPolarity>
<InactiveTimeout>1</InactiveTimeout>
</Counter_Mode>
</Inputl>
<Input2>
<Name>Input 2</Name>
<Text>Description Input 2</Text>
<Filter></Filter>
<InputMode>
<Short_Pulse_detection_enable>0FF</
Short_Pulse_detection_enable>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
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<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
<InactiveTimeout></InactiveTimeout>
</Counter_Mode>
</Input2>
<Input3>
<Name>Input 3</Name>
<Text>Description Input 3</Text>
<Filter></Filter>
<InputMode>
<Short_Pulse_detection_enable>0FF</
Short_Pulse_detection_enable>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
<InactiveTimeout></InactiveTimeout>
</Counter_Mode>
</Input3>
<Input4>
<Name>Input 4</Name>
<Text>Description Input 4</Text>
<Filter></Filter>
<InputMode>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
<InactiveTimeout></InactiveTimeout>
</Counter_Mode>
</Input4>
<Input5>
<Name>Input 5</Name>
<Text>Description Input 5</Text>
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<Filter></Filter>
<InputMode>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
<InactiveTimeout></InactiveTimeout>
</Counter_Mode>
</Input5>
<Input6>
<Name>Input 6</Name>
<Text>Description Input 6</Text>
<Filter></Filter>
<InputMode>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
<InactiveTimeout></InactiveTimeout>
</Counter_Mode>
</Inputé6>
<Input7>
<Name>Input 7</Name>
<Text>Description Input 7</Text>
<Filter></Filter>
<InputMode>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
<InactiveTimeout></InactiveTimeout>
</Counter_Mode>
</Input7>
<Input8>
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<Name>Input 8</Name>
<Text>Description Input 8</Text>
<Filter></Filter>
<InputMode>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
<InactiveTimeout></InactiveTimeout>
</Counter_Mode>
</Input8>
<Input9>
<Name>Input 9</Name>
<Text>Description Input 9</Text>
<Filter></Filter>
<InputMode>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
<InactiveTimeout></InactiveTimeout>
</Counter_Mode>
</Input9>
<Inputl0>
<Name>Input 10</Name>
<Text>Description Input 10</Text>
<Filter></Filter>
<InputMode>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
<InactiveTimeout></InactiveTimeout>
</Counter_Mode>
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</Inputlo>
<Inputll>
<Name>Input 11</Name>
<Text>Description Input 11</Text>
<Filter></Filter>
<InputMode>
<Change_detection_enable>0FF</Change_detection_enable>
<Clear_counter_on_read>0FF</Clear_counter_on_read>
<Bidirectional_counter_enable>0FF</
Bidirectional_counter_enable>
</InputMode>
<Counter_Mode>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
<InactiveTimeout></InactiveTimeout>
</Counter_Mode>
</Inputll>
</Inputs>
<Outputs>
<Outputo>
<Name>Output 0</Name>
<Text>Description Output 0</Text>
<GroupMode>
<_0--1_2--3_parallel>0FF</_0--1_2--3_parallel>
<_0--1--2--3_parallel>0FF</_0--1--2--3_parallel>
</GroupMode>
<SafetyState>
<Safety_enable><enable>0FF</enable><state>0FF</state></
Safety_enable>
</SafetyState>
<Logic>
<InputMask>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputMask>
<InputInverter>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
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<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputInverter>
<LogicFunc>
<AND>ON</AND>
<OR>OFF</OR>
</LogicFunc>
<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>
</OutputInverter>
</Logic>
<Puls>
<Duration>5000</Duration>
<PulsPolarity>
<negative>0FF</negative>
<positive>ON</positive>
</PulsPolarity>
</Puls>
</Output6>
<Outputl>
<Name>Output 1</Name>
<Text>Description Output 1</Text>
<GroupMode>
<_0--1_2--3_parallel>0FF</_0--1_2--3_parallel>
<_0--1--2--3_parallel>0FF</_0--1--2--3_parallel>
</GroupMode>
<SafetyState>
<Safety_enable><enable>0FF</enable><state>0FF</state></
Safety_enable>
</SafetyState>
<Logic>
<InputMask>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
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</In

putMask>

<InputInverter>

</In

<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>

<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>

putInverter>

<LogicFunc>

<AND>ON</AND>
<OR>OFF</OR>

</LogicFunc>
<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>

</0u
</Logic>
<Puls>

tputInverter>

<Duration>2000</Duration>

<Pul

</Pu
</Puls>
</Outputl>
<Output2>

sPolarity>

<negative>0FF</negative>

<positive>ON</positive>
lsPolarity>

<Name>Output 2</Name>

<Text>Description Output 2</Text>

<GroupMode>
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<_0--1_2--3_parallel>0FF</_0--1_2--3_parallel>

<_0--1--2--3_parallel>0FF</_0--1--2--3_parallel>
</GroupMode>
<SafetyState>

<Safety_enable><enable>0FF</enable><state>0FF</state></

</SafetyState>

<Logic>

<InputMask>

<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
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<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputMask>
<InputInverter>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputInverter>
<LogicFunc>
<AND>ON</AND>
<OR>OFF</OR>
</LogicFunc>
<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>
</OutputInverter>
</Logic>
<Puls>
<Duration>1000</Duration>
<PulsPolarity>
<negative>0FF</negative>
<positive>ON</positive>
</PulsPolarity>
</Puls>

</Output2>
<Output3>

<Name>Output 3</Name>

<Text>Description Output 3</Text>

<GroupMode>
<_0--1_2--3_parallel>0FF</_0--1_2--3_parallel>
<_0--1--2--3_parallel>0FF</_0--1--2--3_parallel>

</GroupMode>

<SafetyState>
<Safety_enable><enable>0FF</enable><state>0FF</state></

</SafetyState>
<Logic>
<InputMask>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
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<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputMask>
<InputInverter>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputInverter>
<LogicFunc>
<AND>ON</AND>
<OR>OFF</OR>
</LogicFunc>
<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>
</OutputInverter>
</Logic>
<Puls>
<Duration>1000</Duration>
<PulsPolarity>
<negative>0FF</negative>
<positive>ON</positive>
</PulsPolarity>
</Puls>
</Output3>
<Output4>
<Name>Output 4</Name>
<Text>Description Output 4</Text>
<GroupMode>
<_4--5_6--T7_parallel>0FF</_4--5_6--7_parallel>
<_4--5--6--7_parallel>0FF</_4--5--6--7_parallel>
</GroupMode>
<SafetyState>
<Safety_enable><enable>0FF</enable><state>0FF</state></
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<Logic>

<InputMask>

</In

<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>

<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>

putMask>

<InputInverter>

</In

<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>

<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>

putInverter>

<LogicFunc>

<AND>ON</AND>
<OR>OFF</OR>

</LogicFunc>
<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>

</0u
</Logic>
<Puls>

tputInverter>

<Duration></Duration>

<Pul

</Pu
</Puls>
</Output4>
<Output5>

sPolarity>

<negative>0FF</negative>
<positive>0FF</positive>

lsPolarity>

<Name>Output 5</Name>

<Text>Description Output 5</Text>

<GroupMode>
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<_4--5_6--T7_parallel>0FF</_4--5_6--7_parallel>
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<_4--5--6--7_parallel>0FF</_4--5--6--7_parallel>
</GroupMode>
<SafetyState>

<Safety_enable><enable>0FF</enable><state>0FF</state></

</SafetyState>

<Logic>

<InputMask>

</In

<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>

<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>

putMask>

<InputInverter>

</In

<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>

<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>

putInverter>

<LogicFunc>

<AND>ON</AND>
<OR>OFF</OR>

</LogicFunc>
<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>

</0u
</Logic>
<Puls>

tputInverter>

<Duration></Duration>

<Pul

</Pu
</Puls>
</Output5>
<OQutput6>

sPolarity>

<negative>0FF</negative>
<positive>0FF</positive>

lsPolarity>
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<Name>Output 6</Name>
<Text>Description Output 6</Text>
<GroupMode>
<_4--5_6--T7_parallel>0FF</_4--5_6--7_parallel>
<_4--5--6--7_parallel>0FF</_4--5--6--7_parallel>
</GroupMode>
<SafetyState>
<Safety_enable><enable>0FF</enable><state>0FF</state></
Safety_enable>
</SafetyState>
<Logic>
<InputMask>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputMask>
<InputInverter>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputInverter>
<LogicFunc>
<AND>ON</AND>
<OR>OFF</OR>
</LogicFunc>
<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>
</OutputInverter>
</Logic>
<Puls>
<Duration></Duration>
<PulsPolarity>
<negative>0FF</negative>
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<positive>0FF</positive>
</PulsPolarity>
</Puls>
</Output6>
<Qutput7>
<Name>Output 7</Name>
<Text>Description Output 7</Text>
<GroupMode>
<_4--5_6--T7_parallel>0FF</_4--5_6--7_parallel>
<_4--5--6--7_parallel>0FF</_4--5--6--7_parallel>
</GroupMode>
<SafetyState>
<Safety_enable><enable>0FF</enable><state>0FF</state></

</SafetyState>
<Logic>

<InputMask>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>

</InputMask>

<InputInverter>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>

</InputInverter>

<LogicFunc>
<AND>ON</AND>
<OR>OFF</OR>

</LogicFunc>

<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>

</OutputInverter>
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</Logic>
<Puls>
<Duration></Duration>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
</Puls>
</Output7>
<Output8>
<Name>Output 8</Name>
<Text>Description Output 8</Text>
<GroupMode>
<_8_9_10_11_separated>ON</_8_9_10_11_separated>
<_8--9_10--11_parallel>0OFF</_8--9_10--11_parallel>
<_8--9--10--11_parallel>0FF</_8--9--10--11_parallel>
</GroupMode>
<SafetyState>
<Safety_enable><enable>0FF</enable><state>0FF</state></

</SafetyState>
<Logic>

<InputMask>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>

</InputMask>

<InputInverter>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>

</InputInverter>

<LogicFunc>
<AND>ON</AND>
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<OR>OFF</OR>
</LogicFunc>
<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>
</OutputInverter>
</Logic>
<Puls>
<Duration></Duration>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
</Puls>
</Output8>
<Output9>
<Name>Output 9</Name>
<Text>Description Output 9</Text>
<GroupMode>
<_8_9_10_11_separated>ON</_8_9_10_11_separated>
<_8--9_10--11_parallel>0OFF</_8--9_10--11_parallel>
<_8--9--10--11_parallel>0FF</_8--9--10--11_parallel>
</GroupMode>
<SafetyState>
<Safety_enable><enable>0FF</enable><state>0FF</state></
Safety_enable>
</SafetyState>
<Logic>
<InputMask>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputMask>
<InputInverter>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
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<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputInverter>
<LogicFunc>
<AND>ON</AND>
<OR>OFF</OR>
</LogicFunc>
<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>
</OutputInverter>
</Logic>
<Puls>
<Duration></Duration>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
</Puls>
</Output9>
<Qutputlo>
<Name>Output 10</Name>
<Text>Description Output 10</Text>
<GroupMode>
<_8_9_10_11_separated>ON</_8_9_10_11_separated>
<_8--9_10--11_parallel>0OFF</_8--9_10--11_parallel>
<_8--9--10--11_parallel>0FF</_8--9--10--11_parallel>
</GroupMode>
<SafetyState>
<Safety_enable><enable>0FF</enable><state>0FF</state></
Safety_enable>
</SafetyState>
<Logic>
<InputMask>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputMask>
<InputInverter>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
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<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputInverter>
<LogicFunc>
<AND>ON</AND>
<OR>OFF</OR>
</LogicFunc>
<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>
</OutputInverter>
</Logic>
<Puls>
<Duration></Duration>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
</Puls>
</Outputlo>
<Qutputll>
<Name>Output 11</Name>
<Text>Description Output 11</Text>
<GroupMode>
<_8_9_10_11_separated>ON</_8_9_10_11_separated>
<_8--9_10--11_parallel>0OFF</_8--9_10--11_parallel>
<_8--9--10--11_parallel>0FF</_8--9--10--11_parallel>
</GroupMode>
<SafetyState>
<Safety_enable><enable>0FF</enable><state>0FF</state></
Safety_enable>
</SafetyState>
<Logic>
<InputMask>
<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputMask>
<InputInverter>
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<Input_0>0FF</Input_0>
<Input_1>0FF</Input_1>
<Input_2>0FF</Input_2>
<Input_3>0FF</Input_3>
<Input_4>0FF</Input_4>
<Input_5>0FF</Input_5>
<Input_6>0FF</Input_6>
<Input_7>0FF</Input_7>
<Input_8>0FF</Input_8>
<Input_9>0FF</Input_9>
<Input_10>0FF</Input_10>
<Input_11>0FF</Input_11>
</InputInverter>
<LogicFunc>
<AND>ON</AND>
<OR>OFF</OR>
</LogicFunc>
<QutputInverter>
<Qutput_Inverter>0FF</Output_Inverter>
</OutputInverter>
</Logic>
<Puls>
<Duration></Duration>
<PulsPolarity>
<negative>0FF</negative>
<positive>0FF</positive>
</PulsPolarity>
</Puls>
</Outputll>
</Outputs>
</Ports>
<Manufacturer>
<Name>Wiesemann & Theis GmbH</Name>
<Address>Porschstr. 12<br>
42279 Wuppertal<br>
Germany</Address>
<Support_Hotline>+49-(0)202-2680-0</Support_Hotline>
<Internet>www.wut.de</Internet>
<DeviceTyp>Web-IO0 Digital 12xIn, 12xOut</DeviceTyp>
<DeviceNo>#57630 TB 900571</DeviceNo>
<Logo>logo.gif</Logo>
</Manufacturer>
</Config>
</io-Digitall2x12.3>

19.3 Jupiter Systems PixelNet Video Wall Control

This section covers the following topics:

Introduction
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Configuration
AVAutomation
- Template Editor
Configuration File
Implementation
Connection
Requests to Implement
To Use LoadLayoutEx
- To Use ActivateWall and LoadLayout

- To Use LoadLayoutOnWall
- To Use ActivateWall with LoadLayoutOnWall

19.3.1 Introduction

The protocol is text based commands and responses sent on TCP/IP. Text encoding is UTF-8. The
protocol is synchronous - i.e. a command (request) shall always result in a response, and a new
command shall not be sent until the response to the previous command has been received.

19.3.2 Configuration

AVAutomation
The router protocol is named JUPITERPIXELNET. Configuring the PixelNet video wall interface
requires the following parameters:

IP address of the PixeINet Domain Controller
Port number (default is set to 30326)
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,

A AVAutomation: NameOfGallery (DEMO) ~
Devices Show  Studio setups (DEMO)  Standby  Backup Idle
H K FM [2 (2

m Mosart Device Properties . @

Vision Moxer | Video Servers | Graphics | Audio | Camera Robics | Light Cortrol | Router | Subliles | GPI/O | Taly | Vitual Set | Weather {Video Wall{int ¢ | »

[¥ Videowall type |JUPITERPIXELl »

1 Connection path: [Hostname=10.211.111.115 L L

m

|AudioChann)
I |AudicChann|
\AudioChann|
\AudioChann|
|AudioChann)
\AudioChann|
IA connectio
iproperly respl
failed becau
10.211.111
IA connectio
iproperly respl
failed becau
10.211.111
IA connectio
iproperly resq]
failed becaul
10211111
upiterFixell Close
Requesting

i | -- - -Inttisliz
Fade Up in FrEview ignarea.
WupiterPixelNet wall layout

PREVIEW ACCESSORIES

\Videowall Recall AndMee("wall” "layout™, D}

WupiterPicelNet wall2 layout2

izero audio channels. Leave existing levels

i| |Request timed out: +PocelNet QuerySystem Status

A comnection attempt failed because the connectad party did not
property respond after a period of time, or established connection
failed because connected host has failed to respond
10.211.111.115:30326

JupiterPixelNet autherticated

Fade Up in Preview ignored.

WupiterPixelNet wall layout

PREVIEW ACCESSORIES

\‘a'idenwall Recall AndMix("wall" "lavout”. 0} S
bl m. ’

Template Editor

In the template editor, enable Video Wall. In Device Properties, enter wall and layout (in double
quotes) in that order, space separated, in both ‘RECALL PREVIE’ and EMEMNR:

Implementation may be based on the WATCHOUT protocol implementation.

NAME RECALL PREVIE EMEMNR
Vall || "wall" "layout” || "wall2" “layout2" OK Cancel

Configuration File

The PixelNet configuration file is located in the program-folder under \Mosart Medialab\Mosart
Server\ConfigurationFiles\VideoWallJupiterPixelNet.xml. To use it, copy it to c:\channeltemplates,
and append

;Config=VideoWalljupiterPixelNet.xml

to the connection string.
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The following configurations are available:

Setting

PinglInterval

Port

Reconnectinterval

Server

TimeoutActivateWall

TimeoutLoadlLayout

TimeoutLoadLayoutEx

TimeoutLoadLayoutOnWall

TimeoutQuerySystemStatus

UseActivateWall

UseDispatcherForRecallAnd
Mixes

UselLoadLayout

UselLoadLayoutOnWall

Description

The amount of time (in ms) to wait before
ping after connect, ping or RecallAndMix

The port number of the PDC computer

The amount of time (in ms) to wait before
reconnect after unsuccessful connect or
lost connection

The DNS name of the PDC computer

The timeout (in ms) for the ActivateWall
request

The timeout (in ms) for the LoadLayout
request

The timeout (in ms) for the LoadLayoutEx
request

The timeout (in ms) for the
LoadLayoutOnWall request

The timeout (in ms) for the
QuerySystemStatus request

Whether (True/False) an ActivateWall
request is sent before the
LoadLayoutOnWall request. Has no effect
unless UselLoadlLayout is False.

Whether (True/False) the RecallAndMix

requests are executed in the dispatcher,
i.e. in the same Thread as (re-)connects
and pings.

Whether (True/False) LoadlLayout requests
are sent instead of LoadLayoutEx requests

Whether (True/False) LoadLayoutOnWall
requests are sent instead of LoadLayoutEx
requests
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Default

10000 (10s)

30326

10000 (10s)

None

2000 (2s)

2000 (2s)

2000 (2s)

2000 (2s)

2000 (2s)

False

False

False

False
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WalllsFirstArgument Whether (True/False) the Wall argument of  False
the LoadLayoutOnWall request is the first
Argument

WalllsInt Whether (True/False) the Wall argument of  False

the LoadLayoutOnWall request is an integer

19.3.3 Implementation

Connection

PixeINet uses the PixelNet Domain Control (PDC) protocol. PDC protocol is developed on top
of the Remote Method Call (RMC) inter-process communication protocol, implemented over a
TCP/IP connection.

- The Watchout video wall driver may serve as a model for this driver.

- The protocol can be tested over a Telnet session.
Port number to connect to is 30326.

19.3.4 Requests to Implement

Five requests are implemented:

- ActivateWall (used only if UseLoadLayout is True, or if both UseActivateWall and
UselLoadLayoutOnWall are True)
LoadLayout (used only if UseLoadLayout is True)
LoadLayoutEx (used if both UseLoadLayout and UseLoadLayoutOnWall are False)
LoadLayoutOnWall (used only if UseLoadlLayout is False, and UselLoadlLayoutOnWall is True)
QuerySystemStatus (used for (internal) Ping)

& Note: Although LoadLayoutOnWall will likely not work, it was included since version 1.5
indicated that this was the request that should be utilized.

To Use LoadlLayoutEx

Leave all Use... settings at their default False.

To Use ActivateWall and LoadLayout

Set UselLoadlLayout = True.

To Use LoadLayoutOnWall
Set
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UselLoadLayout = False
UselLoadLayoutOnWall = True
- WalllsFirstArgument = True
- WalllsInt = True.

& Note: LoadLayoutOnWall may not work.

To Use ActivateWall with LoadLayoutOnWall

UseActivateWall = True.

A Note: ActivateWall with LoadLayoutOnWall may not work.

AVAutomation Implementation
The following methods declared in MMVideoWall must be implemented:

Public MustOverride Function Connect(ByVal strConnection As String) As String Implements
IConnect.Connect

Public MustOverride Function Disconnect() As String Implements IConnect.Disconnect
Public MustOverride Function Ping() As String Implements IConnect.Ping
Public MustOverride Sub RecallAndMix(ByVal presetName As String, ByVal transrate As Integer)

& Note: The final method in the list above, RecallAndMix, calls LoadLayoutOnWall.

19.4 Stagetec Driver Configuration

This section describes how to configure the Stagetec driver. The configuration consists of three
parts:
If needed, change the AudioMixerStagetecDiamondRas.xml config file

Configure one or more scenarios
- Configure Mosart to use these scenarios

19.4.1 AudioMixerStagetecDiamondRas.xml Config File

The default contents of this file are as follows:

<?xml version="1.0" encoding="utf-8" ?>
<DeviceConfig name="StagetecDiamondRasConfig">

<Properties>
<!--The strip number of the leftmost fader in the add-on panel-->
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<!--The default setting is for controlling strips 33-40-->
<item name="FirstAddOnStrip" value="33"/>

<!--This alternative setting is for controlling strips 1-8 of the Auratus
simulator-->
<I--<item name="FirstAddOnStrip" value="1"/>-->

<!--The 1dnitial scenario, if any-->
<item name="InitialScenario" value=""/>
</Properties>
</DeviceConfig>

The default value (33) of the setting FirstAddOnStrip is for controlling the add-on panel
described in the document linked to above. If that’s what you want to do, you should not
change it. The alternative setting is for controlling the Stagetec simulator.

The InitialScenario setting is for setting a scenario to be invoked at start-up. The value
should be a scenario name as described in the next chapter.

If you want to change the file, please follow the normal procedure: Copy the file from
ConfigurationFiles in the installation folder to Channeltemplates, then make changes to the
COPY.

19.4.2 Scenario Configuration

One or more scenarios may be configured. Each scenario is represented by an xml file (i.e., with
extension .xml and containing valid xml). The scenario config files must be put in one of the
places normally used for config files, preferably Channeltemplates.

The installation contains a sample scenario config file, Studio3Mics.xml. This file may be copied
and used as a model for real scenarios. The sample scenario config file Studio3Mics.xml has the
following contents:

<?xml version="1.0" encoding="utf-8" ?>
<StagetecDiamondRasStripsConfig>
<Strips>
<Strip Number="1" FaderType="DeviceType" Channel="MIC"
PreviewOrProgram="Program" />
<Strip Number="2" FaderType="Empty" PreviewOrProgram="Program" />
<Strip Number="3" FaderType="Ignore" PreviewOrProgram="Program" />
<Strip Number="4" FaderType="Static" Channel="Ch 3"
PreviewOrProgram="Program" />
<Strip Number="5" FaderType="DeviceType" Channel="MIC"
PreviewOrProgram="Preview" />
<Strip Number="6" FaderType="Empty" PreviewOrProgram="Preview" />
<Strip Number="7" FaderType="Ignore" PreviewOrProgram="Preview" />
<Strip Number="8" FaderType="Static" Channel="Ch i
PreviewOrProgram="Preview" />
</Strips>
</StagetecDiamondRasStripsConfig>
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The outer parts are fixed:

<?xml version="1.0" encoding="utf-8" ?>
<StagetecDiamondRasStripsConfig>
<Strips>

</Strips>
</StagetecDiamondRasStripsConfig>
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There are one or more Strip elements, each defining which channel to assign to the strip. The

attributes are as follows:

Attribute Valid values

Number 1-8

FaderType DeviceType OR Empty OR Ignore
OR Static

Channel Mixer channel name
OR

device type (none, server,
server_ch2, graphics, external,
mic, tIf, OR soundplayer)
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Explanation

This attribute determines which strip is
defined. The strips should always be
Number-ed 1-8; the actual strip
number also depends on the value of
the FirstAddOnStrip setting described
above:

Number - 1 + FirstAddOnStrip

With the default config, Number="1"
then corresponds to strip 33.

If DeviceType: The actual channel will
be determined as described below this
table.

If Empty: The fader/strip will be
unassigned.

If Ignore: The Strip element will be
ignored altogether.

If Static: The channel will simply be the
one with name equal to the value of
the Channel attribute.

If FaderType="Static”: The mixer
channel with the specified name is
assigned to the stripe.

If FaderType="DeviceType”: The actual
channel will be determined as
described below this table.

Page 577



Viz Mosart Administrator Guide - 5.0

PreviewOrProgram  Preview Used only if
FaderType="DeviceType” (but must be

OR Program present also in the other cases, but
then without any effect).
Sticky true OR false (default) Only required if

° FaderType="DeviceType” AND

° the fader allocation is reevaluated
after the templates have changed (i.e.,
NOT when setting the initial scenario
(see above) or changing the current
scenario through a control command
(see below)).

The effect will be described below this
table.

If FaderType="DeviceType”, the actual channel will be determined as follows:

- A channel of the type specified by the Channel attribute (an ‘eligible’ channel) will be
assigned.
If PreviewOrProgram="Preview”, the channel chosen will be among the eligible channels in
the preview template. If the scenario has SEVERAL Strip elements with
FaderType="DeviceType”,
- the same Channel, and
PreviewOrProgram="Preview”

each such Strip element will define a different channel (as long as there are enough eligible
channels in the preview template).

- Similarly, if PreviewOrProgram="Program”, the channel chosen will be among the eligible
channels in the program template. If the scenario has SEVERAL Strip elements with
FaderType="DeviceType”,
- the same Channel, and
PreviewOrProgram="Program”

each such Strip element will define a different channel (as long as there are enough eligible
channels in the program template).

If there are not enough eligible channels (in the preview or program template, respectively)
of the specified type, each surplus strip will be DEASSIGNED (i.e., not have a fader/channel
assigned), UNLESS the strip is Sticky, AND the fader allocation is reevaluated after the
templates have changed. (In this case, the strip is left as is; hence the designation ‘sticky’.)

- The Strip elements with FaderType="Static” does not play any role whatsoever here; so the
same channel may be assigned to several strips.

Assuming that the preview template contains the MIC channel Micl (but not Mic2 or any other),
and that the program template contains the MIC channel Mic2 (but not Mic1 or any other), the
sample scenario results in this assignment:

Strip Channel
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33 Mic2

34 (unassigned)
35 (unchanged)
36 Ch 3

37 Micl

38 (unassigned)
39 (unchanged)
40 Ch 1

& Note: the fader allocation described above is reevaluated whenever the templates changes.

19.4.3 Using the Scenarios

The scenarios will be invoked through control commands. Each such control command should be
as follows:

- Command: DEVICE_PROPERTY (usually selectable in a dropdown)
- Value: AUDIO (sometimes, but not always, selectable in a dropdown)
Parameter: RECALL_EXTERNAL_FADER_ALLOCATION_SNAPSHOT=Studio3Mics

A Note: Studio3Mics is an example only. In practice, the actual scenario name (= file name
WITHOUT EXTENSION .xml) should be supplied.

In Template properties it looks like this:
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Template properties

¥ Command On Take

¥ Continue Points

Cue Next ltem Index

o

¥ Command On Take Out

—Control

General Control Commands | Newsroom tags order

Take

Command

Value | Parameter

DEVICE_PROPERTY ~|

El

r—Continue Points

Autotake

Command Value | Parameter | Description

DEVICE_PROFERTY LI AUDIO RECALL_EXTERNAL_|

FADER_AL...

=

—Control

Take Out

DEVICE_PROPERTY

| |ﬁUDIO _~| [R_ALLOCATION_SNAPSHOT=Studio 3Micd

™ Hide from user

o] o

On the Ul:

( ) Viz Mosart - Keyboard shortcuts

Layout (Default)
Filter by:

¥ Control Command

IDevice pROPERTY |

Alt

DEVICE_PROPER

Shift

Cul > Template

Touchm = OnAir = None

Preview Insert Allow drop Drop content only

DEVICE_PROPERTY ¥

Parameter1 | AUDIO |

Y Contrc

Parameter2 |RECALL_E){TERNAL_FADER_ALLOCAHON_SNAPSHOT

Parameter3 |S1:udi03 Mic:sl

19.5 Structure Of MOS Objects Sent To NRCS

You can send Mosart templates as MOS objects to an NRCS and then use them to create items in a

Viz Mosart rundown (as an alternative to the Mosart ActiveX method) as a brick system.

In addition to MOS objects that contain Viz Mosart templates, there is a special MOS object that
can be sent containing lower thirds information.

This topic is covered in section Mosart Templates Feedback to the NRCS.

This section provides some sample MOS object files:
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MOS Objects with Mosart Templates Grouped by Type

MOS Object with Mosart Templates not Grouped by Type

MOS Object with Clip Templates Merged in a Mosart Template
MOS Object with Lowerthird Information

Octopus

19.5.1 MOS Objects with Mosart Templates Grouped by Type

Variants for Mosart Templates of Same Type
Variants for Mosart Templates of Same Type and SendAllTemplateSets set to True

Variants for Mosart Templates of Same Type

A single MOS object will be created for Mosart templates of same type from the default template

set. In this example

5.0

<mosExternalMetadata> node contains the list of variants for the Mosart templates, of same

type.

<objlD> of the MOS object is the template type, for example 0 for CAMERA or 1 for
PACKAGE.

<objGroup> is the default template set name.

<type> node has the name set to the template type name (for example CAMERA, PACKAGE

etc.), and templateset set to the name of the default template set.

<mosObj>
<objID>0</0objID>
<objSlug>CAMERA</objSlug>
<mosAbstract>CAMERA</mosAbstract>
<objGroup>Talkshow</objGroup>
<objType>STILL</objType>
<objTB>50</0bjTB>
<objRev>1</objRev>
<objDur>0</objDur>
<status>NEW</status>
<objAir>NOT READY</objAir>
<createdBy>
</createdBy>
<created>2019-03-04T13:23:38,000Z</created>
<changedBy>
</changedBy>
<changed>2020-03-07T09:22:21,256Z</changed>
<description>CAMERA</description>
<mosExternalMetadata>
<mosScope>PLAYLIST</mosScope>
<mosSchema>http://www.mosartmedialab.no/schema/mositem.dtd</mosSchema>
<mosPayload>
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<mosarttemplate>
<type name="CAMERA" templateset="Talkshow” category="">
<variants fieldtype="LIST" value="1">
<variant name="1">
<transitions value="DEFAULT" enable="false">
<transition name="DEFAULT">
<field name="" value="" fieldtype="TEXT" />
</transition>
<transition name="MIX">
<field name="transitionrate" value="0" fieldtype="NUMBER" range="

>
</transition>
<transition name="WIPE">
<field name="transitionrate" value="" fieldtype="NUMBER" range="0
</transition>
<transition name="EFFECT">
<field name="effectname" value="" fieldtype="LIST" keylist="effec
</transition>
</transitions>
<fields />
</variant>
<variant name="2">
<transitions value="DEFAULT" enable="false">
<transition name="DEFAULT">
<field name="" value="" fieldtype="TEXT" />
</transition>
<transition name="MIX">
<field name="transitionrate" value="0" fieldtype="NUMBER" range="
>
</transition>
<transition name="WIPE">
<field name="transitionrate" value="" fieldtype="NUMBER" range="0
</transition>
<transition name="EFFECT">
<field name="effectname" value="" fieldtype="LIST" keylist="effec

</transition>
</transitions>
<fields />
</variant>
</variants>
<keys name="mixerinputs'">
<k>
</k>
<k>CAM1</k>
<k>CAM2</k>
<k>GRAPHIC1</k>
<k>GRAPHIC2</k>
<k>LIVE1</k>
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<k>LIVE2</k>
<k>SKYPE1</k>
<k>SKYPE2</k>
<k>PLAYA</k>
<k>PLAYB</k>
<k>PLAYC</k>
<k>PLAYD</k>
<k>ME1</k>
<k>ME2</k>
<k>ME3</k>
</keys>

<keys name="effects">

<k>1</k>
<k>2</k>
<k>3</k>
<k>4</k>
<k>5</k>
<k>6</k>
<k>7</k>
<k>8</k>
<k>9</k>
<k>10</k>
<k>11</k>
<k>12</k>
<k>13</k>
<k>14</k>
<k>45</k>
<k>47</k>
</keys>

<keys name="routersources">

<k>SAT_10</k>

<k>DEP_01_A</k>

</keys>

<keys name="routerdestinations'>

<k>M_VISU_2</k>
<k>M_ROBO_2</k>

<k>TESTLOW</k>

<k>TESTHIGH</k>

</keys>

</type>

</mosarttemplate>
</mosPayload>
</mosExternalMetadata>

</mosO0bj>
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Variants for Mosart Templates of Same Type and SendAllTemplateSets set to True

A single MOS object will be created for Mosart templates of the same type for each template set. In

this example:

<mosExternalMetadata> node contains the list of variants for the Mosart templates of the
same type.
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For example, if there are 3 template sets and 10 template types having 2 variants each, then
there are 30 MOS objects created, each having 2 variants.

<objID> is the “TemplateSet-TemplateType”.

For example in the ’FuncSpec’ template set, FuncSpec-0 for CAMERA or FuncSpec-1 for
PACKAGE.

<objSlug> is the template type name.

For example, CAMERA or PACKAGE.

<objGroup> is the template set name.

<type> node has the name of the template type name (for example CAMERA, PACKAGE etc.),
and templateset set to the name of the template set.

In the example below there are there are 2 template sets:

- FuncSpec having 3 Camera templates and

- Demo having 2 Camera templates.

<mosObj>
<objID>FUNCSPEC-0</0objID>
<objSlug>CAMERA</objSlug>
<mosAbstract>CAMERA</mosAbstract>
<objGroup>Funcspec</objGroup>
<objType>STILL</objType>
<objTB>50</0objTB>
<objRev>1</objRev>
<objDur>0</objbDur>
<status>NEW</status>
<objAir>NOT READY</objAir>
<createdBy>
</createdBy>
<created>2016-04-01T11:42:09,000Z</created>
<changedBy>
</changedBy>
<changed>2017-09-22T12:05:20,070Z</changed>
<description>CAMERA</description>
<mosExternalMetadata>
<mosScope>PLAYLIST</mosScope>
<mosSchema>http://www.mosartmedialab.no/schema/mositem.dtd</mosSchema>
<mosPayload>
<mosarttemplate>
<type name="CAMERA" templateset="Funcspec" category="">
<variants fieldtype="LIST" value="LIVE">
<variant name="LIVE">
<transitions value="DEFAULT" enable="false">
<transition name="DEFAULT">
<field name="" value="" fieldtype="TEXT" />
</transition>
<transition name="MIX">
<field name="transitionrate" value="0" fieldtype="NUMBER" range="
0,999" />
</transition>
<transition name="WIPE">
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<field name="transitionrate" value="" fieldtype="NUMBER" range="0
,999" />
</transition>
<transition name="EFFECT">
<field name="effectname" value="" fieldtype="LIST" keylist="effec
ts" />
</transition>
</transitions>
<fields>
<field name="xpointl" value="CAM1" default="CAM1" fieldtype="LIST"
keylist="mixerinputs" />
</fields>
</variant>
<variant name="21">
<transitions value="DEFAULT" enable="false">
<transition name="DEFAULT">
<field name="" value="" fieldtype="TEXT" />
</transition>
<transition name="MIX">
<field name="transitionrate" value="2" fieldtype="NUMBER" range="

0,999" />
</transition>
<transition name="WIPE">
<field name="transitionrate" value="" fieldtype="NUMBER" range="0
,999" />
</transition>
<transition name="EFFECT">
<field name="effectname" value="" fieldtype="LIST" keylist="effec
ts" />
</transition>
</transitions>
<fields />
</variant>
<variant name="20">
<transitions value="DEFAULT" enable="false">
<transition name="DEFAULT">
<field name="" value="" fieldtype="TEXT" />
</transition>
<transition name="MIX">
<field name="transitionrate" value="2" fieldtype="NUMBER" range="
0,999" />
</transition>
<transition name="WIPE">
<field name="transitionrate" value="" fieldtype="NUMBER" range="0
,999" />
</transition>
<transition name="EFFECT">
<field name="effectname" value="" fieldtype="LIST" keylist="effec
ts" />
</transition>
</transitions>
<fields />

</variant>
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</variants>
<keys name="mixerinputs">
<k>
</k>
<k>CAM1</k>
<k>CAM2</k>
<k>LIVE1</k>
<k>VIZ</k>
<k>IN11_HD1</k>
<k>IN12_HD2</k>
<k>VIZ2</k>
<k>ME1</k>
<k>ME2</k>
<k>LIVE2</k>
<k>DUMMY</k>
<k>DDR1</k>
<k>DDR2</k>
</keys>
<keys name="effects">
<k>1</k>
<k>2</k>
<k>3</k>
<k>4</k>
<k>5</k>
<k>6</k>
<k>7</k>
<k>8</k>
<k>9</k>
</keys>
<keys name="routersources">
<k>R CAM 1</k>
</keys>
<keys name="routerdestinations">
<k>0PUS 1</k>
</keys>
</type>
</mosarttemplate>
</mosPayload>
</mosExternalMetadata>
</mosObj>
<mosO0bj>
<objID>DEMO-0</0objID>
<objSlug>CAMERA</objSlug>
<mosAbstract>CAMERA</mosAbstract>
<objGroup>DEMO</objGroup>
<objType>STILL</objType>
<objTB>50</0objTB>
<objRev>1</objRev>
<objDur>0</objbDur>
<status>NEW</status>
<objAir>NOT READY</objAir>
<createdBy>
</createdBy>
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<created>2014-11-11T12:55:05,000Z</created>

<changedBy>

</changedBy>

<changed>2016-05-04T11:01:27,903Z</changed>

<description>CAMERA</description>

<mosExternalMetadata>
<mosScope>PLAYLIST</mosScope>
<mosSchema>http://www.mosartmedialab.no/schema/mositem.dtd</mosSchema>
<mosPayload>

<mosarttemplate>
<type name="CAMERA" templateset="DEMO" category="">
<variants fieldtype="LIST" value="1">
<variant name="1">
<transitions value="DEFAULT" enable="false">
<transition name="DEFAULT">
<field name="" value="" fieldtype="TEXT" />
</transition>
<transition name="MIX'">

range="

<field name="transitionrate" value="0" fieldtype="NUMBER"
0,999" />
</transition>
<transition name="WIPE">
<field name="transitionrate" value="10" fieldtype="NUMBER" range="
0,999" />
</transition>
<transition name="EFFECT">
<field name="effectname" value="0" fieldtype="LIST" keylist="effe
cts" />
</transition>
</transitions>
<fields />
</variant>
<variant name="2">
<transitions value="DEFAULT" enable="false">
<transition name="DEFAULT">
<field name="" value="" fieldtype="TEXT" />
</transition>
<transition name="MIX">
<field name="transitionrate" value="50" fieldtype="NUMBER" range="
0,999" />
</transition>
<transition name="WIPE">
<field name="transitionrate" value="50" fieldtype="NUMBER" range="
0,999" />
</transition>
<transition name="EFFECT">
<field name="effectname" value="0" fieldtype="LIST" keylist="effe
cts" />

</transition>
</transitions>
<fields />
</variant>
</variants>
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<keys name="mixerinputs">
<k>
</k>
<k>CAM1</k>
<k>CAM2< /k>
<k>LIVE1</k>
<k>VIZ</k>
<k>IN11_HD1</k>
<k>IN12_HD2</k>
<k>VIZ2</k>
<k>ME1</k>
<k>ME2</k>
<k>LIVE2</k>
<k>DUMMY</k>
<k>DDR1</k>
<k>DDR2</k>
</keys>
<keys name="effects">
<k>1</k>
<k>2</k>
<k>3</k>
<k>4</k>
<k>5</k>
<k>6</k>
<k>7</k>
<k>8</k>
<k>9</k>
</keys>
<keys name="routersources">
<k>R CAM 1</k>
</keys>
<keys name="routerdestinations'">
<k>0PUS 1</k>
</keys>
</type>
</mosarttemplate>
</mosPayload>
</mosExternalMetadata>
</mosObj>

19.5.2 MOS Object with Mosart Templates not Grouped by Type
For each Mosart template, a MOS object will be created to be sent to NCS. In this example:

<mosExternalMetadata>is the node containing the variant of the Mosart template it
represents.

<objID> is the format <TemplateSet>-<Type>-<Variant>.

<objSlug> has <Type> <Variant>;<Name>.

<objGroup> is set to the template set the template belongs to.
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<type> node has its name set to the type of the template.
For example CAMERA, PACKAGE etc, and templateset has the name of the template set this
template belongs to.
Other information is:
The list of video crosspoints (“mixerinputs”)
Effect numbers (“effects”)
Router sources (“routersources”)
Router destinations (“routerdestinations”)
as configured in AvConfig.xml file.

The name of these key lists must be exactly as given in the parentheses, because they can be
referenced from a Mosart item when adding newsroomtags to a template.

<mosObj>
<objID>Talkshow-1-FULL</objID>
<objSlug>PACKAGE FULLj;name...</objSlug>
<mosAbstract>PACKAGE FULL;description</mosAbstract>
<objGroup>Talkshow</objGroup>
<objType>STILL</objType>
<objTB>50</0bjTB>
<objRev>1</objRev>
<objDur>0</objbDur>
<status>UPDATED</status>
<objAir>NOT READY</objAir>
<createdBy/>
<created/>
<changedBy/>
<changed/>
<description>PACKAGE</description>
<mosExternalMetadata>
<mosScope>PLAYLIST</mosScope>
<mosSchema>http://www.mosartmedialab.no/schema/mositem.dtd</mosSchema>
<mosPayload>
<mosarttemplate>
<type name="PACKAGE" templateset="Talkshow” category="CLIP">
<variants fieldtype="LIST" value="FULL">
<variant name="FULL">
<transitions value="DEFAULT" enable="false">
<transition name="DEFAULT">
<field name="" value="" fieldtype="TEXT" />
</transition>
<transition name="MIX">
<field name="transitionrate" value="0" fieldtype="NUMBER"
range="0,999" />
</transition>
<transition name="WIPE">
<field name="transitionrate" value="" fieldtype="NUMBER"
range="0,999" />
</transition>
<transition name="EFFECT">
<field name="effectname" value="" fieldtype="LIST"
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keylist="effects" />
</transition>
</transitions>
<fijelds>
<field name="clip_hirespath" fieldtype="TEXT" />
<field name="clip_description" fieldtype="TEXT" />
<field name="clip_mark_in" default="00:00:00:00"
fieldtype="TIMECODE" -inputmask="hh:mm:ss:ff" />
<field name="clip_dur" default="00:00:00"
fieldtype="TIMECODE" -nputmask="mm:ss:ff" />

</fields>

</variant>

</variants>

<keys name="mixerinputs">

<k>

</k>

<k>CAM1</k>

<k>CAM2</k>

<k>GRAPHIC1</k>

<k>GRAPHIC2</k>

<k>LIVE1</k>

<k>LIVE2</k>

<k>SKYPE1</k>

<k>SKYPE2</k>

<k>PLAYA</k>

<k>PLAYB</k>

<k>PLAYC</k>

<k>PLAYD</k>

<k>ME1</k>

<k>ME2</k>

<k>ME3</k>

</keys>

<keys name="effects">

<k>1</k>

<k>2</k>

<k>3</k>

<k>4</k>

<k>5</k>

<k>6</k>

<k>7</k>

<k>8</k>

<k>9</k>

<k>10</k>

<k>11</k>

<k>12</k>

<k>13</k>

<k>14</k>

<k>45</k>

<k>47</k>

</keys>

<keys name="routersources">

<k>SAT_10</k>

<k>DEP_01_A</k>
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</keys>
<keys name="routerdestinations">
<k>M_VISU_2</k>
<k>M_ROBO_2</k>
<K>TESTLOW</k>
<k>TESTHIGH</k>
</keys>
</type>
</mosarttemplate>
</mosPayload>
</mosExternalMetadata>
</mosObj>

Newsroomtags for crosspoints and router control inputs

When enabling a Switcher Crosspoint or a Router Control device for the template given above and
adding some newsroomtags for crosspoints and for router control inputs, the Mosart item created
from the template above could have the following fields and transitions:

<fields>
<field name="1input_preview" value="SAT_10" default="SAT_10" fieldtype="LIST"
keylist="routersources" />
<field name="+dnput_program" value="SAT_10" default="SAT_10" fieldtype="LI
sT"
keylist="routersources" />
<field name="output_preview" value="M_VISU_2" default="M_VISU_2"
fieldtype="LIST"
keylist="routerdestinations" />
<field name="output_program" value="M_VISU_2" default="M_VISU_2"
fieldtype="LIST"
keylist="routerdestinations" />
<field name="xpoint" value="CAM2" default="CAM2" fieldtype="LIST" keylist="
mixerinputs" />
</fields>
<transitions value="EFFECT" enable="false" rate="9" next_cue_delay="10">
<transition name="EFFECT">
<field name="effectname" value="9" fieldtype="LIST" keylist="effects" />
</transition>
</transitions>

& Note: The keylists in the Mosart item refers to the keys in the MOS object for a Mosart
template.

19.5.3 MOS Object with Clip Templates Merged in a Mosart Template

A single MOS object is created for all Mosart templates of type PACKAGE or VOICEOVER from the
default template set. In this example:

<mosExternalMetadata> node contains the list of variants for the Mosart templates of type
PACKAGE and VOICEOVER.
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<objlD> of the MOS object is set to 25, representing a Mosart item type CLIP.
<objGroup> is the default template set name.

<type> node has name and category set to “CLIP”, and templateset set to the name of the
default template set.

The variant for each template is built using some prefixes:

1) for PACKAGE, the variant is set to MAZ-<template variant>

2) for VOICEOVER, the variant is set to OFFMAZ-<template variant>

A Note: When GroupByType is false, no MOS object will be sent for templates of type
PACKAGE and VOICEOVER.

<mosObj>
<objID>LOWERTHIRDS</objID>
<objSlug>LOWERTHIRDS</objSlug>
<mosAbstract />
<objGroup>TEMPLATES</objGroup>
<objType>STILL</objType>
<objTB>50</0bjTB>
<objRev>1</objRev>
<objDur>0</objDur>
<!-- The status of the MOS object can be NEW, UPDATED or DELETED -->
<status>NEW</status>
<objAir>NOT READY</objAir>
<createdBy/>
<created/>
<changedBy/>
<changed/>
<description />
<mosExternalMetadata>

<mosScope>PLAYLIST</mosScope>

<mosSchema>http://www.mosartmedialab.no/schema/mositem.dtd</mosSchema>

<mosPayload>

<mosarttemplate>
<type name="LOWERTHIRDS" category="GRAPHICS">
<variants fieldtype="LIST" value="AUTOOUT">
<variant name="AUTOOUT">
<fields>
<field name="graphics_description" fieldtype="TEXT" />
<field name="graphics_id" fieldtype="TEXT" />
<field name="tc_in" fieldtype="TIMECODE" +inputmask="mm:ss"
default="00:00"/>
<field name="tc_out" fieldtype="TIMECODE" -inputmask="mm:ss"

default="00:00"/>

<field name="channel" value="DSK" fieldtype="LIST" keylist="ch

annels" />

<field name="take" value="AUTO" fieldtype="LIST" keylist="take

types" />
</fields>
</variant>
<variant name="KEEPWHILEBACKGROUND">
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<fields>
<field name="graphics_description" fieldtype="TEXT" />
<field name="graphics_id" fieldtype="TEXT" />
<field name="tc_in" fieldtype="TIMECODE" -inputmask="mm:ss"
default="00:00" />
<field name="tc_out" fieldtype="TIMECODE" inputmask="mm:ss"
default="00:00" />
<field name="channel" value="DSK" fieldtype="LIST" keylist="c
hannels" />
<field name="take" value="AUTO" fieldtype="LIST" keylist="ta
ketypes" />
</fields>
</variant>
<variant name="KEEPWHILESTORY">
<fields>
<field name="graphics_description" fieldtype="TEXT" />
<field name="graphics_id" fieldtype="TEXT" />
<field name="tc_in" fieldtype="TIMECODE" -inputmask="mm:ss"
default="00:00" />
<field name="tc_out" fieldtype="TIMECODE" -inputmask="mm:ss"
default="00:00" />
<field name="channel" value="DSK" fieldtype="LIST" keylist="
channels" />
<field name="take" value="AUTO" fieldtype="LIST" keylist="ta
ketypes" />
</fields>
</variant>
<variant name="NONEAUTOOUT">
<fields>
<field name="graphics_description" fieldtype="TEXT" />
<field name="graphics_id" fieldtype="TEXT" />
<field name="tc_in" fieldtype="TIMECODE" -inputmask="mm:ss"
default="00:00" />
<field name="tc_out" fieldtype="TIMECODE" -inputmask="mm:ss"
default="00:00" />
<field name="channel" value="DSK" fieldtype="LIST" keylist="
channels" />
<field name="take" value="AUTO" fieldtype="LIST" keylist="ta
ketypes" />
</fields>
</variant>
</variants>
<!-- List of active channels (graphics destinations) as configured 1in
OverlayGraphics Interface-->
<keys name="channels">
<k>WALL_2</k>
<k>WALL</k>
<k>TABLE</k>
<k>DSK</k>
</keys>
<keys name="taketypes">
<k>AUTO< /k>
<k>MANUAL</k>
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The list of channels contains the active destinations (destinations linked to a graphic engine) as
configured in the Overlay Graphics interface.

19.5.4 MOS Object with Lowerthird Information

<mosObj>
<objID>LOWERTHIRDS</objID>
<objSlug>LOWERTHIRDS</objSlug>
<mosAbstract />
<objGroup>TEMPLATES</objGroup>
<objType>STILL</objType>
<objTB>50</0bjTB>
<objRev>1</objRev>
<objDur>0</objDur>

Along MOS objects corresponding to the Mosart channel templates, Mosart also sends to NCS a
MOS object containing information about lower thirds.

<!-- The status of the MOS object can be NEW, UPDATED or DELETED -->

<status>NEW</status>

<objAir>NOT READY</objAir>

<createdBy/>

<created/>

<changedBy/>

<changed/>

<description />

<mosExternalMetadata>
<mosScope>PLAYLIST</mosScope>

<mosSchema>http://www.mosartmedialab.no/schema/mositem.dtd</mosSchema>

<mosPayload>
<mosarttemplate>

<type name="LOWERTHIRDS" category="GRAPHICS">
<variants fieldtype="LIST" value="AUTOOUT">

<variant name="AUTOOUT">
<fields>

<field name="graphics_description" fieldtype="TEXT" />
<field name="graphics_id" fieldtype="TEXT" />
<field name="tc_in" fieldtype="TIMECODE" inputmask="mm:ss"

default="00:00"/>

<field name="tc_out" fieldtype="TIMECODE" -inputmask="mm:ss"

default="00:00"/>

<field name="channel" value="DSK" fieldtype="LIST" keylist="ch

annels" />
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<field name="take" value="AUTO" fieldtype="LIST" keylist="take
types" />
</fields>
</variant>
<variant name="KEEPWHILEBACKGROUND">
<fields>
<field name="graphics_description" fieldtype="TEXT" />
<field name="graphics_id" fieldtype="TEXT" />
<field name="tc_in" fieldtype="TIMECODE" -inputmask="mm:ss"
default="00:00" />
<field name="tc_out" fieldtype="TIMECODE" inputmask="mm:ss"
default="00:00" />
<field name="channel" value="DSK" fieldtype="LIST" keylist="c
hannels" />
<field name="take" value="AUTO" fieldtype="LIST" keylist="ta
ketypes" />
</fields>
</variant>
<variant name="KEEPWHILESTORY">
<fields>
<field name="graphics_description" fieldtype="TEXT" />
<field name="graphics_id" fieldtype="TEXT" />
<field name="tc_in" fieldtype="TIMECODE" -inputmask="mm:ss"
default="00:00" />
<field name="tc_out" fieldtype="TIMECODE" -inputmask="mm:ss"
default="00:00" />
<field name="channel" value="DSK" fieldtype="LIST" keylist="
channels" />
<field name="take" value="AUTO" fieldtype="LIST" keylist="ta
ketypes" />
</fields>
</variant>
<variant name="NONEAUTOOUT">
<fields>
<field name="graphics_description" fieldtype="TEXT" />
<field name="graphics_id" fieldtype="TEXT" />
<field name="tc_in" fieldtype="TIMECODE" -inputmask="mm:ss"
default="00:00" />
<field name="tc_out" fieldtype="TIMECODE" -inputmask="mm:ss"
default="00:00" />
<field name="channel" value="DSK" fieldtype="LIST" keylist="
channels" />
<field name="take" value="AUTO" fieldtype="LIST" keylist="ta
ketypes" />
</fields>
</variant>
</variants>
<!-- List of active channels (graphics destinations) as configured 1in
OverlayGraphics Interface-->
<keys name="channels">
<k>WALL_2</k>
<k>WALL</k>
<k>TABLE</k>
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<k>DSK</k>
</keys>
<keys name="taketypes'">
<k>AUTO</k>
<k>MANUAL</k>
</keys>
</type>
</mosarttemplate>
</mosPayload>
</mosExternalMetadata>
</mosObj>

& Note: The list of channels contains the active destinations (destinations linked to a graphic
engine) as configured in Overlay Graphics interface.
See section Overlay Graphics Configuration.

19.5.5 Octopus

When using template feedback to Octopus, templates are listed with the Mosart Type names only,
not the translated names from the NRCS tags list in Newsroomsettings.

For Viz Mosart to be able to create the correct timeline objects you must include the Mosart
type names as NRCS tag names for all template types.
As a partial example:

<tags>

<tag name="CAM" type="CAMERA" scope="All" />

<tag name="CAMERA" type="CAMERA" scope="All" />

<tag name="00V" type="VOICEOVER" scope="All" />

<tag name="VOICEOVER" type="VOICEOVER" scope="All" />
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